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Introduction
ObjectScripting allows you to programmatically customize the Borland C++
integrated development environment (IDE) using built-in classes and a scripting
language called cScript, a language much like C++. This manual explains the cScript
language and describes how to write scripts, load them, and run them.

What's in this book
The ObjectScripting Programmer's Guide is organized into three parts:
Part I, "User's guide," introduces ObjectScripting and includes task-oriented
information on writing, running, loading, and debugging script files. It includes a
quick tutorial to help you become familiar with writing and running scripts.
Part II, "Language reference," explains the basics of the cScript language and
includes information on keywords and functions, operators, and preprocessor
directives.
Part III, "Class reference," provides reference material on the built-in cScript classes
you use in a script file to customize the IDE.

Introduction
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Manual conventions

Manual conventions
This manual uses the typefaces and symbols described in Table 1.1 to indicate special
text.
Table 1.1

Typefaces and symbols in this manual

Typeface or symbol
Monospace .type

[]
Boldface

Itali.cs

M~aning

Monospaced text represents text as it appears on screen or in code. It also
represents anything you must type.
Square brackets in text or syntax listings enclose optional items. If using
the optional item, do not type the brackets.
Boldfaced words in text represent reserved words.
Italicized words in text represent identifiers, such as variables,
components, properties, methods, and events.

Software registration and technical support
The Borland Assist program offers a range of technical support plans to fit the
diverse needs of individuals, consultants, large corporations, and developers. To
receive help with this product, return the registration card and select the Borland
Assist plan that best suits your needs. North American customers can register by
phone 24 hours a day at 1-800-845-0147. For additional details on these and other
Borland services, see the Borland Assist Support and Services Guide included with this
product.
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User's guide

User's guide

ObjectScripting overview
With ObjectScripting, you can customize the Borland C++ IDE
programatically using built-in classes and a scripting language called cScript,
a language much like C++. cScript supports classes, late binding, objectspecific method overriding, and dynamic variable typing. Using cScript
requires C++ or other object-oriented language experience.
Through an object called IDEApplication, which is instantiated when Borland
C++ first starts up, you can access most parts of the IDE, including the
Editor, the debugger, the keyboard, and the Project Manager. You can
customize them to suit you, as well as add your own new features.

About running a script
By convention, the source files for scripts have the extension .SPP. When you
load a script for the first time, it is compiled into an interpretedtokenized
format called pcode. By default, the tokenized file is created with the same
name using the extension .sPX in the same directory as the script. The header
in the .sPX file contains the original name of the file from which it was
generated (the .spp file) and the date / time stamp of the .SPP file when it was
generated. Before executing a .spp file, the dates are compared to ensure the
source file has not changed. If it has, the. SPX file is regenerated.
If the script affects the display (for example, it contains print statements),
you see something onscreen immediately. If you define new behavior for the
IDE, you will see that behavior when you use that part of the IDE. The script
remains loaded until you unload it.

ObjectScripting overview
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About script loading

You can use the following commands to run scripts:
Table 2.1

Scripting commands

Command . ;.

D;escripfion; .

Script I Run

Opens the Script Run window at the bottom of the IDE desktop, into
which you enter a single script command. Executing a single script
statement is useful when you are developing and testing a script.
Compiles the file in the active Edit window. If the compile is
successful, the script is loaded into the IDE and runs.
Compiles, loads, and runs the file in the active Edit window. Use
Script I Run File if your script contains a breakpoint statement.

Script I Compile
Script I Run File

Use Script I Commands to open the Script Commands dialog box which
displays a list of the available script commands and variables, including
classes, functions, and global objects. If an object is an instance of a class, its
properties and methods are also displayed.
To run a script command,
1 Double-click a command from the list.
2 Enter the argument, if any, next to the selected command.
3 Click Run.

About script loading
You can load a script in any of the following ways:
• Choose the Script I Modules command. In the Script Modules dialog box,
choose the module, or script, you want to load. Click Load. All loaded
modules and all modules on your script path are list~din the Script
Modules dialog box.
• Enter the name of the script in the Startup Scripts field in the Scripting
Options dialog box. For example, enter test. To specify multiple scripts,
separate script names with spaces.
• Specify a script on the BCW command line with the -s switch. The script is
loaded after the complete processing of scripts specified in Scripting
Options dialog box.
• Script names require no quotation marks.
• If you include script parameters, put the script name and parameters in
quotation marks, or put the parameters in parentheses.

• To pass string parameters, enclose the strings in backslash-quotation
combinations.
• To start multiple scripts, use the -s parameter for each script.

2-2
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About script initialization

• Modify the source code of STARTUP.SPP (or any of the files that it loads).
Note that when you update to a new version of Borland C++, you need to
redo the changes to STARTUP.SPP.
• Create a script called PERSONAL.SPP in the Script directory. This script
is automatically loaded after STARTUP.SPP finishes processing.
PERSONAL.SPP can load other scripts, allowing multiple scripts to be
loaded whenever the IDE starts. Using PERSONAL.SPP protects your
script from being overwritten by new releases of Borland C++.
Note

Exannple

To run a loaded script that has either an _initO function or a function with
the same name as the script, choose the function name from the Script
Commands dialog box.
//Starts three scripts from the. BCW command line using the
//-s switch.
//Script3 shows how to start a script from the command line
I/with optional parameters. Note that the script name and
//parameters are in quotation marks.
bcw -sScriptl -sScript2 -s" Script3 Paraml Param2"
//MyScript shows how to pass string parameters using
//backslash-quotation combinations.
bcw -sMyScript(\"string\", \"string\")

The advantage to starting the script from the command line is that the script
will not be·affected whenever you update to a new version of Borland C++.

Exannple

//Starts three scripts - "test", "MyScript" and "bar" //from the Startup Scripts field of the Scripting
//Options dialog box.
test MyScript bar

The advantage of loading a script from the Startup Scripts field of the
Scripting Options dialog box is that script names can be shared by multiple
Borland C++ users. Since a script's path is stored as part of the .sPX file, the
script directory must be mapped to the same path for all users using the
script.
However, every time you install a new version of Borland C++, you have to
reenter script·names.

About script initialization
When you load. a module into the IDE, script initialization takes place as
follows: global commands are processed first, followed by the _initO
function, if one exists. If an auto call function exists, it is processed last.

ob j e c t S c rip tin 9
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About script function referencing

Initialization is the order in which script commands and functions are
processed.
O.rder processed

.·Description

Global commands
_initO function

Script commands not in a function block.
If a module contains an _initO function, it runs automatically,
immediately after the global commands. 1£ a series of scripts are
loaded at the same time, first all the _initO functions are
processed (left to right).
If a module contains a function with the same name as the file in
which it resides (an autocall function), it will execute
automatically, immediately after the global commands and the
_initO function (if any).

Autocall function

The script initialization process lets you implement functionality without
changing the STARTUP script, the IDE command line, or the Borland C++
configuration files.

Example

Assume you have written a script called HELLO.sPP that contains a function
called hello declared as follows:
hello ()
{

print "Hello World";

When you load the script HELLO.sPP for the first time, the message Hello
World displays in the Script page of the Message window and the helloO
function stays in memory. If you subsequently choose Script I Run and type
hello () in the Script Run window and press Enter, the script processor calls
the function helloO which displays Hello World in the Message window.

About script function referencing
When a function is referenced in a script, it is processed as follows:
All loaded modules (scripts) are searched for a matching function name.
Searches are case sensitive (Test is not the same as test). The search starts
with the module most recently loaded. If unsuccessful, the search
continues to the next most recently loaded module.
2 If found, the function executes. If the function exists in more than one
loaded module, the function located in the most recently loaded module is
executed an~ other instances are ignored.
3 If the function is not found, the IDE checks an internal table constructed
by calls to ScriptEngine.SymbolLoad. This table contains a list of scripts and
the predefined symbols they contain. If the function is found in the table,
the associated module is loaded into the IDE and the script runs.
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About script debugging

4 If no matching function is found, the IDE searches the script path defined
in the Scripting Options dialog box for a script file name that matches the
function name.
• If a matching script file name is found, it is loaded into the IDE and the
script runs.
$

Note

If no matching script file name is found, the IDE displays a message in
the Script page of the Message window indicating that the function was
not found.

After the module is loaded, a second search for a function may be successful
when the first search was not. For example, assume that a script file is found
in the symbol table and gets loaded as a result of a function reference. The
first search does not find the function, so the function does not execute. After
the module is loaded, however, a second search finds the function in
memory and it executes.

About script debugging
You can debug scripts using one of the following techniques:
•
•
•
•

Built-in diagnostics
The breakpoint statement
The print statement
The Script I Run command

Built-in diagnostics
To force the cScripting environment to provide diagnostic messages and stop
at breakpoints, you need to set the Scripting options Stop at Breakpoint and
Diagnostic Messages. Stop at Breakpoint halts execution of a script at a
breakpoint statement. Diagnostic Messages displays messages in the Script
page of the Message window. For information on setting Scripting options,
see "Setting scripting options" on page 2-10.

The breakpoint statement
When you enter a breakpoint statement into your script and the Scripting
option Stop at Breakpoint is on, script execution halts and the Script
Breakpoint Tool is displayed. The Script Breakpoint Tool allows:
• Stepping over or into function calls
• Evaluation of the values of expressions or script variables

ObjectScripting overview
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About example scripts

The print statement
Use the print statement to display a value. Output from a print statement is
displayed in the Script page of the Message window. Printed messages are
placed into a queue which, when time allows, is moved into the view.

The ScriptlRun command
The Script I Run command opens the Script Run window at the bottom of the
IDE desktop, into which you can enter a single script command. The results
of the command are immediately displayed in the IDE, making results
immediately available.

About example scripts
Choose Script I Install/Uninstall Examples to load all examples in the BC5\
SCRIPT \ EXAMPLES directory. This command loads:
• All example scripts and makes them available in the Script Commands
dialog box
.
• The Script Manager, a script that helps you work with the example scripts
To unload example scripts or the Script Manager, choose Script I Install/
Uninstall Examples again and restart BCW.
Once the example scripts are loaded, choose the menu item Example Scripts
to see a list of all example scripts. Choose the Example Scripts I Script
Directory command to display the Script Directory window, where you can
load, edit, and unload an example script, as well as edit the Script Manager
data file.

Example scripts
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The script examples directory contains the following types of scripts and
script applets:
Script management

Editing

Coding

Debugging

Project management

Miscellaneous

Support classes and routines

Demonstration
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About example scripts

Table 2.2

Script management examples

Script

Description

LOADLAST.sPP

Load Last Script. Loads the last-loaded script. Useful for
frequently reloading a script under development (before it is
assigned to a hot key, menu, or some other quick trigger).
Script Manager. Allows you to specify scripts for autoloading.
Adds scripts to IDE menus. Displays the Script Directory window.
Test Harness. A template for inserting test code.

SPPMAN.5PP
TEST.SPP

Table 2.3

Editing examples

Script

Description

ALIGNEQ.SPP

.Align at Equals. Aligns a block of assignments by positioning the
equals operators one space after the longest lvalue in the current
block.
API Expander. Expands current word in editor to the matching
Windows API or C RTL signiture. Provides selection list if seed
string has multiple matches. If the match is an RTL member, API
Expander indicates if the corresponding header file needs to be
added to the source file.
Commenter. Comments the selected block, or removes the
comment if the lines are already commented.
Editor Size. Allows easy customization of Edit window size and
position without changing default values in STARTUP.SPP.
CONFIG.SPP provides a different but more comprehensive
approach to positioning IDE windows.
Edit Only. Temporarily shows only those lines in the current buffer
that contain a specified string. Useful.for seeing how an identifier is
being used, making changes without searching and replacing,
isolating strings for spell-checking, etc.
Shift Block. Shifts the current block right or left a column at a time.
Search All. Searches and replaces across files in the current project.
BRIEF Template Support. Causes the IDE to use BRIEF template
support. This support is used in all editor emulation.

APIEXP.5PP

COMMENT.SPP
EDITSIZE.SPP

EDONLY.SPP

SHIFTBLK.SPP
SRCHALL.SPP
TEMPLATE.5PP

Table 2.4

Coding examples

Script

Description

CODELIB.SPP

Code Library. Displays libraries of code snippets you can insert in
the current buffer. You can also edit code library data files, and
create library entries from selected text. You can create as many
code libraries as you want.
File Insert. Inserts a file into the current buffer.
Find Tabs. Searches all .C, .H, .CPP, .HPP, and .SPP files in the
specified directory and reports all lines that have at least one tab
character to the message database. Double-click a message to edit
the referenced file. Useful for coding styles that don't use tab
characters.

FILEINSRSPP
FINDTABS.SPP

ObjectScripting overview
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Table 2.4

Coding examples (continued)

Script

Description"

LONGLINE.SPP

Long Line Finder. Searches all.C, .H, .CPP, .HPP, and .spp files in
the specified directory and reports all lines that are longer than a
given threshold value to the message database. Double-click a
message to edit the referenced file.
Open Header. Opens the .R or .HPP file corresponding to the
current source file. Optionally creates a header file if one does not
exist.
Code Revisit Tool. Quickly lists occurrences of a configurable
"revisit this code" marker in all files in the specified directory.

:

OPENHDR.SPP

REVISIT .SPP

Table 2.5

:;'Coo''"'O

Debugging examples

Script

Description

EV ALTIPS.SPP

Evaluation Tips. When the debugger has a process loaded, evaluates
the item under the cursor and displays the result in a mouse tip.
View Locals. Inspects local variables if the debugger has a process.

VIEWLOCS.SPP

Table 2.6

Project management examples

Script

Description

LOADPROJ.SPP
PRJNOTES.SPP

Load Project. Opens the last project on startup.
Project Notes. For new projects, creates a notes text file in the
project directory and adds it to the project.

Table 2.7

Miscellaneous examples

Script

Description

AUTOSAVE.5PP

Autosave. Saves files, environment, desktop, project, and/ or
messages at the specified interval.
Configure Windows. Resizes and positions IDE windows as they
are created. Also maps keys in the default and classic keyboards
for buffer manipulation.
Directory Tool. Creates a new tool called Directory Listing, which
takes a file specification and generates a directory listing in the
Message window.
File Maintenance. Displays a directory listing and loads the
following commands:

CONFIG.SPP

DIRTOOL.SPP

DIRVIEW.SPP

Command

Description

Backspace
Backs up one directory
Delete
Deletes selected file or directory
Enter
Changes to selected directory or opens selected file
Insert
Creates a new file in the current directory
Escape
Exits the directory listing.
To make these commands the default, add the following to
STARTUP.SPP:
scriptEngine. Load (" dirview") ;

2-8
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Miscellaneous examples (continued)

Table 2.7

Script

Description

FASTOPEN.SPP

Fast Open. Opens files and projects based on a search path, so you
don't have to navigate directories.
Key Assignments. Shows what commands are assigned to a given
key sequence.
'

KEYASSGN.sPP
NETHELP.sPP

SOUND.SPP

Internet Help. Opens an URL with Netscape Navigator by
selecting from a list of programming pages, FTP sites, and
newsgroups.
'
Sound Enabler. Plays W A V files on specified IDE events, such as
Build Failure.

Table 2.8

Support classes and routines

Script

Description

FILE.SPP
FOREACH.SPP

File Classes. Includes configuration file management.
For Each. Calls a function for all the nodes of the given type in a
project.
Message Class. Provides methods to simplify and standardize user
messages. Message captions automatically indicate the calling
module.
Miscellaneous. Miscellaneous script.
Sort. Quick sorting routines.

MSG.SPP

MISC.SPP
SORT.sPP

Table 2.9

Demonstration examples

Script

Description

AUTO.SPP

Automation. Demonstrates the IDE as an OLE automation controller
and server.
CRTL. Demonstrates script access to the CRTL by writing to a file.
International. Demonstrates the use of FormatString for localization
of strings in scripts.
Module List. Demonstrates how to handle events from other objects
to maintain the contents of a list. Implements some of the
functionality provided by the Script Modules dialog box.
Multi-select list window. Demonstrates a simple multiple-selection
list window. Also shows how to position a popup window in the list.
List Window. Demonstrates a simple sorted list window.
SpeedMenu. Demonstrates a simple SpeedMenu.

CRTL.SPP
INTNATL.SPP
MODLIST.SPP

MLIST.sPP
LIST.sPP
POPUP.SPP

Script' Directory window
To display the Script Directory window, choose Example Scripts I Script
Directory.
Note

To display the Example Scripts menu bar item, choose Script I Install/
Uninstall Examples.
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Setting scripting options

The Script Directory window consists of four columns of information:
Table 2.10

Script Directory window

C~Jurnt);;: ::';~.s:~rlPtiQIl,.'V;:
Script Name
. Description
Autoload Status
,Load Status

The name of script file in the BC5\ SCRIPT \ EXAMPLES directory.
A brief description of what the script does .
Indicates whether the script is automatically loaded when BCW is
started up.
Indicates whether the script is currently loaded.

Click a script to display the Script Directory SpeedMenu. Commands on the
SpeedMenu let you load, edit, and unload script files; edit the Script
Manager script file; cancel the SpeedMenu; and close the directory.
Table 2.11

Script Directory'SpeedMenu

, Column

Description

Load
Loads the selected script file.
Edit
Loads the selected script file into an Edit window.
Unload
Unloads the selected script file.
Edit Script Manager Data File Loads the Script Manager data file, SPPMAN .oAT, into
an Edit window.
Cancel
Cancels the SpeedMenu.
Close Directory
Closes the Script Directory window.

Setting scripting options
To set options for the scripting environment,
Choose Options IEnvironment IScripting. The Scripting Options dialog
box is displayed.
2 Set the following options:
Table 2.12

Scripting options

Opti()n~'

~Q$cripti~n

Stop at Breakpoint

Stops the script when the keyword breakpoint appears.
Loads the script debugger's Breakpoint Tool.
Specifies whether or not to display all script processor
messages in the Script page of the Message window. By
default, this option is off.

Diagnostic Messages
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Table 2.12

Scripting options (continued)

.Option

Descriptior.

Startup Scripts

Script Path

Specifies the script to load and execute as part of the IDE
startup procedure. (Borland C++ always tries to load
STARTUP.SPP from the SCRIPT subdirectory or any path
you specify for scripts.) Use spaces to separate multiple
script names. You can specify script parameters by enclosing
the script name and its arguments in qtlotation marks. For
example,
MyStartup DisplayCurProj "Ascript Paraml"
Specifies the path to search when loading a script. During a
load, every entry on the path is searched for a file with the
.SPX extension. If that fails, the same directories is searched
a second time for files with the .spp extension. Starting the
path with . i causes the current directory to be searched first.

Executing a script statement
To execute a script print statement and view it in the Script page of the
Message window,
1 Choose View I Message. Click the Script tab to open the Message window
Script page, where the output of all script print statements is directed.
To start with a blank page, delete the existing messages by right clicking
in the Script page and choosing Delete All.
2 Choose Options I Environment I Scripting and click Diagnostic Messages
to send all scripting messages to the Script page.
3 Choose Script I Run. The Script Run window opens at the bottom of the
IDE desktop.
4 Enter the following statement:
print "Hello World" i

5 Press Enter.
Hello World

is displayed at the end of the Message window.

If you made an error entering the statement, error messages appear in the
Script page of the Message window.

Displaying output in a message box
To display output in a message box, instead of in the Script page of the
Message window,
Choose Options I Environment I Scripting and click Diagnostic Messages
to send all scripting messages to the Script page.

ObjectScripting overview
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2 Choose Script I Run. The Script Run window opens at the bottom of the
IDE desktop.
'
3 Enter the following statement:
IDE.Message("Hello World");

The method IDEApplication.Message displays output in·a message box
instead of in the Message window.
4 Press Enter.
Hello World is displayed in an information dialog box.

If you made .an error entering the statement, error messages appear in the
Script page of the Message window.

5 Click OK to close the message box.

Writing a script
Scripts are simply ASCII text files. You can use any text editor to write a
script, then save it to a file with an .spp extension. Header files for scripts
typically have the extension .H. (Header files are used to define constants
and provide for conditional compilation.) .
Follow these steps to write a simple script:
1 Choose Options I Environment I Scripting.
2 Add your script directory to the Script Path so the IDE can find your
scripts. For example, if your path already contains. iC: \BC5\SCRIPT, it
would look like this after you add a directory.called C: \ MYSCRPTS:
.;C:\BC5\SCRIPT;C:\MYSCRPTS

Do not insert any spaces before your path name. Doing so will stop the
search at the previous path.
3 While you're in the Scripting options dialog box, click Diagnostic
Messages to send scripting error messages and print statement output to
the Script page of the Message window.
4 Press Enter to exit the Scripting Options dialog box.
5 Choose View I Message and click the Script tab to open the Message
window Script page.
To start with a blank page, delete the existing messages by right clicking
in the Script page and choosing Delete All.
6 Choose File I New I Text Edit to open a new file in the IDE editor. Enter the
following script:

2-12
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import IDE;//Use the IDE object and any of its methods
hello ()
{

IDE.Message ("Hello World");
}

7 Choose File I Save and save the file with an .SPP extension in a directory of
your choice (for example, C: \ MYSCRPTS \ HELLO.SPP).

Running a script
To run the script you just created,
Choose Script I Run File.
Script I Run File compiles the script, runs it, and loads it into the IDE.
2 Hello World is displayed in a message box.
If you made an error entering the statement, error messages appear in the

Script page of the Message window.
3 Click OK to close the message box.

Debugging a script
To add a debug statement to a file and use the script debugger,
1 Choose View I Message. Click the Script tab to open the Message window
Script page, where the output of all script print statements is directed.
To start with a blank page, delete the existing messages by right clicking
in the Script page and cho~sing Delete All.
2 Choose Options I Environment I Scripting and click Stop at Breakpoint to
stop the script at the breakpoint statement and open the Script Breakpoint
Tool.
'
3 Click Diagnostic Messages to send all scripting messages to the Script
page.
4 Choose File I Open and open the Hello World file.
The file should look like this:
import IDE;//Use the IDE object and any of its methods
hello ()
{

IDE.Message ("Hello World");
}

ObjectScripting ,overview
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5 Embed the keyword breakpoint in your source code before line that starts
with IDE.Message. The file should now look like this:
import IDE;//Use the IDE object and any of its methods
hello ()
{

breakpoint;
IDE.Message ("Hello World");
}

6 Choose File I Save.
7 Choose Script I Run File.
S The Script Breakpoint Tool is displayed.
@>

@>

Click Step Over to execute the call to IDE.Message without stepping into
and executing it. Note that nothing happens since you are stepping
over the line that displays output. Press Run to run the script to the
end.
Click Step Into to step into and execute IDE.Message. Hello Word is
displayed in a message box. Press OK to close the message box .

.. Click Run to continue full-speed execution of the script until the next
breakpoint statement is encountered, or the script ends.
@>

@

Click Abort to cancel script execution and close the Script Breakpoint
Tool.
To immediately execute a line of code, enter the code into the
Statement(s) edit box and click Execute. This lets you test code before
you add it to your script.

Script Breakpoint Tool
The Script Breakpoint Tool is a script debugging tool that lets you step
through cScript statements and evaluate the values of expressions or script
variables. The Tool is displayed when a breakpoint statement is encountered
in an executing script.
Note

To display the Script Breakpoint Tool, the Stop at Breakpoint option in the
Scripting Options dialog must be on.
Script function calls can either be stepped over or into, and the value of any
variable visible within the context of the actively executing script can be .
evaluated. The name of the running script is displayed as well as the next
statement to be executed and its line number.
When the Script Breakpoint Tool is active, output from print statements in
the script itself continue to be sent to the Script page of the Message window.
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However, you can enter a print statement in the Immediate Mode
Statement(s) edit box whose output is displayed in the Output box.
Table 2.13

Script Breakpoint Tool options

Option

Description

Immediate Mode
Statement(s)

The cScript statement to execute.
Immediate Mode statements are executed in the context of the
active script, as if the statement entered were actually in the
script before the next line of the script about to be executed.
Variables must be within scope in that context to be available for
evaluation. In-scope variables can be both read and their values
changed, although caution must be taken in changing them.
Any function available to script at the time of execution can also
be called, whether a local cScript function, an IDE object method,
or an external library function from an active dynamic library.
Care must be taken to ensure that the method is appropriate in a
given context.
If the statement is a print statement, its output is displayed in the
Output box. In this way, an Immediate Mode Statement can be
used to inspect the current value of script variables.
Executes the cScript statement in the Immediate Mode
Statement(s) edit box.
Displays the results of the statement executed in the Immediate
Mode Statement(s) edit box. Output is displayed only if the
statement is valid or if you have pr~ssed the Execute button.
Continues full-speed execution of the script until the next
breakpoint statement is encountered or the script ends.

Execute
Output

Run
Abort
Step Over

Stops script execution and closes the Script Breakpoint TooL
When the next executable statement is a call to a cScript function,
executes the function call without stepping into and executing
the function's statements.
'

Step Into

When the next executable statement is a call to a cScript function,
steps into and executes the function's statements.

Help

Displays Help.

Unloading a script
Scripts are not unloaded automatically. To unload a script,
1 Choose Script I Modules.
2 In the Script Modules dialog box, choose the na~e of the script you want
to unload.

3 Click Unload.
Scripts can also be unloaded by using unload.

ObjectScripting overview
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Unloading a script

When a script unloads, it looks for a function in the script called -0 (the name of the
function is simply a tilde). If this function is found, it is executed as part of the script
unloading process and acts as a destructor for the script.
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ObjectScripting tutorial
This tutorial teaches you how to use the cScript language to add menu items to the
Help menu. The tutorial consists of four parts:
.
Part 1 Adds an item to the Help menu that prints text in the Script page of
the Message window. This part takes approximately 10 minutes to
complete.
Part 2

Adds the menu item OWL Help to the Help menu and launches the
OWL Help file when the menu item is selected. This part takes
approximately 10 minutes to complete.

Part 3 Adds two new items, ObjectScripting Help and Standard Template
Library Help, to the Help menu using two different methods.
Launches the appropriate Help file when a menu item is selected.
This part takes approximately 15 minutes to complete.
Part 4

Adds all of the Borland C++ Help files to the Help menu. Launches
the appropriate Help file when a menu item is selected. This part
takes approximately 20 minutes to complete.

About this tutorial
Each part of this tutorial teaches how to accomplish a unique task, building on
knowledge learned in the previous part(s). It is recommended that you follow the
tutorial from beginning to end. You are not required to complete the tutorial in one
sitting, however. You can choose to complete only one part and return at another
time to complete another part or parts.
Note

When entering sample code, type it exactly as shown, noting indentations and curly
braces. Press Enter at the end of each line you add.

ObjectScripting tutorial
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ObjectScripting Tutorial: Part 1
This part of the tutorial teaches you how to:
•
•
•
•
•
•
•

Start the script file (step 1)
Create a local instance of an object (step 2)
Create a class (step 3)
Load MENUHOOK.SPP(step 4)
Declare a method that adds a menu item (step 5)
Execute the method (step 6)
Run the script file (step 7)

Sample code for Tutorial Part 1
II ObjectScripting example
II Copyright (c) 1996 by Borland International, All Rights Reserved
II STEP1.SPP: Add an item to the .Help menu that prints text
II
in the Script page of the Message window.
declare ScriptEngine scriptEngine;
class HelpMenu ( )
{

II Load "MENUHOOK.SPP", necessary for adding menu items.
if ( !scriptEngine. IsLoaded ("menuhook. spp") )
{

scriptEngine. Load ("menuhook. spp") i
}

II Declare a method to add a menu item and execute the associated script.
AddMenu(menu_text, script_text)
{

assign_to_view_menu("IDE", menu_text, script_text, menu_text);
}
}i

II At load time, create a Print Text menu item on the Help menu.
II When Print Text is selected, print "A message from the Help menu!"
II in the Script page of the Message window.
declare x = new HelpMenu() i
x.AddMenu("&HelpIPrint Text", "print(\"A message from the Help menu!\") ");

Starting the script file
To start a script file in Borland C++,
Choose File I New I Text Edit.
2 To name the file, choose File I Save As.
3 In the Save File As dialog box, choose the following directory:
C:\BC5\SCRIPT\EXAMPLES
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4 In the File Name box, enter the name STEPl ~ SPP.
5 Click OK.
You have just started a script file called STEPl.sPP.
In the next step, you will start adding code to your script file.

Creating tt local instance of an object

Part 1, step 2 of 7

A ScriptEngine object loads, unloads, executes, maintains modules and keeps error
information on scripts. In this step, you will create a local instance of the object.
To create a local instance of a ScriptEngine object,
1 Enter the following text in STEPl.sPP:
declare ScriptEngine scriptEngine;

You have just created a local instance of a ScriptEngine object. Creating the script
engine locally provides slightly better performance than importing the symbol of the
system-wide instance.
In the next step, you will create a class called HelpMenu.

Creating a class

Part 1, step 3 of 7

Use the class keyword to define a cScript class. A class is a collection of properties,
methods, and events that affect the behavior of the IDE.
To create a cScript class,
1 . Add the following line to your script file:
class HelpMenu ( )

You have just created a class called HelpMenu. You will use this class in your script
file when you add a menu item to the Help menu.
In the next step, you will load the file MENUHOOK.sPP.

Loading MENUHOOK.SPP

Part 1, step 4 of 7

MENUHOOK.DLL, in the BC5 \ BIN direCtory, contains the functionality you need to
add menu items to menus, menu items to SpeedMenus, and buttons to the SpeedBar.
To use this functionality, you need to load the associated script file,
MENUHOOK.SPP.

o b j e c t Sc rip tin 9

t u tor i a I

3-3

ObjectScripting Tutorial: Part 1

When you load MENUHOOK.sPP, the following functions become available:

Function
assign_to_view_menuO
remove_view_menu_itemO
define_buttonO

Adds a menu item to a menu
Removes a menu item that was added with
assign_to_view_menu 0
Defines a button that can be added to the SpeedBar

To load MENUHOOK.sPP,
1 Add the following lines to your script file:
{

if ( ! scriptEngine. IsLoaded ("menuhook. spp") )
{

scriptEngine. Load ("menuhook. spp") ;
}

The first line uses the if keyword with the! logical operator and the
ScriptEngine.IsLoaded method to determine if MENUHOOK.SPP has already been
loaded. If it has not been loaded, the ScriptEngine.Load method loads it.
Note

Case is important when loading and running script files. For more information,
see" About script initialization" on page 2-3 and" About script function
referencing" on page 2-4.
You have just loaded MENUHOOK.sPP.
In the next step, you will declare a method that adds a menu item.

Declaring a method that adds a menu item

Part 1, step 5 of 7

This step declares a method, AddMenuO, that adds a new menu item to the Help
menu.
To declare AddMenuO,
Add the following lines to your script file:
AddMenu(menu_text, script_text)
{

assign_to3iew_menu("IDE", menu_text, script_text, menu_text);
}
};

The first line declares amethod called AddMenuO with the parameters menu_text
and scripCtext. AddMenuO uses assign_to~view_menu, a function defined in
MENUHOOK.SPP, to assign a menu item to a menu.
You have just declared the AddMenuO method.
In the next step, you will execute the method when the menu item is selected.
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Exe'cuting the method

Part 1, step 6 of 7

To execute AddMenuO when the menu item is selected,
1 Add these lines to your script file:
declare x = new HelpMenu()i
x.AddMenu("&HelpIPrint Text", "print (\"A message from the Help menu!\") ") i

The declare keyword declares the variable x. This line also assigns the variable x to
a new instance of the HelpMenu class.

x.AddMenu displays the string Print Text on the Help menu. A message from the
Help menu! is displayed on the Script page of the Message window when Help I
Print Text is selected.
You have just executed a method that prints a message on the Script page of the
Message window.
In the next step, you will run the script file.

Running the script file

Part 1, step 7 of 7

To run the script file you've been working on,
Choose File I Save to save the script file.
2 To run the script, right click in the Edit window and choose Run File.
3 To see the results, go to the Help menu. Note that the menu item Print Text has
been appended to the bottom of the Help menu. Click Print Text.
4 Display the Message window by choosing View I Message. Choose the Script tab.
Scroll to the bottom of the message display, where the following text is displayed:
A message from the Help menu!

5 To remove the Print Text command from the Help menu, exit Borland C++. When
you load Borland C++ again, Print Text will no longer display.
You have now finished Part 1 of the tutorial.
In Part 2, you will add the menu item OWL Help to the Help menu and launch the
OWL Help file when the menu item is selected.

ObjectScripting Tutorial: Part 2
This part of the tutorial teaches you how to:
•
•
•
•

Import the IDE object (step 1)
Import a symbol of a system-wide instance of a ScriptEngine object (step 2)
Declare a method that adds a menu item to the Help menu (step 3)
Execute the method (step 4)
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Sample code for Tutorial Part 2
II ObjectScripting example
II Copyright (c) 1996 by Borland International, All Rights Reserved
II STEP2.SPP: Add the menu item OWL Help to the Help menu. Launch the
II
OWL Help file when OWL Help is selected.
import IDE;
import scriptEngine;
class HelpMenu()
{

II Load "MENUHOOK.SPP", necessary for adding menu items.
if

(! scriptEngine. IsLoaded ("menuhook. spp")
{

)

scriptEngine. Load ("menuhook. spp") ;
}

II Declare a method to add a menu item and execute the associated script.
.

AddMenu(menu_text, script_text)
{

assign_to3iew_menu ("IDE", "&Help I" + menu_text., script_text, menu_text);
}
};

II At load time, create an OWL Help menu item on the Help menu.
II When OWL Help is selected, launch the help file OWL.HLP.
declare helpMenu = new HelpMenu();
helpMenu. AddMenu ( "OWL Help", "IDE. HelpOWLAPI ( ) " ) ;

Importing the IDE object

Part 2, step 1 of 4

When you start the Borland C++ IDE, the object IDE, in IDEApplication, is
automatically created as a global object. IDE gives you control over the system. All
items contained in the Borland C++ IDE menu structure can be accessed through the
ID E object.
I

First, start a script file and call it STEP2.SPP. If you don't know how to do this, see
Part I, step l.
To import the IDE object,
1 Enter the following text in the script file.
import IDE;

You have just started a script file and imported the IDE object.
In the next step, you will import a symbol of a system-wide instance of the
ScriptEngine object.
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Importing a symbol of the system-wide
instance of an object

Part 2, step 2 of 4

A ScriptEngine object loads, unloads, executes, maintains modules and keeps error
information on scripts. You can import a symbol of a system-wide instance of the
ScriptEngine object (note that a local instance can also be created).
To import a symbol of a system-wide instance of a ScriptEngine object,
1 Enter the following text in your script:
import scriptEngine;

You have just imported a symbol of a system-wide instance of a ScriptEngine object.
Importing the symbol as system-wide makes the script engine's functionality
available to all scripts. In Part 1; step 2, you created the script engine as a local
instance, which slightly increases performance.
In the next step, you will create a class called HelpMenu, load MENUHOOK.5PP, and
declare a method that adds a menu item.

Declaring a method that adds a menu item

Part 2, step 3 of 4

This step declares a method, AddMenuO, that adds a menu item to the Help menu.
As you learned in Part I, create a class called HelpMenu, then load
MENUHOOK.SPP. If you need more information, go to Part I, step 3 and step 4.
To declare AddMenuO,
1 Add the following lines to your script:
AddMenu(menu_text, script_text)
{

assign_to_ view_menu ("IDE", "&Help I" + menu_text, scripLtext, menu_text);
}
};

The first line declares a method called AddMenuO with the arguments menu_text
and script_text. AddMenuO usesassign_to_view_menu, a function that is defined
in MENUHOOK.SPP, to add a menu item to a menu. In this case, the new menu
item is being added to the Help menu of the IDE view.
Note

In Part I, step 5, you performed a similar task, but specified the Help menu when
the method was loaded. These two examples represent two different ways to use
the assign_to_view_menu function.
You have just created HelpMenu class,·loaded MENUHOOK.5PP, and declared the
AddMenuO method.
In the next step, you will execute the method and run the script.
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Executing the method

Part 2, step 4 of 4

To execut~ AddMenuO when the associated menu item is selected,
1 Add these lines to your script:
declare helpMenu = new HelpMenu() i
helpMenu. AddMenu ( "OWL Help", "IDE. HelpOWLAPI () ") i

The declare keyword declares the variable helpMenu. This line also assigns the
variable helpMenu to a new instance of the HelpMenu class. (Note the difference in
case; cScript is a case-sensitive language.) helpMenu.AddMenu displays OWL Help
on the Help menu and launches the associated Help file when Help I OWL Help is
selected.
2 Save the script file and run it. For more information, see Part I, step 7.
To see the results, go to the Help menu. Note that the menu item OWL Help is
now on the Help menu.
3 Click OWL Help.
The Contents topic of the OWL Help file is displayed.
4 To remove the OWL Help command from the Help menu, exit Borland C++.
When you load Borland C++ again, OWL Help will no longer display.
You have just learned how to execute a method that launches the OWL Help file
when the menu item OWL Help is selected.
You have now finished Part 2 of the tutorial. In Part 3, you will use two different
methods to add two new items, ObjectScripting and Standard Template Library, to
the Help menu.

ObjectScripting Tutorial: Part 3
This part of the tutorial teaches you how to:
• Locate the Borland C++ Help directory and store it (step 1)
• Declare two methods that add menu items to the Help menu (step 2)
• Assign a menu item to the Help menu (step 3)
• Declare a function that adds a backslash to the Help directory path name (step 4)
• Launch a Help file when the associated Help menu item is selected (step 5)

Sample code for Tutorial Part 3
// ObjectScripting example
// Copyright (c) 1996 by Borland International, All Rights Reserved
1/ STEP3.SPP: Add two menu items to the Help menu. Launch Help files
//
when menu item is selected.

3-8
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import IDE;
import scriptEngine;
class HelpMenu()

II Find the help directory and store it in the static sHelpDir
declare sProgram = new String();
sProgram.Text = IDE.ModuleName;
declare breakIndex = sProgram. Index ( "\ \BIN\ \ ", SEARCH_BACKWARD);
declare sHelpDir = sProgram.SubString(O, breakIndex - 1) .Text + "\\HELP\\";
II Load "MENUHOOK.SPP", necessary for adding menu items.
if ( !scriptEngine. IsLoaded ("menuhook. spp") )
{

scriptEngine.Load("menuhook.spp");
}

II Add a menu item under "Help" menu, launch the Help file
II associated with it. The helpFile parameter is the file name
II without the path.
AddHelpFile(menuText, helpFile)
{

AddHelpFileFullPath(menuText, sHelpDir + helpFile);
}

AddHelpFileFullPath(menuText, helpFile)
{

declare menuCmd =
"IDE.Help(\"" + AddBackSlash(helpFile) + "\", "
+ 113,

II

+ 11\11\1111 + 11);11;

assign_to_view_menu("IDE" , "&Helpl" + menuText,
menuCmd, menuText);
II
//
//
//

Important note! .
The command text passed to assign_to_view_menu
should be IDE:Help ("C: \ \BC5\ \HELP\ \ ... ", ... ).
When cScript compiles, it compiles the double backs lash
/1 as a single backslash. This routine adds a backs lash to
/1 the directory path name.

AddBackSlash(fileName)
{

declare origFileName = new String();
origFileName.Text = fileName;
declare targetFileName = "";
declare break Index = origFileName.Index("\\");
while (breakIndex > 0)
{

targetFileName += origFileName.SubString(O, breakIndex - 1) .Text
+ "\ \ \ \" ;

origFileName = origFileName.SubString(breakIndex);
breakIndex = origFileName .. Index (" \ \ " ) ;
}

targetFileName += origFileName.Text;
return targetFileName;
}
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};

II At load time, create two new menu items on the Help menu:
II ObjectScripting for SCRIPT.HLP, and Standard Template
II Library for STL.HLP.
I I These two menu items show two different ways to add a help item.
declare helpMenu = new HelpMenu();
helpMenu.AddHelpFile ("ObjectScripting", "SCRIPT .HLP");
helpMenu .AddHelpFileFullPath ("Standard Template Library",
"C:\\BC5\\HELP\\STL.HLP");

Finding the Help directory

Part 3, step 1 of 5

This step shows you how to find the name of the Borland C++ Help directory and
store it. You use the stored name when you add the Help file name to the Help menu.
First, start a script file and call it STEP3.SPP. Then, as previously learned:
• Import the IDE object (Part 2, step 1)
• Import a symbol of a system-wide instance of ScriptEngine (Part 2, step 2)
• Create a class called HelpMenu (Part 1, step 3)
To find the name of the Help directory,

1 Add the following lines to your script:
{

,

declare sProgram = new Stri'ng () ;
sProgram.Text = IDE.ModuleName;
declare breakIndex = sProgram. Index (" \ \BIN\ \", SEARCH_BACKWARD);

The declare keyword declares the variable sProgram. This line also assigns the
variable sProgram to a new instance of the String class. sProgram. Text is assigned
the value returned by IDE.ModuleName (the name of the currently executing
module).
The next line declares the variable breakIndex. This line also assigns breakIndex to
the string returned by the Index method (the occurrence of the specified substring).
2 Enter the following code to store the path name in sHelpDir.

= sProgram.SubString(O, breakIndex - 1) . Text + "\\HELP\\";
This line declares the variable sHelpDir. It also assigns sHelpDir to the value
returned by SubString (breakIndex using the specified starting and ending
positions) plus the value in $Program.Text plus the value "\ \HELP\ \".
You have just imported the IDE object, imported a symbol of a system-wide instance
of ScriptEngine, created a class called HelpMenu, and added code that will find the
name of the Help directory and store it in sHelpDir.
declare sHelpDir

In the next step, you will load MENUHOOK.5PP and declare two methods that add
menu items to the Help menu.

3-10
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Declaring methods that add menu items

Part 3, step 2 of 5

This step declares two methods:
• AddHelpFileO adds the Help file name to the Help menu and launches the Help
file.
• AddHelpFileFullPathO uses sHelpDir to locate the full path name of the Help
directory, then adds the Help file name to the Help menu and launches the Help
file.
First, as you learned in Part 1, add code to load MENUHOOK.SPP. (For more
information, see Part 1, step 4; however, in your code, do not include the first curly
brace shown in that step.)
To define AddHelpFileO and AddHelpFileFullPathO,
1 Add the following lines to your script:
AddHelpFile(menuText, helpFile)
{

AddHelpFileFullPath(menuText, sHelpDir + helpFile);
}

The first line declares AddHelpFileO, passing the arguments menu Text and
helpFile. The third line declares AddHelpFileFullPathO, passing the arguments
menuText and sHelpDir plus helpFile. In both cases, helpFile is the Help file name
without the path.
2 Add:
AddHelpFileFullPath(menuText, helpFile)

Here, the parameter helpFile now includes the path.
You have just declared methods that will add menu items to the Help menu.
In the next step, you assign a menu item to the Help menu.

Assigning a menu item

Part 3, step 3 of 5

This step shows how to use the assign_to_view_menu function to assign a new
menu item to the Help menu.
Note

When you load MENUHOOK.SPP, the assign_to_view_menu function
automatically becomes available.
To assign a menu item to the Help menu,
1 Add the following lines to your script:
{

declare menuCmd =
"IDE.Help(\"" + AddBackSlash(helpFile) + "\", "
+ 113,11 1:' 11\11\"" + lI)jllj
assign_to_view_menu (" IDE", "&Help I" + menuText,
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menuCmd, menuText);
}

The first statement invokes a Help file using the IDE.Helpmethod. The name of the
invoked Help file is assigned to menuCmd. The second statement uses the
assign_to_view_menu function to assign the new menu item to the Help menu.
You have just assigned a menu item to the Help menu.
In the next step, you will declare the AddBackSlashO function.

Adding a backslash to the path name

Part 3, step 4 of 5

Because cScript compiles a double backslash as a single backslash when it sends a file
path to WinHelp, you need to add code that will add a double backslash to your
script. This step declares the AddBackSlashO function, used in menuCmd (defined in
the previous step).
To declare AddBackSlashO,
1 Add the following lines to your script:
AddBackSlash(fileName)
{

declare origFileName = new String();
origFileName.Text = fileName;
declare targetFileName= "";
declare breakIndex = origFileName.Index("\\");
while (breakIndex > 0)
{

targetFileName += origFileName.SubString(O, break Index - 1) .Text
+ "\\\\";

origFileName = origFileName.SubString(breakIndex);
breakIndex = origFileName. Index ( "\ \ ") i
}

targetFileName += origFileName.Text;
return targetFileName~
}
};

.

The first declare statement declares the variable origFileName. This line also
assigns origFileName to a new instance of a String object. In the next line,
origFileName.Text is assigned to fileName.
The next·declare statement declares the variable targetFileName. This line also
assigns targetFileName an empty value. The last declare statement declares the
variable breakIndex. This line also assigns breakIndex to the string returned by the
Index method (~he occurrence of the specified substring).
The while loop says that while breakIndex is greater than zero, give targetFileName
. the current value of targetFileName plus the value returned in SubString (the value
of breakIndex specified by the starting and ending positions) plus
Then,
assign origFileName the value returned by the SubString method (the value of the
substring specified by breakIndex). The last line of the while loop assigns breakIndex
II \
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the value returned by the Index method. If this value is greater than 0, the while
loop executes again.
When breakIndex is equal to 0, targetFileName equals targetFileName plus the value
returned by the Text property. The return statement exits the AddBackSlashO
function, returning the value of targetFileName.
You have just declared the AddBackSlashO function used in the AddHelpFilePathO
method.
In the next step, you will add the Help file names to the Help menu and run the
script.

Executing Help menu methods

Part 3, step 5 of 5

This step shows how to execute AddHelpFileO and AddHelpFileFullPathO.
To execute these methods,
1 Add the following lines to your script file,
declare helpMenu = new HelpMenu()i
helpMenu.AddHelpFile("ObjectScripting", "SCRIPT.HLP")i
helpMenu . AddHelpF i leFull Pa th ( Standard Template Library",
"C:\\BC5\\HELP\\STL.HLP") i
II

The declare keyword declares the variable helpMenu. This line also assigns
helpMenu to a new instance of the HelpMenu class. (Note the difference in case;
cScript is a case-sensitive language.)

helpMenu.AddHelpFile assigns the value "ObjectScripting" tothe parameter
menu Text. SCRIPT. HLP is assigned to the helpFile parameter. SCRIPT.HLP is
launched when the Help I ObjectScripting menu item is selected.
helpMenu.AddHelpFileFullPath assigns the value "Standard Template Library" to
the parameter menu Text. STL.HLP(and the full path name) is assigned to the
helpFile parameter. STL.HLP is launched when the Help I Standard Template
Library menu item is selected.
2 Save the script file and run it. For more information, see Part I, step 7.
To see the results, go to the Help menu. Note that the menu items ObjectScripting
and Standard Template Library have been appended to the bottom of the Help
menu. Click Standard Template Library.
The Contents topic of the Standard Template Library Help file is displayed.
3 To remove the Help files from the Help menu, exit Borland C++. When you load
Borland C++ aga,in, these help files will no longer display on the Help menu.
You have just assigned new menu items to t~e Help menu, executed the associated
Help files, and run the script file.
You have now finished Part 3 of the tutorial.
In Part 4, you will add all the Borland C++ Help files to the Help menu.
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This part of the tutorial teaches you how to:
• Declare a fl.l.nctionthat adds all Borland C++ Help files to the Help menu (step 1)
• Execute the function (step 2)

Sample code for Tutorial Part 4
II ObjectScripting example
II Copyright (c) 1996 by Borland International, All Rights Reserved
II STEP4.SPP: Add all menu items to the Help menu. Launch Help' file
II
when menu item is selected.
import IDE;
import scriptEngine;
class HelpMenu()

II Find the help directory and store it in the static sHelpDir.
declare sProgram = new String();
,
sProgram.Text = IDE.ModuleName;
declare breakIndex = sProgram. Index ( \BIN\ \ ", SEARCH_BACKWARD);
declare sHelpDir = sProgram.SubString(O, breakIndex - 1) .Text + "\\HELP\\";
11 \

II Load "MENUHOOK.SPP", necessary. for adding menu items.
if(!scriptEngine.IsLoaded("menuhook.spp") )
{

scriptEngine. Load ("menuhook. spp" ) ;
}

II Add a menu item on the Help menu, launch the Help file
II associated with it. The helpFile parameter is the file name
II without the path.
AddHelpFile(menuText, helpFile)
{

AddHelpFileFullPath(menuText, sHelpDir + helpFile);
}

AddHelpFileFullPath(menuText,. helpFile)
{

declare menuCmd =
"IDE.Help(\"1 + AddBackSlash(helpFile) + "\",

11

+ 113, II + "\11\1111 + 11);11;

assign_to_view_menu(IIIDE", "&Helpl" + menuText,
menuCmd, menuText);

II
II
II
II
II
II
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AddBackSlash(fileName)
{

declare origFileName = new String();
origFileName.Text = fileName;
declare targetFileName = "";
declare breakIndex = origFileName.Index("\\");
while (breakIndex > 0)
{

targetFileName += origFileName.SubString(O, breakIndex - 1) . Text
+ "\\\\";
origFileName = origFileName. SubString (breakIndex) ;
break Index = origFileName.Index("\\");
}

targetFileName +~ origFileName.Text;
return targetFileName;
}

II This is a list of all the Help files in BC5.
II Comment out the ones you don't need.
AddStandardHelpFiles()
{

AddHelpFile("Borland CH Tools", "BCTOOLS.HLP");
AddHelpFile("Borland CH User's Guide", "BCW.HLP");
AddHelpFile ("Borland Custom Controls", "BWCC. HLP") ;
AddHelpFile ("CH Programmer's Guide", "BCPP. HLP") ;
AddHelpFile("Class Library Reference", "CLASSLIB.HLP");
AddHelpFile("Control 3D", "CTL3D.HLP");
AddHelpFile ("DOS Reference", "BCDOS.HLP");
AddHelpFile("Error Messages", "BCERRMSG.HLP");
I I AddHelpFile ( "Formula One Visual Tools", "VTSS. HLP" ) ;
II AddHelpFile("Help Author's Guide", "HCW.HLP");
II AddHelpFile("Hot Spot Editor", "SHED.HLP");
II AddHelpFile("HeapWatch32", "HW32.HLP");
I I AddHelpFile ("MAPI Programmer's Reference", "MAPI. HLP" ) ;
II
AddHelpFile("Message Compiler for NT", "MC.HLP");
I I AddHelpFile("MicroHelp Customer Controls", "VBT300.HLP");
II AddHelpFile("OCF Reference", "OCF.HLP");
AddHelpFile("ObjectScripting", "SCRIPT.HLP");
II AddHelpFile("OLE 2 Reference", "OLE.HLP");
II AddHelpFile("OLE 2.0 Object viewer", "OLE2VIEW.HLP");
II AddHelpFile("OLE Knowledge Base", "KBASE.HLP");
II AddHelpFile("Open GL", "OPENGL.HLP");
AddHelpFile ("OpenHelp", "OPENHELP. HLP") ;
AddHelpFile("OWL 5.0 Examples", "OWLEX.HLP");
AddHelpFile("OWL 5.0 Reference", "OWL50.HLP");
II
AddHelpFile ( "Remote Procedure Call Reference", "RPC. HLP" ) ;
II
AddHelpFile ("Resource Compiler for NT", "RC .HLP");
II
AddHelpFile ("Resource Localization Manager", "RLMAN .HLP") ;
II AddHelpFile("Resource Reference", "RC32.HLP");
AddHelpFile("Resource Workshop", "WORKSHOP.HLP");
AddHelpFile ("TDWINI. EXE Information", "TDWINI.HLP");
AddHelpFile("Standard Template Library", "STL.HLP");
AddHelpFile("Visual Database Tools", "BCVDTREF.HLP");
AddHelpFile("Windows 16 API", "WIN31WH.HLP");
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AddHelpFile ("Windows· 32 API", "WIN32 .HLP") ;
AddHelpFile("Windows 32s Reference", "WIN32S.HLP");
AddHelpFile ("Windows Developer's Guide", "95GUIDE.HLP");
AddHelpFile ("Windows Interface Guidelines", "UIGUIDE. HLP") ;
AddHelpFile ("Windows System Class",' "WINSYS .HLP") ;
I I AddHelpFile ( "winSight ", "WINSIGHT. HLP" ) ;
I I AddHelpFile ("WinSpector", "WINSPCTR. HLP" ) ;
}
};

II At load time, load a list of help files.
II Customize the list by modifying AddStandardHelpFiles() function.
declare helpMenu = new HelpMenu ();
helpMenu.AddStandardHelpFiles();

Declaring a method

Part 4, step 1 of 2

This step declares the AddStandardHelpFilesO method that adds all Borland C++
Help files to the Help menu. Because there are many Help files, you may want to
comment out any Help files you don't think you'll usefrequently.
First, start a script file and call it STEP4.SPP. Then, as previously learned:
• Import the IDE object (Part 2, step 1)
• Import a symbol of a system-wide instance of ScriptEngine (Part 2, step 2)
• Create a class called HelpMenu. (Part 1, step 3)
• Find the location of the Borland C++ Help directory and store it (Part 3, step 1)
• Load MENUHOOK.5PP. (Part 1, step 4). In your code, do not include the first
curly brace shown in this step.
• Declare two functions that add menu items to the Help menu (Part 3, step 2)
• Assign a menu item to the Help menu (Part 3, step 3)
• Add a backslash to the Help directory path name (Part 3, step 4). In your code, do
not include the final curly brace and semi-colon shown in this step.
To declare the AddStandardHelpFilesO method,

1 Add the following lines to your script file:
AddStandardHelpFiles()
{

AddHelpFile ("Borland Ctt Tools", "BCTOOLS. HLP") ;
AddHelpFile ("Borland Ctt User's Guide", "BCW .HLP") ;
AddHelpFile("Borland Custom Controls", "BWCC.HLP");
AddHelpFile("Ctt Programmer's Guide", "BCPP.HLP");
AddHelpFile("Class Library Reference", "CLASSLIB.HLP");
AddHelpFile("Control 3D", "CTL3D.HLP");
AddHelpFile ("DOS Reference", "BCDOS .HLP") ;
AddHelpFile("Error Messages", "BCERRMSG.HLP");
AddHelpFile("Formula One Visual Tools", "VTSS.HLP");
AddHelpFile("Help Author's Guide", "HCW.HLP");
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AddHelpFile("Hot Spot Editor", "SHED.HLP") i
AddHelpFile ("HeapWatch32", "HW32 .HLP") i
AddHelpFile ("MAPI Programmer s Reference", "MAPI .HLP") i
AddHelpFile ("Message Compiler for NT", "MC. HLP") i
AddHelpFile ("MicroHE;lp Customer Controls", "VBT300 .HLP") i
AddHelpFile("OCF Reference", "OCF.HLP")i
AddHelpFi Ie ( "Obj ectScripting", "SCRIPT. HLP" ) i
AddHelpFile ("OLE 2 Reference",· "OLE .HLP") i
AddHelpFile ("OLE 2.0 Object Viewer", "OLE2VIEW .HLP") i
AddHelpFile("OLE Knowledge Base", "KBASE.HLP") i
AddHelpFile ("Open GL", "OPENGL.HLP") i
AddHelpFile ("OpenHelp", "OPENHELP .HLP") i
AddHelpFile("OWL 5.0 Examples", "OWLEX.HLP")i
AddHelpFile("OWL 5.0 Reference", "OWL50.HLP")i
AddHelpFile ("Remote Procedure Call Reference", "RPC .HLP") i
AddHelpFile ("Resource Compiler for NT", "RC .HLP") i
AddHelpFile ("Resource Localization Manager", "RLMAN .HLP") i
AddHelpFile ("Resource Reference", "RC32 .HLP") i
AddHelpFile ("Resource Workshop", "WORKSHOP .HLP") i
AddHelpFile ("TDWINI.EXE Information", "TDWINI.HLP") i
AddHelpFile("Standard Template Library", "STL.HLP") i
AddHelpFile ("Visual Database Tools", "BCVDTREF .HLP") i
AddHelpFile ("Windows 16 API", "WIN31WH.HLP") i
AddHelpFile ("Windows 32 API", "WIN32. HLP") i
AddHelpFile("Windows 32s Reference", "WIN32S.HLP") i
AddHelpFile ("Windows Developer s Guide", "95GUIDE .HLP") i
AddHelpFile ("Windows Interface Guidelines", "UIGUIDE .HLP") i
AddHelpFile ("Windows System Class", "WINSYS .HLP") i
AddHelpFile ("WinSight", "WINSIGHT .HLP") i
AddHelpFile ( "WinSpector", "WINSPCTR. HLP" ) i
I

I

}
}i

The AddStandardHelpFilesO method uses the AddHelpFileO method. Each
AddHelpFileO method identifies:
@I

@I

The Help file to display on the Help menu (the menuText parameter)
The filename of the file to launch when the Help menu item is selected (the
helpFile parameter)

You have just declared a method that adds all Borland C++ Help files to the Help
menu.
In the next step, you will execute the method and run the script file.

Executing the Help menu method

Part 4, step 2 of 2

This step executes AddStandardHelpFilesO.
To execute the Help menu method,
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1 Add the following lines to your script file:
declare helpMenu = new HelpMenu() i
helpMenu.AddStandardHelpFiles()i

The declare keyword declares the variable helpMenu. This line also
assigns the variable helpMenu to a new instan.ce of the HelpMenu class. (Note the
difference in case; cScript is a case-sensitive language.)
helpMenu.AddStandardHelpFiles adds all Borland C++ Help files to the Help menu.
A Help file is launched when a menu item is selected.
2 Save the script file and run it.
To see the results, go to the Help menu. Note that many menu items have been
appended. to the bottom of the Help menu. Choose one.
The Contents topic of the selected Help file is displayed.
3 To remove the help files from the Help menu, exit Borland C++. When you load
Borland C++ again, these help files will no longer display.
You have now finished Part 4 of the tutorial.
For more information on ObjectScripting,'click the Contents tab of the Help system
(SCRIPT.HLP) and browse through the Help topics. You can also look at the example
programs in BCS \ SCRIPT \ EXAMPLES.
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About cScript
The cScript language is a late-bound, object-oriented language that supports
syntax and constructs familiar to the C++ developer; you declare classes and
provide them with properties and member functions.
cScript offers C++ programmers a familiar environment for customizing the
IDE. It has many of the same constructs as C++ and on the surface looks and
feels like C++.
But under the hood the two languages are very different: They address two
separate problem domains, the early-bound environment versus late-bound,
and as a result there are some major semantic differences.

About late-bound languages
cScript is a late-bound, object-oriented language, which is roughly analogous
to being an interpreted language. This gives cScript programs more
flexibility than early-bound programs, such as those written in C++; In C++,
everything about a program is known at compile time. The types of the
variables, the return types and number of parameters to functions, the
classes that will be used as well as all their properties and behaviors are all
known when the program is compiled.
cScript is very different. While the syntax looks very similar to C++, you
cannot declare a variable's type at compile time. Variables are generic and
can hold any type of data needed at runtime. In fact, the same variable can
hold different types of data as the program executes.
Just as in C++, you create classes with properties and methods and create
objects which are instances of those classes. But in cScript, you are free to
override the methods for a given object (not the class, just the object itself) at
runtime with a new implementation of the method or a method "borrowed"
from another object.

About cScript
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This means that an object of one class can use the methods of an object of
another class without having to know anything about the second object at
compile time. Existing objects can have their functionality extended without
the need for the source code to the object's class, and without recompiling.

The benefits of late-binding
Late-binding provide important practical benefits. Let's say that you want to
create a program to extend the functionality of the Borland C++ IDE. For
example, you want to create a script that automatically saves changed source
files to a central repository on the network as well as in your project
directory. You want to add this functionality to the IDE and have it behave
like a built-in feature.
The Borland C++ IDE is represented by a cScript object call~d IDE of the
cScript class IDEApplication. If the object IDE was instead created from a C++
class, you would-have to alter that C++ class and add your repository
methods to it directly, through multiple inheritance, function pointers, or
through some other mechanism. Then you would need to recompile the
source for the class to create the extended object IDE. In cScript, you do not
need to touch the definition of ID EApplication (the class) at all. You can use
cScript to attach your repository methods to the IDE object at runtime. There
are no changes to the IDEApplication class and no recompilation is necessary.
So late-binding means that you can alter and extend the behavior of objects
without having to know the details of how they are implemented, without
having access to the source code, and without having to recompile.

Differences between cScript and C++
cScript differs from C++ in the following ways:
• All class members are public. There is no way to make members private or
protected as part of their declaration. You can use on statements to make
members inaccessible.
• cScript programs have no mainO or WinMainO function.
• Globally scoped statements are allowed and will be executed when the
script is run.
• Executable statements are allowed within a class definition, and in
conjunction with optional initialization arguments passed when the class
is instantiated, constitute the class's constructor. There is no constructor
function per se in cScript.The implementation of a class's methods are
defined within the class. That is, the definition (not just the declaration) of
a member function must always occur in the class declaration.
• Arrays are objects in cScript. When de allocating an array with the delete
command, the square brackets are not needed.
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• Functions may have varying numbers of parameters. cScript truncates or
.pads argument lists as necessary.
• Compound logical expressions do not short circuit. For example, in the
expression if (TRUE I I Faa ( ) ) .,,' the function Faa () will always be called even
though the constant TRUE insures that the expression will always
evaluate to true.
• cScript does not have the following C++ features (this is not a complete
list):
$

Type checking (but there are type conversions with some operations).
See "cScript and types" on page 4-4 for more information.

@

Type casting

@

Multiple inheritance

@

C++-style exceptions

@

Class constructor functions

@

Function overloading

@

Character arrays (cScript directly supports strings)

@

Default arguments to functions

@

Templates

@

Default parameters in method declarations
Pointers

@

Direct memory access

@

Function declarations that support default parameters

@

Enums

@

Unions

@

Structs or typedefs

@

Bitfields

@

Operator overloading

@

The const keyword (except in DLL imports)

@

The static keyword

III

Global scope resolution. You can access globally scoped variables,
using the module function

@t

The #if preprocessor directive (#ifdef is supported)

@t

The following operators: -> * ->*
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cScript objects
All objects in the IDE are exposed through the global object called IDE, in the
class IDEApplication. This object is created in STARTUP.sPP, a script that is
automatically executed when Borland C++ is started. You use IDEApplication
to access many parts of the IDE. Additional classes provide access to the
debugger, the search engine, the Editor, and the Keyboard Manager. Classes
are also provided to create and manage list windows and pop-up menus.
In the Borland C++ IDE, all user commands are directly mapped to
corresponding scripts. Every IDE window that uses the keyboard API has
each keystroke mapped to a script. All main menu commands have a
mapping to a script. These scripts, supplied by Borland, provide standard
behavior that you can use to customize your environment. If you want to
modify the behavior of the IDE, you can write scripts that interact with the
exposed IDE components.

cScript and types
cScript is not an explicitly typed language and does not allow you to declare
variables with C++ base types. When the parser encounters an unknown
identifier, it makes it a new variable (unless the identifier is immediately
followed by an open parenthesis, which might indicate it's a function). New
variables created this way are local to the current scope.
The only declarators you can use are declare, import, and export, which are
not types but declarators that indicate a new variable. Declaring variables
discusses declare, import, and export.
Identifiers do have types, but the type of an identifier is determined by its
value. For example, x in the following code is an integer because it is
assigned an integer:
declare x

= 25i

x can become any other cScript native type, depending on what is assigned to
it. In the following example, x is of type IDEApplication because an object of
that class is assigned to it:
declare MyIDE
x = MyIDEi

= new

IDEApplicationi

Use the intrinsic function typeid to determine the type of an identifier.

Type conversions
When you use operators with variables of different types, the simple
conversion rule with binary operators (such as + and /) is that the operand
on the left determines the type of the expression. For example,
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declare x = 4;
declare y = 4.0;
print x/3; II output is 1
print y/3; II output is 1.333333

The rule becomes more complicated with conversions between strings and
numbers because cScript does some interpretation.
• When converting from a number to a string, cScript represents digits as
numeric strings (3 becomes "3").
• When converting from a string to a number, th~ string is converted to a
number if the string can be interpreted as a number. If the string evaluates
to anything but a number, it is converted to zero ("33" becomes 33,
"33abc" also becomes 33, but abc33" becomes 0). For example,
/I

declare x = 10;
print "String" + x;
print x + "String";

II prints "Stiing10"
II prints the result of 10 + 0 which is "10"

• If an object is converted to a string, it becomes the string "[OBJECT]". For
example,
declare a = new IDEApplication;
declare b

=

"Hello";

II create a new
II IDEApplication object
/ I create a new string variable

II add the object to the string
II converting the object to a string

declare c
print C;

= b + a;
I I prints "Hello [OBJECT] "

Comments
cScript supports C++ comment syntax, including:
• / / This is a comment to the end of the physical line
• /* This is a comment to the closing */

Nested comments are permitted in cScript.

Identifiers
Identifier names are made up of letters, digits and underscores C). The first
character of an identifier name cannot be a digit. Identifier names can be up
to 64 characters in length.
cScript is case-sensitive. Therefore foo, Foo, and Faa are three different
identifiers. Keywords, operators, and intrinsic function names are also casesensitive.
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Declaring variables
A cScript source file (an .spp file) is a module. A variable declared or used
for the first time at the module level is global to that module, and a variable
declared or used for the first time inside a block is local to that block.
Because you don't have to declare variables as you do in C++, it's easy to
mistakenly use a global variable in a function or class when you intend it to
be local. It's safest to use declare with variables that you intend to be local.
Variables created at the module level (not in a function, method, class,
control structure, or block) are global variables of the module. They are not
normally accessible to other modules. To access a variable defined in module
A from module B, three things must occur:
• Both module A and module B must be loaded.
• The variable must be declared export in Module A, at module scope.
• Module B must contain an import statement for the variable, at module
scope.

Exannple

II This is an example of declaring a local variable
declare X = 2;
II Module scope X
II Module scope Y
declare Y = 4;
II Parameter (local variable) X
II modifies global Y.

Func1 (X) {
Y = "hello";
}

Func2 (X) {
declare Y = "hello";

Exannple

II Parameter (local variable) X
II New local variable Y created
II and set to "hello".

IIThis example shows how to declare a: variable export in Module A
Iland import in Module B.
Module A
IIA 'global variable accessible only in Module A.
declare varOne;
export varTwo;
IIA variable accessible outside Module A.
Module B
import varOne;
import varTwo;

4-6

IITrying to link with exported varOne. Will fail
Ilunless some other module exports varOne.
IITrying to link w~th varTwo in Module A.

varOne

= 33;

IICauses the runtime warning "Cannot locate

varTwo

= 33;

Ilexternal variable varOne".
IIChanges the value of varTwo in Module A to 33.
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Statements
As in C++, statements must terminate with a semicolon. You can group
multiple statements by surrounding them with braces. Variables declared
within braces are local to those braces and go out of scope when the closing
brace is reached.
You can chain expressions with the comma operator.

Strings
cScript strings (note the lowercase "s") work much the same as C++ strings.
A string is a series of characters delimited by quotation marks. In cScript, a
string's length is limited to 4096. cScript automatically keeps track of the
ends of strings; appending \0 (NULL) is unnecessary.
Unlike C or C++, you cannot access each character of the array
independently using an offset of [] operators, as a string is not a pointer to
memory. Internally, the variable assigned to the string represents the entire
group of characters as a string. To access characters independently of each
other, use a String object.
Because strings are stored as an entire group of characters you can:
• Add text together
• Check for equality, inequality, greater than, and less than

String formatting characters
cScript recognizes many C++ formatting characters within strings such as
new line (\n) and horizontal tab (\ t).
Besides the alphanumeric and other printable characters, you can designate
hexadecimal and octal escape sequences much as you can in C++. These
escape sequences are interpreted as ASCII characters, allowing you to use
characters outside the printable range (ASCII decimal 20-126).
The format of a hexadecimal escape sequence is \x<hexnum>, where
<hexnum> is up to 2 hexadecimal digits (a-F). For example, the string "R3"
can be written as "\x523" or "\x52\x33".
Octals are a backslash followed by up to three octal digits (\ 000). For
example, "R3" in octal could be written" \ 1223" or "\ 122 \ 063" .

Prototyping
Forward referencing for functions and methods is not supported. Because
scripts are interpreted in a single pass at runtime, classes and the methods in
them, must be defined before they can be used.

About cScript
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cScript does not provide a function prototype mechanism. This is because
when the parser sees a function call, it needs to know the implementation at
that time. At compile time, however, a c++ compiler only needs to be able to
match the name, number of parameters, the types of the parameters! and the
return values, but does not really need to know anything internally about the
function.
Parameter counting and type conversions are performed at runtime. cScript
will pad (with NULLS) or truncate the argument list as necessary at runtime
to ensure that the correct number of arguments is available on the stack.

Flow control statements
The following flow control statements work in cScript as they do in C++:

break

continue

do

else

if

for

return

while

The behavior of switch is slightly different. Because cScript is not a compiled
language, the expression is checked against each case exactly as if evaluating
an if-else-if construct. This means that the cases need not be constants; they
may be any expression (indudingfunction calls). It also means that if a
,default case is desired, it must be the last case.

Example

I I Switch example
switch( someNumber )
case 3:
case MyFunc():
DoSomeStuff() ;

IIExecution continues to case bar()
II No break. Even if this case executes,
II the next case is still evaluated.

case W.Y.Z:
DoSomethingElse() ;
break;
II If this case executes, switch ends here.
case 42:
DoHAll ();
default :
I I Anything not matching previous cases comes' through here

Pass by reference
Parameters passed to methods and functions are passed by value unless
explicitly made to be passed by reference. (Passing by value does not allow
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changes to the value of the caller's variable, while passing by reference does.)
For example,
PassByValueFunction(aValueParameter) {
aValueParameter = 100; II Value of aValueParameter changed to
II 100. Caller's value unmodified.
PassByReferenceFunction(&aReferenceParameter) {
aReferenceParameter = 100; II Value of aReferenceParameter
}
II changed to 100. Caller's value
II also updated

If you want to pass a variable by value in a pass-by-reference parameter, put
it in parentheses. For example,
10;
PassByReferenceFunction((x)) ;
print x;
II Prints 10
PassByReferenceFunction(x) ;
print x;
II Prints 100
x =

Built-in functions
The cScript language provides the following built-in functions:
Table 4.1

Built-in functions

Links a
of an instance of one class to a method of an instance
of another class.
call

Directly invokes a closure.

detach

FormatString
initialized

Detaches a method instance of one class from a method instance of
the same or another class when the two were previously linked
using attach.
Formats strings at runtime.
Indicates if a variable has ever been initialized.

load

Opens and parses·the specified script.

moduleO

Gets access to any loaded module.

pass

Used in an on handler to invoke the original function that is being
overridden.

print

Prints the specified expression in the Script page of the Message
window.

reload
run

Does an unload followed by a load.
Loads and runs the module indicated.

select

Creates a special global variable, selection,that refers to the selected
variable.

typeid

Gets runtime identification of variables or the resulting value of
expressions.
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Table 4.1

Built-in functions (continued)

,·;r:~~'~~i~Cll~~n},~i\\~~:",:Y'B~~~,ri~t',~,·., • .• :~';' ""
unload
yield

Unloads the specified module.
Forces cScript to check if the abort (Esc) key has been pressed.

Reserved identifiers
cScript reserves identifier names starting with two underscores as internal to
the language. The following identifiers cannot be used in your scripts:
-

const

-

cdecl

_error

_pascal

- refc

_rundebug

- runimmediate

- stack

_stdcall

_warn

event

Factory

false

library

method

FALSE
NULL

object

property

system

true

TRUE

cScript and DLLs '
Because all needed functionality is not directly available through the
language or exposed by an object in the system, cScript allows you to access a
function in a DLL directly through cScript by using code similar to the
following:
II expose DLL entry points
import "foo. dll" {
int' __ pascal FooFunc(short, char, unsigned, long);
void Dort () i
}

II directly access the DLL calls
if (FooFunc(l, "hello there",2,3))
print "FooFunc () succeeded" i
else
Dort () i

This DLL call uses the data type keywords short, char, unsigned, and long.
Other data type keywords available for use in DLL calls are void, int, bool,
and const.
This form of the import command allows you to declare a prototype for the
external DLL functions, including their return types and arguments.
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Unlike normal cScript functions, variable numbers of arguments are not
supported when using functions from DLLs. You can pass dummy integer
arguments for enums and pointers, since cScript does not support these
types. There is no support for passing structs.
Note

When possible, declaring arguments of DLL calls with the const modifier
will improve performance.
cScript supports the calling conventions _cded, _pascal, and _stdcall.

cScript and OLE2
cScript to OLE2 interaction
If an automatable object has been exposed in the OLE2 registry, its

functionality may be accessed from cScript by using the special OleObject
class. For example,

II Creates an object with all the methods of
II Microsoft Word BASIC
wordBasic

= new OleObject("word.basic");

II Call the Word BASIC function Applnfo() to find out
II what version of Word is installed
print wordBasic.AppInfo(2);
II Returns "7.0" for Word version 7.0

OLE2 to cScript interaction
The IDE registers the automation name BorlandIDE.Application with the
OLE2 registry during initialization. From any automation controller, the
IDE's functionality may be accessed by creating a BorlandIDE.Application
object and using it. For example, from a Visual dBASE program you could do
the following:

* Visual dBASE syntax:
BorCppIDE = NEW OleAutoClient ("BorlandIDE.Application")
BorCppIDE.ProjectOpenProject("foo.ide")
IF(BorCppIDE.ProjectBuildAll() )
BorCppIDE. FileSend ( success notification ")
II

ELSE
BorCppIDE.FileSend("failure notification")
ENDIF

Arrays.
cScript supports two types of arrays:
• Bounded arrays
• Associative arrays

About cScript
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Bounded arrays
cScript bounded arrays are similar to C++ arrays and are declared with a size
specifier. Runtime warnings occur if you attempt to access a bounded array
out of bounds. Bounded arrays use a zero-based index; that is, the first
element of an a~ray is element a and the last element is element size - 1.
You can declare a bounded array by using either of the following syntax
variations:
x = new array [10];
array x [10] ;

Access is then as you would expect:
x[O] = 5;
x[l] = "a string";
x[2] = Foo;
x[3] = x[2];

You can also declare and initialize a bounded array using the following:
z[] = {"one", "two", x};

IINote the use of braces, {},
Ilrather than brackets, [].

In this case, one, two, and the value of x are the values in the array, and the
array indexes start at a and go to 2. For example,
print z[O];
print z[l];
print z[2];

IIPrints one
IIPrints two
IIPrints the value of x

You cannot initialize variables in an array initialization list: You must
initialize them elsewhere. For example, you cannot define an array as
follows:
z = {x=l, y=3, slogan="No more woe"} IIIllegal syntax

In this array definition, assignments to x, y, and slogan must be elsewhere in
your code.
Note

Be careful not to unintentionally overwrite an existing array with a new one
during initialization. The following example declares an array a", but then
overwrites it with the elements 1, red and 2.
/I

declare array a[10]; II declares an array with 10 elements
II The next line destroys the array "a" and declares
II a new array with three initialized elements
a = {1, "red"; 2};

You can assign values beyond arrC;ly bounds. Such an assignment does not
increase the size of the bounded array to match the new index, but rather
declares an associative array that is attached to the original bounded array.
You can use any value as the new index.
Note

4-12

You cannot-use a negative number to index into an array. Doing so causes a
runtime, warning.
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Exannple

II This script generates no errors or warnings. It declares
II and initializes a bounded array with 4 elements (0 - 3)
declare a = new array[4];
a [0]
"Able";
a [1]
"Baker" ;
a[2]
"Charlie";
a[3]
"Delta";
print a[O]; II prints Able
print a[l]; II prints Baker
print a[2]; II prints Charlie
print a[3]; II prints Delta

II The following lines seem to add an element to the bounded array
lion the fly, but are actually declaring an associative array and
II appending it to the bounded array. Since the index is contiguous
II with the indices of the bounded array, the new element can be
II used as if it were part of the bounded array.
a [4] = "Edward";
print a[O]; II prints Able
print a[l]; II prints Baker
print a[2]; II prints Charlie
print a[3]; II prints Delta
print a[4]; II prints Edward
II The following lines add an element to the associative array.
II The new element's index is not contiguous with the existing
II elements. Note: adding element a[6] does NOT declare element a[5].
a[6] = "Frank";
print a[O]; II
print a[l]; II
print a[2]; II
print a[3]; II
print a[4]; II
print a[5]; II
print a[6]; II
~

prints
prints
prints
prints
prints
prints
prints

Able
Baker
Charlie
Delta
Edward
[UNINITIALIZED]
Frank

II The following lines add an element to the associative array using
II a string as an index. Adding this element has no effect on the rest
II of the array.
a ["Bob"] = "Robert";
print a[O];
II prints
print a[l];
II prints
print a[2];
II prints
print a[3];
II prints
print a[4];
II prints
print a[5];
II prints
print a [6] ;
II prints
print a ["Bob"]; II prints

Able
Baker
Charlie
Delta
Edward
[UNINITIALIZED]
Frank
Robert

return;
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Associative arrays
You declare associative arrays without a size specifier and access them on
demand. They grow as required. Associative arrays are typically sparse and
do not perform as well as bounded arrays.
To declare a new associative array, use one of the following syntax
variations:
z = new array[]
array z [] i

i

Associative arrays can take string as their indexes as well as numbers.
Typically, the index of an associative array element is something which is
related to the data the element holds. For example,
History = newarraY[]i
History [" President"] = "Bill Clinton"
History["Vice President"] = "AI Gore"
History[1776] = "U.S. Independence"
History[1789] = "U.S. Constitution"

You also declare an assoCiative array when you make assignments beyond
the bounds of a bounded array. For more information, see "Bounded arrays"
on page 4-12.
.
Note

You cannot use a negative number to index into an array. Doing so causes a
runtime warning.

Classes
cScript supports single inheritance. There is no support for overloaded
methods (member functions). In addition, there is no hiding of members: all
properties (member data) and methods are public and virtual. You can
override an instance of a class (an object) withon and pass, and you can bind
objects' events (function calls) together in an event handling chain using
attach. For more information, see "Event handling" on page 4-18.

Defining methods
All methods must be defined entirely in the class definition. A class
definition may be nested in another class definition. The name of that nested
class exists in the scope of the outer class, and is thus protected from
accidental collision with identifier names in the module and global scopes.
You can·instantiate a nested class with the following syntax:
II Class Inner is nested in class Outer
class Outer {
class Inner {}

declare Outer outerInstancei
declare innerInstance = new Inner from outerInstancei
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Modifying the behavior of methods and properties
You can modify the behavior of methods in script classes:
• Derive a new class from the script class, overriding the methods whose
behavior you want to change. Use this technique when you want to
provide new behavior for a collection of objects.
• Override an instance of a class by using an on handler or attach to hook
one of the object's methods. Use this technique when you want to tweak
the behavior of a particular instance of a class.
You can also modify the behavior of properties in script classes:
• Derive a new class from the script class, overriding the properties whose
values you want to change. Use this technique when you want to provide
new behavior· data values for a collection of objects.
• Override an instance of a property by using getters and setters. Use this
technique when you want to tweak the behavior of a particular instance of
a class.

Declaring a class
There are no constructors in cScript as there are in C++. (Defining a method
with the same name as the class, as you do in C++, does not make it a
constructor.) Instead, code embedded in the class declaration that is not part
of a method declaration is executed for each object instantiated from the
class, and is therefore treated as constructor code. For this reason,
. constructor arguments must be defined in the class declaration.
Member functions must be defined entirely in the class declaration. You
cannot declare a member function in a class and then define it later in the
program.
There are destructors in cScript, and they work as they do in C++. (Defining
a method that starts with a tilde (-) and has the same name as the class
makes it a destructor.) Destructors are called when the object is being
destroyed.

Exannple

II The following class is declared without parameters
class noParams{
declare aMemberj
declare anotherMemberi
II Constructor code is any code outside of class methods
Funcl() i
II call to a module-level method
for (declare y=li y<10i y++) II more constructor code
print "hello" i
II Here is the destructor:
~noParams() {
print "A hoParams has been destroyed."i
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II More constructor code.
print "noParams construction completed"i
}i

x = new
x = Oi

Exannple

noPara~si

II declare instance, run constructor code
II calls destructor

II The following class is declared with parameters
class Base(parmOne, parmTwo)
print "parmOne=", parmOnei
print "parmTwo=", parmTwoi
declare X = parmOnei
declare Y = parmTwoi
MethodOne() {
X = X + Yi
AnotherMethod ()
}

}

II aParm and cParm are passed through to
II Base as ParmOne and parmTwo.
class Derived (aParm, bParm, cParm): Base (aParrn, cParm) {
declare Z = bParrni
}i

declare di
d = new Derived
print "d.X ="
print "d.Y ="
print "d.Z ="

Exannple

(1,2,3)i
d.Xi
d.Yi
d.Zi

liThe following class is inherited from the class Base
II aParm and cParm are passed through to Base
class Derived (aParm, bParm, cParm): Base (aParm, cParm)
. declare Z = bParmi
}i

Note

Initialization arguments must be explicitly passed to the base class. They
must also be stated in the derived class parameter list because that is the list
referenced when a derived class object is instantiated.

Creating instances of cScript classes
Objects in script are created in one of two ways (assuming an already defined
class Foo):
x = new Foo () i

or
Foo x() i
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As with any declaration, you can use the declare and export keywords when
you create objects. For example,
declare x = new Foo();
export Foo y();

cScript has automatic garbage collection. When an object goes out of scope, it
is deallocated. Objects can be explicitly deallocated using the delete
command. For example,
declare x
delete x;

= new Foo(); II allocate new object
II explicitly delete object

Because cScript is untyped, you can destroy an object by assigning it another
value. For example, cScript does not complain when you assign a to the
object x as follows:
declare x
x = 0;

Note

=

new MyClass ();

I I create an obj ect of clas·s MyClass
II object overwritten and replaced with 0

The object is only actually destroyed if the reassigned variable is the only
reference to that object. If there are additional references to the object, the
object will continue to exist when one of its reference variables is reassigned.

Discovering class and array members
You can use ?? and iterate to discover the contents of classes and associative
arrays.
• With?? you can test if a particular property exists in an object or if a
particular index exists in an array.
• With iterate, you can see all members of a class or array.

Closures
Closures let you obtain a reference to a method or property without invoking
it. They are analogous to function pointers in C++.
Closures are powerful features of cScript. You can pass a closure as a
function argument, for example. Since it represents a member of a class
instance (an object), it carries a this pointer for that object with it and has all
of the object's context information.
Use the closure operator ( :> ) in the following situations:
• To bind a class instance (an object) with one of its methods in a single
reference.
• To assign a closure to a variable and use that variable anywhere you
would use the closure.
• To dynamically expand or change the interface or behavior of a particular
object, in ways not specified in the class of which the object is an instance.
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• To declare arrays of closures to use like arrays of function pointers. The
functions need not do anything unless they happen to be defined. Calling
an undefined closure is not an error - nothing happens because there's
nothing to call.
• In on handlers and attach and detach statements to handle a method call.
In both cases, you can use pass to call the original method (if any) from
within the attached method, and control the parameters passed to the
original method. Overriding or adding an object method using an on
handler or an attach statement affects only the one object instance. It does
not affect the class, or any existing or new objects instantiated from that
class. Only when on handlers are defined within a class definition itself
using the this reference do all objects of that type inherit that event
handling behavior.

Event handling
cScript uses an event handling model to override class behavior. Given an
instance of a class, you can modify its behavior by hooking a specified
method and supplying an alternative implementation. You can use either an
on handler or attach and ~etach to accomplish this. For more information,
see the next section "On handlers," and" Attach and detach" on page 4-19.

On handlers
You can use an on handler to hook method call events for an instance of a
class and override, or enhance, its functionality. You need not call the
hooked method inside the on handler: Any code in the on handler will be
executed instead of the hooked method. If you want to invoke the original
method, use pass. If the hooked method returns a value, that or any other
value can be returned by assigning the return value of pass to a local
variable, including a return statement in the event handler.
In the on handler header, you use the closure operator ( : > ) to bind a class
instance (an object) with a method of the object as a closure reference. For
example,
declare AClass MyObject; II or MyObject = new Aclass;
II Given this instance of class AClass, you
II can intercept one of its methods.
on MyObject:>Methodl(parml){
II Programmer may provide some preprocessing here.
II Programmer may delegate to original implementation
II or get original return value with pass().
declare rv = pass (parml) ; II call MyObject.Methodl(parml)
II Programmer may provide some postprocessing here.
return rv;
}
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Note

To be bound to an existing object method, the number of parameters in the
on handler definition must match the hooked method. Once invoked,
however, pass will call the hooked event regardless of how many arguments
it passes. As with all function calls, cScript will ensure that the proper
number of arguments are passed, truncating or padding as needed.
While inside an on handler, keep the following in mind:
• You aren't actually in a method of the object. Simple function calls resolve
to their global counterparts, not to the object's methods. If you want to call
the method bar from the Methodl on handler, you must explicitly denote
the object. For example,
on MyObject:>Methodl() {
MyObject.bar() ;

• Another way to explicitly denote a method of this object is to use the
shorthand dot notation, which relies on the fact that, in an on handler, the
dot is a shortcut for the controlling object. For example (given anobject
MyObject that has methods Methodl and bar):
on MyObject:>Methodl() {
.bar() i
}

Attach and detach
If you want to make dynamic changes to class instances, you can set up
dynamic on handlers using the closure operator with attach and detach. An
on handler is not dynamic, but stays in effect once established as long as the
module in which it is defined remains loaded and as long as the object exists.
Attached closures are used to set up a linkage between any member (method
or property) of an instance of one class with any member from an instance of
another class.

Example

I I attach and detach example
x

= new Foo();

x.Color() ;
y = new Bar ( ) ;
y.Notify() ;
attach y:>Notify to x:>Color;
x.Color() ;
II NOTE: In y.Notify() a pass() will
II now delegate back to x.Color().
detach y:>Notify from x:>Color;
x.Color() ;

II
II
II
II
II
II
II
II
II

Create an instance of Foo called x
and assume Color() is a method.
Call x.Color().
Create an instance of Bar called y
and assume Notify() is a method.
Call y.Notify().
When x.Color() is called,
instead call y.Notify().
Call y.Notify().

/1 unlink the two objects

II Call x.Color().
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AccessingcScript properties
You can use on handlers to control what happens when users get (read) or
set (write) the values of properties. These two types of on handlers are called
getters and setters. This feature allows you to execute some code when a
property is accessed instead of having to implement the property as a
method.

Using getters
You can use a getter:
• To restrict access to a property
• To execute related methods or modifying related properties
• To perform computations on a value before returning it
The syntax for a getter is:
on object:>property{
[optional pre-processing statement(s,) 1
return [pass() ISomeValuel;
}

Since no value is passed to the on handler, no parameter is needed. You need
a return statement because a getter is always invoked when the object's
property is used in a statement that needs to obtain its current value. When
you access the property (for example, on the right side of an assignment
operator or as an argument in a print statement), the on-read property event
handler is called and its statements are executed.

Exannple

II The following getter hides the property Hiddenl:
import IDE;
IIImport IDE, an IDEApplication object
class MyClass () {
declare HiddenI = "Hidden: can't see this one";
declare PublicI = "Public: can see this one";
I I Getter
on this:>HiddenI
return NULL;

} II End MyClass declaration
getter () {
declare MyClass myobj;
IDE.Message (myobj .HiddenI);
IIPrints nothing
IDE.Message (myobj .Publicl);
IIPrints "Public: can see this one"
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Using setters
You can use a setter:
•
•
•
•
•

To restrict values of a property to a certain range
To limit access to a property (or even make it read-only)
To execute related methods or modify related properties
To perform computations on a value before setting it
To convert user;..supplied data to an internal format

The syntax for a setter is:
on ClassInstance: >property (parameter) {
[optional pre-processing statement(s) 1
[pass(parameter I SomeValue) il
[optional post-processing statement(s)l
}

Unlike the getter syntax, parentheses and a parameter are required for the
setter to obtain the value intended to be assigned to the hooked object
property. If youwant the handler to be able to set the property (rather than
simply block write access to it), you need a pass statement that sets the
property's value. When you try to set the property (for example, when the
property is used on the left side of the assignment operator obj ect . property =
1), the on handler code executes.

Exannple

II In the following example, the setter uses the value set
II in radius to calculate and set the values of circumference
I and area. It then passes the user's value on to radius.

import IDEi
IIImport IDE, an IDEApplication object
declare PI = 3.141592654i
class Circle(rad) {
declare radius = radi
declare circumferencei
declare areai
II Setter
on this:>radius(x)
if

(x > 0)

{

circumference = PI * 2 * Xi
area = PI * x * Xi
pass (x) i
}

else
IDE.Message("Error: Radius must be greater than zero.") i
II Methods
}
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ShowProperties() { .
IDE.Message("radius

= " + radius +
circumference = "
+ circumference +
area = " + area);

II End of Circle class declaration

declare Circle obj (1) ;
obj.Showproperties() ;

IIInitialize radius to 1.

IICall the IDEApplication method SimpleDialog to prompt

lithe user for input and get a value for radius.
declare radius

= IDE.SimpleDialog("Enter a radius", "10");

obj.radius = 0 + radius; IIConvert string to integer
obj.Showproperties() ;

Adding menu items and buttons to the IDE
Through cScript, you can add menu items to a view's SpeedMenu or to
menus on the main IDE menu, and define buttons that can be added to the
IDE SpeedBar. This functionality is contained in the file MENUHOOK.DLL,
located in the Borland C++ BIN directory. A script called MENUHOOK.5PP
is provided in the Borland C++ SCRIPT directory to enable these capabilities
through cScript.
.
To use its functions, MENUHOOK.SPP must be loaded using the load
command or through the Script Modules dialog box. To automatically load
MENUHOOK.SPP each time you start the IDE, add the following line to
STARTUP.5PP:
scriptEngine.Load("menuhook");

II load the MenuHook functions

MENUHOOK functions
The following table lists the MENUHOOK functions:
Function

Description

assign_to_view_menuO
remove_view_menu_itemO
define_buttonO

Adds a menu item to a menu
Removes a menu item from a menu
Defines a button that can be added to the SpeedBar

Creates a new menu item on a SpeedMenu or on a main IDE menu.
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Syntax

Return value
Description

int assign_to_view_menu(string view_type, string menu_text, string scripUext, string hint_text);

view_type

Defines the type of view to attach this menu item to. Supported
values are: IDE, Editor, and Project. Passing IDE creates a new
menu bar item on the main IDE menu. The other values attach
the menu item to the SpeedMenus of views of the given type.

menu_text

The words that will appear on the menu item. If you include an
ampersand ( & ) in the string, the character following the
ampersand will be underlined and will be the selection
character for the menu item. Menu items can be nested by
putting a pipe ( I ) between the words of the menu items.

script_text

cScript statement(s) to be executed when the menu item is
selected.

hinCtext

The text to display in the status bar when the menu item is
highlighted.

1 if the menu item is successfully added, 0 otherwise.
menu_text should be unique for the menu. Built-in menu items cannot be
replaced using this function. Defining a menu item with view_text identical to
that of a menu item previously defined with assign_to_view_menuOwill
replace the original menu item with the new one.

A one-level submenu can be created by specifying a menu_text with a pipe
(I ) character between the menu text and the menu item text. By using the
same menu text to the left of the pipe with different menu item text to the
right of the pipe in several calls to assign_to_view_menuO, you can create a
submenu with several menu items.
Editor or project views that are visible when assign_to_view_menuO is
executed will not have their menus updated. By adding calls to
assign_to_view_menuO in STARTUP.5PP, you can customize the IDE's
menu system from the time it starts up, and assure that all views will have
the customized menus.
Menu items can be removed from SpeedMenus using
remove_view_menu_itemO. Menus created on the IDE menu bar cannot be
removed without exiting the IDE.

Example

I I Loads the MENUHOOK functions if not loaded in STARTUP. SPP
load ("menuhOQk" ) i
II This function call adds a single menu item
II to the editor view's SpeedMenu.
assign_to_view_menu("Editor", "&Click Me",
"IDE.Message(\"I'm clicked!\") i",
"Click this menu item to see a message")

i

II These function calls add a submenu to the project
II view's SpeedMenu with three menu items.
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assign_to3iew_menu("Project", "Ne&w Menu I &First Item",
"IDE.Message(\"Clicked the first item\") ;",
"This is the first submenu item");
assign_to3iew_menu("Project", "Ne&w Menu I &Second Item",
"IDE.Message (\ "Clicked the second item\");",
"This is the first submenu item");
assign_ to_ view_menu ( "Proj ect", "Ne&w Menu I &Third Item",
"IDE.Message(\"Clicked the third item\");",
"This is the first submenu item");
II These function calls add a menu pad to the
II main IDE menu bar with three menu items.

assign_to3iew_menu( "IDE", "E&xample I &First Item",
"IDE.Message(\"Clicked the first item\");",
"This is the first submenu item");
assign_to_view_menu("IDE", "E&xample I &Second Item",
"IDE.Message(\"Clicked the second item\");",
"This is the first submenu item");
assign_to3iew_menu (" IDE", "E&xample I &Third Item",
"IDE.Message(\"Clicked the third item\");",
"This is the first submenu item");

Removes a menu item from the specified view's SpeedMenu.

Syntax

Return value

int remove_view_menujtem(string view_type, string menu_text);

view_type

Defines the type of view the menu item is attached to.
Supported values are; Editor and Project.

menu_text

The words that appear on the menu item to be removed. This
includes the ampersand ( & ) denoting the selection character, if
any. If a menu and menu item were defined using a pipe ( I ) in
menu_text in the call to assign_to_view_menuO that created the
menu/menu item, then the exact same text, including the pipe,
are required in this function as well.

1 if the menu item is successfully removed, 0 otherwise.
\

Description

menu_text must exactly match the string used in the menu_text argument in
assign_to_view_menuO.
Menus and menu items created with assign_to_view_menu() can be
removed. Menus and menu items on the IDE menu bar can also be removed.
When removing menus with multiple menu items,
remove_view_menu_itemO must be called for each item in the menu.

Example

II These function calls remove the SpeedMenu menus and menu
II items created with the assign_to_view_menu() example.
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II Removes menu item from the editor view's SpeedMenu
remove3iew_menu_item("Editor", "&Click Me");
II Removes the submenu from the project view's SpeedMenu
remove3iew_menu_item("Project", "Ne&w Menu I &,F'irst Item");
remove3iew_menu_item("Project", "Ne&w Menu I &Second Item") i
remove3iew_menu_item("Project", "Ne&w Menu I &Third Item") i

Defines a new SpeedBar button.

Syntax

int define_button(string button_name, string scripUext, string hinUext, string tooltip_text,
int buttonjndex);

button_name

Defines a name for this button. The name should not
conflict with any of the built-in button names. Multiple
buttons with the same name can be defined.

script_text

cScript statement(s) to be executed when the button is
selected.
The text to display in the status bar when the mouse pointer
rests on the button.
.

tooltip _text

The tip text to display when the mouse pointer rests on the
button.
The index of the glyph to show for the button.
MENUHOOK.DLL contains a built-in set of 38 glyphs
(numbered a through 37) that can be used for buttons.

Return value
Description

1 if the button successfully added, 0 otherwise.
Defining a button with define_buttonO adds the button to the Available
Buttons list in the Options I Environment I SpeedBar I Customize dialog box.
Use this dialog to add the button to the button bar.
User-created button definitions are automatically saved to the IDE
configuration file when the IDE shuts down, and reloaded when the IDE
starts.

Example

II Creates a new button definition and adds it to the
II Available Buttons list so it can be added to the
II SpeedBar.
define_button ("Example Button",
"IDE.Message(\"You pressed the example button\") ;",
"This is the example button",
"Example Button", 4) i
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Keywords and functions
Keywords and functions are reserved for use in the cScript language and
cannot be used as names of variables, methods, or classes or as any other
identifier names.

array
Declares an array.

Syntax 1

declare array-var = new array[ [size]];
declare arrayarray-var[ [size]];

size

Syntax 2

Description

The number of elements in the bounded array. If size is omitted,
the array is associative.

array-var[ [size]] = {element1 [, element2[, ... J] };

size

An array created with this syntax always takes the number of
elements in the declaration list. size is ignored.

elementl...

Creates a bounded array with contents elementl, element2, and
so on. Element numbering starts at 0 and continues to size - 1.
The number of elements determines the size of the array and
overrides size if it is specified.

In cScript, you can create two types of arrays, bounded and associative:
• Bounded arrays are similar to C++ arrays. As in C++, they use a zerobased index. (The first element is 0 and the last is size - 1.) If you create an
array with a list of elements, as in Syntax 2, it is a bounded array and its
size is the number of elements.
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• Associative arrays are grown as needed. If you assign more members to a
bounded array than its size, the rest of the array becomes an associative
array.
Arrays can contain data of any cScript type, including objects and other
arrays. An array with other arrays as elements is multidimensional. Elements
of the contained arrays are accessed using additional sets of square brackets
as shown in the example.

Exannple

II Creates a bounded array of 10 elements
declare myArray;
myArray = new array[10] ;
myArray [1] = "Hello";
myArray [2] = "World" ;
print myArray[O] , myArray[1];
I I prints "Hello World"
II Creates an associative array
declare myAssocArray;
myAssocArray = new array []
myAssocArray["Element1"] = "One";
myAssocArray ["Element2"] = "Two";
print myAssocArray [" Element2" ]

I I no size declared

I I prints "Two"

II Creates a multidimensional array
declare array multiArray[] = {{1,2,3}, myArray, myAssocArray};
print multiArray[O] [2], multiArray[1] [0], multiArray[2] ["Element2"];
II Prints: 3 Hello Two

attach
Links a method of an instance of one class to a method of an instance of
another class.

Syntax
Description

attach Classlnst1 :>method1 to Classlnst2:>method2

To make dynamic changes to class instances, you can set up dynamic
function call event handlers (also called on hancUers) using the closure
operator with attach. This technique allows you to supply an alternative
implementation for an instance method.
In other words, you can override an object's method and provide an
alternate implementation of that method at runtime, without affecting the
class from which the object was instantiated. The override remains in effect
for the lifetime of the object or until the link is broken using detach.
This binding is on a per-instance basis unless you use the attach statement in
the class definition with the this reference in place of a specific instance
name.

Exannple

5-2

II Attaches a method belonging to a String object (myStr1)
II to an EditStyle object (myStyle);
declare myStr1, myStr2, myStyle;
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myStrl = new String ("HELLO WORLD")
myStyle = new EditStyle ("Example")

j
j

II Attaches myStrl's Lower() method to myStyle
attach myStrl:>Lower to myStyle:>Lowerj
II Calls Lower() from myStyle
myStr2 = myStyle.Lower()j
print myStr2.Textj

I I prints "hello world"

II Detaches Lower() from myStyle
detach myStrl:>Lower from myStyle:>Lowerj
myStr2 = myStyle.Lower() j
print myStr2.Textj
II prints [UNINITIALIZED]

break
Passes control to the first statement following the innermost enclosing brace.

Syntax
Description

break;

Use break within a:
•
•
•
•
•

do loop
while loop
for loop
iterate loop
switch construct

The implementation of break in cScript is identical to the implementation in
C++.

breakpoint
Stops the program and passes control to the script debugger Breakpoint
Tool.

Syntax
Description

breakpoint;

If the Breakpoint Tool is not active, breakpoint is ignored.

call
Directly invokes a closure.
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Syntax

0

n 5, cas e

call ClosureName(argumentList);

ClosureName
argumentList

Description

Exannple

The name of the closure.
The arguments for the method or property being invoked.

The closure is invoked using the same arguments as the method normally
uses. There is no method for obtaining a return value when calling through
closures. If the method returns a value, it will be ignored.
II Shows creating a closure and assigning it to a
II variable, then calling the closure directly.

Class MyClass {
methodl (pl, p2)
{

print pl, p2;
};

declare MyClass instance;
declare closure = instance:>rnethodl; II declare the closure
call closure ("Hello", "world") i II output is Hello world

case
Determines which statements to execute in a switch statement.

Syntax

switch ( switch_expression ){
case expression :
[statement1 ;]
[statement2;]
[break;]
[default:
[statement1 ;]
[statement2;]
... ]

5-4

switch_expression

Any valid cScript expression, including a function call.
Unlike C++, the switch_expression is evaluated for each
case in a top-down fashion until a match is found or no
more case statements remain.

expression
statement

Any valid cScript expression, including a function call.
One or more statements to execute;
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Description

Note

A case statement is the branch condition of a switch statement. If the value of
the expression following case matches the value of switch_expression, the
statements up to the next break or the end of the switch execute.

Because cScript is a late-bound language, expression does not have to be a
literal as in C++, nor does the expression have to be of integral type.
Otherwise, case behaves exactly as it does in C++.

class
Defines a cScript class.

Syntax

class className [(initialization List)]
[: baseClassName[ (i nit Expression List)]]
{memberList}[;]

className

The name of the class. className can be any name
unique within its scope

initializationList
baseClassName

The initial constructor values for the class, if any.

initExpressionList
memberList

The initialization for the class instance.

The class that this class derives from (optional). of is a
synonym for the: separator preceding this identifier.
Declarations of the class's properties, methods, and
events.

Description . A class declaration in cScript is similar to a class declaration in C++, with a
few key differences.
For example, defining a method with the same name as the class, as you do
in C++, does not make it a constructor. Instead, executable statements
embedded in the class declaration that are not part of a method declaration is
considered constructor code. For this reason, initialization parameters must
be defined in the class declaration. The base class is always initialized first,
before the child class.
Only one base class can be initialized in a derived class declaration because
cScript does not support multiple inheritance. Where a class is defined as
being derived from a base class and the base class requires initialization
values, they must be passed to the base class through the derived class's
declaration. The base class initializer is essentially an implicit constructor
call, and as such, expressions are allowed for its arguments.
When instantiated, the number and type of initializers is not checked
(function overloading is not supported in cScript). Arguments are padded
and/or truncated the same as they arewith functions.
Methods must be defined entirely in the class declaration. You can't just
declare a member function in a class and then define it later in the program.
All properties and methods of the class are public.
Key w 0 r d san d fun c t ion s
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Destructors in cScript work as they do in C++. Defining a method that starts
with a tilde (.... ) and has the same name as the class makes it a destructor.
Destructors are called when the object is being destroyed. Destructors may
not have parameters.
Where inheritance is used, the access method for base class members is the
same as for those of the derived class. However, if a derived class member
has the same name as one of the base class, you must use super to clearly
specify the reference.
Note

Example 1

You cannot instantiate a class aspart of its declaration as in traditional C
structs, so a semicolon is optional at the end of the declaration.
liThe following class is declared without parameters:
class noParams{
declare aMember;
declare anotherMember;
Funcl();
II constructor code
for (y = 1; y < 10; y++) II more constructor code
print "hello";

-noPar'ams(){
print "A noParams has been destroyed.";
}
}

II The following class is declared with parameters:
class Base (parmOne, parmTwo){
declare X = parmOne; II a member variable
declare Y = parmTwo; II a member variable
MethodOne(){
X = X + Y;
}

AnotherMethod(){
}
}

Example 2

II The following class is inherited from the class Base:
II aParm and cParm are passed through to
II Base as parmOne and parmTwo.
class Derived (aParm, bParm, cParm) : Base (aParm, cParm) {
declare Z = bParm;
}

II example using the Derived class:
declare obj = new Derived(l, 2, 3)11 1&3 passed to Base
II Base constructed before
II Derived

continue
Passes control to the end of the innermost enclosing brace, allowing the loop
to skip intervening statements and re-evaluate the loop condition
immediately.
5-6
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Syntax
Description

continue;

Use continue within a:
•
•
•
•

do loop
while loop
for loop
iterate loop

The implementation of continue in cScript is identical to the implementation
in C++.

declare
Declares a variable and ensures that it is local to the current scope and does
not override a variable from an enclosing scope.

Syntax

declare identifier [optional identifier_syntax][, identifier ... ];

identifier
identifier_syntax

Description

The variable being declared.
The variable's default values. identifier_syntax is optional.

The scope of a variable is the block in which it is first used and any blocks
nested in that block. While in a nested block, it is possible that a variable you
think you are using for the first time has already been used in the enclosing
block. What happens in that case is that you override the enclosing block's
variable value (and possibly its type as well) with what you mistakenly think
is a local variable.
To ensure that this doesn't happen, use declare with any variables that are
local to a block. Although not needed, declare can also be used in
conjunction with the export and import declarators. Note that you can
declare multiple basic variables, objects, and arrays in a single statement, but
you cannot mix them in the same statement.
See "array" on page 5-1 and "new" on page 5-17 for specifics on declaring
arrays and class objects.

Example

/ / Examples of declare
declare Xi
declare X = Ii
declare x, y, Zi
declare X = 1, y, z = 2i

default
Provides statements to process in a switch statement when none of the case
conditions apply.
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Syntax

switch (switch_expression ){
case expression :
[statemenUist;]
[break;]
[default:
[statemenUist;]
... ]

Description

switch_expression

Any valid cScript expression, including a function call.
Unlike C++, the switch_expression is evaluated for each
case in a top-down fashion until a match is found or no
more case statements remain.

expression
statemenClist

Any valid cScript expression, including a function call.
A list of statements to execute.

default is optional. If you include a default statement, it must be the last
condition in the switch. If you do not include a default statement and none
of the cas'e conditions apply, none of the statements in the switch are
executed. The behavior of default in cScript is the same as c++.

delete
Deallocates an object and causes the object destructor, if any, to be called.

Syntax 1 delete objecCname;
object_name

The name of the object to delete.

Syntax 2 delete array_name;
The name of the array to delete. Deleting an array does not
require square brackets in the delete command, as it does in
C++.
.

Description

Unlike C++, cScript has automatic garbage collection. Therefore, objects are
automatically deleted when there are no longer any references to them, or
when they go out of scope. Use delete only when you need to explicitly
deallocate an object before the references to that object have been destroyed.

detach
Detaches a method instance of one class from a method instance of the same
or another class when the two were previously linked using attach.

5-8
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Syntax
Description

detach Cla,sslnst1 :>method1 from Classlnst2:>method2

To make dynamic changes to class instances, you can set up dynamic
function call event handlers (also called on handlers) using the closure
operator with attach. This technique allows you to supply an alternative
implementation for an instance method.
In other words, you can override an object's method and provide an
alternate implementation of that method at runtime without affecting the
class from which the object was instantiated. The override remains in effect
for the lifetime of the object or until the link is broken using detach.

Example

I I Attaches a method belonging to a String obj ect (myStrl)
II to an EditStyle object (myStyle) i
declare myStrl, myStr2, myStylei
myStrl = new String ("HELLO WORLD") i
myStyle = new EditStyle ("Example") i

II Attaches myStrl's Lower() method to myStyle
attach myStrl:>Lower to myStyle:>Loweri
II Calls Lower() from myStyle
myStr2 = myStyle.Lower()i
print myStr2.Texti

II prints "hello world"

II Detaches Lower() from myStyle
detach myStrl:>Lower from myStyle:>Loweri
myStr2 = myStyle.Lower() i
print myStr2.Texti
II prints [UNINITIALIZED]

do
Executes the specified statement until the value of the specified condition
becomes FALSE.

Syntax

Description

Note

do statement while ( condition);

statement

The statement to be executed. statement executes repeatedly as
long as the value of condition remains TRUE.

condition

Either TRUE or FALSE. When FALSE, .statement stops
executing.

The behavior of do in cScript is the same as c++. break terminates loop
execution, while continue evaluates condition immediately without executing
any intervening statements.
Because co~dition is tested after statement is executed, the loop executes at
least once.
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export
Provides access to a variable across modules.

Syntax

export variable_name;

variable_name

Description

The name of the variable to export.

Declare the variable as export in the module that declares it and import in
another module that needs access to it.
Variables created at the module level (not In a function, method, class, or
control structure) are global variables of the module, but are not accessible to
any other modules. ,To access module scope variables defined in module A
from module B, three things must occur:
• Both module A and module B must be loaded.
• The module scope (global) variable must be declared export in Module A.
• Module B must contain an import statement for the variable.

Example

I I Example of export and import
II FILE1.SPP
export myExVaril1 export variable for use in other modules
. myLocal = 10 i
myExVar = 10 i
II FILE2.SPP
import myExVaril1 import variable exported by another module
print myLocalil1 prints [UNINITIALIZED]
print myExVaril/ prints 10

for
Executes the specified statement as long as the condition is TRUE.

Syntax

for ( [initialization] ; [condition] ; [expression] ) statement

initialization

Initializes variables for the loop. initialization can be an
expression or a declaration. Variables are initialized before
the first iteration of the loop.

condition

Must evaulate to either TRUE or FALSE. When FALSE,
statement stops executing.

expression

The expression to evaluate after each iteration of the loop.
expression usually increments or decrements the initialization
variable in some way.
The statement to be executed. statement executes repeatedly
as long as the value of condition remains TRUE.

statement
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Description

The behavior of for in cScript is the same as c++. statement executes
repeatedly as long as condition is TRUE. The scope of any identifier declared
within the for loop extends to the end of the script module.
Because condition is tested before statement is executed, the loop may never
execute.

Note

The cScript for statement works the same as a C++ for statement.
All the parameters are optional. If condition is left out, it is assumed to be
always TRUE. break will cause loop execution to be terminated, while
continue will cause the condition to be evaluated immediately without
executing any intervening statements.

FormatString
Formats strings at run time.

Syntax

Return value
Description

FormatString("formatString" [, expression1 [, expression2 ... ]]);

formatString

Literal text, placeholders for values, or a combination of the
two. A placeholder is in the format of U%n", where n is the
number representing the place of the expression in the list
following the format string.

expression

Any valid cScript expression (literals, variables, function
calls, and so on). Note that numeric values are automatically
converted to strings.

The string created by combining the formatString and the variable list.
Use FormatString to build strings at runtime using a formatting string and a
list of cScript expressions.
For example,
declare str = "Hello";
declare value = 10;
print FormatString(" str = %1, value = %2", str, value)
II the string "str = Hello, value = 10" is printed

i

In the above example, the value of str, the first variable in the list, was
substituted for %1 in the output string. Likewise, the value of value, the
second variab~e in the list, was substituted for %2 in the output string.
The number of variables in the variable list must match the number of
placehplders in forma tS tring.

from
Used ina detach statement or when instantiating nested classes.

Keywords and functions
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Syntax 1 innerObject = new Inner from Classlnstance;
Inner

The nested class.

ClassInstance

Instance of the enclosing class.

.Syntax 2

detachClasslnst1 :>method1 from Classlnst2:>method2;

Exannple

II Attaches a method belonging to a String object (myStrl)
II to an EditStyle object (myStyle)i
declare myStrl, myStr2, mySty Ie i
myStrl = new String ("HELLO WORLD") i
myStyle = new EditStyle ("Example") i

II Attaches myStrl's Lower() method to myStyle
attach myStrl:>Lower to myStyle:>Loweri
II Calls Lower() from myStyle
myStr2 = myStyle.Lower() i
PJint myStr2.Texti

II prints "hello world"

II Detaches Lower() from myStyle
detach myStrl:>Lower from myStyle:>Loweri
myStr2 = myStyle.Lower() i
print myStr2.Texti
II prints [UNINITIALIZED]

if
Implements a conditional statement. if works exactly as it does in C++.

Syntax 1 if ( condition) statement;
condition

Must evaulate to either TRUE or FALSE. When FALSE,
statement stops executing.

statement

The statement to be executed. statement executes repeatedly as
long as the value of condition remains TRUE.

Syntax 2 if ( condition) statement;
else statement2;

condition

Must evaulate to either TRUE or FALSE. When TRUE, statement
executes. When FALSE, statement2 executes.

statement The statement to execute. statement executes repeatedly as long as
the value of condition remains TRUE.
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An optional keyword. If you use nested if statements, any else
statement is associated with the closest preceding if unless you
force association with braces.

statement2 The second statement to execute. staternent2 executes when the
value of condition is FALSE. staternent2 can be another if
statement.

Description

Use if to implement a conditional statement.
You can declare variables in the condition expression. For example,
if lint val = func (arg) )
is valid syntax. The variable val is in scope for the if statement and extends to
an else block when it exists.
The condition statement must convert to a bool type. Otherwise, the
condition is ill-formed.
When <condition> evaluates to TRUE, <staternentl> executes.
If <condition> is FALSE, <statement2> executes.

The else keyword is optional, but no statements can come between an if
statement and an else.
'

import
Allows access to a variable across modules.

Syntax 1 import variable Name;
variableNarne

The name of the variable to import.

Description 1 Declare the variable as export in the module that declares it and import in
another module that needs access to it.

'

Variables created at the module level (not in a function, method, class, or
control structure) have module scope. They are not accessible to any other
modules. To access a variable defined in module A from module B, three
things must occur:
• Both module A and module B must be loaded.
• The variable must be declared export in Module A.
• Module B must contain an import statement for the variable.
import is also used to make functionality contained within a Windows DLL
file avaihible from within cScript.

Example 1

I I Example of export and import
II FILE1.SPP
export myExVar;11 export variable for use in other modules

Key W 0 r d san d fun c t ion s
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'myLocal= 10;
myExVar = 10 j
II FILE2,SPP
import myExVarjl1 import variable exported by another module
print myLocaljl1 prints [UNINITIALIZED]
print myExVarjl1 prints 10

Syntax 2 import "DLL_Name" {functionPrototypes}
DLL_Name

The name of the DLL you wish to use. The path can be
included if necessary.

functionPrototypes

Each external function must be prototyped according
to general c++ prototype conventions. DLL calls use
the data type keywords char, short, int, unsigned,
long, bool, void and const.

Description 2 Makes functions contained in external DLLs available to cScript.
Unlike normal cScript functions, variable numbers of arguments are not
supported when using functions from DLLs. You can pass int arguments for
enums, and long for pointers, since cScript does not support these types.
There is no support for passing structs.
cScript supports the calling conventions _cded, _pascal, and _stdcall.

Example 2

I I This example exposes DLL entrypoints using import
import "foo. dll" {
int __ pascal FooFunc(short, char, unsigned, long)j
void Dort () j
}

II directly access the DLL calls
if (FooFunc(l, "hello there", 2, 3))
print "FooFunc () succeeded";
else
Dort () j

initialized
Indicates if a variable has ever been initialized.

Syntax

initialized(x);

x

Return values
Description
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The name of the variable to check.

TRUE if the value has ever been initialized, FALSE otherwise
initialized is an intrinsic function that provides a means for determining the
state of a variable before using it. Using an uninitialized variable is almost
never as dangerous as in C++, but is also usually not what was intended.
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initialized is particularly useful in determining the state of arguments
passed to functions on call, and in class instantiation, and can also be used to
prevent unintended divide by zero errors because of an uninitialized divisor.

Example

I I Example of initialized
declare x, Yi II declares variables,
II but does not initialize them!
x = 10i
II initialized!
print initialized(x) ;11 returns TRUE
print initialized(y); II returns FALSE

iterate
Use an iterate loop to cycle through the members of a class object or an
associative array in first to last order.

Syntax

Description

iterate( outputvar; object[;keyvar])[ statement];

outputvar

A variable to hold a copy of the co~tents of the array or class
data member.

object
keyvar

The array or class object to iterate.

statement

The statement to be executed.

Variable to hold the index or key into the array, or class object
data member name.

iterate is a loop structure that allows some action, such as printing, to be
performed on each member of the array or property of a class object.

You can use continue and break to control execution inside the loop. Like a
for loop, curly braces ( {} ) must be used to enclose multiple loop statements.
iterate can also be used to determine the number of properties in an object or
the number of elements in an array.

Example

IIPrints all the members of associative array z
Ilusing the variable x
iterate( x; z ) {
print x;
}

IIPrints all the members and the key values of
Ilassociative array z using the variable x
iterate( x; z; k ) {
print "Key = " + k + "Value = " + x;
}

Keywords and functions
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load
Opens and parses the specified sqipt file.

Syntax, module Handle =load(fileName);
fileName

The name of the script file to open and parse.

Return value

A module handle (module object reference) if successful, or NULL if not.

Description

Once the script file is opened and parsed, load executes the file using run.
Although classes and functions defined in ,a module come into existence
when the module is loaded, variables declared in the module are not
defined, nor are any other statements executed, until the script is run.
If there is an _init function, the module executes that code first. If there is a
function with the same name as the module, that function is then executed.

Example

IILoads and runs a script file
declare myModulei
"
myModule = load("demo.spp") i II loads module and gets a handle
if (myModule) {II if loaded
run (myModule) ill run the module
. unload (myModule) ill unloads the module
}

module command
Provides an alternative internal name, or alias, for a module.

Syntax

module ["newName"];

newName

Description

The module's alternative name.

After being parsed, every script file loaded into the IDE is assigned a module
name. The name defaults to the file name without its path Of file extension.
This name may be used by other modules to explicitly access functionality in
the module.
You can alter a module's name by embedding the following anywhere in the
file:
module "newname"i

module function
Gets access to any loaded module.'
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Syntax

module (["moduleName"]);

moduleName

Return value

The name of the module to get.

If moduleName is not specified, returns one of the following:

• A reference to an object
• The module handle associated with the named module
• The module handle associated with the current module
If moduleName is specified and no matching module is available or no
parameter is entered, it returns NULL.

Description

Use module to get access to any loaded module. If you use it withthe current
module, moduleName has the same value as this used at the module level.
One use for this function is to access a globally scoped variable from a local
scope. For example,
II Modtest.spp
declare x = 1;
declare ModRef = this;
local x = 2;
print (module()) .x; II prints 1
print ModRef.x;
II prints 1

new
Creates a new object or array.

Syntax 1 objectname =new className[([initializerList])] [fromouterClassN\ime[([initializerList])]]
initializerList

Syntax 2

arrayn~me

arraySize

Description

The list of objects used for initializing this class.

=new array [[arraySize]];
The size of the array.

Use new as an alternate syntax for creating new class objects or arrays. For
more information, see" class" on page 5-5, "array" on page 5-1, and
"declare" on page 5-7.'
Unlike C++, cScript does not distinguish between static and dynamiC
memory allocation. The difference between the standard declaration syntax
and that using new is syntactic only.
cScript has automatic garbage collection. Therefore, objects created with
new, or otherwise, are automatically deleted when there are no longer
references to them (that is, when these objects and any variables that
reference them go out of scope). Use delete only when you need to explicitly
deallocate an object before the references to that object have' been destroyed.

Keywords and functions
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of
A synonym for the colon (:)separator used when defining a class that
derives from a base class.

Syntax

class classname [ (initializationJist) ] [of baseClass[ (initializationJist)

initializationList
member_list

II { memberjist}

The initial constructor values for the class, if any.
Declarations of the class's properties, methods, and
events.

on
Sets up one of the following:
• A dynamic object method call event handler, also called an on handler
(syntax 1)
,
• An object read-property getter (syntax 2)
• A write-property setter (syntax 3)

Syntax 1 on Classlnstance:>{xe ">"}Method([argumentList]){
[pre-processing statement(s)]
[pass([argumentList]);]
[post-processing statement(s)]
[return [value];]

This syntax is used for an object method call event handler. This form of
dynamic event handling allows processing to occur both before and after the
optional call, through pass to the hooked method. It also allows alternate
values to be both passed to the hooked method and returned by the event
handler.
Note

In order to be bound to an existing object method, the number of parameters
in an on handler definition must match the hooked method. Once invoked,
pass will call the hooked method regardless of how many arguments it
passes. As with all function calls, cScript will ensure that the proper number
of arguments are passed, truncating or padding as needed.

Syntax 2 on Classlnstance:>property{
[pre-processing statement(s)]
return [passO I value];

This syntax is used for a property getter and would be triggered by any
subsequent statement that references that object's property for read access,
such as on the right hand side of an assignment statement.
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This form of the syntax allows pass to return the actual value, or,
alternatively, any specified value.

Syntax 3 on Classlnstance:>property(parameter){
[pre-processing statement(s)]
[pass(parameter I value);]
[post-processing statement(s)]

This syntax is used for a property setter. The setter is triggered when the
object's property is used as an lvalue, such as on the left hand side of an
assignment statement. The value to be assigned to the property is what is
passed to the setter as its parameter. The value passed in pass sets the value
of the property.

Description

Use on handlers (also referred to as object method call event handlers) to
create new methods, or redefine existing metho<is, on an object of a given
class.
Unlike attach, methods overriden with on cannot be detached. To call the
original method from within the overriden version with the same name,
invoke the pass function. on handlers can be defined to control both read
and write access to an object's properties.

Note

Example

If the global reference variable selection has been set using select, its
reference will not be affected, but is superseded with the with block.
import edi tor;
II Create a new Debugger object called debug
declare debug = new Debugger();
II Create a new method called RunToCurrent()
lion the object debug (not the class!)
on debug:>RunToCurrent()
{

declare fileNilme = editor.TopBuffer.FullName;
declare row = editor.TopBuffer.TopView.Position.Row;
. RunToFileLine (fileName, row);

pass
Used in an on handler to invoke the original function that is being
overridden.

Syntax

varname = pass([param1 [,param2[, ... ]]);
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print
Prints the specified expression in the Script page of the Message window.

Syntax

print [expression_list];

expression_list

Description

The list of expressions to print.

print takes any string, expression, or variable as a parameter. To concatenate
expressions, separate them with commas. For example:
print "hello world" i
print "the number is", Xi
print "My name is" I name I "and I'm", years I "years old" i

A space is printed for each comma in the expression list. If no expressions are
passed, print does nothing.
• An uninitialized value outputs [UNINITIALIZED].
• A variable initialized to NULL outputs [NULL].
• An object outputs [OBJECT].

reload
Does an unload followed by a load.

Syntax

reload (moduleName);

moduleName

Return value
Description

Note

The name of the module to unload and load.

A module handle if successful or NULL if not
reload searches the module list for a matching module. If found, reload
removes it and then loads it again. If it does not find a module to unload, it
simply loads the module for the first time.
If when reloaded, the module references global objects, these references

continue to refer to the older objects. (The module is not destroyed, but is
stored to maint,ain these references.) Global module values that are not part
of an object are destroyed and then reloaded.

return
Exits from the current function, on handler, or module, optionally returning
a value.

Syntax
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Description

Example

A module, by default, returns TRUE if successfully run. However, an explicit
return statement can be provided to return a customized return value, or
simply to terminate execution prior to the end c:>f the script.
IIExample of return
sqr(x)
{

return (x*x);
}

run
Loads and runs the module indicated.

Syntax

run (moduleName)

moduleName

The name of the module to load and run.

Return value

By default, run returns TRUE if successful or FALSE if not. If the module has
a global return statement, run returns that value if the module successfully
runs and then displays a warning that the standard return value for run has
been overridden.
.

Description

run runs the module if it is already loaded. The module remains loaded until
explicitly unloaded using unload.

Example

IILoads and runs a script file
declare myModule;
myModule = load("demo.spp"); II loads module and gets a handle
if (myModule) {II if loaded
run(myModule);11 run the module
unload (myModule) ;11 unloads the module
}

select
Creates a special global variable, selection,that refers to the selected variable.

Syntax

select objectName;

objectName

Description

The name of the object to select.

You can call select on any variable that is loaded in any script. Doing so sets
selection to reference that variable for all scripts in the 'session. You then
have access to that variable from any script by using the alias selection as the
name of the variable. Variables so selected can also be referenced using the
shorthand dot (".") notation.
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Because the variable is global to all loaded scripts, only one selection can be
active in an IDE session at a .time. If you call select and there is already a
selection, you override the current selection with your new one.

Example

I I Example of select and selection
II SELECTl.SPP
class CO (pl, p2, p3)
declare vl = pl;
declare v2 = p2;
declare v3 = p3;
class Cl (pl; p2, p3)
declare vl = p1;
declare v2 = p2;
declare v3 = p3;
declare CO objl("One", "Two", "Three");
declare Cl obj2(l, 2, 3);

II Select the first object
select objl;
II Iterate across the selected object
II using selection, then dot notation.
iterate (iterator; selection; key)
print typeid(selection), "property", key, "=", iterator;
iterate (iterator; . ; key)
print typeid(.), "property"; key, "=", iterator;

II Note that the dot within the with
II block refers to its own local selection.
with(obj2)
iterate (iterator; . ; key)
print typeid(,), "property", key, "=", iterator;

II But the global selection has not changed.
print .vl;
print selection.v2;
print ". and selection still refer to", typeid ( .) ;

selection
Defines a special global reference variable created by calling select on a
variable.

Syntax

selection.Member

Member

Description
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The class. member for which the global variable is created.

Once the selection has been made, you can use selection in any way that you
normally use the variable it refers to. You can access members of the
referenced object with selection. member. The dot e'.") shorthand syntax can

0 bj e c t S c rip tin 9 Pro 9 ram mer's Gu ide

· Keywords and functions, super

also be used instead of selection outside a with or iterate block or an on
handler. In those situations, the dot has local context and refers to the
controlling variable for that block (usually an object).
Because the selection variable is global to all loaded scripts, only one
selection can be active in an IDE session at a time.

Example

I I Example of select and selection
II SELECT1.SPP
class CO (pl, p2,p3)
declare vl = pl;
declare v2 = p2;
declare v3 = p3;
class Cl (pl, p2, p3)
declare vl =pl;
declare v2 = p2;
declare v3 = p3;
declare CO objl("One", "Two", "Three");
declare Cl obj2(l, 2, 3);

II Select the first object
select objl;
II Iterate across the selected object
II using selection, then dot notation.
iterate (iterator; selection; key)
print typeid(selection) , "property", key, "=", iterator;
iterate(iterator; . ; key)
print typeid (.), "property", key, "=", iterator;

II Note that the dot within the with
II block refers to its own local selection.
with(obj2)
iterate (iterator; . ; key)
print typeid(.), "property", key, "=", iterator;

II But the global selection has not changed.
print .vl;
print selection.v2;
print ". and selection still refer to", typeid ( . ) ;

super
Provides access to a member of the base class with the same name as a
member of a derived class.

Syntax

objectName.super[.super... ].member

objectName

The name of the object to access.
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Description

Base class members can be directly accessed without using super where the
member name is unique within the class definition.
cScript does not support function overloading or the :: operator. However,
you can use super to get access to overridden class members as follows:
class Cl {
declare x = "Cl";
Methodl() {
print x;
}
}

class C2: Cl {
Methodl() {
print "C2 derived from ", x;
}
}

MyObj = new C2;
MyObj.Methbdl();
//Prints C2 derived from Cl
MyObj.super.Methodl(); //Prints Cl

If a base class is itself a derived class and you want to access one of its
overridden members, use super. super (and so on for further access up the
inheritance hierarchy). For example:
class C3:C2 {
Methodl() {
print "C3 derived from C2";
}
}

MyObj3 = new C3i
//Prints C3 derived from C2
MyObj3.Methodl() i
MyObj 3. super .Methodl () i
//Prints C2 derived from Cl
dMyObj3.super.super.Methodl() i //Prints Cl
class C3: C2 {
Methodl() {
print "C3 derived from C2"i
}
}

MyObj3 = new C3i
MyObj3.Methodl() i
MyObj3.super.Methodl() i
MyObj3.super.super.Methodl()

i

//Prints C3 derived from C2
//Prints C2 derived from Cl
/ /PrintsCl

switch
Chooses one of several alternatives.

Syntax

switch (switch_expression){
case expression :

[statement 1;]
[statement2;]
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[break;]
[default:
[statement1;]
[statement2;]
... ]

Description

swi tch_expression

Any valid cScript expression, including a function call.
Unlike C++, the switch_expression is evaluated for each
case in a top-down fashion until a match is found or no
more case statements remain.

expression
statement

Any valid cScript expression, including a function call.
The statement to execute.

The value of the switch_expression is checked against the value of each case
expression until a match is found or until either default or the end of the
switch statement is reached.
As in C++, all statements but case or default following the matching case are
executed until break or the end of the switch statement is reached. If no case
expression matches switch_expression, the statements following default, if any,
are executed.
If you insert a default case, it must be the last case.

Note

If you don't use break as the last statement in the case that executes, all
remaining statements (except case or default) in the switch execute until
either a break is encountered or the end of the switch is reached. If you do,
use a break that executes, the switch statement ends there.

this
Provides an object reference within a class definition.

Syntax
Description

this:>method10

0

The cScript this keyword is analogous to the C++ this pointer. It is used to
provide an object reference within a class definition. this is primarily needed
to define closures used in event handlers that will apply to all instances of
that class.
For example, given the class definition:
class MyClass {
methodl() {}
on this:>methodl() {}
}

Keywords and functions
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all objects of that class will have a default method call event on handler
defined (rather than on a per-instance basis as when the on handler is
defined outside of the class).
When this is used outside of a class definition, it refers to the current module
object since a script module can actually be treated as an object. You can use
it to create an event handler for a global function.
For example,
DoNo thing (){}
on this:>DoNothing()
print "Did something else first";
pass();
.

IIGlobally scoped function
II method of current object

}

Note

Calls to module scope functions for which an event handler has been defined
will only trigger the handler when they are called in the same way as defined
in the on handler. For example,
this.DoNothing() ; II Triggers the event handler
DoNothing() ;
II Does not trigger an event

Example

The following example shows how to use this in a class definition in
conjunction with on handlers or attach to bind a method across all instances
of that class.
Event handlers normally provide a binding to a specific object or instance,
and not to all instances of a class. Yau can bind an event handler to a class
when you want to do either of the following:
• Ensure that some default processing occurs as the very first action
regardless of how many other event handlers are subsequently chained to
a method of a specific class
• Use more complex pre-processing and post-processing of method calls
class co {
declare propertyl = 0;
GetPropertyl() {
return propertyl;
}

on this:>GetPropertyl() { II Increments propertyl before call
propertyl++;
return pass();
}

declare co myObj;
print myObj.propertyl;
print myObj.GetPropertyl();

II Prints 0
II Prints 1

typeid
Gets runtime identification of variables or the resulting value of expressions.
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Syntax

typeid(name_expn);

name_expn

Return value

Any legal variable name or expression.

A string representing the type. Possible return values are:
• [ARRAY]
• class name
•
•
•
•
•
•

Description

[CLOSURE]
[INTEGER]
[NULL]
[REAL]
[STRING]
[UNINITIALIZED]

If the variable or expression value is a built-in type, typeid returns the type
in brackets [ ]. If it is an object, typeid returns the class name. If the
expression is a function or method, typeidO indicates the type of the return
value of the function.

unload
Unloads the specified module.

Syntax

unload (moduleName);

moduleNameThe name of the module to unload.

Return value
Description

Example

TRUE if successful, otherwise FALSE
unload searches the module list for a matching module. If found, unload
removes it, causing all functions, classes, and local variables that were
defined in the module to become invalid. However, if an object within the
script is referenced from another active script (for example, where a function
in the unloaded script returned a reference to an object), that object will not
. be destroyed.
IILoads and runs a script file
declare myModulei
myModule = lOad ("demo. spp") i I I loads module and gets a handle
if (myModule) {II if loaded
run (myModule) ill run the module
unload (myModule) ill unloads the module
}

while·
Repeats one or more statements until condition is FALSE ..
Keywords and functions
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Syntax

Description

while [( condition )] [{statemenUist}]

condition

Either TRUE or FALSE. When FALSE, statemenClist stops
executing. ,

statemenClist

The list of statements to execute.

If no condition is specified, the while clause is equivalent to while(TRUE).
Because the test takes place before any statements execute, if condition
evaluates to FALSE on the first pass, the loop does not execute.

break will cause loop execution to be terminated, while continue will cause
the condition to be evaluated immediately without executing any intervening
statements.

Example

I I Example of while loop
i =0
while (p [i] < 50)
p[i] += 10;
i += 1;
}

with
Creates a shorthand reference to a variable.

Syntax

with (variable){membeUist}

variable
member_list

Description

The variable being referenced.
Declarations of properties,' methods, and events.

with is particularly useful when the variable is a deeply nested object.
Fo~ example, assume an object z, which is contained within an object y,
which is contained within an object x. Access to z's members can be
cumbersome. For example,
x.y.z.DoSomething() ;
x.y.z.DoSomethingElse() ;
x.y.z.NowDoThis();

You can decrease syntactical complexity by assigning x.y.z to another
variable. For example,
p = x.y.z;
p.DoSomething();
p.DoSomethingElse() ;
p.NowDoThis() ;
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If you use with, referencing can be made even simpler:
with (x.y.z) {
.DoSornething() i
.DoSornethingElse() i
.NowDoThis() i

II 1
II No
II No
II No

lookup
lookup
lookup
lookup

}

Scoping of with- statements in functions is handled as you would expect: the
scope is local to the current function and the correct member gets called. For
example:
WFuncl(){
with (x.y.z) {
.DoSornething()

i

}

}

WFunc2(){
with (MyClass){
Wfuncl() i
.Fui1c2() i

II WFuncl calls x.y.z.DoSornething()
II This call is to MyClass.Func2()

}
}

Note

Using the dot operator in a with block refers to the current with assignment.
If the global reference variable selection has been set using select, its
reference will not be affected, but is superseded with the with block.

yield
Forces cScript to check if the abort (Esc) key has been pressed.

Syntax
Return value
Description

yield;

None
Imbedding yield in a time consuming process, such as a loop that executes
many times, provides a way to break out of th~ process, if desired.

Key W 0 r d's and fun c t ion s
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Operators
Operators are tokens that trigger some computation when applied to
variables and other objects in an expression. cScript uses many of the C++
operators. For the most part, these operators have the same precedence,
associativity, and functionality as in C++.
Because cScript has no structs, unions, or references to memory locations, the
following C++ operators do not exist in cScript:
->I

*

->*

.*

For the same reason, the & operator can be used only to declare function
parameters as pass-by-reference parameters (not to dereference variables).
Additionally, cScript does not provide the following C++ operators:
::

sizeaf canst_cast reinterpret_cast

cScript does provide two new operators:
:>

The closure operator, typically used in on statements to override
functions.

??

The in operator, used to test members of arrays and classes.

Depending on context, the same operator can have more than one meaning.
For example, the minus (-) can be interpreted as:
• subtraction (x - y)
• a unary negative (-y)
Note

No spaces are allowed in compound operators (such as : ». Spaces change
the meaning of the operator and will generate an error.
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Operator precedence
Operators on the same line in the table below have equal precedence.
Table 6.1

Operator precedence

Operators

Associativity.

0

[]

left to right
left to right·

:>

??

left to right
right to left

*
+
«
<

+
%
»
<=

++

>

&

left to right
left to right
left to right
left to right
left to right
left to right
left to right
left to right
left to right·

>=

!:::

&
1\

&&
II
?:

*=

/=

%=

+=

&=

1\=

1=

«=

»=

left to right
left to right
right to left
left to right

Binary operators
The binary cScript operators are as follows:
Table 6.2

Binary operators

Type

Operator

Description

Arithmetic

+

Binary plus (add)
Binary minus (subtract)
Multiply
Divide
Remainder (modulus)
Shift left

*

/
%

Bitwise

«
»
&
1\

Logical

&&
II
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Shift right
Bitwise AND
Bitwise XOR (exclusive OR)
Bitwise inclusive OR
Logical AND
Logical OR

Arithmetic operators

Table 6.2

Binary operators (continued)

Type

Operator :

Assignment
*=

/=
+=

«=
»=
&=

Relational

1=
<
>
<=
>=

!=
Conditional

?:
a?x: y

Comma

:1?~~9riptIOQ'
Assignment
Assign product
Assign quotient
Assign remainder (modulus)
Assign sum
Assign difference
Assign left shift
Assign right shift
Assign bitwise AND
Assign bitwise XOR
Assign bitwise OR
Less than
Greater than
Less than or equal to
Greater than or equal to
Equal to
Not equal to
Actually a ternary operator
"if a then x else y"
Evaluate

Arithmetic operators
The arithmetic operators are:
+ -

Syntax

* / %

++

--

+ expression
- expression
expression1 + expression2
expression1 - expression2
expression1 * expression2
expression1 / expression2
expression 1 % expression2
postfix-expression ++
++ unary-expression
postfix-expression --- unary-expression

(postincrement)
(preincrement)
(postdecrement)
(predecrement)
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Description

Use the arithmetic operators to perform mathematical computations.
expressionl determines the type of the result when variables of different types
are used.
Table 6.3

Arithmetic operators

+ (unary expression)
- (unary expression)
+ (addition)
- (subtraction)

Assigns a positive value to expression.
Assigns a negative value to expression.
Adds all data typs.
Subtracts data types.

* (multiplication)

Multiplies data types.
Divides data types.
Returns the remainder of integer division.
Adds one to the value of the expression. Postincrement adds
one to the value of the expression after it evaluates; while
preincrement adds one before it evaluates.
Subtracts one from the value of the expression. Postdecrement
subtracts one from the value of the expression after it evaluates;
while predecrement subtracts one before it evaluates.

/ (division)

% (~odulus operator)
+ + (increment)

- - (decrement)

Assignment operators
The assignment operators are:
«=

Syntax
Description

*=

/=

»=

&=

%=

+=

1=

unary-expr assignment-op assignment-expr

The = operator is the only simple assignment operator, the others are
compound assignment operators.
In the expression El = E2 El must be a modifiable lvalue. The assignment
expression itself is not an lvalue.
I

The expression
El op

= E2

has the same effect as
El

= El

op E2

except the lvalue El is evaluated only once. The expression's'value is El after
the expression evaluates.
For example, the following two expressions are equivalent:
x += Yi
x = x + Yi
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Any assignment can change the cScript native type of the value on the left of
the assignment, depending on the type of the value assigned.
Note

Do not separate compound operators with spaces. For example, do not enter:
+<space>=

This generates errors.

Bitwise operators
Use bitwise operators to modify individual bits of a number rather than the
whole number.

Syntax

AND-expression &equality-expression
exclusive-OR-expr A AND-expression
inclusive-OR-expr eXclusive-OR-expression
",expression
shift-expression « additive-expression
shift-expression » additive-expression

Table 6.4

Bitwise operators
Bitwise AND: compares two bits and generates a 1 result
otherwise, it returns O.
Bitwise inclusive OR: compares two bits and generates a 1 result if either or
both bits are 1; otherwise, it returns O.
Bitwise exclusive OR: compares two bits and generates a 1 result if the bits
are complementary; otherwise, it returns O.
Bitwise complement: inverts each bit. (~is also used to create destructors.)
.Bitwise' shift right: moves the bits to the right, discards the far right bit and
. assigns the leftmost bit to O.
Bitwise shift left: moves the bits to the left, it discards the far left bit and
assigns the rightmost bit to O.

1\

»
«

Both operands in a bitwise expression must be of an integral type.

E1

E2

E1 & E2

E1 "E2

E11 E2

o

o

o

o

o

1

o

o

1

1

o

1

o

1

1

1

1

1

o

1
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Comma (,) punctuator and operator
A comma acts as a punctuator and operator. It is used as follows:
• Separates elements in a fUnction argument list
• Acts as an operator in comma expressions
Mixing the two uses of comma is legal, but you must use parentheses to
distinguish them.

Syntax
Description

expression, assignment-expression

If the left operand El is evaluated as a void expression, then the right

operand E2 is evaluated to give the result and type of the comma expression.
By recursion, the expression
El, E2, ... , En

results in the left-to-right evaluation of each Ex, with the value and type of
En giving the result of the whole expression.
To avoid ambiguity with the commas in function argument and initializer
lists, use parentheses. The following example calls func with three
arguments: i, 5, and k.
func(i, (j

= 1, j +

4),

k)i

Conditional (?:) operator
The conditional operator (?:) is a ternary operator used as a shorthand for HeIse statements.

Syntax
Description

logical-OR-expr ? expr : conditional-expr

This operator allows you to use a shorthand for
if (expression)
statementli
else
statement2i

In the expression'
El ? E2 : E3

El evaluates first. If its value is nonzero (TRUE), then E2 evaluates and E3 is
ignored. If El evaluates to zero (FALSE), then E3 evaluates and E2 is
ignored. The result of the statement is the value of either E2 or E3, depending
upon which evaluates.
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Logical operators

Example

Ilif-else statement:
if (x < y)
z = x;
else
z = y;
IIEquivalent:
z = (x < y) ? x : y;

Logical operators
Use logical operators to evaluate an expression to TRUE or FALSE.

Syntax

logical"AND-expr && inclusive-OR-expression
logical-OR-expr II logical-AND-expression
! expression

Table 6.5

Logical operators

,qperatQr . )e~cr:iptiOrl, '
&&

II

Logical AND returns TRUE (1) only if both expressions evaluate to a
nonzero value; otherwise it returns FALSE (0). Unlike C++, if the first
expression evaluates to FALSE, the second expression is still evaluated.
Logical OR returns TRUE (1) if either of the expressions evaluates to a
nonzero value; otherwise it returns FALSE (0). Unlike C++, if the first
expression evaluates to TRUE, the second expression is still evaluated.
Logical negation returns TRUE (1) if the entire expression evaluates to a
nonzero value; otherwise it returns FALSE (0). The expression IE is
equivalentto (0 == E).

Reference operator
Passes arguments in a function definition header by reference.

Syntax
Description

methodName( &parameter[, ... ]){statementList}

In cScript as in C++, the default function calling convention is to pass by
value. The reference operator can be applied to parameters in a function
definition header to pass the argument by reference instead.
cScript reference types created with the & operator, create aliases for objects
and let you pass arguments to functions by reference.
When a variable x is passed by reference to a function, the matching formal
argument in the function receives an alias for x, (similar to an address pointer
in C++). Any changes to this alias in the function body are reflected in the
value of x.
When a variable x is passed by value to a function, the matching formal
argument i~ the function receives a copy of-x. Any changes to this copy
Ope rat 0 r s
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Relational operators

within the function body are not reflected in the value of x itself. Of course,
the function can return a value that could be used later to change x, but the
function cannot directly alter a parameter passed by value.
Note

The reference operator is only valid when used in function definitions as
applied to one or more of its parameters. The address of operator is not
supported in cScript as it is in C++, where it can be used to obtain the
address of (create a pointer to) a variable.

Example

I I Example of reference· operator
func1 (i){i=5i}
func2 (&Ir) {i=5i}
II It is a reference variable
sum = 3i
func1 (sum) ;
print sum;
func2 (sum) ;
print sum;

II
II
II
II

sum passed by valu"e
Prints 3
sum passed by reference
Prints 5

sum, passed by reference to func2, has its value changed when the function
exits. func1, on the other hand, gets a copy of the sum argument (passed by
value), so sum itself cannot be altered by func1.

Relational operators
Relational operators test equality or inequality of expressions.

Syntax

Description

equality-expression == relational-expression
equality-expression != relational-expression
relational-expression < shift-expression
relational-expression> shift-expression
relational-expression <= shift-expression
relational-expression >= shift-expression

If the statement evaluates to TRUE it returns a nonzero value; otherwise, it

returns FALSE (0).
Table 6.6

!=
>
<
>=
<=
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Relational operators

equal
not equal
greater than
less than
greater than or equal
less than or equal
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Enclosing operators
The enclosing operators are:
(brackets)
(double-brackets)
( ) (parentheses)
{ } (braces)
[ J

[[ J J

Syntax

(expression-list)
function (arg-expression-list)
array-name [expression]
{statement-list}
compound-statement {statement-list}
OLEObject. indexedProperty[[expression]]

Table 6.7

Enclosing operators

'QRe1'8tQ r :D~$erilifi~ • •'"

: :'"

[]

Array subscript operator. Indicates single and multidimensional array
subscripts.

[[]]
()

OLE index operator. Indicates the index of an indexed OLE property.
Parentheses operator. Groups expressions, isolates conditional
expressions, or indicates function calls and function parameters.
Braces. Starts and ends compound statements and indicates a code block.

{}

Array subscript ([ ]} operator
The array subscript operator ([ ]) indicates single and multidimensional
array subscripts.

Syntax
Description

[expression-list]

Use the array subscript operator to declare an array or to access individual
array components.
For example,
declare rnyArray = new array [10];
rnyArray[O] = 5;
rnyArray[l] = "Cheers";
declare array rnultiArray[] = {rnyArray};
print rnultiArray[O] [1];// prints "Cheers"

OLE index ([[]]} operator
The OLE index operator ([[ ]]) indicates an OLE object's indexed property
index.
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Syntax
Description

[[expression]]

Use double-brackets to access individual indexed entries of an OLE object's
indexed property:
II create an OLEObject of class OLEGeneric

// which contains an indexed. property called faa
declare myObj = new OleObject(IOLEGeneric") i
print myObj.foo[ [311i II print the third element of faa
Note

This operator is only to be used for accessing elements of an OLE indexed
property.

Parentheses ( ) operator
Use the parentheses operator

0 to:

• Group expressions
• Isolate conditional expressions
• Indicate function calls and function parameters

Syntax 1 (expression-list)
Description

Syntax 1 groups expressions or isolates conditional expressions.

Syntax 2 postfix-expression (arg-expression-list)
arg-expression-list

Description

A comma-delimited list of expressions of any type
representing the actual (real) function arguments.

Syntax 2 describes a call to the function given by the postfix expression. The
value of the function call expression, if it has a value, is determined by the
return statement in the function definition.

Object-oriented operators
The cScript object-oriented operators are:
Table 6.8

Object-oriented operators

Op~raforDescriptiQn
:>
??

Closure operator. Binds a class instance and a method as a single closure
reference.
In operator. Tests for the existence of a class object property or array index.
Member selector. Access a class object member.

In addition, there is a colon (:) punctuator:
Refers to a base class in a derived class declaration.
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Object-oriented operators

Closure (:» operator
Binds a class instance with a class member.

Syntax 1 on handler:
on Classl nstance:>Method{[code _to _replace _method_code]}

Syntax 2

attach:
attach Classlnst1 :>method1 to Glasslnst2:>method2;

Syntax 3

detach:
detach Classlnst1 :>method1 from Classlnst2:>method2;

Syntax 4

getter:
on Classlnstance:>property{
II your code. here
return [passOISomeValue];
}

Syntax 5

setter:
on Classlnstance:>property(parm){
II your code here
[pass(SomeValue);]
}

Syntax 6

closure variable:
. declare closureVar

Note

=classlnstance:>methodName;

A closure variable as declared above can subsequentlybe used wherever a:.
closure is needed. For example, an alternative to the attach statement (Syntax
2) using closure variables would be:
declare closureVar1 = classlnst1:>method1;
declare closureVar2 = classlnst2:>method2;
attach closureVar1 to closureVar2;

Description

Example

Use the closure operator (:» in an on handler, an attach statement, or a
detach statement to bind a class instance with a class member as a single
closure reference.

/ / Example of closure
import scriptEngine;
import IDE;
modList

= new ListWindow(50, 5, 100, 300, "Module List",
TRUE, FALSE, loadedModules);

Ope rat 0 r s
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II Hook the Accept event in order to do nothing.
II Default behavior is to put the list away.

on modList:>Accept() {}

Member (.) selector operator
Use the member selector operator (.) to access class members.

Syntax
Description

class-instance. class-member

Suppose that the object a is of class A and b is a property declared in A. The
expression:
a.b

represents the property b in a.
Note

Although the precedence of the. operator is the same as C++ in most
respects, one place where it not is in cScript native function calls that do
not use parentheses. For example, print module "MyModule Datal does not
print the Datal member of MyModule. To print this reference, you must use
parentheses with the module function, as follows:

is

11 •

print module ("MyModule") .Datal

Example

I I Example of member selector (.) operator
class myClass {
i = 0;

s = new myClass();
s.i ;= 3;

II assign 3 to the i property of myClass s

In (??) operator
Use the in operator (??) to test for the existence of an object property or for an
array index.

Syntax 1 string-expression I "string" ?? objectname larrayname
Syntax 2 integer-expression I integer?? arrayname
Description

Use a quoted string, or an expression that evaluates to a string, to test for the
existence of an object property or an associative array index.
Use an integer, or an integer expression, to test for the existence of an index
value in an indexed array. For example,
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class MyClass {
declare property1 = 0;
declare property2 = 1;
}

declare MyClass instance;
if ("property1" ?? instance)
print "property1 is a property of instance.";
declare array a1[);
a1 [0) = "a";
al["Hello") = 1;
if (0 ?? a1)
print "Arrayal has an index· 0.";
if ("Hello" ?? a1)
print "Arrayal has an index \ "Hello\".";

Unary operators
Syntax
Description

unary-operator unary-expression

cScript provides.the following unary operators:
Table 6.9

Unary operators

++

Increment
Decrement

+

Plus
Minus
Logical negation
Bitwise complement

Increment and decrement operators
The increment and decrement operators are ++ and --. They can be used
either to change the value of the operand expression before it is evaluated
(pre) or change the value of the whole expression after it is evaluated (post).
The increment or decrement value is appropriate to the type of the operand.

Syntax 1 pre:
postfix-expression ++
postfix-expression --

Description

(postincrement)
(postdecrement)

The value of the whole expression is the value of the postfix expression
before the increment or decrement is applied. After the postfix expression is
evaluated, the operand is incremented or decremented by 1.
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Syntax 2 post:
++ unary-expression
-- unary-expression

(preincrement)
(predecrement)

unary-expression

Description

The operand, which must be a modifiable lvalue.

The operand is incremented or decremented by 1 before the expression is
evaluated. The value of the whole expression is the incremented or
decremented value of the operand.

Plus and minus operators
The plus (+) and minus (-) operators can operate in either a unary or binary
fashion on any type of variable.

Syntax 1 Unary:
+ unary-expression
- unary-expression

+ unary-expression

Value of the operand after any required integral
promotions.

- unary-expression

Negative of the value of the operand after any required
integral promotions.

Syntax 2 Binary:
expression1 + expression2
expression 1 - expression2

expressionl
expression2

Determines the type of the result.
Is converted if necessary to a type matching expressionl, and
then the operation is carried out.

Multiplicative operators
There are three multiplicative operators:
Table 6.10

:'q~~tator
*
/
%
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:\' :pj~~t:i'tloh~
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~

,

,

Multiplication
Division
Modulus or remainder
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Syntax

Description

multiplicative-expr * unary-expression
multiplicative-expr / unary-expression
multiplicative-expr % unary-expression

The usual type conversions are made on the operands.
(opl

*

op2) Product of the two operands

(opl / op2) Quotient of the two operands (opl divided by op2)
(opl % op2) Remainder of the two operands (opl divided by op2)

For / and %, op2 must be a nonzero value. If op2 is zero, the operation results
in an error. Note that division of a number by a string can result in this
divide by zero error.
When opl is an integer, the quotient must be an integer. If the actual quotient
would not be an integer, the following rules are used to determine its value:
If opl and op2 have the same sign, opl / op2 is the largest integer less than
the true quotient, and opl % op2 has the sign of opl.

2 If opl and op2 have opposite 'signs, opl / op2 is the smallest integer greater
than the true quotient, and opl % op2 has the sign of opl.
Note

Rounding is always toward zero.

Punctuators
The cScript punctuators (also known as separators) are:
Table 6.11
()
{}

#

Punctuators

Parentheses (see "Parentheses ( ) operator" on page 6-10)
Braces
Comma (see "Comma (,) punctuator and operator" on page 6-6)
Semicolon
Colon
Equal sign
Pound sign

Most of these punctuators also function as operators.

Braces ({ }) punctuator
Braces ({ }) indicate the start and end of a compound statement.
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Punctuators

Semicolon (;) punctuator
The semicolon (;) is a statement terminator.
Any legal cScript expression (including the empty expression) followed by ;
is interpreted as a statement. The expression is evaluated and its value is
discarded. If the statement has no side effects, cScript can ignore it.
Semicolons are often used to create an empty statement.

Colon (:) punctuator
Use the colon when declaring a child class or a class with a label.

Syntax 1

class childClass:parentClass

Use this version to indicate the parent class when declaring a child class. For
an example of this syntax, see "class" on page 5-5.

Syntax 2

case expression: .

Use this version to indicate the end of a case expression. For example:
switch (a) {
case 1:
print "One";
break;
case 2:
print "Two";
break;
default: print "None of the above!";

Equal sign (=) punctuator
The equal sign (=) separates variable declarations from initialization lists and
determines the type of the variable.

Syntax
Description

array x[] = { 1, 2, 3, 4, 5};
x = 5;·

In cScript, declarations of any type can appear (with some restrictions) at any
point within the code. In a cScript function argument list, the equal sigh
indicates the default value for a parameter:
MyFunc(i

= 0) {... } //Parameter i has default value of zero

The equal sign is also used as the assignment operator.
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Pound· sign (#) operator
The pound sign (#) indicates a preprocessor directive when it occurs as the
first non-whitespace character on a line. It signifies a compiler action not
necessarily associated with code generation.

Ivalues and rvalues
Ivalues
An lvalue is an identifier or expression that can be accessed as an object and
legally changed in memory. A constant/ for example/ is not an lvalue. A
variable/ array member/ or property is an lvalue.
Historically/ the I stood for left/ meaning that an lvalue could legally stand on
the left (the receiving end) of an assignment statement. Only modifiable
lvalues can legally stand on the left of an assignment statement.
For example/ if a and bare variables/ they are both modifiable values and
assignments. The following are legal:
a
b

=1
=a

+b

rvalues
U

An rvalue (short for "right value is an expression that can be assigned to an
lvalue. It is the "right side of an assignment expression. While an lvalue can
also be an rvalue/ the opposite is not the case. For example/ the following
expression cannot be an lvalue:
)

U

a +b

a + b = a is illegal because the expression on the left is not related to an object
that can be accessed and legally changed in memory.
However/ a = a + b is legal/ because a is a variable (an lvalue) and a + b is an
expression that can be evaluated and assigned to a variable (an rvalue).
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Preprocessor directives
Preprocessor directives are usually placed at the beginning of your source
code, but they can legally appear at any point in a program.
The cScript preprocessor, unlike a c++ preprocessor, supports preprocessor
directives in the expansion side of a macro definition. It detects the following
preprocessor directives and parses the tokens embedded in them:

#define

#ifndef

#else

#include

#endif

#Undef

#ifdef

#Warn

Any line with a leading # is considered as a preprocessor directive unless the
# is part of a string literal, is in a character constant, or is embedded in a
comment. The initial # can be preceded or followed by one or more spaces
(excluding new lines). .

#define
Defines a macro.

Preprocessor directives
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#ifdef, #ifndef, #else, and #endif

Syntax

. Description

#define macrojdentifier <token_sequence>

macro_iden tifier

The identifier for the macro. Each occurrence of
macro_identifier in your source code following the
#define is replaced with token_sequence (with some
exceptions). Such replacements are known as macro
expansions.

token_sequence

The sequence to replace macro_identifier 'with. The token
sequence is sometimes called the body of the macro. If
token_sequence is empty, the macro identifier is removed
wherever it occurs in the source code .

The #define directive defines a macro. Macros provide a mechanism for
token replacement with or without aset of formal, function-like parameters.
Unlike c++ preprocessors, cScript allows you to continue a line with a
backslash (\). You cannot use cScript keywords as macros.
After each individual macro expansion, the preprocessor scans the newly
expanded text to see if there are further macro identifiers that are subject to
replacement (nested macros).
cScript imposes these restrictions on macro expansion:
• Any occurrences of the macro identifier found within literal strings,
character constants, or comments in the source code are not expanded.
• A macro is not expanded during its own expansion (so #define A A won't
expand indefinitely).

Examples

/ / Examples of #define
#define HI "Have a nice dayl"
#define empty
#define NIL ""
#define GETSTD #include <stdio.h>

#ifdef, #ifndef, #else, and #endif
Tests whether an identifier is currently defined or not.

Syntax

Description

#ifdef/#ifndef identifier [logical-operator identifier [... ]]
<section-1 >
[#else
<final-section>]
#endif
<next-section>

Assume that #ifdef tests TRUE for the defined condition; so the line
#ifdef identifier
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#include

means that if identifier is defined, include the code up to the next #else or
#endif. If identifier is not defined, ignore that code and skip to the next #else
or #endif.
The line
#else

means that if identifier is not defined, include the code up to the next #endif.
The line
#ifndef

tests TRUE for the not-defined condition; so
#ifndef identifier

means that if identifier is not defined, include the code up to the next #else or
#endif. If identifier is defined, ignore that code.
In this case, #else means that if identifier is defined, include the code up to the
next #endif.
In the true case, after section - 1 has been preprocessed, control passes to the
matching #endif (which ends this conditional sequence) and continues with
next-section. In the FALSE case, control passes to the next #else line (if any),
which is used as an alternative condition for which the previous test proved
false. The #endif ends the conditional sequence.
The processed section can contain further conditional clauses, nested to any
depth; each #ifdef or #ifndef must be matched with a closing #endif.
The net result of the preceding scenario is that only one section (possibly
empty) is passed on for further processing. The bypassed sections are
relevant only for keeping track of any nested conditionals, so that each #ifdef
or #ifndef can be matched with its correct #endif.
The #ifdef and #ifndef conditional directives let you test whether an
identifier is currently defined or not; that is, whether a previous #define
command has been processed for that identifier and is still in force. You can
combine identifiers with logical operators.
An identifier defined as NUtL is considered to be defined.
cScript supports conditional compilation by replacing the lines that are not to
be compiled as a result of the directives with blank lines. All conditional
compilation directives must be completed in the source or include file in
which they begin.

#include
Pulls other cScript files into the source code.

Syntax 1

#include <file_name>
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Syntax 2 #include "file_name"
Syntax 3 #include macrojdentifier
Description

The #include syntax has three formats:
• The first and second formats imply that no macro expansion will be
attempted; in other words, file_name is never scanned for macro
identifiers. file_name must be a valid file name with an optional path name
and path delimiters.
• The third format does not allow < or " to appear as the first nonwhitespace character following #include. A macro definition that expands
the macro identifier into a valid delimited file name with either of the
<file_name> or ''file_name'' formats must follow the #include.
The preprocessor removes the #include line and replaces it with the entire
text of the cScript source file at that point in the source code. The source code
itself is not changed, but the compiler processes the enlarged text. The
placement of the #include can therefore influence the scope and duration of
any identifiers in the included file.
If you place an explicit path in the file_name, only that directory will be
searched.

Unlike the c++ #include, there is no difference between the <file_name> and
''file_name'' formats. With both versions, the file is sought first in the current
directory (usually the directory holding the source file being compiled). If
the file is not found there, the search continues in the script directories in the
order in which they are defined in the Options I Environment I Scripting I
Script Path dialog box. If the file is not located in any of the default
directories, an error message is issued.

Example

This #include statement causes the preprocessor to look for MYINCLUD.H
in the current directory, then in default directories.
#include "myinclud.h"

or
#include <myinclud.h>

After expansion, this #include statement causes the preprocessor to look in
C: \BC5 \ SCRIPT \INCLUDE \ MYSTUFF.H. Note that you must use double
backslashes in the #define statement.
#define myinclud "C:\\BC5\\SCRIPT\\INCLUDE\\MYSTUFF.H"
#include myinclud
/* macro expansion */

#Undef
Undefines a macro.
7-4
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Syntax
Description

#undef macrojdentifier

#undef detaches any previous token sequence from the macro identifier; the
macro definition is forgotten, and the macro identifier is undefined. No
macro expansion occurs within #undeflines.
The state of being defined or undefined is an important property of an
identifier, regardless of the actual definition. The #ifdef and #ifndef
conditional directives, used to test whether any identifier is currently
defined or not, offer a flexible mechanism for controlling many aspects of a
compilation.
After a macro identifier is undefined, it can be redefined with #define, using
the same or a different token sequence.
Attempting to redefine an already defined macro identifier will result ina
warning unless the new definition is exactly the same token-by-token
definition as the existing one. The preferred strategy where definitions might
exist in other header files is 'as follows:
#ifndef BLOCK_SIZE
#define BLOCK_SIZE 512
#endif

The middle line is bypassed if BLOCK_SIZE is currently defined; if
BLOCK_SIZE is not currently defined, the middle line is invoked to define it.
No semicolon (;) is needed to terminate a preprocessor directive. Any
character found in the token sequence, including semicolons, will appear in
the macro expansion. The token sequence terminates at the first nonbackslashed new line encountered. Any sequence of whitespace, including
comments in the token sequence, is replaced with a single-space character.

Example

/ / Example of #undef
#define BLOCK_SIZE 512
#undef BLOCK_SIZE
/* use of BLOCK_SIZE now would be an illegal "unknown" identifier */
#define BLOCK_SIZE 128

/* redefinition */

#Warn
Sets the warning level.

Syntax

#Warn warning_level

warning_level

Ranges from 0 (suppress all warnings) to 3 (show all
warnings).
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Description

For example, the following statement causes all warnings to be shown when
the script is compiled:
#warr). 3

Macros with parameters.
The following syntax is used to define a macro with parameters:
#define macro_identifier«arg_list» token_sequence

Any comma within parentheses in. an argument list is treated as part of the
argument, not as an argument delimiter.
There can be no whitespace between the macro identifier and the (. The
optional arg_Iist is a sequence of identifiers separated by commas, not unlike
the argument list of a C function. Each comma-delimited identifier plays the
role of a formal argument or placeholder.
Such macros are called by writing
macro_identifier<whitespace> «actual_arg_list»

in the subsequent source code. The syntax is identical to that of a function
call. However, there are some important semantic differences, side effects,
and potential pitfalls.
The optional actuaLarg_list must contain the same number of commadelimited token sequences, known as actual arguments, as found in the
formal arg_list of the #define line. There must be an actual argument for each
formal argument. An error will be reported if the number of arguments in
the two lists is different.
A macro call results in two sets of replacements. First, the macro identifier
and the parenthesis-enclosed arguments are replaced by the token sequence.
Next, any formal arguments occurring in the token sequence are replaced by
the corresponding real arguments appearing in the actuaLarg_list.
As with simple macro definitions, res canning occurs to detect any embedded
macro identifiers eligible for expansion.
Note

The similarities between function and macro calls can obscure their
differences. A macro call can give rise to unwanted side effects, especially
when an actual argument is evaluated more than once.

Nesting parentheses and commas
The actuaLarg_Iist can contain nested parentheses provided that they are
balanced; also, commas appearing within quotes or parentheses are not
treated like argument delimiters.

Using the backslash (\) for line continuation
Along token sequence can straddle a line by using a backslash (\). The
backslash and the following newline are both stripped to provide the actual
token sequence used in expansions.
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Class reference

BufferOptions class
This class is one of the editor classes. BufferOptions objects hold data
controlling the characteristics of edit buffers.

Syntax

BufferOptionsO

Properties
boo I CreateBackup

Read-write

bool CursorThroughTabs

Read-write

boo I HorizontalScroliBar

Read-write

boollnsertMode

Read-write

int LeftGutterWidth

Read:..write

int Margin

Read-write

boo I OverwriteBlocks

Read-write

bool PersistentBlocks

Read-write

boo I PreserveLineEnds

Read-write

boo I SyntaxHighlight

Read-write

string TabRack

Read-write

string TokenFileName

Read-write

boo I UseTabCharacter

Read-write

bool VerticalScroliBar

Read-write
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Methods
void Copy(BufferOptions source)

Events
None

BufferOptioriS class description
This class holds buffer options settings, such as scroll bars, right margin
setting, tab rack, syntax highlighting, cursor shape, gutter width, block style
and tabbing modes.
An instance of this class exists as a member of the global editor options
accessible via Ediitor.Options. This class controls the settings of all edit
buffers. Any change to this object changes the settings of all edit buffers. The
properties are initialized during construction to match the global defaults.
You can instantiate a member of this class to store buffer options. They are
not applied to any edit buffers until you copy them into Editor.Options, at
which point the settings affect all edit buffers.
For example, in a BufferOptions object, you can store a set of options that you
want to apply to a buffer when it is activated (such as tab stops, syntax
highlighting and color). Applying these values to Editor.Options sets the
buffer options for the new buffer and all other edit buffers as,well.

CreateBackup property
Automatically creates a backup of the source file loaded in the active Edit
window when you choose File I Save. The backup file has the extension
.BAK.

Access
Type expected
Description

Read-write
boolCreateBackup

In the IDE, CreateBackup is set with the Create Backup option of the
Environment Options dialog. To display this dialog box, choose Options I
Environment I Editor I File.

CursorThroughTabs property
Causes the cursor to move uniformly through the line as you press arrow
keys for horizontal movement.
8-2
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Access
Type expected
Description

Read-write
boo I CursorThroughTabs

When CursorThroughTabs is FALSE, the cursor jumps several columns when
moved over a tab.This setting has no effect unless tabs are set with the
TabRack property.
In the IDE, CursorThroughTabs is set with the Cursor Through Tabs option of
.
the Environment Options dialog. To display this dialog box, choose
Options I Environment I Editor I Options.

HorizontalScrollBar property
Set to TRUE to display a horizontal scroll bar in the active Edit window. Set
to FALSE to hide the horizontal scroll bar.

Access
Type expected
Description

Read-write
bool HorizontalScroliBar

In the IDE, HorizontalScrollBar is set with the Horizontal Scroll Bar option of

the Environment Options dialog. To display this dialog box, choose
Options I Environment I Editor I Display.

InsertMode property
Sets or clears text insert mode.

Access
Type expected
Description

Read-write
boollnsertMode

Set to TRUE to put the buffer in Insert mode. This pushes the existing text to
the right as you type.
Set to FALSE to put the buffer in Overwrite mode. This writes over the
existing text.
In the IDE, InsertMode is set with the Insert Mode option of the Environment
Options dialog. To display this dialog box, choose Options I Environment I
Editor I Options.

LeftGutterWidth property
The width of the Edit window's left gutter.
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Access
Type expected
Description

Read-write
int LeftGutterWidth

The gutter width represents pixels. It is a positive decimal measurement (for
example 16). The default setting is 32.
In the IDE, GutterWidth is set with the Gutter Width option of the
Environment Options dialog. To display this dialog box,choose Options I
Environment I Editor I Display.

Margin property
The column number to use for the Edit window's right margin.

Access
Type expected
Description

Read-write
int Margin

Valid entries are from 1 to 1024.
In the IDE, Margin is set with the Right Margin option of the Environment
Options dialog. To display this dialog box, choose Options I Environment I
Editor I Display.

OverwriteBlocks property
Deletes selected text as you type.

Access
Type expected
Description

Note

Read-write
bool OverwriteBlocks

Works in conjunction with PersistentBlocks to delete selected text as you type.
If you mark a block of text and type aletter, the letter you type replaces the
entire marked block.
If you .pres$..•

Ov:erwriteB IQcl(~ will ••.

DEL or Back.space
Any key or choose Edit I Paste

Clear the entire block of selected text
Replace the entire block of selected text

When this property is FALSE and PersistentBlocks is TRUE, text entered in a
marked block is added at the insertion point.
In the IDE, OverwriteBlocks is set with the OverwriteBlocks option of the
Environment Options dialog. To display this dialog box, choose Options I
,Environment I Editor I Options.
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PersistentBlocks property
Allows marked blocks to remain selected until they are deleted or unmarked,
or until another block is selected.

Access
Type expected
Description

Read-write
bool PersistentBlocks

When PersistentBlocks is FALSE and you move the cursor after a block is
selected, the text does not stay selected.
In the IDE, PersistentBlocks is set with the Persistent Blocks option of the
Environment Options dialog. To display this dialog box, choose Options I
Environment I Editor I Options.

PreserveLineEnds property
Saves files with their original line ends. When PerserveLineEnds is FALSE,
files are saved with the Borland C++ default value for line ends.

Access
Type expected
Description

Read-write
bool PreserveLineEnds

Use this option to specify how the line ends are written when a file is saved:
you can use the Borland C++ default value, or you can write the original line
end of the file.
Line ends usually consist one of the following combination of characters:
• LF

• CR
• LFCR

• CR LF (Borland C++ default)
where LF = Line Feed (ASCII value 10) and CR = Carriage Return (ASCII
value 13).
In the IDE, PerseveLineEnds is set with the Perserve Line Ends option of the
Environment Options dialog. To display this dialog box, choose Options I
Environment I Editor I File.

SyntaxHighlight property
Indicates if the editor displays code with syntax highlighting.
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Access
Type expected
Description

Read-write
boo I SyntaxHighlight

You can specify your own keywords, functions, or other language elements
that you want highlighted. These elements are stored in token (.TOK) files.
Use TokenFileName to open the .TOK file.
In the IDE, SyntaxHighlighting is setwith the Use Syntax Highlightingoption
of the Environment Options dialog. To display this dialog box, choose
Options I Environment I Syntax Highlighting.

TabRack property .
The buffer's tab settings.

Access

Read-write

Type expected

string TabRack

Description

The tab settings are indicated as a space-delimited sequence of tab stops in
ascending order. For example, 1/3 712" sets tab stops at 3",7" and 12".
In the IDE, TabRack is set with the Tab Stops option of the Environment
Options dialog. To display this dialog box, choose Options I Environment I
Editor I Options.
.

TokenFileName property
The name of the token file (.TOK) to use for syntax highlighting.

Access
Type expected
Description

Read-write
string TokenFileName

In the IDE, TokenFileJ'falrJe is set with the Syntax Extensions option of the
Environment Options dialog. To display this dialog box, choose Options I
Environment I Syntax Highlighting.

UseTabCharacter property
If TRUE, inserts a true tab character (ASCII 9) when you pressTab. If FALSE,
replaces tabs with spaces.

Access

Read-write
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Type expected
Description

bool UseTabCharacter

TabRack determines the number of spaces used to replace a tab.
In the IDE, UseTabCharacter is set with the Use Tab Character option of the
Environment Options dialog. To display this dialog box, choose Options I
Environment I Editor I Options.

VerticalScrollBar property
Set this property to TRUE to display a vertical scroll bar in the active Edit
window. Set to FALSE to hide the vertical scroll bar.

Access
Type expected
Description

Read-write
bool VerticalScroliBar

In the IDE, VerticalScrollBar is set with the Vertical Scroll Bar option of the
Environment Options dialog. To display this dialog box, choose Options I
Environment I Editor I Display.

Copy method
Copies the values from the source BufferOptions object into this BufferOptions
object.

Types expected

void Copy(BufferOptions source)

source

Return value

The name of the buffer to copy from.

None

BufferOptions class
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Debugger class
Debugger class members let you debug a cScript program. You can set
breakpoints, single step through code, and inspect variables.

Syntax

DebuggerO

Properties
bool HasProcess

Read-only

Methods
bool AddBreakpointO
boo I AddBreakpointFileLine(string fileName, int lineNum)
bool AddWatch(string symbolName)
bool AnimateO
bool Attach(string processlD)
bool BreakpointOptionsO
string Evaluate(string symbol)
bool EvaluateWindow(string symbol)
boo I FindExecutionPointO
bool Inspect(string symbol)
bool InstructionSteplntoO
bool InstructionStepOverO

Deb u 9 9 ere I ass
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bool IsRunnable(int processlD)
bool Load(string exeName)
bool PauseProgramO
bool ResetO
bool RunO
bool RunToAddress(string addr)
bool RunToFileLine(string fileName, int lineNum)
bool StatementSteplntoO
bool StatemeiltStepOverO
booI TerminateProgramO
boo I ToggleBreakpoint(string fileName, int lineNum)
bool ViewBreakpointO
bool ViewCaliStackO
bool ViewCpu([address])
boo I ViewCpuFileLine(string fileName, int IineNum)
bool ViewProcessO
bool ViewWatchO

Events
void DebugeeAboutToRunO
void DebugeeCreatedO
void DebugeeStoppedO
void DebugeeTerminatedO

Debugger class description
No matter how careful you are when you code, your script is likely to have
errors (bugs) that prevent it from running the way you intended. Debugging
is the process of locating and fixing errors that prevent your script from
operating correctly.
The Debugger class lets you:
• Add breakpoints to your script file
• Add a watch on a symbol name
• Watch your script's execution in slow motion
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• Evaluate expressions
• Inspect symbols
• Step over and step into function calls
• Pause, reset and run the current process
• View the call stack
• View the CPU register

HasProcess property
TRUE when the debugger has a process loaded, FALSE, otherwise.

Access
Type expected

Read-only
bool HasProcess

AddBreakpoint method'
Op~ns

Types expected
Returnvalue

the Add Breakpoint dialog.

bool AddBreakpointO

TRUE if successful, FALSE, otherwise

AddBreakpointFileLine method
Adds a breakpoint on the specified line of the specified file.

Types expected

Return value

Description

boo I AddBreakpointFileLine(string fileName, int IineNum)

fileName

The name of the file to add the breakpoint to.

lineNum

The number of the line on which to add the breakpoint.

TRUE if successful, FALSE, otherwise

If the arguments are NULL, AddBreakpointFileLine opens the Add Breakpoint
dialog.

AddWatch method
Adds a watch on the specified symbolName.
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Types expected . bool AddWatch(string symbol Name)
symbolName The name of the symbol on which to place the watch.

Return value
Description

TRUE if successful, FALSE, otherwise
If symbolName is NULL, AddWatch opens the Add Watch dialog.

Animate method
Lets you watch your script execute in "slow motion."

Types expected
Return value
Description

bool AnimateO

TRUE if successful, FALSE, otherwise

Animate performs a continuous series of StatementSteplnto commands.
To interrupt animation, invoke one of the following Debugger methods either
by menu selections or by keystrokes tied to the script:

•
•
•
•
•
•
•

Run
RunToAddress
RunToFileLine
PauseProgram
Reset
TerminateProgram
FindExecutionPoint

Attach method
Invokes the debugger for the currently executing process.

Types expected

booI Attach(string processlD)

processID

Return value

The process to debug.

TRUE if successful, FALSE, otherwise

BreakpointOptions method
Opens the Breakpoint Condition/ Action Options dialog.

Types expected
Return value
9-4

bool BreakpointOptionsO

TRUE if successful, FALSE, otherwise
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Evaluate method
Evaluates the given expression, such as a global or local variable or an
arithmetic expression.

Types expected

string Evaluate(string expression)

expression

Return value

The expression to evaulate.

The result of the evaluation

EvaluateWindow method
Opens the Evaluator window.

Types expected

boo I EvaluateWindow(string expression)

expression

Return value
Description

The expression to evaluate.

TRUE if successful, FALSE, otherwise
When EvaluateWindow opens the Evaluator window, expression is pasted into
the Expression field of the window.

FindExecutionPoint method
Displays the current execution point.

Types expected
Return value
Description

bool FindExecutionPointO

TRUE if successful, FALSE, otherwise
The current execution point is indicated by the ElP register. If the current
execution point is in source, the execution point is shown in an Edit window.
(The appropriate source file is opened if necessary.)
If the current execution point is at an address which has no source associated
with it, the execution point is shown in a CPU view. (One is opened if
necessary. )

Inspect method
Opens an inspector for the specified symbol.

Deb u g 9 ere I ass

9-5

Debugger class, InstructionSteplnto method

Types expected

Return value

boollnspect(string symbol, EditView view, int row, int column)

symbol

The symbol to inspect.

view

The view on which to place the Inspector window.

row

The number of the row at which to place the top of the Inspector
window.

column

The number of the column at which to place the left side of the
Inspector window.

TRUE if successful, FALSE, otherwise

InstructionSteplnto method
Executes the next instruction, stepping into any function calls.

Types expected
Return value
Description

boollnstructionSteplntoO

TRUE if successful, FALSE, otherwise

If a process is not loaded, InstructionSteplnto first loads the executable for the
current project.
.

InstructionStepOver ·method
Executes the next instruction, running any functions called at full speed.

Types expected
Return value
Description

boollnstructionStepOverO

TRUE if successful, FALSE, otherwise

If a process is not loaded, InstructionStepOver first loads the executable for the

current project.

IsRunnable method
Indicates if the specified process can be run or single stepped.

Types expected

boo I IsRunnable(int processlD)

processID

Return value
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The process you wish to query: If that process is not runnable or
does not exist, the current process is used·.

TRUE if the EXE is runnable or can be single stepped; FALSE, otherwise
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Load method
Loads the specified executable into the debugger.

Types expected

bool Load(string exeName)

exeName

Return value
Description

The name of the executable to load. If exeName is NULL, Load
opens the Load Program dialog.

TRUE if successful, FALSE, otherwise
Upon loading, the process runs to the starting point specified in the Options I
Environment IDebugger IDebugger Behavior dialog.

PauseProgram method
Pauses the current process.

Types expected
Return value
Description

bool PauseProgramO

TRUE if successful, FALSE, otherwise

PauseProgram has an effect only if the current process is running or is
animated.
.

Reset method
Reset the current process to its starting point.

Types expected
Return value
Description

bool ResetO

TRUE if successful, FALSE, otherwise
The starting point is specified in the Options IEnvironment IDebugger I
Debugger Behavior dialog.

Run method
Causes the debugger to run the current process.

Types expected
Return value

bool RunO

TRUE if successful, FALSE, otherwise
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Description

If no process is loaded, Run first loads the executable associated with the
~urrent project.

RunToAddress method
Runs the current process until. the instruction at the given address is
encountered.

Types expected

boo I RunToAddress(string address)

address

Return value
Description

The address at which to stop execution. address must be given as
a hexidecimal value (i.e. it must begin with "Ox").

TRUE if successful, FALSE, otherwise

If no process is loaded, Run first loads the executable associated with the
current project.

RunToFileLine method
Runs the current process until the source at the specified line in the specified
file is encountered.

Types expected

Return value
Description

bool RunToFileLine(string fileName, int lineNum)

fileName

The name of the file to execute.

lineNum

The number of the line at which to halt execution.

TRUE if successful, FALSE, otherwise

If no process is loaded, RunToFileLine will first load the executable associated
with the current project.

StatementSteplnto method
Executes the next source statement and steps through the source of any
function calls.

Types expected
Return value
Description
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bool StatementSteplntoO

TRUE if successful, FALSE, otherwise

If a process is not loaded, StatementSetplnto first loads the executable for the
current project.
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StatementStepOver method
Executes the next source statement and does not step into any functions
called, but rather runs them at full speed.

Types expected
Return value
Description

bool StatementStepOverO

TRUE if successful, FALSE, otherwise
If a process is not loaded, StatementStepOver first loads the executable for the
current project.

TerminateProgram method
Terminates the current process.

Types expected
Return value
Description

bool TerminateProgramO

TRUE if successful, FALSE, otherwise
If no process is loaded, TermlnateProgram has no effect.

ToggleBreakpoint method
If no breakpoint exists, ToggleBreakpoint adds a breakpoint on the specified
line of the specified file. If a breakoint exists, ToggleBreakpoint deletes it.

Types expected

Return value
Description

bool ToggleBreakpoint(string fileName, int lineNum)

fileName

The name of the file to add the breakpoint to.

lineNum

The number of the line on which to add the breakpoint.

TRUE if successful, FALSE, otherwise
If the arguments are NULL, ToggleBreakpoint opens the Add Breakpoint
dialog.

ViewBreakpoint method
Opens the Breakpoints window.

Types expected

bool ViewBreakpointO
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Return value

TRUE if successful, FALSE, otherwise

ViewCallStack method
Opens the Call Stack window.

Types expected . boo I ViewCaliStackO
Return value
Description

TRUE if successful, FALSE, otherwise

ViewCallStack works only if a process is loaded.

ViewCpu method
Opens or·selects the CPU window.

Types expected

bool ViewCpu([address])

address

Return value
Description

The address at which to open the CPU window. address is
optional. If it is not specified, the view opens for the current
address.

TRUE if successful, FALSE, otherwise
If the Allow Multiple CPU Views option is checked in the Debugger
Behavior dialog, ViewCpu always opens~ new CPU window. If the option is

not checked, ViewCpu only opens a new CPU window if one is not already
open.

ViewCpu works only if a process is loaded.

ViewCpuFileLine method
Opens or selects the CPU window.

Types expected

bool ViewCpu(string fileName, int lineNum)

fileName
lineNum

Return value
Description

The name of the file to view in the CPU window.
The number of the line to view in the CPU window.

TRUE if successful, FALSE, otherwise
If the Allow Multiple CPU Views option is checked in the Debugger

Behavior dialog, ViewCpuFileLine always opens a new CPU window. If the
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option is not checked, ViewCpuFileLine opens a new CPU window only if one
is not already open.
After opening or selecting a CPU window, the Disassembly pane is scrolled
so that the disassembled code for the specified line of the specified file is
visible:
If the parameters are NULL or if the line doesn't generate code, the window
displays an error message. ViewCpuFileLine works only if a process is loaded.

ViewProcess method
Opens the Process window.

Types expected
Return value

boo I ViewProcessO

TRUE if successful, FALSE, otherwise

ViewWatch method
Opens the Watches window.

Types expected
Return value

boo I ViewWatchO

TRUE if successful, FAL~E, otherwise

DebugeeAboutToRun event
Raised just before a process is run.

Types expected
Return value

void DebugeeAboutToRunO

None

DebugeeCreated event
Raised when a new process is loaded into the debugger.

Types expected
Return value

void DebugeeCreatedO

None
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DebugeeStopped event
Raised when a process stops.

Types expected
Return value
Description

void DebugeeStoppedO

None
A process can stop for any number of reasons:
•
•
•
•
•

Upon normal termination
After a step
When a breakpoint is hit
When an exception occurs
When the user pauses, resets, or terminates a running application

DebugeeTerminated event
Raised when a process is terminated.

Types expected
Return value
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void DebugeeTerminatedO

None
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EditBlock class
This class is one of the editor classes. EditBlock class members provide areamarking features for an edit buffer or view.

Syntax

EditBlock(EditBuffer);
EditBlock(EditView) ;

Properties
bool IsValid

Read-only

int EndingColumn

Read-only

int EndingRow

Read-only

bool Hide

Read-only

int Size

Read-only

int StartingColumn

Read-only

int Starting Row

Read-only

int Style

Read-write

string Text

Read-only

Methods
void BeginO
void Copy([bool useClipboard, bool append])
void Cut([bool useClipboard, bool append])
bool DeleteO

Ed it B I 0 eke I ass
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void End

0

bool Extend(int newRow, int newCol)
boo I Ext~ndPageDownO
bool ExtendPageUPO
boo I ExtendReal(int newRow, int newColumn)
bool ExtendRelative(int deltaRow, int deltaColumn)
void Indent(int magnitude)
void LowerCaseO
bool PrintO
void ResetO
void RestoreO
void SaveO
bool SaveToFile([string fileName])
void ToggleCaseO
void UpperCaseO

Events
None

EditBlock class description
EditBlock objects let you mark areas of text. Because EditBlock members exist
in both the EditView and the EditBuffer, EditView and EditBuffer support
different marked areas in different views on the same EditBuffer.
Although multiple EditBlocks can exist in script for an individual EditBuffer or
Edit View, they are mapped to the same internal representation of the
EditBlock. Therefore, manipulations on one will affect the others.
Use of the following EditBlock members will cause the EditPosition for the
owner to be updated appropriately:

•
•
•
•
•

10-2

Extend
ExtendPageDown
ExtendPageUp
ExtendReal
ExtendRelative

0 bj e C t S c rip tin 9 Pro 9 ram mer's G u ide

EditBlock class, IsValid property

IsValid property
Is TRUE if the block is valid. Becomes FALSE in any of the following cases:
• The owning EditBuffer or EditView is destroyed.
• A destructive operation, such as delete or cut, occurrs on the block.
• The ending point is not greater than the starting point.

Access
Type expected

Read-only
boollsValid

EndingColumn property
Initialized to the current position in the EditView or EditBuffer upon
construction. May be changed by a call to an external method.

Access
Type expected

Read-only
int EndingColumn

EndingRow property
Initialized to the current position in the EditView or EditBuffer upon
construction. May be changed by a call to an external method.

Access
Typ~ expected

Read-only
int EndingRow

Hide property
Visually disables the block without modifying its coordinates.

Access
Type expected

Read-write
boo I Hide

Size property
If the areais not valid, the value is zero; otherwise, the value is the number of
characters contained in the marked area. A newline (CR/LF) counts as one
character.

Ed i t B I 0 c k c I ass
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Access
Type expected

Read-write
int Size

StartingColumn property
Initialized to the current position in the EditView or EditBuffer upon
construction. May be changed by a call to an external method.

Access
Type expected

Read-only
int StartingColumn

StartingRow property
In~tialized

to the current position in the EditView or EditBuffer upon
construction. May be changed by a call to an external method.

Access
Type expected

Read-only
int StartingRow

Style property
.

/

Sets the style of the EditBlock.

Access
Type expected
Description

Read-write
int Style

Style can be set to one of the following values:
•
•
•
•
•

INCLUSIVE_BLOCK
EXCLUSIVE_BLOCK
COLUMN_BLOCK
LINE_BLOCK
INVALID_BLOCK

An EditBlock is initially set to the Style EXCLUSIVE_BLOCK. It is also set to
this style after a Reset is called.
If an EditBlock has a Style of INVALID_BLOCK, it was retained after the

EditBuffer or EditView to which it was attached was destroyed.

10-4
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Text property
If the marked block is valid, Text returns the marked text. If it is invalid, Text
returns the empty string.

Access
Type expected

Read-only
string Text

Begin method
Resets the StartingRow and StartingColumn values to the current location in
the owning EditBuffer or EditView.

Type expected
Return value

void BeginO

None

Copy method
Copies the contents of the marked block to the Windows Clipboard.

Types expected

void Copy([bool append])

append

Return value

Defaults to FALSE. If TRUE, the contents of the marked block
are appended to the Clipboard.

None

Cut method
Cuts the contents of the marked block to the Windows Clipboard and
invalidates the marked block.

Types expected

void Cut([bool append])

append

Return value

Defaults to FALSE. If TRUE, the contents of the marked block
are appended to the Clipboard.

None

EditBlock class
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Delete method
Deletes the current block if it is valid. The cursor position is restored to the
position it occupied prior to the delete.

Types expected
Return value

bool DeleteO

TRUE if characters were deleted; FALSE, otherwise

End method
Resets the EndingRow and EndingColumn values to the current location in the
owning EditBuffer or EditView.

Types expected
Return value

void EndO

None

Extend .method
Extends an existing EditBlock to encompass the text delimited by newRow and
newCol.

Types expected

Return value

bool Extend(int newRow, int newCol)

newRow

The row to extend the block to. Text delimited by this row is
included in the block.

newCol

The column to extend the block to. Text delimited by this
column is inCluded in the block.

TRUE if the Extend successfully completes; FALSE, otherwise

ExtendPageDown method
Updates the starting or ending points of the existing mark to extend the mark
to the specified location.

Types expected
Return value
Description

10-6

bool ExtendPageDownO

TRUE if the cursor move is successful; FALSE, otherwise

ExtendPageDown causes the position in the owning EditBuffer or EditView to
be updated to the new location. ExtendPageDown only works if the block is
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associated with an EditView. It is ignored if the block is, associated with an
EditBuffer.

ExtendPageUp method
Updates the starting or ending points of the existing mark to extend the mark
to the specified location.

Typp expected
Return value
Description

boo I ExtendPageUPO

TRUE if the cursor move is successful

ExtendPageUp causes the position in the owning EditBuffer or EditView to be
updated to the new location. ExtendPageUp only works if the block is
associated with an EditView. It is ignored if the block is associated with an
EditBuffer.
.

ExtendReal method .
Updates the starting or ending points of the existingmark to extend the mark
to the specified location.
'

Types expected

Return value
Description

boo I ExtendReal(int newRow, int newColumn)

newRow

The row to extend the block to. Text delimited by this row is
included in the block.

newCol

The column to extend the block to. Text delimited by this
column is included in the block.

TRUE if the cursor move is successful

ExtendReal causes the position in the owning EditBuffer or EditView to be
updated to the new location.

ExtendRelative method
Updates the starting or ending points of the existing mark to extend the mark
to the specified relative location.

EditBlock class
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Types expected

Return value
Description

bool ExtendRelative(int deltaRow, int deltaColumn)

deltaRow

The row to extend the block from. Text delimited by this row is
included in the block.
.

newCol

The column to extend the block from. Text delimited by this
column is included in the block.

TRUE if the cursor move is successful

ExtendRelative causes the position in the owning EditBuffer or Edit View t'f., be
updated to the new location.

,Indent method
Maves the contents of the block.

Types expected

void Indent(int magnitude)

magnitude

Return value

The number of columns to move the block. Negative values
move the block to the left, positive values move it to the right.

None

LowerCase method
Converts all alphabetic characters enclosed within the EditBlock to lowercase.

Types expected
Return value

void LowerCaseO

None

Print method
Prints the current block.

Types expected
Return value

bool PrintO

TRUE if the print was successful, FALSE if there is no marked block or if the

print failed.

Reset method
Unmarks the block. Implidtly invoked by the constructor.

10-8
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Types expected

void ResetO

Return value

None

Description

Reset also resets the Style to EXCLUSIVE_BLOCK and the starting and
ending points to the current position in the owning EditBuffer or EditView.

Restore method
Restores a block from an internal stack. The block must have been saved with
Save.

Types expected

void RestoreO

Return value

None

Save method
Preserves the block attributes on an internal stack for future restoration using
Restore.

Types expected
Return value

void SaveO

None

SaveToFile method
Causes the contents of the marked block to be saved.

Types expected

bool SaveToFile([string fileName])

fileName

Return value

The name of the file to save the block to. HfileName is not
supplied, the user will be prompted for one.

TRUE if the save was successful or FALSE if it wasn't.

ToggleCase method
Converts all the uppercase alphabetic characters in the EditBlock to
lowercase, and the lowercase characters to uppercase.

Types expected

void ToggleCaseO
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Return value

None

UpperCase method
Converts all the lowercase alphabetic characters in the EditBlock to
uppercase.

Types expected
Return value

10-10

void UpperCaseO.

None
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EditBuffer class
This class is one of the editor classes. An edit buffer is associated with one file
and any number of edit views.

Syntax

EditBuffer(string fileName [, bool private, boo I readOnly))

fileName
private

The name of the file associated with the edit buffer.
Implies that the buffer is a hidden system buffer. Undo
information is not retained, and the EditBuffer is never
attachable to an EditView. The file attached to the buffer cannot
be viewed in the IDE until the private buffer is destroyed.
When a private EditBuffer is no longer needed, you should
always explicitly destroy it with EditBuffer.Destroy.
The default value of private is FALSE.

readOnly

Marks the buffer as read-only. The default value is FALSE.
Associating a read-only file with the EditBuffer does not make
the EditBuffer read-only.

Properties
EditBlock Block

Read-only

TimeStamp CurrentDate

Read-only

string Directory

Read-only

string Drive

Read-only

string Extension

Read-only

. string FileName '

Read-only

string Full Name

Read-only

Ed i t 8 u ff ere la s s
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TimeStamp InitialDate

Read-only

bool IsModified

Read-only

bool IsPrivate

Read-only

bool IsReadOnly

Read-only

boollsValid

Read-only

EditPosition Position

Read-only

EditView TopView

Read-only

Methods
void ApplyStyle(EditStyle styleToApply)
EditBlock BlockCreateO
string DescribeO
bool DestroyO
EditBuffer NextBuffer(bool privateToo)
EditView NextView(EditView)
EditPosition PositionCreateO
bool PrintO
EditBuffer PriorBuffer(bool privateToo)
bool Rename(string newName)
int Save([string newName])

Events
void AttemptToModifyReadOnlyBufferO
void AttemptToWriteReadOnlyFileO
void HasBeenModifiedO

EditBuffer class description
An EditBuffer is a representation of the contents of a file. An EditView is used
to provide a visual representation of the EditBuffer. The same EditBuffer can
be displayed simultaneously in different Edit Views (for example, two edit
windows can be open on the same file). EditBuffer objects provide
functionality for a file being edited that is independent of the number of
views associated with the buffer.
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Edit buffers:
• Use the NextView method to to traverse the list of views containing the
same EditBuffer.
• Maintain access to a list of bookmarks (position markers which track text
edits).
• Can be queried for their time and date stamps.
• Have a Position member through which manipulation of the underlying
EditBuffer is performed. Typically this member will be used when
manipulating an EditBuffer through script.
• Can be specified as read-only.
• Can be created as private or system buffers. System buffers are not visible
in the IDE or listed in the buffer list.
A single EditBuffer object exists internally for each file loaded into the buffer.
If you create additional representations for an edit buffer, they are attached
to the existing EditBuffer object. Any changes to one of these representations
changes the others, since they refer to the same object. All representations
inherit the IsReadOnly and IsPrivate attributes of the original, because these
properties are set only when the object is first created.
You can make buffers private to provide raw data storage for script usage.
No undo information is maintained for private buffers, nor are they
attachable to an EditView. Private EditBuffer objects should be explicitly
destroyed when no longer needed using the Destroy method. Otherwise, they
remain in memory for the duration of the IDE session.

Block property
Contains a reference to the hidden EditBlock.

Access
Type expected

Read-only
EditBlock Block

CurrentDate property
Originally set to the same value as InitialDate but is updated when the
buffer's contents are altered.

Access
Type expected

Read-only
TimeStamp CurrentDate
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Directory property
NULL if the EditBuffer is invalid; otherwise, in~icates the directory path in

uppercase letters.

Access
Type expected

Read-only
string Directory

Drive property
NULL if the EditBuffer is invalid; otherwise, indicates the drive in uppercase
with the associated colon (:).

Access
Type expected

Read-only
string Drive

Extension property
NULL if the EditBuffer is invalid; otherwise, indicates the file extension in
uppercase including the period (.), if any.

Access
Type expected

Read-only
string Extension

FileName property
NULL if the EditBuffer is invalid; otherwise, indicates the file name in

uppercase.

Access· Read-only
Type expected

string FileName

FuliName .property
The name of the EditBuffer or NULL if the EditBuffer is invalid.

Access
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Type expected

string FullName

InitialDate property
The date on which the file was first created.

Access
Type expected
Description

Read-only
TimeStamp InitialDate

If the buffer was initialized from a disk file, InitialDate reflects the file's age. If
the file does not reside on disk, InitialDate holds the time at which the buffer
was created. It is a read-only property.

IsModified property
Indicates if the buffer was changed since it was last opened or saved,
whichever occurred most recently.

Access

Read-only

Type expected. bool IsModified

IsPrivate property
TRUE if the buffer was created with the private parameter set to TRUE;
FALSE, otherwise.

Access

Read-only

Type expected

bool IsPrivate

IsReadOnly property
TRUE if the buffer was created with the readOnly parameter set to TRUE;
FALSE otherwise.

Access
Type expected

Read-only
bool IsReadOnly
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11-5

EditBuffer class, IsValid property

IsValid property
FALSE if the EditBuffer is destroyed, otherwise, TRUE.

Access
Type expected

Read-only
boollsValid

Position property
Provides access to the EditPosition instance for this EditBuffer.

Access
Type expected

Read-only
EditPosition Position

TopView property
The topmost Edit View that contains this EditBuffer. NULL if no view is
associated with the buffer.

Access
Type expected

Read-only
EditView TopView

ApplyStyle method
Updates the EditOptions.BufferOptions property with the contents of
styleToApply.

Types expected

void ApplyStyle(EditStyle styleToApply)

styleToApply

Return value

The EditStyle object to apply.

None

BlockCreate method
Creates an edit block for the EditBuffer.

Types expected
Return value
11-6

EditBlock BlockCreateO

The edit block.
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Describe method
Invoked during buffer list creation by an Editor object. Returns a text
description of the buffer, as in:
• FOO.CPP(modified)
• BAR.CPP

Types expected
Return value

string DescribeO

None

Destroy method
Removes the buffer from the IDE's buffer list and does not save any changes.

Types expected
Return value

bool DestroyO

TRUE if the buffer was actually·destroyed, or FALSE if views relying on it

still exist.

Description

When private EditBuffer objects are longer needed, you should always
explicitly destroy them.

NextBuffer method
Finds the next edit buffer in the buffer list.

Types expected

EditBuffer NextBuffer(bool privateToo)

privateToo

Return value
Description

TRUE if private buffers are to be included in the buffer list,
FALSE otherwise.

The edit buffer found or NULL if none is found.
The buffer list is circular, so if a buffer exists, it will be found. However, if all
buffers are private and if privateToo is set to FALSE, no buffer will be found.

NextView method
Returns the next EditView containing this EditBuffer.

EditBuffer class
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Types expected

EditView NextView(EditView next)

next

Return value
Description

The view to use in getting the next associated view for this edit
buffer. Start traversing the view list by passing the value of
TopView to this method.

None
An EditBuffer is a representation of the contents of a file. An EditView is used
to provide a visual representation of the EditBuffer. The same EditBuffer can
be displayed simultaneously to the user in different EditViews (for example,
two edit windows can be open on the same file). This method enables you to
cycle through all the EditViews representing this EditBuffer.

PositionCreate method
Creates an EditPosition object.

Types expected
Return value

EditPosition PositionCreateO

None

Print method
Prints this buffer.

Types expected
Return value

boo I PrintO

TRUE if the print was successful or FALSE if the print failed.

PriorBuffer method
Finds the previous edit buffer in the buffer list.

Types expected

EditBuffer PriorBuffer(bool privateToo)

privateToo

Return value
Description

11-8

TRUE if private buffers are to be included in the buffer list,
FALSE otherwise.

The edit buffer found or NULL if none is found
The buffer list is circular, so if a buffer exists, it will be found. However, if all
buffers are private and if private Too is set to FALSE, no buffer will be found.
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Rename .method
Changes the EditBuffer name.

Types expected

bool Rename(string newName)

newName

Return value

The new name of the buffer.

TRUE if the operation succeeded or FALSE if it failed

Description

Rename fails when an EditBlfffer with the new name is already in the buffer
list. If a file with the new name already exists on disk, it is overwritten when
this buffer is saved.

Save method
Writes the file associated with the buffer to disk.

Types expected

int Save([string newName])

newName

Return value
Description

The new name of the file.

The number of bytes written or 0 if the save was unsuccessful.
Saves the file whether it was modified or not. Save uses the current name of
the file or newName if it is specified ..

AttemptToModifyReadOnlyBuffer event
Triggered when an attempt is made to modify a read-only buffer.
Note

Types expected
Return value

For the EditBuffer to be read-only, it must be created with the readOnly
parameter set to TRUE. Creating an EditBuffer from a read-only file does not
create a read-only buffer.
void AttemptToModifyReadOnlyBufferO

None

AttemptToWriteReadOnlyFile event
Triggered when an attempt is made to write the contents of an EditBuffer to a
read-only file. Thebuffer mayor may not have been created as read-only.

Types expected

void AttemptToWriteReadOnlyBufferO
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Return value

None

HasBeenModified event
Triggered when a buffer has been modified for the first time.

Types exp~cted
Return value

11-10

void Has8eenModifiedO

None
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EditOptions class
This class is one of the editor classes. EditOptions class members hold editor
characteristics of a global nature.

Syntax

EditOptionsO

Properties
string BackupPath

Read-write

int Blocklndent

Read-write

BufferOptions BufferOptions

Read-only

string MirrorPath

Read-write

string Original Path

Read-write

string SyntaxHighlightTypes

Read-write

bool UseBRIEFCursorShapes

Read-write

bool UseBRIEFRegularExpression

Read-write

Methods
None

Events
None

Ed itO p t ion sci ass
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EditOptions class description
The EditOptions object holds editor characteristics of a global nature, such as:
•
•
•
•
•
•

Whether to create backups
The destination paths for backups
The insert / overtype setting
The optimal fill setting
Handling of blocks cut or copied from the buffer (scrap manipulation)
The default regular expression language

Property values are initialized from global defaults during construction.

BackupPath property
Contains the path where the editor stores back ups.

Access
Type expected
Description

Read-write
string BackupPath

In the IDE, BackupPath is set with the BackupPath option of the Environment
Options dialog. To display this dialog box, choose Options I Environment I
Editor I File.

Blocklndent property
Indents or outdents a block of characters.

Access

Read-write

Type expected

int Blocklndent

Description

Blocklndent indicates the number of characters to indent or outdent a block of
characters. The value must be between 1 and 16.
In the IDE, Blocklndent is set with the Block Indent option of the Environment
Options dialog. To display this dialog box, choose Options I Environment I
Editor I Options.

BufferOptions property
Holds the buffer options settings for all edit buffers.

Access
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Type expected

BufferOptions BufferOptions

MirrorPath property
Holds the path where the editor stores mirror copies of files.

Access
Type expected
Description

Read-write
string MirrorPath

In the IDE, MirrorPath is set with the Mirror Path option of the Environment
Options dialog. To display this dialog box, choose Options I Environment I
Editor I File.

Original Path property
Holds the path where the editor stores the original files.

Access
Type expected
Description

Read-write
string OriginalPath

In the IDE, OriginalPath is set with the Original Path option of the
Environment Options dialog. To display this dialog box, choose Options I
Environment I Editor I File.

SyntaxHighlightTypes property
Holds the file extensions, or file names, of the file types for which syntax
highlighting is to be enabled in the editor.

Access
Type expected
Description

Read-write
string SyntaxHighlightTypes

Wild cards are permitted. Separate multiple names / extensions with a
semicolon.
In the IDE, SyntaxHighlightTypes is set with the Syntax Extensions option of
the Environment Options dialog. To display this dialog box, choose
Options I Environment I Syntax Highlighting.

EditOptions class
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Example

IIExample of SyntaxHighlightTypes
JavaSyntaxHighlight( yes) {
if ( yes) {
IDE . Editor. Options .BufferOptions. TokenFileName = "java. tok" ;
II enable syntax highlighting fot .java files
IDE . Editor. Options . SyntaxHighlightTypes = "*. java";
else {
IDE.Editor.Options.BufferOptions.TokenFileName = ""; II c++
II enable syntax highlighting for standard Ctt files
IDE.Editor.Options.SyntaxHighlightTypes =
,,* . cpp; *. c; * .hi * .hpp i * .rhi * .rc" i

11-- redraw with new option settings -declare EditStyle eSi
IDE. Editor.ApplyStyle( es ) i
}

UseBRIEFCursorShapes property
When TRUE, the editor uses the default cursor shapes that Brief provides for
insert mode and overtype mode.

Access
Type expected
Description

Read-write
bool UseBRIEFCursorShapes

In the IDE, UseBRIEFCursorShapes is set with the BRIEF Cursor Shapes
option of the Environment Options dialog. To display this dialog box, choose
Options I Environment I Editor I Display.

UseBRIEFRegularExpression property
When TRUE, complex search and search/replace operations can be
performed using the Brief regular expression syntax:

Access
Type expected
Description

12-4

Read-write
boo I UseBRIEFRegularExpression

In the IDE, UseBRIEFRegularExpressions is set with the BRIEF Regular
Expressions option of the Environment Options dialog. To display this
. dialog box, choose Options I Environment I Editor I ~ptions.
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EditPosition class
This is one of the editor classes. EditPosition class members provide
positioning functionality related to the active location in an EditView or
EditBuffer.

Syntax

EditPosition(EditBuffer)
EditPosition(EditView)

Properties
int Character

Read-only

int Column

Read-only

bool IsSpecialCharacter

Read:-only

boollsWhiteSpace

Read-only

bool IsWordCharacter

Read-only

int LastRow

Read-only

int Row

Read-only

Search Options Search Options

Read-only

Methods
void Align(int magnitude)
bool BackspaceDelete([int howMany])
bool Delete([int howMany])
int DistanceToTab(int direction)

Ed it Po sit ion c I ass
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bool GotoLine(int lineN umber)
void InsertBlock(EditBlock block)
void InsertCharacter(int characterTolnsert)
void InsertFile(string fileName)
void InsertScrapO
void InsertText(string text)
bool Move([int row, int col])
booI MoveBOLO
boo I MoveCursor(moveMask)
boo I MoveEOFO
boo I MoveEOLO
boo I MoveReal([int row, in! col])
boo I MoveRelative([int delta Row, int deltaCol])
string Read([int numberOfChars])
bool Replace([string pat, string rep, boo I case, boo I useRE, bool dir, int reFlavor, bool global, EditBlock block])
bool ReplaceAgainO
void RestoreO
string RipText(string legalChars [,int ripFlags])
void SaveO
int Search([string pat, bool case, bool useRE, boo I dir, int reFlavor, EditBlock block])
int SearchAgainO
void Tab(int magnitude)

Events
None

EditPosition class description
An EditPosition object is the point at which operations occur within the EditBuffer.
One EditPosition object exists for each EditBuffer and each EditView. In the EditView,
the cursor location visually represents the EditPosition's current location.
Since each EditView can have its own EditPosition object, you can have multiple
EditViews at multiple locations. Additionally, the EditBuffer's EditPosition object
maintains its own location information.
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Character property
Integer value of the character at this position or one of the following values:
VIRTUAL_TAB
VIRTUAL_PAST_EOF
VIRTUAL_PAST_EOL

Access

Read-only

Type expected

int Character

Column property
The current column position in the buffer. To change, use one of the
following EditPosition methods:

Move
MoveEOL

Access
Type expected

MoveBOL
MoveReal

MoveCursor
MoveRelative

MoveEOF

Read-only
int Column

IsSpecialCharacter property
TRUE if the character at the current edit position is not an alphanumeric or
whitespace character; FALSE otherwise.

Access
Type expected

Read-only
bool IsSpecialCharacter

IsWhiteSpace property
TRUE if the character at the current edit position is a Tab or Space; FALSE,

otherwise.

Access
Type expected

Read-only
booI IsWhiteSpace
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IsWordCharacter property
TRUE if the character at the current edit position is an alphabetic character,
numeric character or underscore. Otherwise, FALSE.

Access· Read-only
Type expected

boollsWordCharacter

LastRow property
The line number of the last line in the edit buffer.

Access
Type expected

Read-only
int LastRow

Row property
The current row position in the buffer. To change, use one of the following
EditPosition methods:

Move
MoveEOL

Access
Type expected

MoveBOL
MoveReal

MoveCursor
MoveRelative

MoveEOF

Read-only
int Row

SearchOptions property
Contains an instance of the SearchOptions class, the options currently in place
for searching.

Access
Type expected

Read -only
SearchOptions Search Options

Align method
Positions the insertion point on the current line, aligning it with columns
calculated from prior lines in the file.
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Types expected

void Align(int magnitude)

magnitude

If positive, enough characters are inserted to align the character
position as follows:

• Starting with the column defined by the current character
position on the current line, the character is aligned with the
first character after the first white space on the previous line
after the column position.
• If the previous line is too short to calculate a position on the
current line, previous lines are scanned until finding one that
is long enough to calculate a column position.
If negative, the column position is moved to the left.

Return value
Example

None
Assume that two lines of code contain the text "Leaning over the console, she
stuck out her hand and said," and "'Hello there, buddy.'" The cursor (A) is
in column 2 on the current line.
Leaning over the console, she stuck out her hand and said,
"How are you, buddy"

Calling Ali gn (1) results in:
Leaning over the console, she stuck out her hand and said,
"How are you, buddy."

Calling Align (1) again results in:
Leaning over the console, she stuck out her hand and said,
"How are you, buddy."

Calling Al ign (1) again results in:
Leaning over the console, she stuck out her hand and said,
"How are you buddy."

Calling Al i gn (- 1) results in:
Leaning over the console, she stuck out her hand and said,
"Hello there, buddy."

Backs pace Delete method
Deletes characters t? the left of the current position.
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Types expected

bool 8ackspaceDelete([int howMany])

howMany

Return value

The number of characters to delete. The default is 1.

TRUE if any characters are deleted; FALSE if there are no characters to the
left.

Delete method
Deletes characters to the right of the current position.

Types expected

bool Delete([int howMany])

howMany

Return value

The number of characters to delete. The default is 1.

TRUE if any characters are deleted; FALSE if there are no characters to the
right.

DistanceToTab method
Retrieves the number of character positions between the current cursor
position and the next/previous tab stop.

Types expected

int DistanceToTab(int direction)

direction

Return value

Either SEARCH_FORWARD or SEARCH_BACKWARD.
SEARCH_FORWARD is the default.

Number of character positions between the current cursor position and the
next / previous tab stop.

GotoLine method
Moves the cursor to the specified line, without changing column position.

Types expected

bool GotoLine(int IineNumber}

lineNumber The number of the line to change to. If lineNumber is not
specified, the user is prompted for a line number.

Return value

13-6

TRUE if the move was successful, FALSE, otherwise.
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InsertBlock method
Inserts the last marked block at the current cursor position.

Types expected

void InsertBlock(EditBlock block)

block

Return value

Restricts the search to the indicated block.

None

InsertCharacter method
Inserts a character at the current cursor position.

Types expected

void InsertCharacter(int characterTolnsert)

characterTolnsert The integer value of the character to insert..

Return value

None

InsertFile method
Inserts the contents of the specified file at the current cursor position.

Types expected

void InsertFile(string fileName)

fileNarne

Return value

The name of the file to insert.

None

InsertScrap method
Insert text in the Windows Clipboard at the current cursor position.

Types expected

Return value

void InsertScrapO

None

InsertText method
Inserts the specified string at the current cursor position.

EditPosition class
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Types expected

void InsertText(string text}

text

Return value

The string to insert.

None

Move method
Moves the cursor to the specified row and column.

Types expected

boo I Move([int row, int col])

row
col

Return value
Description

The number of the row to move to.
The number of the column to move to.

The return value, TRUE or FALSE, indicates whether the position actually
changed.

Move attempts to position:
• The column at 0 or less
• The column at 1025 or more
• The row at 0 or less

MaxLineNumber + 1 or more are invalid. MaxLineNumber depends on the
computer's capacity.

MoveBOL method
Moves the cursor to the first character on the current line.

Types expected
Return value
Description

boo I MoveBOLO

The return value, TRUE or FALSE, indicates whether the position actually
changed.

MoveBOL attempts to position:
• The column at 0 or less
• The column at 1025 or more
• The row at 0 or less

MaxLineNumber + 1 or more are invalid. Ma:XLineNumber depends on the
computer's capacity.
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MoveCursor method
Moves the current position forward or backward in the buffer.

Types expected

bool MoveCursor(moveMask)

moveMask

The position to move the cursor to. The value of moveMask can
be built from the one of the following:
SKIP_WORD (default)
SKIP_NONWORD
SKIP_WHITE
SKIP_NONWHITE
SKIP_SPECIAL
SKIP_NONSPECIAL.
These masks can be combined with SKIP_LEFT (default) or
SKIP_RIGHT. SKIP_STREAM can also be used with any of
these combinations if line ends are ignored.

Return value
Description

The return value, TRUE or FALSE, indicates whether the position actually
changed.

MoveCursor attempts to position:
• The column at 0 or less
• The column at 1025 or more
• The row at 0 or less

MaxLineNumber + 1 or more are invalid. MaxLineNumber depends on the
computer's capacity.

MoveEOF method
Moves the current position to the last character in the file.

Types expected
Return value
Description

bool MoveEOFO

The return value, TRUE or FALSE, indicates whether the position actually
changed.

MoveEOF attempts to position:
• The column at 0 or less
• The column at 1025 or more
• The row at 0 or less

EditPosition class
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MaxLineNumber + 1 or more are invalid. MaxLineNumber depends on the
computer' s capacity~

MoveEOL method
Moves the current position to the last character on the line.

Types expected
Return value
Description

bool MoveEOLO

The return value,. TRUE or FALSE, indicates whether the position actually
changed.

MoveEOL attempts to position:
• The column at 0 or less
• The column at 1025 or more
• The row at 0 or less

MaxLineNumber + 1 or more are invalid. MaxLineNumber depends on the
computer's capacity.

MoveReal method
The position assumes that the file is unedited. If edits have been made to the
file, the move is relative to the original, unedited file.

Types expected

Return value
Description

boo I MoveReal([int row, int col])

row

The number of the row to move the cursor to. row is relative to the
line numbers in the original, unedited file.

col

The number of the column to move the cursor to. column is relative
to the column numbers in the original, unedited file ..

The return value, TRUE or FALSE, indicates whether the position ac~ally
changed.
'

MoveReal attempts to position:
• The column at 0 or less
• The column at 1025 or more
• The row at 0 or less

MaxLineNumber + 1 or more are invalid. MaxLineNumber depends on the
computer's capacity.
For example, assume that the original, unedited file is a two-line file with the
word ONE on the first line and the word TWO on the second line. The user
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subsequently inserts 100 lines of text after line 1. MoveReal (2,l)moves the
cursor to the "T" in "TWO".

MoveRelative method
. Moves the cursor the specified number of rows and columns from .the
current row and column position.

Types expected

Return value
Description

boo I MoveRelative([int delta Row, int deltaCol])

deltaRow

The number of rows to move the cursor. deltaRow is relative to
the current row number.

deltaCol

The number of columns to move the cursor. deltaCol is relative
to the current column number.

The return value, TRUE or FALSE, indicates whether the position actually
changed.

MoveRelative attempts to position:
• The column at 0 or less
• The column at 1025 or more
• The row at 0 or less

MaxLineNumber + 1 or more are invalid. MaxLineNumber depends on the
computer's capacity.

Read method
Reads the specified number of characters.

Types expected

string Read([int numberOfChars])

numberOfChars

The number of characters to read from the current cursor
position. If omitted, it reads to the end of the line.

Return value . A string containing the characters read

Replace method
Searches EditBuffer in the indicated direction for the search expression. The
expression is replaced with the specified expression.

Ed it Po sit ion c I ass
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c Types

expected

bool Replace([string pat, string rep, bool case, bool useRE, bool dir, int reFlavor, booI
global, EditBlock block])

pat
rep"
case
useRE
dir

The string to search for.
The string to replace with.
Indicates if the case of pat is significant in the search.
Indicates whether or not to interpret pat as a regular expression
string.
One of the following:
SEARCH_FORWARD (default)
SEARCH_BACKWARD

reFlavor

The type of regular expression being used; it may be one of the
following:
IDE_RE (default)
BRIEF_RE
BRIEF_RE_FORW ARD _MIN
BRIEF_RE_SAME_MIN
BRIEF_RE_BACK_MIN
BRIEF_RE_FORW ARD_MAX
BRIEF_RE_SAME_MAX
BRIEF_RE_BACK_MAX

block

Return value

If given, restricts the search to the indicated block.

TRUE if the replace operation was successful, FALSE, otherwise.

ReplaceAgain method
Repeats the most recently performed Replace operation.

Types expected
Return value

bool ReplaceAgain{) "

TRUE if the replace operation was successful, FALSE, otherwise.

Restore method
Restores the cursor position to the position saved by the last call to the Save
method.
.

Typesexpected
13-12

void RestoreO
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Return value

None

RipText method'
Performs an edit rip operation. This routine can rip an entire line.

Types expected

string RipText(string legalChars [,int ripFlags])

legal Chars

Determines the legal characters to include in the edit rip. If
legalChars is omitted,
INCLUDE_ALPHA_CHARS
INCLUDE_NUMERIC_CHARS
INCLUDE_SPECIAL_CHARS
are all automatically added to the rip Flags argument, making
any character beween ASCII decimal 32 and 128 a legal
character. A rip can be halted by specifying a character in
legalChars then using INVERT_LEGAL_CHARS as the ripFlags
parameter.

ripFlags

A mask built by combining any or all of the following values:

INCLUDE_LOWERCASE_ALPHA_CHARS
INCLUDE_UPPERCASE_ALPHA_CHARS
INCLUDE_ALPHA_CHARS
INCLUDE_NUME;RIC_CHARS
INCLUDE_SPECIAL_CHARS

Return value

Interpret the legal Chars string as the inverse of the string you
wish to use for legalChars. In other words, specify t to mean
any ASCII value between 1 and 255 except t.
Append the characters abcdefghijklmnopqrstuvwxyz to the
legalChars string.
Append the characters ABCDEFGHIJKLMNOPQRSTUVWXYZ to the
legalChars string.
Append both uppercase and lowercase alpha characters to the
legalChars string.
. Append the characters 1234567890 to the legalChars string.
Append the characters '-= [] \i
/-!@#$%"&*()_+{} I: "<>?
to the legalChars string.
f f.

The string copied from the edit buffer.

Save method
Save the current cursor position. Use Restore to later restore the cursor to this
position.

Types expected

void SaveO

EditPosition class
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Return value

None

Search method
Searches the edit buffer for the search expression.

Types expected

int Search(string pat [, boo I case, boo I useRE, boo I dir, int reFlavor, EditBlock block])

pat
case
useRE
dir

The string to search for.
Indicates if the case of pat is significant in the search.
Indicates whether or not to interpret pat as a regular expression.
One of the following:
SEARCH_FORWARD (default)
SEARCH_BACKWARD

reFlavor

The type of regular expression in use; it may be one of the
following:
IDE_RE (default)
BRIEF_RE
BRIEF_RE_FORWARD _MIN / / same as BRIEF_RE
BRIEF_RE_SAME_MIN
BRIEF_RE_BACK_MIN
BRIEF_RE_FORWARD _MAX
BRIEF_RE_SAME_MAX
BRIEF_RE_BACK_MAX

block
Note

If given, restricts the search to the indicated block.

If case, useRE, or reFlavor is not supplied, the value is determined by querying

the Editor object.

Return value

The size (in characters matched) of the match.

SearchAgain method
Repeats the most recently performed Search operation.

Types expected
Return value
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I

int SearchAgainO

The number of matches found.
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Tab method
Moves the current cursor location to the next or previous tab stop.

Types expected

void Tab(int magnitude)

magnitude

Return value

If positive, moves the cursor to the next tab stop. If negative,
moves to the previous tab stop.

None
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EditStyle class
This class is one of the editor classes. EditStyle applies styles that overrride
settings for a buffer or for the entire editor.

Syntax

EditStyle(string styleName[,EditStyle styleTolnitializeFromj)

styleName

The name of the style to create.

styleTolnitializeFrom

The name of the style to initialize from.

Properties
EditOptions EditMode

Read-write

int Identifier

Read-only

string Name

Read-write

Methods
None

Events
None

EditStyle class des,cription
EditStyle objects provide a mechanism to collect EditOptions, name them, and
apply them across buffers, across the .entire Editor, or both. You can store all

EditStyle class
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your preferred settings for the editor in an EditStyle object and apply them to
an editor all at once.

EditStyle objects contain:
• An EditOptions member
• Aname
• An internal filter that indicates the characteristics that the style controls

. EditStyles are implicitly persistent. The list of available styles may be
traversed from the Editor object.

EditMode property
Contains an EditOptions object that defines the options for the style.

Access
Type expected

Read-write
EditOptions EditMode

Identifier property
Identifies styles with a unique integer.

Access
Type expected

Read-only
int Identifier

Name property
A unique name for this EditStyle, taken from the styleName parameter.

Access
Type expected

14-2

Read-write
string Name
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EditView class
This class is one of the editor classes. EditView class members provide the
visual representation of the EditBuffer.
• Each edit view has only one edit buffer.
• Each edit view is in an edit window.

Syntax

EditView (EditWindow parent[, EditBuffer buffer])

parent
buffer

The edit window.
The currently active buffer. If buffer is omitted, the parent's
currently active EditBuffer is used.

Properties
EditBlock Block

Read-write

int BottomRow

Read-only

EditBuffer Buffer

Read-only

int Identifier

Read-only

bool IsValid

Read-only

bool IsZoomed

Read-write

int LastEditColumn

Read-only

int LastEditRow

Read-only

int LeftColumn

Read-only

EditView Next

Read-only

EditPosition Position

Read-only
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EditView Prior

Read-only

int RightColumn

Read-only

int TopRow

Read-only

EditWindow Window

Read-only

Methods
EditBuffer Attach(EditBuffer buffer)
bool BookmarkGoto(int bookmarklDorPrevRef)
int BookmarkRecord(int bookmarklDorPrevRef)
void Center([int row, int col])
void MoveCursorToViewO
void MoveViewToCursorO
void PageDownO
void PageUPO
void PaintO
int Scroll(int deltaRow[, int deltaCol])
void SetTopLeft(int topRow, int leftCol)

Events
None

EditView class description
EditView objects provide an editing window for the current buffer. The frame
of an EditView is an EditWindow. Each view has a direCt relationship to an
EditBuffer. During creation, the EditView's Position member is initialized from
the EditBuffer's Position member.
Edit views:
• Have methods that traverse their sibling views.
• Can be queried to find the associated EditWindow or EditBuffer.
• Have a Position member that manipulates the underlying EditBuffer.
Typically this member is used by scripts and primitives tied to the user
interface.
The underlying EditBuffer object owns the list of bookmarks (position
markers that track text edits). Use EditView.BookmarkRecord and
15-2
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EditView.BookmarkGoto to provide access to those bookmarks. A common list
of bookmarks is maintained for the same buffer regardless of the view being
used.

Block property
Provides access to the instance of the EditBlock class attached to this EditView.

Access

Read-write

Type expected 'EditBlock Block

BottomRow property
Row number displayed at the last line in the view.

Access
Type expected

Read-only
int BottomRow

Buffer property
Returns the EditBuffer to which the view is attached.

Access
Type expected

Read-only
EditBuffer Buffer

Identifier property
A unique identifier for each view.

Access
Type expected

Read -only
int Identifier

IsValid property
TRUE if the view is valid, FALSE if it is not.

Access

Read~only

EditView class
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Type expected
Description

bool IsValid

The view will be invalidated if it is destroyed by the user.

IsZoomed property
Zooms the view.

Access

Read-write

Type expected

bool IsZoomed

Description

A zoomed EditView expands to occupy the entire EditWindow client space. If
an EditView is zoomed in an EditWindow, you cannot manipulate sibling
views by creating, resizing or deleting them.

LastEditColumn property
Identifies the position of the most recent edit.

Access
Type expected
Description

Read-only
int LastEditColumn

LastEditColumn works in conjunction with LastEditRow to identify the
character position of the most recent edit. An edit modifies the contents of
the buffer and occurs as a character or block insertion or deletion.

LastEditRow property
Identifies the position of the most recent edit.

Access
Type expected
Description

Read-only
int LastEditRow

LastEditRow works in conjunction with LastEditColumn to identify the
character position of the most recent edit. An edit modifies the contents of
the buffer and occurs as a character or block insertion or deletion.

LeftColumn property
Column number displayed at the left edge of the view.
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Access
Type expected

Read-only
int LeftColumn

Next property
The next EditView embedded in the same window.

Access

Read-only

Type expected

EditView Next

Position property
Provides access to the instance of the EditPosition class attached to this
EditView.

Access
Type expected

Read-only
EditPosition Position

Prior property
The previous EditView embedded.in the same window.

Access

Read-only

Type expected

EditView Prior

RightColumn property
Column number displayed at the right edge of the view.

Access
Type expected

Read-only
int RightColumn

TopRow property
Row number displayed at the first line in the view.

Access

Read~only
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Type expected

Window property

int Top Row

Window property
Returns the window in which this view is embedded.

Access
Type expected

Read-only
EditWindow Window

Attachmeth6d
Attaches the view to a new EditBuffer.

Types expected

EditBuffer Attach(EditBuffer buffer)

buffer

Return value
Description

The name of the buffer to attach to.

The previous edit buffer

Attach replaces the currently attached edit buffer. When a view is created, it
is associated with an EditBuffer. The purpose of the view is to provide a
visual representation of the edit buffer to which it is attached.
For example, to display a current view in a different edit buffer, use Attach to
switch its associated buffer to another edit buffer.

BookmarkGoto method
Updates the EditBuffer position with the value from the specified marker.

Types expected

bool BookmarkGoto(int bookmarklDorPrevRef)

bookmarkIDorPrevRef Either an index (range 0-19) to the list of bookmarks
in the buffer or a reference to a bookmark that was
returned from a previous call to BookmarkRecord.

Return value

TRUE if the marker is valid, FALSE otherwise.

BookmarkRecord method
Returns a value suitable for passing to BookmarkGoto. Returns zero if there
was an error.
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Types expected

int BookmarkRecord(int bookmarklDorPrevRef)

bookmarkIDorPrevRef

Return value
Description

Either an index (range 0-19) to the list of bookmarks
. in the buffer or a reference to a bookmark that was
returned from a previous call to BookmarkRecord.

None
Use BookmarkRecord to store a known location in a buffer. The bookmark
moves with edit inserts and deletes.
For example, if you insert a bookmark using BookMarkRecord (1) at the a in are
in the following line, you could move around and then return to that location
with BookmarkGoto(l):
hello how are you?

If the word how were deleted, you would still return to the a in are.

Center method
Scrolls the EditView as necessary to center the character in the view window.

Types expect~d

Return value
Description

void Center([int row, int col])

row

The number of the row to center the character to. A 0 does not
change the row number.

col

The number of the column to center the character to. A 0 does not
change the column number.

None

Center centers the character at the specified position vertically or horizontally
or both. If the character is alreaq.y centered, nothing happens.

MoveCursorToView method
Ensures that the cursor is visible in the view by altering the cursor's position,
if necessary.

Types expected
Return value

void MoveCursorToViewO

None
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MoveViewToCursor method
Ensures that the cursor is visible in the view by altering the view's
coordinates, if necessary.

Types expected
Return value

void MoveViewToCursorO

None

PageDown method
Advances the row position by the number of visible rows in the EditView.

Types expected
Return value

void PageDownO

None

PageUp method
Moves the cursor toward the top of the buffer by the number of lines in the
visible rows in the EditView.

Types expected
Return value

void PageUPO

None

Paint method
Force's a screen refresh. During normal script execution, screen updates are
suppressed.

Types expected
Return value

void PaintO .

None

Scroll method
Scrolls in the direction indicated and returns the number of lines actually
scrolled.
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Types expected

int Scroll(int deltaRow[, int deltaCol])

deltaRow

The direction in which to scroll.
• A value less than a means scroll up by the specified number
of lines.
• A value greater than a means scroll down by the specified
number of lines.

deltaCol

The magnitude of the scroll.
• A value less than a means scroll left by the specified number
of columns.
• A value greater than a means scroll down by the specified
number of columns.

Return value

Number of lines and columns scrolled.

SetTopLeft method
Attempts to position the character at the specified position in the upper left
corner of the EditView. Might fail if the position is outside the window's
bounds.

Types expected

Note

Return value

void SetTopLeft(int topRow, int lettCol)

top Row

The row number of the upper left corner of the EditView. A a
ignores the position request andsets only the column number.

leJtCol

The column number of the upper left corner of the EditView. A a
ignores the position request and sets only the row number.

A zero in both parameters causes the method to be ignored altogether.
None

EditView class

15-9

15-10

ObjectScripting Programmer's Guide

EditWindow class
This class is one of the editor classes. EditWindow class members provide
control of editor views.

Syntax

EditWindow(EditBuffer buffer)

buffer

The name of the EditBuffer to create.

Properties
int Identifier

Read-only

bool IsHidden

Read-write

boollsValid

Read-only

EditWindow Next

Read-only

. EditWindow Prior

Read-only

string Title

Read-write

EditView View

Read-only

Methods
void ActivateO
void CloseO
void PaintO
EditView ViewActivate(int direction[, EditView srcViewj)
EditView ViewCreate(int direction[, EditView srcViewj)

Ed it Win dow c I ass
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boo I ViewDelete(int direction[, EditView srcView])
EditView ViewExists(int direction[, EditView srcView])
void ViewSlide(int direction[, int magnitude, EditView srcView])

Events
None

EditWindow class·description
EditWindow objects manage window panes (also known as views). An
EditWindow can contain one or more views in which each Edit View represents
different buffers.
.

Creation of an EditWindow does not cause a window to appear; it provides an
object to which a view may be attached. As soon as the first view is attached
to an EditWindow, it can be displayed.
Views can be zoomed, in which case they expand to fill the client area of their
EditWindow. A zoomed view hides all sibling views.. Sibling views are those
embedded in the same EditWindow. As long as an EditWindow contains a
zoomed view, views can't be created, destroyed or resized.
EditWindows can be hidden and unhidden to allow the user to free screen
space and preserve the view layout.

Identifier property
Identifies views with a unique value.

Access
Type expected

Read-write
int Identifier

IsHidden property
Indicates if the current EditWindow is hidden.

Access

Read-write

Type expected

bool IsHidden
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IsValid property
TRUE if the current EditWindow is ready for edit operations, FALSE if the
window is not available (for example, it is closed).

Access
Type expected

Read-only
bool IsValid

Next property
Indicates the next EditWindow, if any.

Access
Type expected

Read-only
EditWindow Next

Prior property
Indicates the previous EditWindow, if any.

Access
Type expected

Read-only
EditWindow Prior

Title property
Indicates the title of the current EditWindow.

Access
Type expected

Read-:write
string Title

View property
Indicates the current EditView.

Access

Read-only

Type expected

EditView View
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Activate method
Brings this window to the top and gives it focus.

Types expected
Return value

void ActivateO

None

Close method
Closes the current window.

Types expected
Return value

void CloseO

None

Paint method
Forces a screen refresh. During normal script execution screen updates are
suppressed.

Types expected
Return value

void Paint()

None

ViewActivate method
Makes an existing view the current, active view.

Types expected

EditView ViewActivate(int direction[, EditView srcView])

direction

Relative to the current EditView in an EditWindow. If direction is
0, and a srcView is specified, the specified srcView is activated.
direction can be one of the following values:
UP
DOWN
LEFT
RIGHT

srcView

Return value

16-4

The view to activate. If omitted, the EditWindow's current .
Edit View is activated.

The newly activated view or NULL if no view exists
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ViewCreate method
Creates an EditView.

Types expected

EditView ViewCreate(int direction[, EditView srcView])

direction

Relative to the existing EditView(s) in an EditWindow. Ignored
for the first view. direction can be one of the following values:

UP
DOWN
LEFT

RIGHT

srcView

Return value

The view to create. If omitted, the EditWindow's current
EditView is used. By default, the newly created EditView is not
activated.

The new Edit View or NULL if creation failed

ViewDelete method
Deletes the view in the direction relative to the src View, if any.

Types expected

bool ViewDelete(int direction[, EditView srcView])

direction

Relative to the existing EditView(s) in an EditWindow and
ignored for the first view. Can be one of the following values:

UP
DOWN
LEFT

RIGHT

srcView

Return value

The view to delete. If omitted, the EditWindow's current
EditView is deleted. The target view (if any) is then removed
from the EditWindow.srcView is then resized to occupy the
space previously held by the target view.

TRUE if the view was deleted, FALSE otherwise

ViewExists method
Gets a reference to an adjoining EditView, if the adjoining EditView exists.
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Types expected

EditView ViewExists(int direction[, EditView srcView])

direction

Relative to the current EditView in an EditWindow. Can be one of
the followingvalues:
UP
DOWN
LEFT
RIGHT

srcView

Return value

If omitted, the EditWindow's current Edit View is used.

The EditView or NULL if the EditView does not exist

ViewSlide method
Moves the view in the direction indicated.

Types expected

void ViewSlide(int direction[,int magnitude,
EditView srcView])

direction

Relative to the exjsting EditView in an EditWindow. Can be
one of the following values:
\

UP

DOWN
LEFT
RIGHT

, Return value
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magnitude

The direction (+ or -) and amount to move

srcView

If omitted, the EditWindow's current EditView is used.

None
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Editor class
This class provides access to the IDE's internal editor. Editor is associated
with other classes which provide the editor with its functionality.

Syntax

Editor'()

Properties
EditStyle FirstStyle

Read-only

EditOptions Options

Read-only

SearchOptions SearchOptions

Read-only

EditBuffer TopBuffer

Read-only

EditView TopView

Read-only

Methods
void ApplyStyle(EditStyle newOptions)
void BufferListO
BufferOptions BufferOptionsCreateO
boo I BufferRedo(EditBuffer buffer)
bool BufferUndo(EditBuffer buffer)
EditBuffer EditBufferCreate(string fileName [, boo I private, bool readOnly])
EditOptions EditOptionsCreateO

Editor class
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EditStyle EditStyleCreate(string styleName[,EditStyle tolnheritFrom])
EditWindow EditWindowCreate(EditBuffer buffer)
string GetClipboardO
int GetClipboardTokenO
EditWindow GetWindow([bool getLast])
bool.lsFileLoaded(string filename)
EditStyle StyleGetNext(EditStyle)
boo I ViewRedo(EditView view)
bool ViewUndo(EditView view)

Events
void BufferCreated(EditBuffer buffer)
void MouseBlockCreatedO
void MouseLeftDownO
void MouseLeftUPO
string MouseTipRequested(EditView theView, int line, int column)
void OptionsChanged(EditorOptions newOptions)
void OptionsChanging(EditorOptions newOptions)
void ViewActivated(EditView view)
void ViewCreated(EditView newView)
void ViewDestroyed(EditView deadView)

Editor class description
The IDE instantiates an Editor object, which maintains undo and redo data
and has methods allowing access to the list of all buffers and edit windows.
Editors have a member of type EditOptions that controls global editor
characteristics.
Although multiple instances' of Editor objects may be created in script, they
all refer to the same instance of a single C++ object internal to the IDE.
Modification of one Editor object's options will be reflected in all Editor
objects.
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Manipulating the Editor
The Editor's functionality is accessible at a low enough level that you can
mimic in script the behavior of popular editors (such as BRIEF, Epsilon, vi,
and WordStar). The Editor itself is accessed through an object instantiated
from the Editor class. Because the IDE instantiates an Editor object itself" any
Editor objects you instantiate point to this internal IDE object; therefore,
modifications in one Editor object's options are reflected in all Editor objects.
Further editor access is provided through the following classes:

BufferOptions

Controls characteristics of the EditBuffer, such as margin, tab
rack, syntax highlighting, and bookmarks.

EditBlock
EditBuffer
EditOptions

Cut, copy, delete, dimensions, and style.
Access status, save, describe; time / date stamp.
Holds characteristics of a global nature, such as the insert/
overtype setting, optimal fill, and scrap settings (how to
handle blocks cut or copied from Editor buffers).

EditPosition

Location-dependent operations in a view or buffer: cursor
movement, text rip, search, insert.

Edi"tStyle

Provide named styles that overrride settings in a buffer or the
entire editor.

Edit View
EditWindow

Access to buffer, visual cursor manipulations, zoom.
Pane control, access to views.

FirstStyle property
Contains the first style in the list of editor styles.

Access
Type expected
Description

Read-only
EditStyle FirstStyle

FirstStyle is usually used with the StyleGetNext method. At least one EditStyle
must exist for this property to contain a valid value.

Options property
Holds the buffer options settings.

Access
Type expected

Read-only
EditOptions Options

Ed ito r c I ass

17-3

Editor class, SearchOptions property

Description

Options holds the options settings for all edit buffers. Changing an option in
this property affects all edit buffers.

SearchOptions property
Provides access to the instance of SearchOptions associated with this editor.

Access
Type expected

Read-only
SearchOptions SearchOptions

TopBuffer property
The current edit buffer.

Access
Type expected

Read-only
EditBuffer TopBuffer

TopView property
The current view.

Access
Type expected
Description

Read-only
EditView TopView

Top View provides a quick way to get at the top view associated with the
current edit buffer. When you create a script which operates on the current
view, obtain Top View from the editor a~ outline below:
//Import the instance of the IDE's editor
import editor;
PrintCurrentLineAneRow()
{

//Get the current view's Editposition object
declare ep=editor.TopView.Position;
print "Row=",ep.Row, "Column=",ep.Column

ApplyStyle method
Updates the edit options.
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Types expected

void ApplyStyle(EditStyle newOptions)

newOptions The options for the EditStyle object.·

Return value

None

BufferList method
A text description of the buffer list.

Types expected
Return value
Description

void BufferListO

None
The description returned in BufferList comes from the EditBuffer.Describe
method.

BufferOptionsCreate method
Creates a new instance of the BufferOptions class.

Types expected
Return value

BufferOptions BufferOptionsCreateO

A BufferOptions object

BufferRedo method
. Reapplies the last operation on the buffer or view regardless of whether the
operation was performed on the EditBuffer, the EditView, an EditBlock, or an
EditPosition.

Types expected

bool BufferRedo(EditBuffer buffer)

buffer

Return value

The name of the buffer or view to reapply the operation to.

TRUE if there are more operations to redo, or FALSE if there are not

BufferUndo method
Undoes the last operation on the buffer or view regardless of whether the
operation was performed on the EditBuffer, the EditView, an EditBlock, or an
EditPosition.

Ed ito r c I ass
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Types expected

bool BufferUndo(EditBuffer buffer)

buffer

Return value

The name of the! buffer or view from which to undo the operation.

TRUE if there are more operations to undo or FALSE if there are not

EditBufferCreate method
Creates an edit buffer.

Types expected

Return value

EditBuffer EditBufferCreate(string fileName [, bool private, bobl readOnly])

fileName
private

The name of the file associated with the edit buffer.

readOnly

Marks the buffer as read-only. The default value is FALSE.
Associating a read-only file with the EditBuffer does not make
the EditBuffer read-only.

Implies that the buffer is a hidden system buffer. Undo
information is not retained, and the EditBuffer is never
attachable to an EditView. The default value is FALSE.

The edit buffer created, or NULL if none could be created

EditOptionsCreate method
Creates a new instance of the EditOptions class.

Types expected
Return value

EditOptions EditOptionsCreateO

An EditOptions object

EditStyleCreate method
Creates an edit style.

Types expected

EditStyle EditStyleCreate(string styleName[,EditStyle tolnheritFrom])

styleName
. tolnheritFrom

The name of the style to create.
The name of the EditStyle object to inherit from .

Return value ' The edit style created, or NULL if none could be created
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EditWindowCreate method
Creates an edit window.

Types expected

EditWindow EditWindowCreate(EditBuffer buffer)

buffer

Return value

The name of the buffer to associate with this edit window.

The edit window created, or NULL if none could be created

GetClipboard method
Returns the contents of the Windows Clipboard in a string.

Types expected

string GetClipboardO

GetClipboardToken method
Returns the memory address of the Windows Clipboard contents.

Types expected

int GetClipboardTokenO

GetWindow method
Returns an EditWindow.

Types expected

EditWindow GetWindow([bool getLast])

getLast

The name of the window to get.
• If getLast is FALSE,~ GetWindow returns the top level window.
• If it is TRUE, GetWindow returns the last EditWindow in the Zorder.

getLast defaults to FALSE.

Return value.N one

IsFileLoaded method
Verifies if the specified file is loaded.

Editor class
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Types expected

boollsFileLoaded(string fileName)

fileName

Return value

The name of the file to check for.

TRUE if a buffer by that name exists, or FALSE if one doesn't.

StyleGetNext method
Gets the next style in the list of editor styles.

Types expected
Return value
Description

EditStyle StyleGetNext(EditStyle).

The editor style that was found, or NULL if no editor style is found.
Use with FirstStyle to access the circularly linked list representing all the
editor styles. At least one EditStyle must exist for this property to contain a
valid value.

ViewRedo method
Reapplies the last operation that was undone on the buffer or view
regardless of whether the operation was performed on the EditBuffer, the
EditView, an EditBlock, or an EditPosition.

Types expected

bool ViewRedo(EditView view)

view

Return value

The name of the buffer or view to reapply the operation to.

TRUE if there are more operations to redo, or FALSE if there are not

ViewUndo method
Undoes the last operation on the buffer or view regardless of whether the
operation was performed on the EditBuffer, the EditView, an EditBlock, or an
EditPosition.

Types expected

bool ViewUndo(EditView view)

view

Return value
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The name of the buffer or view from which to undo the operation.

TRUE if there are more operations to undo, or FALSE if there are not
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BufferCreated event .
Triggered when a new EditBuffer is created. The default action is to do
nothing.

Types expected

void BufferCreated(EditBuffer buffer)

buffer

Return value

The name of the buffer to create.

None

MouseBlockCreated event
Triggered when the user selects a block with the mouse in the top view.

Types expected
Return value

void MouseBlockCreatedO

None

MouseLeftDown event
Triggered when the mouse left button is pressed in an Edit window.

Types expected
Return value

void MouseLeftDownO

None

MouseLeftUp event
Triggered when the mouse left button is released in an Edit window.

Types expected
Return value

void MouseLeftUpO

None

MouseTipRequested event
Raised when the mouse has remained idle over an editor window for a
period of time.

Editor class
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Types expected

string MouseTipRequested(EditView theView, int line, int column)

the View

The Edit View object describing the edit window that contains
the idle mouse.

line, column The position in the edit buffer of the character the cursor is on.

Return value

If this routine returns a string, it displays the string to the user as a help hint.

The· default implementation returns a NULL.

OptionsChanged event
Raised when the OptionsChanging event handler has completed and the
global values have been changed.

Types expected

void OptionsChanged(EditorOptions newOptions)

newOptions The new global editor options to apply.

Return value
Description

None

OptionsChanged notifies a script that needs to update the global options that
those options have changed.

OptionsChanging event
Raised when leaving one of the editor MPD pages with accept.

Types expected

void OptionsChanging(EditorOptions newOptions)

newOptions

Return value
Description

The new global editor options.

None

Options Changing contains a copy of the new values for the global editor
options. An event handler may examinJe these values and determine if any of
the values need to be overridden with any values from newOptions.

ViewActivated event
Triggered when the EditView represented by view is activated. There is no
default action for this event.

Types expected

void ViewActivated(EditView view)

view
17-10

The name of the view to activate.
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Return value, None

ViewCreated event
Triggered when the EditView represented by new View is created. There is no
default action for this event.

Types expected

void ViewCreated(EditView newView)

new View

Return value

The name of the view to activate.

None

ViewDestroyed event
Triggered when the EditView represented by dead View is destroyed. There is
no default action for this event.

Types expected

void ViewDestroyed(EditView deadView)

dead View

Return value

The name of the view to destroy.

None

Editor class
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IDEApplication class
This class represents the Borland c++ Integrated Development Environment
(IDE). An IDEApplication object called IDE is instantiated when Borland C++
starts up. You typically use this class to determine how to use or extend this
IDE object.

Syntax

IDEApplicationO

Properties
string Application

Read-only

string Caption

Read-write

string CurrentDirectory

Read-only

string CurrentProjectNode

Read-only

string DefaultFilePath

Read-write

Editor Editor

Read-only

string Full Name

Read-only

int Height

Read-write

int IdleTime

Read-only

int IdleTimeout

Read-write

int LoadTime

Read-only

string KeyboardAssignmentFile

Read-write

KeyboardManager KeyboardManager

Read-only

int Left

Read-write

string ModuleName

Read-only

IDE A Ppi i cat ion c I ass
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string Name

Read-only

string Parent

Read-only

bool RaiseDialogCreatedEvent

Read-write

string StatusBar

Read-write

intTop

Read-write

bool UseCurrentWindowForSourceTracking

Read-write

int Version

Read-only

bool Visible

Read-write

int Width

Read-write

Methods
void AddToCreditsO
boo I CloseWindowO
bool DebugAddBreakpointO
bool DebugAddWatchO
boo I DebugAnimateO
bool DebugAttachO
bool DebugBreakpointOptionsO
string DebugEvaluateO
bool DebuglnspectO
bool DebuglnstructionSteplntoO
bool DebuglnstructionStepOverO
bool DebugLoad()
bool DebugPauseProcessO
boo I DebugResetThisProcessO
bool DebugRun()
bool DebugRunToO
bool DebugSourceAtExecutionPointO
bool DebugStatementStepl ntoO
bool DebugStatementStepOverO
bool DebugTerminateProcessO
int DirectionDialog(string prompt)
string DirectoryDialog(string prompt, string initialValue)
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void DisplayCreditsO
bool DoFileOpen(string filename, string tool Name [, ProjectNode node])
bool EditBufferListO
bool EditCopyO
bool EditCutO
boo I EditPasteO
bool EditRedoO
boo I EditSelectAIiO
bool EditUndoO
void EndWaitCursorO
void EnterContextHelpModeO
void ExpandWindowO
boo I FileCloseO
string FileDialog(string prompt, string initialValue)
bool FileExit( lint IDEReturn] )
boo I FileNew([string toolName, string fileName])
bool FileOpen([string name, string toolName])
bool FilePrint(bool suppressDialog)
boo I FilePrinterSetupO
bool FileSaveO
bool FileSaveAIiO
boo I FileSaveAs([string newName])
bool FileSendO
int GetRegionBottom(string RegionName)
int GetRegionLeft(string RegionName)
int GetRegionRight(string RegionName)
int GetRegionTop(string RegionName)
bool GetWindowStateO
void Help(string helpFile, int command, string helpTopic)
boo I HelpAboutO
bool· HelpContentsO
bool HelpKeyboardO
boo I HelpKeywordSearch([string keyword])

IDE A PPI i cat ion c I ass
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bool HelpOWLAPIO
bool HelpUsingHelpO
bool HelpWindowsAPIO
string KeyPressDialog(string prompt, string default)
string[ ] ListDialog(string prompt, booI multiSelect, bool sorted, string [ ] initialValues)
void MenuO
bool Message(string text,int severity)
int MessageCreate(string destinationTab, string toolName, int messageType, int parentMessage,
string filename, int lineN umber, int columnNumber, string text, string helpFileName, int
helpContextld)
bool NextWindow(bool priorWindow)
bool OptionsEnvironmentO
bool OptionsProjectO
bool OptionsSaveO
bool OptionsStyleSheetsO
boolOptionsToolsO
bool ProjectAppExpertO
bool ProjectBuildAII([bool suppressOkay, string node Name])
bool ProjectCloseProjectO
bool ProjectCompile([string nodeName])
bool ProjectGenerateMakefile([string node Name])
bool ProjectMakeAII([bool suppressOkay, string nodeName])
bool ProjectManagerlnitializeO
bool ProjectNewProject([string pName])
bool ProjectNewTarget( [string nTarget, int targetType, int platform, int IibraryMask,
int modelOrMode] )
bool ProjectOpenProject([string pName])
void QuitO
bool SaveMessages(string tabName, string fileName)
bool ScriptCommandsO
bool ScriptCompileFile(string fileName)
bool ScriptModulesO
booI ScriptRun([string command])
booI ScriptRunFile([string filename])
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booI SearchBrowseSymbol([string sName])
boo I SearchFind([string pat])
bool SearchLocateSymbol([string sName])
bool SearchNextMessageO
bool SearchPreviousMessageO
boo I SearchReplace([string pat, string rep])
boo I SearchSearchAgainO .
bool SetRegion(string RegionName, int left, int top, int right, int bottom)
boo I SetWindowState(int desiredState)
string SimpleDialog(string prompt, string initialValue [, int maxNumChars])
void SpeedMenuO
void StartWaitCursorO
string StatusBarDialog(string prompt, string initialValue [, int maxNumChars])
bool StopBackgroundTaskO
bool Tool([string toolName, string commandstring])
void UndoO
bool ViewActivate(int direction)
bool ViewBreakpointO
bool ViewCaliStackO
boo I ViewClassesO
bool ViewClassExpertO
bool ViewCpuO
bool ViewGlobalsO
boo I ViewMessage([string tabName])
bool ViewProcessO
boo I ViewProjectO
bool ViewSlide(int direction [, int amount])
. bool ViewWatchO
bool WindowArrangelconsO
bool WindowCascadeO
bool WindowCloseAII([string typeName])
bool WindowMinimizeAII([string type Name])
bool WindowRestoreAII([string typeName])

IDE App I i c a·U 0 n c I ass
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bool WindowTileHorizontalO
boo I WindowTileVerticalO
string YesNoDialog(string prompt, string default)

Events
void BuildComplete(bool status, string inputPath, string OutputPath)
void BuildStartedO
void DialogCreated(string dialogName, int dialogHandle)
void ExitingO
void HelpRequested(string filename, int command, int data)
void IdleO
void KeyboardAssignmentsChanged(string newFilename)
void KeyboardAssignmentsChanging(string newFilename)
void MakeComplete(bool status, string inputPath, string outputPath)
void MakeStartedO
void ProjectClosed(string projectFileName)
void ProjectOpened( string projectFileName)
void SecondElapsedO
void Started(bool VeryFirstTime)
void SubsytemActivated(string system Name)
bool TransferOutputExists(TransferOutput output)
void TranslateComplete(bool status, string inputPath, string outputPath)

IDEApplication class description
When you start the Borland C++ IDE, the object IDE, in IDEApplication, is
automatically created as a global object. IDE gives you control over the
system. All items contained in menu commands can be accessed through the
IDE object.
The IDE object is registered as a Windows automation server, so any
automation controller can programmatically run the full IDE.
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IDEApplication function groups
This table shows the main function groups, according to the menu they
correspond to:
Table 18.1

IDEApplication function groups

Group

D~scription

Debug

Corresponds to the Debug menu. Use these functions to load the debugger,
run it, set breakpoints, add watches, and inspect variables.
Corresponds to the Edit menu. Use these functions to undo, redo, cut,
copy, paste and select text in an edit window.
Corresponds to the File menu. Use these functions to create, open, close,
save and print files.
Corresponds to the Help menu. Use these functions to display the Help
contents, perform keyword searches, get help about the keyboard and get
help about using help.
Corresponds to the Options menu. Use these functions to set options for
the project and the working environment, to customize the Tools menu
and to create and edit style sheets.
Corresponds to the Project menu. Use these functions to open and close a
project, compile a file, build the project or rebuild the entire project.
Corresponds to the Search command. Uses these functions to search for
text, replace text and search for symbols.
Corresponds to the Script command. Use these functions to load, run and
compile script files.
Corresponds to the View menu. Use these commands to display the Project
window, Message window, the Classes window, the Globals window, the
CPU window, the Processes window, the Watches window, the Breakpoint
window and the Stack window.
Corresponds to the Window menu. Use these commands to arrange editor
windows, close windows, minimize and maximize windows and restore
them.

Edit
File
Help

Options

Project
Search
Script
View

Window

Applicationproperty
Contains the IDEApplication object's internal name.

Access
Type expected
Description

Read-only
string Application

The internal name is used by Windows. Its presence is required by Microsoft
guidelines for automation servers. It serves as a starting place for an
automation controller, like Word or Excel.

IDEApplication class
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Caption property
Gets and sets the caption of the Borland C++ IDE main window.

Access

Read-write

Type expected

string Caption

CurrentDirectory property
The application's current directory.

Access
Type expected
Description

Read-only
string CurrentDirectory

Whenever a project file is opened, the value of CurrentDirectory changes to
the directory containing the project file.

CurrentProjectNode property
The name of the node currently selected in the Project window.

Access
Type expected
Description

Read-only
string CurrentProjectNode

If the Project window is closed, or if multiple nodes are selected in the Project

window, CurrentProjectNode contains an empty string (" ").

DefaultFilePath property
The default file path for the Borland c++ IDE.

Access
Type expected

Read-only
string DefaultFilePath

Editor property
An instance of the Borland C++ IDE editor.
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Access
Type expected

Read-only
Editor Editor

FullName property
Contains the string, uBorland C++ for Windows, verso 5.02" .

Access
Type expected

Read-only
string FuliName

Height property
The height of the Borland C++ IDE main window.

Access
. Type expected

Read-only
int Height

IdleTime property
The number of seconds since the last user:-generated event.

Access
Type expected

Read-only
int IdleTime

IdleTimeout property·
The number of seconds the IDE must remain idle before an idle event will be
generated ..

Access

Read-write

Type expected

int IdleTimeout

Description

IdleTimeOut defaults to 180 (3 minutes).

LoadTime property
The number of milliseconds it takes for the IDE to load.
IDE A Ppi i cat ion c I ass
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Access

Read-only

Type expected

int LoadTime

Description

LoadTime reflects time through the processing of the startup script. Thereafter
it remains fixed.

KeyboardAssignmentFile property
The name of the keyboard file (.KBD) most recently selected from the
Options I Environment I Editor dialog.

Access
Type expected

Read-write
string KeyboardAssignmentFile

KeyboardManager property
An instance of the Borland c++ IDE keyboard manager.

Access
Type expected

Read-only
KeyboardManager KeyboardManager

Left property
The left coordinate of the IDE main window.

Access
Type expected

Read-write
int Left

ModuleName property
The module name of the running application, including its path. For
example:
c:\bc5\bin\bcw.exe

Access
Type expected

18-10

Read-only
string ModuleName
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Name property
The name of the Borland C++ IDE, BCW.

Access
Type expected

Read-only
string Name

Parent property
A value required by Windows.

Access

Read-only

Type expected

string Parent

Description

Parent is required by Microsoft conventions.

RaiseDialogCreatedEvent property
Initialized to FALSE. Setting it to TRUE causes the DialogCreated event to be
raised whenever a new dialog is created.

Access
Type expected

Read-write
bool HaiseDialogCreatedEvent

StatusBar property
Gets or sets the text displayed in the IDE's status bar.

Access

Read-write

Type expected

boo I StatusBar

Top property
The top coordinate of the IDE main window.

Access
Type expected

Read-write
int Top

IDE A Ppi i cat ion c I ass
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UseCurrentWindowForSourceTracking property
If TRUE, the IDE replaces the contents of the active Edit window whenever a
new file is loaded. If FALSE, the IDE opens a new Edit window.

Access
Type expected

Read-write
bool UseCurrentWindowForSourceTracking

Version property
The value 502 for Borland C++ version 5.02.

Access
Type expected

Read-only
int Version

Visible property
If TRUE, makes the IDE visible to the user. If FALSE, the IDE is not visible

on the screen.

Access
Type expected

Read-write
boo I Visible

Width property
The width of the IDE main window.

Access
Type expected

Read-write
int Width

AddToCredits method
Adds a name to the list of developer credits in the About dialog box.

Types expected
Return value

void AddToCreditsO

None
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Description
Note

AddToCredits adds the new name to the end of the existing list.

To display developer credits, choose Help I About and press Aft-f.

CloseWindow method
Closes the currently selected IDE child window.

Types expected
Return value

boo I CloseWindowO

TRUE if the window closed, FALSE if unable to close the window

DebugAddBreakpoint method
Opens the Add B~eakpoint dialog.

Types expected
Return value
Description

bool DebugAddBreakpointO

TRUE if successful, FALSE, otherwise
DebugAddBreakpoint corresponds to the Debug I Add Breakpoint command.

DebugAddWatch method
Adds a watch on the current symbol.

Types expected
Return value
Description

bool DebugAddWatchO

TRUE if successful, FALSE, otherwise

When you call DebugAddWatch from an active Edit windo~, the Add Watch
dialog box contains selected text, or if no text is selected, it contains the word
at the cursor.
After you add the watch, the Watches window is displayed.
DebugAddWatch corresponds to the Debug I Add Watch command.

DebugAnimate method
Lets you watch your program's execution in "slow motion."

Types expected

bool DebugAnimateO

Return value· TRUE if successful, FALSE, otherwise
IDE APpi i cat ion c I ass
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Description

DebugAnimate performs a continuous series of StatementSteplnto commands.
To interrupt animation, invoke one of the following Debugger methods either
by menu selections or by keystrokes tied to the script:

•
•
•
•
•
•
•

Run
RunToAddress
RunToFileLine
PauseProgram
Reset
TerminateProgram
FindExecutionPoint

DebugAttach method
Invokes the debugger for the currently executing process.

Types expected
Return value
Description

bool DebugAttachO

TRUE if successful, FALSE, otherwise

Use DebugAttach to begin a debugging session on a process that is already
running. This is useful when you know approximately when the problem
occurs during program execution, but you are not sure of the corresponding
location in the program source code.

DebugAttach opens the Attach to Program dialog box.

DebugBreakpointOptio.ns method
Opens the Breakpoint Condition/ Action Options dialog.

Types expected
Return value
Description

boo I DebugBreakpointOptionsO

TRUE if successful, FALSE, 6therwise

DebugBreakpointOptions corresponds to the Debug I Breakpoint Options
command.

DebugEvaluate method
Evaluates the current expression, such as a global or local variable or an
arithmetic expression.

Types expected
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Return value

The result of the evaluation.

Debuglnspect method
Opens the Inspect Expression dialog box for the current symbol.

Types expected
Return value
Description

bool DebuglnspectO

TRUE if successful, FALSE, otherwise
Debuglnspect has effect only when the integrated debugger is paused in a
program you are debugging.
Debuglnspect corresponds to the Debug I Inspect command.

DebuglnstructionSteplnto method
Executes the next instruction, stepping into any function calls.

Types expected
Return value
Description

bool Debuglnstruction_SteplntoO

TRUE if successful, FALSE, otherwise

If a process is not loaded, DebuglnstructionSteplnto first loads the executable
for the current project.

DebuglnstructionStepOver method
Executes the next instruction, running any functions called at full speed.

Types expected
Return value
Description

bool DebuglnstructionStepOverO

TRUE if successful, FALSE, otherwise

If a process is not loaded, DebuglnstructionStepOver first loads the executable
for the current project.

DebugLoad method
Loads the current executable into the debugger.

Types expected
Return value

boo I DebugLoadO

TRUE if successful, FALSE, otherwise
IDE A PPI i cat ion c I ass
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Description

Upon loading, the process is run to the starting point as specified in the
Options I Environment IDebugger IDebugger Behavior dialog.
If the parmneter is NULL, this method opens the Load Program dialog.

DebugPauseProcess method
Causes the debugger to pause the current process.

Types expected
Return value
Description

boo I DebugPauseProcessO

TRUE if successful, FALSE, otherwise

DebugPauseProcess has an effect only if the current process is running or is
animated. It corresponds to the Debug IPause Process command.

DebugResetThisProcess method
Resets the current process to its starting point as specified in the Options I
Environment IDebugger IDebugger Behavior dialog.

Types expected
Return value
Description

bool DebugResetThisProcessO

TRUE if successful, FALSE, otherwise

DebugResetThisProcess corresponds to the Debug IReset This Process
command.

DebugRun method
Causes the debugger to run the current process.

Types expected
Return value
Description

bool DebugRunO

TRUE if successful, FALSE, otherwise
If no process is loaded, DebugRun first loads the executable associated with
the current project.

DebugRun corresponds to the Debug IRun command.

DebugRunTo method
Causes the debugger to run the current process.
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Types expected
Return value
Description

bool DebugRunToO

TRUE if successful, FALSE, otherwise

If DebugRunTo is called while working with an EditView, the current process
runs until the source at the current line in the current file is encountered.
If the current object is not an EditView, DebugRunTo runs the current process
until the instruction at the current address is encountered.
If no process is loaded, DebugRunTo first loads the executable associated with
the current project.

DebugSourceAtExecutionPoint method
Displays the source code at the current execution point.

Types expected
Return value
Description

boo I DebugSourceAtExecutionPointO

TRUE if successful, FALSE, otherwise

The current execution point is indicated by the EIP register. If the current
execution point is in source code, the execution point is shown in an Edit
window. (The appropriate source file is opened if necessary.)
If the current execution point is at an address that has no source associated
with it, the execution point is shown in a CPU view. (One is opened if
necessary. )

DebugSourceAtExecutionPoint corresponds to the Debug I Source At Execution
Point command.

DebugStatementSteplnto method
Executes the next source statement and steps through the source of any
function calls.

Types expected
Return value
Description

bool DebugStatementSteplntoO

TRUE if successful, FALSE, otherwise

If a process is not loaded, DebugStatementSetplnto first loads the executable
for the current project.

IDEApplication class
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DebugStatementStepOver method
Executes the next source statement and does not step into any functions
called, but runs them at full speed.

Types expected
Return value
Description

booI DebugStatementStepOverO

TRUE if successful, FALSE, otherwise
If a process is not loaded, DebugStatementStepOver first loads the executable
for the current project.

DebugTerminateProcess method
Terminates the current process.

Types expected
Return value
Description

bool DebugTerminateProcessO

TRUE if successful, FALSE, otherwise

DebugTerminateProcess:
• Stops the current debugging session
• Releases memory your program has allocated and some of the memory
used by the debugger
• Closes any open files that your program was using
If no process is loaded, DebugTerminateProcess has no effect.

DebugTerminateProcess corresponds to the Debug I Terminate Process
command.

DirectionDialog method
Invokes a dialog that allows the user to specify a direction.

Types expected

int DirectionDialog(string prompt)

prompt

'Return value

The value to place in the caption of the dialog.

One of the following values: CANCEL, RIGHT, LEFT, UP, DOWN

DirectoryDialog method
Invokes a directory-browsing dialog box that lets the user choose a directory.
18-18
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Types expected

string DirectoryDialog(string prompt, string initialValue)

prompt
initial Value

Return value

The value to place in the caption of the dialog.
The directory in which to start browsing.

If suc~essful, this method returns a fully qualified directory name. If the user
cancels, it returns the empty string (" ").

DisplayCredits method
Displays the list of developer credits in the About dialog box.

Types expected
Return value
Description

void DisplayCreditsO

None
To display developer credits, choose Help ;1 About and press Alt-I.

DoFileOpen method
Opens the specified file.

Types expected

Return value
Description

bool DoFileOpen(string fileName, string tool Name [,ProjectNode node])

fileName

The name of the file to open. If the specified file does not exist, it
is created.

toolName

The name of the tool to be associated with the file to open. Tools
can be stand-alone programs (like GREP, Turbo Debugger, or
an alternate editor), or they can be translators that are used for
each file (or node) in a project. You can run a DOS program
with the Windows IDE transfer. If toolName is not provided, a
default is used.

node

The node argument is passed if the file is to be associated with a
specific node in the project.

TRUE is successful, FALSE, otherwise

DoFileOpen is used internally by the FileOpen method to open files.

EditBufferList method
Displays the Buffer List dialog.

Types expected

bool EditBufferListO
IDEApplication class
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Return value
Description

TRUE if the buffer list was successfully edited, FALSE ifno edit buffers exist
The Buffer List displays a list of buffers. If a file has been changed since it
was last saved, thelabel (modified) appears after tJ:e file name.
Use EditBufferList to replace the contents of an Edit window without closing
the original file. If the file you replace is not loaded in another Edit window,
it is hidden. You can then lateruse the buffer list to load the hidden buffer
into an Edit window.

EditBufferList corresponds to the Edit IBuffer List command.

EditCopy method
Copies selected text from the current edit buffer to the Windows Clipboard.

Types expected

boo I EditCopyO

Return value

TRUE if the topmost window is an EditView with a valid marked block,
FALSE, otherwise

Description

EditCopy leaves the selected text intact. To paste the copied text into any
other document or somewhere else in the same document, use EditPaste.
EditCopy is only available if an Edit window is currently active and text has
been marked for selection.
EditCopy corresponds to the Edit ICopy command.

EditCut method
Copies selected text from the current edit buffer to the Clipboard and deletes
the selected text.

Types expected
Return value
Description

boo I EditCutO

TRUE if the topmost window is an EditView with a valid marked block,
FALSE, otherwise

EditCut removes the selected text from the Edit window. To paste the cut text
into any other document or somewhere else in the same document, use
EditPaste.
EditCut is only available if an Edit window is currently active and text has
been marked for selection.
You can paste the cut text as many times as you want until you choose
EditCut again or EditCopy.

EditCut corresponds to the Edit ICut command.
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EditPaste method
Copies selected text from the Clipboard to the current edit position in the
current edit buffer.

Types expected
Return value
Description

bool EditPasteO

TRUE if the topmost window is an EditView with a valid marked block,
FALSE, otherwise

EditPaste inserts the contents of the Clipboard into the current window at the
cursor position.
EditPaste is available only if an Edit or Resource Editor window is currently
active and there is something to paste.
EditPaste corresponds to the Edit IPaste command.

EditRedo method
Reapplies the operation that was undone with the last EditUndo.

Types expected
Return value
Description

bool EditRedoO

TRUE if the operation was successful, FALSE, otherwise

EditRedo only has an effect immediately after an EditUndo or another
EditRedo.
A series of EditRedo calls reverses the effects of a series of EditUndo calls.

EditRedo is available only if an Edit window is currently active and there is
something to redo.
EditRedo corresponds to the Edit IRedo command.

EditSelectAl1 method
Selects all the text in the current edit buffer.

Types expected
Return value
Description

boo I EditSelectAIIO

TRUE if the select was successful, FALSE, otherwise

EditSelectAll selects the entire contents of the active Edit window.
You can then use EditCopy or EditCut to copy it to the Clipboard, or perform
any other editing action.
.
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EditSelectAll is available only if an Edit or Resource Editor window is
currently active.
EditSelectAll corresponds to the Edit I Select All comrpand.

EditUndo method
Undoes the last edit operation.

Types expected
Return value
Description

boo I EditUndoO

TRUE if the operation was successful, FALSE, otherwise

EditUndo restores the file in the current window to the way it was before
your most recent edit or cursor movement.
EditUndo inserts any characters you deleted, deletes any characters you
inserted, replaces any characters you overwrote, and moves your cursor back
to a prior position.
If you undo a block operation, your file will appear as it was before you
executed the block operation.

EditUndo will not change an option setting that affects more than one
window or reverse any toggle setting that has a global effect; for example,
Ins/Ovr.
EditUndo is available only if an Edit window is currently active and there is
something to undo.
EditUndo corresponds to the Edit I Undo command.

EndWaitCursor method
Stops the display of the Windows wait cursor (by default, an hourglass).

Types expected
Return value

void EndWaitCursorO

None

EnterContextHelpMode method
Puts the IDE inhelp context mode.

Types expected
Return value
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None
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Description

After EnterContextHelpMode is called, the next click of the mouse generates a
help event for whatever the mouse pointer is on.

ExpandWindow method
Increases the size of the currently selected window to its maximum view
managed size, defined by calls to SetRegion.

Types expected
Return value
Description

void ExpandWindow()

None
After the window has been expanded with ExpandWindow, there is no way to
decrease its size.

FileClose method
Closes the file that is currently open and selected.

Types expected
Return value
Description

boo I FileCloseO

TRUE if the file was successfully closed, FALSE, otherwise

If the project window is active, this command unloads the current project
and closes the project tree including all project nodes.

FileClose corresponds to the File I Close command.

FileDialog method
Invokes an Open a File dialog box and lets the user choose a file.

Types expected

Return value

string FileDialog(string prompt, string initialValue)

prompt

The value to place in the caption of the dialog.

initial Value

The value to initialize the edit field with.

Returns a fully qualified file name if successful. If the user cancels, the
method returns the empty string (" ").

FileExit method
Closes the application after first ensuring that all files are saved.
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Types expected

boo I FileExit( lint IDEReturn] )

IDEReturn

Return value
Description

The return value of the IDE application when it exits. By
default, this value is O.

TRUE if the application was closed, FALSE, otherwise

FileExit corresponds to the File I Exit command.

FileNew method
Creates a new file with the extension .CPP.

Types expected

Return value
Description

bool FileNew([string toolName, string fileName))

toolName

The name of the tool to associate with the file to open. Tools can
be stand-alone programs (like GREP, Turbo Debugger, or an
alternate editor), or they can be translators that are used for
each file (or node) in a project. You can run a DOS program
with the Windows IDE transfer. If toolName is not provided, a
default is used.

fileName

The name of the new file.

TRUE if the file was created, FALSE, otherwise

FileNew opeps a blank Edit window and loads a file with the default name
NONAMExx.CPP (where xx stands for a number). It automatically makes
the new Edit window active. NONAME files are used as a temporary edit
buffer and the Borland C++ IDE prompts you to supply a new name when
saved. If you load a file into an active Edit window that contains an empty
.NONAME file, the contents of the Edit window is replaced.
F~leNew

corresponds to the File I New rText Edit command.

FileOpen method
Opens a file. Internally, this method uses DoFileOpen.

18-24

ObjectScripting Programmer's Guide

IDEApplication class, FilePrint method

Types expected

Return value
Description

boo I FileOpen([string name, string toolName])

name

The name of the file to open. If the specified file doesn't exist,
the user is prompted for a file name.

toolName

The name of the tool to associate with the file being opened.
Tools can be standalone programs (like GREP, Turbo
Debugger, or an alternate editor), or they can be translators that
are used for each file (or node) in a project. You can run a DOS
program with the Windows IDE transfer. If toolName is not
provided, a default is used.

TRUE if the file was opened, FALSE, otherwise

FileOpen displays the Open a File dialog box that lets you select a file to load
into the Borland C++ IDE. Use this command to open a project (.PRJ or IDE),
source file (.C or CPP), resource (.RC), script (.SPP or SPX), or any other type
of file. The IDE automatically loads the file into the default viewer.
FileOpen corresponds to the File I Open command.

FilePrint method
Prints the contents of the active edit window.

Types expected

boo I FilePrint(bool suppress Dialog)

suppressDialog

Return value
Description

If set to TRUE, FilePrint does not display the Printer Options
dialog prior to performing the print operation but reuses the
last print options specified.

TRUE if the print operation was successful, FALSE, otherwise

FilePrint corresponds to the File I Print command.

FilePrinterSetup method
Displays the Printer Setup dialog box.

Types expected
Return value
Description

boo I FilePrinterSetupO

TRUE if the dialog sets the options or FALSE if the user exits with Cancel

FilePrinterSetup displays the system Printer Setup dialog box where you
seled which printer you want to use for printing with the Borland C++ IDE.
FilePrinterSetup does not have an effect if no printer is detected.
FilePrinterSetup corresponds to the File I Printer 'Setup command.
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FileSave method
Saves the file in the active Edit window.

Types expected
Return value
Description

boo I FileSaveO

TRUE if the file was saved, FALSE, otherwise

If the file in the active Edit window has as a default name (such as
NONAMEOO.CPP), FileSave opens the Save File As dialog box so you can
rename the file as well as save it in a different directory or on a different
drive.
If you use an existing file name to name the file, the IDE asks if you want to
overwrite the existing file.

FileSave corresponds to the File I Save command.

FileSaveAl1 method
Saves all open editor files.

Types expected
Return value
Description

bool FileSaveAIiO

TRUE if all files were saved, FALSE if a file could not be saved

FileSaveAll works just like FileSave except that it saves the contents of all
modified files loaded into an Edit window, not just the file in the active Edit
window.
FileSaveAll corresponds to the File I Save All command.

FileSaveAs method
Displays the standard File Save As dialog box so the user can save the
currently active editor file.

Types expected

boo I FileSaveAs([string newName])·

newName

Return value
Description
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The new name of the file. If supplied, FileSaveAs attempts to
save the file under that name in the current directory.

TRUE if the file was saved, FALSE, otherwise

FileSaveAs displays the Save File As dialog box" where you can save the file in
the active Edit window under a different name, in a different directory, or on
a different drive.
.
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You can enter the new file name, including the drive and directory.
All windows containing this file are updated with the new name.
If you choose an existing file name, the Borland C++ IDE asks if you want to

overwrite the existing file.

FileSaveAs corresponds to the File I Save As command.

FileSend method
Instructs the Windows MAPI to send files to another MAPI client.

Types expected
Return value
Description

bool File8endO

TRUE if the file was sent, FALSE, otherwise

FileSend has an effect only if you have a mail message service (MAPI)
installed on your system.
FileSend corresponds to the File I Send command.

GetRegionBottom method
Gets the bottom value of the specified region.

Types expected

int GetRegionBottom(string RegionName)

RegionName

The name of the region to examine. Valid regi?n names are:
• Breakpoint

• CPU

• Debugger

• Editor

• Evaluator

• EventLog

• Inspector

• Message

• Processes

• Project

• Stack

• Thread Count

• Watches

Return value
Description

The bottom value of the specified region in display units (0 - 10000) or -1 if
, no such region exists.

GetRegionBottom can be used with SetRegion to position a window.
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GetRegionLeft method
Gets the left value of the specified region.

Types expected

int GetRegionLeft(string RegionName)

RegionName

Return value
Description

The name of the region to examine. Valid region names are:
• Breakpoint

• CPU

• Debugger

• Editor

• Evaluator

• EventLog

• Inspector

• Message

• Processes

• Project

• Stack
.• Watches

• Thread Count

The left value of the specified region in display units (0 - 10000) or -1 if no
such region exists

GetRegionLeft can be used with SetRegion to position a window.

GetRegionRight method
Gets the right value of the specified region.

Types expected

int GetRegionRight(string RegionName)

RegionName

The name of the region to examine. Valid region names are:
• Breakpoint

• CPU

• Debugger

• Editor

• Evaluator

• Event Log

• Inspector

• Message

• Processes

• Project
• Thread Count

• Stack
• Watches

Return value
Description
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The right value of the specified region in display units (0 - 10000) or -1 if no
such region exists

GetRegionRight can be used with SetRegion to position a window.
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GetRegionTop method
Gets the top value of the specified region.

Types expected

int GetRegionTop(string RegionName)

RegionName

The name of the region to examine. Valid region names are:
• Breakpoint

• CPU

• Debugger

• Editor

• Evaluator

• Event Log

• Inspector

• Message

• Processes

• Project
• Thread Count

• Stack
• Watches

Return value
Description

The top value of the specified region in display units (0 -10000) or -1 if no
such region exists

GetRegionTop can be used with SetRegion to position a window.

GetWindowState method
Retrieves the state of the currently focused window.

Types expected
Return value

boo I GetWindowStateO

One of the following:
SW_NORMAL
SW_MINIMIZE
SW_MAXIMIZE

Help method
Invokes the Windows Help system with the specified Help file and context
ID.
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Types expected

Return value

void Help (string helpFile, int helpCommand, string helpTopic)

helpFile

The name (with optional path) of the Windows Help file to
open.

helpCommand

A constant representing a command passed to the Windows
Help engine. The helpCommand constants begin with HELP_
and are defined in the C++ header file WINUSER.H. See the
Windows API Reference for details on these constants.

helpTopic

The name of the Help topic to display.

None

HelpAbout method
Displays the Help About dialog box.

Types expected
Return value
Description

boo I HelpAbouto

TRUE if the dialog box displays, FALSE, otherwise

HelpAbout corresponds to the Help I About command.

HelpContents method
Displays the default Help contents screen. For Windows 95 Help systems,
this window is the Help Topics Contents page.

Types expected
Return value
Description

bool HelpContentsO

TRUE if the Help window can be displayed, FALSE, otherwise

HelpContents corresponds to the Help I Contents command.

HelpKeyboard method
Displays a Help window describing how to map the keyboard in the IDE.

Types expected
Return value
Description
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boo I HelpKeyboardO

TRUE if the Help window can be displayed, FALSE, otherwise

HelpKeyboard corresponds to the Help I Keyboard command.
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HelpKeywordSearch method
Displays the Help Topics Index page with the specified keyword selected.

Types expected

bool HelpKeywordSearch([string keyword])

keyword

Return value
Description

The entry selected in the Help Topics Index page.

TRUE if the Help window can be displayed, FALSE, otherwise

HelpKeyboardSearch corresponds to the Help I Keyboard Search command.

HelpOWLAPI method
Displays the Help Contents page for the ObjectWindows Library Help.

Types expected
Return value
Description

bool HelpOWLAPIO

TRUE if the Help window can be displayed, FALSE, otherwise

HelpOWLAPI corresponds to the Help I OWL API command.

HelpUsingHelp method
Displays a Help window describing how to use Help.

Types expected

bool HelpUsingHelpO

Return value

TRUE if the Help window can be displayed, FALSE, otherwise

Description

HelpUsingHelp corresponds to the Help I Using Help command.

HelpWindowsAPI method
Displays the Help Contents page for the Microsoft Windows API Help.

Types expected
Return value
Description

bool HelpWindowsAPIO

TRUE if the Help window can be displayed, FALSE, otherwise

Help WindowsAPI corresponds to the Help I Windows API command.
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KeyPressDialog method
Displays a dialog and records the keys pressed.

Types expected

string KeyPressDialog(string prompt, string default)

prompt
default

Return value
Description

The string to display in the caption of the dialog.
The value to display as a default. If default is empty, no value is
displayed.

The key pressed by the user or the empty string (" ") if the user presses Esc or
Cancel.

KeyPressDialog records the keys pressed in a mnemonic format suitable for
using with key assignments.

ListDialog method
Displays a modal list dialog.

Types expected

string[ 1ListDialog(string prompt, boo I multiSelect, bool sorted, string

prompt
multiSelect
sorted
initial Values

Return value

The value to place in the caption of the dialog.
Indicates if multiple selection of items in the list is allowed.
Indicates how the list is to be sorted.
The strings to display in the dialog.

An array containing the strings that were selected.

Menu method
Activates the main menu.

Types expected
Return value

void MenuO

None

Message method
Displays messages to the user in a message box.
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Types expected

boo I Message(string text, int severity)

text
severity

Return value
Description

The message to display.
One of the following values: INFORMATION, WARNING,
ERROR. The value specified also determines the text for the
caption.

TRUE if the message box successfully opened, FALSE, otherwise
The message box contains the following buttons: CANCEL, ABORT, RETRY,
and OK.

MessageCreate method
Adds messages to the Message window.

Types expected

int MessageCreate(string destinationTab, string toolName,
int messageType, int parentMessage, string filename,
int lineNumber, int columnNumber, string text,
string help FileName, int helpContextld)

des tina tion Tab The name of the tab on the page of the Message window on
which this message should appear. The default supp'orted
values for this parameter are Buildtime, Runtime, and Script.
If a non-existent tab name is given, a new tab will be created.
toolName
The name of the tool to be associated with the file to open.
Tools can be standalone programs (like CREP, Turbo
Debugger, or an alternate editor), or they can be translators
that are used for each file (or node) in a project. You can also
use the tool name: AddOn. You can run a DOS program with
the Windows IDE transfer. If toolName is not provided, a
default is used.
messageType
The severity to be associated with the message. The values
supported are: .
INFORMATION (default)
WARNING
ERROR
FATAL
parentMessage The message that this message should be stored under. A
value of 0 creates a new top-level message.
fileName
Provides navigation for the message. When the message is
selected, the user will be taken to ~his file.
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lineNumber

Provides navigation for the message. When the message is
selected, the user will be taken to this line in the specified file.

columnNumber Provides navigation for the message. When the message is
selected, the user will be taken to this column in the specified
line of the specified file.
helpFile
Specifies where the user can find Windows Help for the
message. When set to avalid value, the specified helpContext
in this file will display.
helpContext
Specifies where the user can find Windows Help for the
message. When set to a valid value, this help topic in the
specified help file will display.

Return value

The message ID of the generated message

NextWindow.method
Advances focus and activation to the next MDI child window from the
currently selected window.

Types expected

boo I NextWindow(bool priorWindow)

priorWindow

Return value

If TRUE, focus and activation go to the previous window.
priorWindow defaults to FALSE.

TRUE if focus changes to another window, FALSE, otherwise

OptionsEnvironment method
Displays the Environment Options dialog box where you set IDE options.

Types expected
Return value
Description

bool OptionsEnvironmentO

TRUE if the dialog box can be displayed, FALSE, otherwise

OptionsEnvironment corresponds to the Options I Environment command.

OptionsProject method
Displays the Project Options dialog box where you set project options.

Types expected
Return value
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booI OptionsProjectO

TRUE if the dialog box can be displayed, FALSE, otherwise
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Description

OptionsProject corresponds to the Options I Project command.

OptionsSave method
Opens the Options Save dialog box, where you save the contents of the
project and the desktop, the messages in the Message window, and the
Environment settings.

Types expected
Return value
Description

bool OptionsSaveO

TRUE if the dialog can be opened, FALSE if it cannot

OptionsSave corresponds to the Options I Save command ..

OptionsStyleSheets method
Displays the Style Sheets dialog box where you specify default compile and
run-time option settings associated with a project.

Types expected
Return value
Description

boo I OptionsStyleSheetsO

TRUE if the dialog box can be opened, FALSE, otherwise
Style sheets are predefined sets of options tha~ can be associated with a node.

OptionsStyleSheets corresponds to the Options I Style Sheets command.

OptionsTools method
Displays the Tools dialog box where you install, delete or modify the tools
listed on the Tool menu.

Types expected
Return value
Description

bool OptionsToolsO

TRUE if the dialog box can be opened, FALSE, otherwise
The Tool menu lets you run programming tools of your choice without
leaving the Borland C++ IDE.

OptionsTools corresponds to the Options I Tools command.

ProjectAppExpert method
Starts the kppExpert.
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bool ProjectAppExpertO

TRUE if AppExpert was successfully started, FALSE,otherwise

ProjectBuildAIl method
Builds all the files in the current project, regardless of whether they are out of
date.

Types expected

Return value
Description

bool ProjectBuildAII([bool suppressOkay, string nodeName])

suppress Okay

Builds the project without requiring the tIser to respond with
OK to continue.
.

nodeName

The node to build.

TRUE if the build was successful, FALSE, otherwise

ProjectBuildAll:
1 Deletes the appropriate precompiled header (.CSM) file, if it exists.
2 Deletes any cached auto dependency information in the project.
3 Does a rebuild of the node.
If you abort a ProjectBuildAll by pressing Esc or choosing Cancel, or if you get
errors that stop the build, you must explicitly select the nodes to be rebuilt.

ProjectBuildAll corresponds to the Project IBuild All command.

ProjectCloseProject method
Closesthe current project.

Types expected
Return value
Description

bool ProjectCloseProjectO

TRUE if the project was successfully closed, FALSE, otherwise

ProjectCloseProject unloads your current project including all project files
(nodes) and closes the project tree window, if it is open.
ProjectCloseProject corresponds to the Project IClose Project command.

ProjectCompile method
Compiles the current project.
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Types expected

bool ProjectCompile([string nodeName])

nodeName

The name of the node to compile. Compilation depends on the
type of node:
• A .CPP node causes the·C++ compiler to be called.
• A .RC node causes resource compiler to be called.
• An .EXE node causes the linker to be called.
• A .LIB node causes the librarian to be called.
• An .spp node causes the cScript compiler to be called.

Return value

TRUE if the project was successfully closed, FALSE, otherwise

Description

ProjectCompile corresponds to the Project I Compile command.

ProjectGenerateMakefile method
Generates a make file for the current project.

Types expected

bool ProjectGenerateMakefile([string nodeName])

nodeName

Return value
Description

If specified, the generated makefile contains only the
commands necessary to build that node. Otherwise, commands
are generated to build the entire project.

TRUE if the makefile was successfully generated, FALSE, otherwise

ProjectGenerateMakefile generates a makefile for the current project. It gathers
information from the currently loaded project and produces a makefile
named <projectfilename> .MAK. You cannot convert makefiles to project
files.
The IDE displays the new make file in an Edit window.

ProjectGenerateMakefile corresponds to the Project I Generate Makefile
command.

ProjectMakeAlimethod
Makes all targets for the current project, rebuilding only those files that are
out of date.
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Types expected

boo I ProjectMakeAII([bool suppressOkay, string nodeName])

suppressOkay Makes the project without requiring the user to respond with
OK to continue.
nodeName
Makes only the specified node.

Return value
Description

TRUE if the targets were successfully made, FALSE, otherwise

ProjectMakeAll MAKEs all targets. It checks file dates and times to see if they
have been updated. If so, ProjectMakeAll rebuilds those "files, then moves up
the project tree and checks the next nodes' file dates and times.
ProjectMakeAll checks all the nodes in a project and builds all of the out-ofdate files.
The .EXE file name is fully spelled out in the project tree for target names. If
no project is loaded, the .EXE name is derived from the name of the file in the
Edit window.

ProjectMakeAll corresponds to the Project I Make All command.

ProjectManagerlnitialize method
ProjectManagerlnitialize is called once during IDE initialization to ensure that
the IDE Project Manager is in a stable state prior to the occurrence of any
major events, such as the opening of files or creation of new targets.

Types expected
Return value

boo I ProjectManagerlnitializeO

TRUE if the Project Manager has successfully initialized, FALSE, otherwise

ProjectNewProject method
Creates a new project.

Types expected

boo I ProjectNewProject([string pName])

. pName

Return value

If specified, the project is created with pName as its name .
Otherwise, the user is prompted for a project name.

TRUE if the project was successfully created, FALSE, otherwise

, ProjectNewTarget method
Creates a new target for the specified node.
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Types expected

boo I ProjectNewTarget ( [string nTarget, int targetType, int platform, int libraryMask,
int modelOrMode] )

nTarget
targetType

The name of the node.
One of the following target values:
TE_APPLICATION
(default)
TE_DLL

TE_STATICLIB

TE DOSCOM

TE_WINHELP

/-

platform

One of the following .platform values:
TE_WIN32 (default)

libraryMask

TE_EASYWIN

TE_DOSOVERLAY

Indicates which libraries to link. One or more of the
following values:
TE_STDLIBS (default: same as TE_STDLIB_BIDS I
TE_STDLIB_RTL I TE_STDLIB_EMU)
TE_STDLIB_BGI
TE_STDLIB_BWCC

TE_STDLIB_CODEGUARD

TE_STDLIB_COF

TE_STDLIB_CTL3D

TE_STDLIB_EMU

TE_STDLIB_MATH

TE_STDLIB_NOEH
TE_STDLIB_OLE2

~

TE_STDLIB_OWL

TE_STDLIB_RTL
TE_STDLIB_VBX

modelOrMode

One of the following values:
TE_NT_GUI (default if platform is TE_WIN32)
TE_MM_LARGE (default if platform is not TE_WIN32)
TE_MM_TINY

Return value

TE_MM_SMALL

TE_MM_MEDIUM

TE_MM_COMPACT

TE_MM_HUGE

TE_NT_WINCONSOLE

TRUE if the target was successfully created, FALSE, otherwise
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Description

The new node is added to the current project and placed at the bottom of the
project tree. This is created as a stand alone target. You can move it or make it
a child of another node in the project tree by using the Alt+VpArrow /
Alt+DownArrow, or Alt+LeftArrow / Alt+RightArrow keys:

ProjedNewTarget corresponds to the Project I New Target command.

ProjectOpenProject ·method
Displays the Open a Project dialog box, where you select and load an existing
project file.

Types expected

bool ProjectOpenProject([string pName])

pName

If specified, ProjectOpenProject opens the project. If not, it

displays the Open a Project dialog box and prompts the user for
a project name.

Return value
Description

TRUE if the project opened, FALSE, otherwise

You can load and use projects from previous versions of Borland C++ (.PRJ
files for example). If you load an old Borland C++ project, it is converted to
the new project format.

ProjectOpenProject corresponds to the Project I Open Project command.

Quit method
Shuts down the IDE and exits, without saving files or prompting the user.

Types expected
Return value
Description

void QuitO

None
To exit and prompt the user to save changes, use FileExit.

SaveMessages method
Saves the contents of the specified Message window tab page to the specified
file.
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Types expected

bool SaveMessages(string tabName, string fileName)

tabName

One of the following values:
• Buildtime
• Runtime
• Script

Return value

TRUE if the messages are saved, FALSE, otherwise

ScriptCommands method
Displays the Script Commands dialog.

Types expected
Return value
Description

bool ScriptCommandsO

TRUE if the users chooses a command and clicks Run, FALSE, otherwise
The Script Commands dialog lists the currently available script commands
and variables, including classes, functions, and global objects. If an object is
an instance of a class, its properties and methods are also d.isplayed.

ScriptCommands corresponds to the Script ICommands command.

ScriptCompileFile method
Compiles the specified script file.

Types expected

booI ScriptCompileFile(string fileName)

fileName

Return value
Description

The name of the script file to compile.

TRUE if the compile was successful, FALSE, otherwise

ScriptCompileFile corresponds to the Script ICompile File command.

ScriptModules method
Displays the Script Modules dialog box. The dialog box lists the modules
loaded (.spp or .SPX files) and modules in the Script Path.

Types expected
Return value
Description

booI ScriptModulesO

TRUE if a module is selected, FALSE, otherwise

ScriptModules corresponds to the Script IModules command.
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ScriptRun method
Executes the specified script command.

Types expected

boo I ScriptRun(string command)

command

The script command to execute. If no command is given, the
Script Run window is displayed.

Return value

TRUE if the command is executed, FALSE, otherwise

.Description

ScriptRun corresponds to the Script IRun command.

ScriptRunFile method
Executes the specified script file.

Types expected

boo I ScriptRunFile([string fileName])

fileName

Return value
Description

The name of the script file to execute. If no fileName is given,
ScriptRunFile attempts to execute the commands in the current
EditView.

TRUE if a file is executed or an EditView is found, FALSE, otherwise

ScriptRunFile corresponds to the Script I Run File command.

SearchBrowseSymbol method
Searches for the specified symbol.

Types expected

bool SearchBrowseSymbol([string sName])

sName

Return value
Description
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The name of the symbol to search for. If sName is not provided,
the Browse Symbol dialog box is displayed. If sName is not
provided and an edit .window is active, the Browse Symbol
dialog box contains the word at the cursor.

TRUE if the symbol is found, FALSE, otherwise

SearchBrowseSymbolcorresponds to the Search IBrowse Symbol command.
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SearchFind method
Searches the EditBuffer for the specified pattern.

Types expected

bool SearchFind([string pat])

pat

Return value
Description

The string to search for. If pat is found, the cursor is moved to
the occurrence of pat. The pattern can be a simple string or a
search expression.

TRUE if the expression is found, FALSE, otherwise
If the Edit window is active, SearchFind searches the Edit window for pat. If
the Message window is active, Search Find searches the Message window.

SearchFind corresponds to the Search IFind command.

SearchLocateSymbol method
Searches through the current target of the current project for the specified
symbol.

Types expected

bool SearchLocateSymbol([string sName])

sName

Return value
Description

The name of the symbol to search for. If sName is not provided,
the user will be prompted for it.

TRUE if the expression is found, FALSE, otherwise

SearchLocateSymbol uses the Browser's symbol information to locate a
symbol's definition.
On success, SearchLocateSymbol opens the source file and line where the
symbol name sName is defined. If sName is NULL, SearchLocateSymbol rips
the current word out of the editor and searches for that symbol.
SearchLocateSymbol works only with glC?bally defined symbols
For a function symbol, SearchLocateSymbollocates the line where the function
begins. For a class or typedef symbol, it locates the line where the typedef or
class is defined. For a variable, it locates the line where the variable is
defined.
.

SearchLocateSymbol corresponds to the Search ILocate Symbol command.

SearchNextMessage method
Displays an active Edit window and places the cursor on the line in your
source code that generated the next error or warning.
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Types expected
Return value
Description

bool SearchNextMessageO

TRUE if the next message is displayed, or FALSE if there is no message to
display

SearchNextMessage works only if a Message window is displayed and
another message exists.
.
SearchNextMessage corresponds to the Search INext Message command.

SearchPreviousMessage method
Displays an active Edit window and places the cursor on the line in your .
source code that generated the previous error or warning.

Types expected
Return value
Description

bool SearchPreviousMessageO

TRUE if the source line is found, FALSE, otherwise

SearchPreviousMessage works only if a Message window is displayed and a
previous message exists.
SearchPreviousMessage corresponds to the Search IPrevious Message
. command.

Search Replace method
Searches. the EditBuffer for the specified pattern and replaces it with the
specified'string.

Types expected

Return value
Description

bool SearchReplace([string pat, string rep])

pat

The string to search for. The pattern can be a simple string or a
search expression.

rep

The string to replace the found string with.

TRUE if the text is found, FALSE, otherwise
If pat or rep is not specified, SearchReplace opens the Replace Text dialog box
and prompts the user for input.

SearchReplace corresponds to the Search IReplace command.

SearchSearchAgain method
Repeats the last SearchFind or SearchReplace.
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Types expected
Return value
Description

bool SearchSearchAgainO

TRUE if the text is found, FALSE, otherwise

SearchSearchAgain corresponds to the Search I Search Again command.

SetRegion method
Determines how windows tile and cascade on the IDE desktop and their
initial position when they are created.

Types expected

bool SetRegion(string RegionName; int left, int top, int right, int bottom)

RegionName

left, top, right, bottom

Return value
Description

The name of the region to examine. Valid region
names are:
• Breakpoint

• Message

• CPU
• Debugger

• Processes

• Editor

• Stack

• Evaluator

• Thread Count

• EventLog

• Watches

• Project

• Inspector
The dimensions of the window in display units of
1-9999.

TRUE if the region was successfully set, FALSE otherwise

SetRegion is used with the following IDEApplication class methods:
GetRegionBottom
GetRegionTop
GetRegionLeft
GetRegionRight
These methods change the area where windows are placed when tiled and
cascaded.
For example, the default configurati9n of the IDEis to have all Editor
windows in the upper two-thirds of the screen when you tile, and the
Message window and the Project window in the lower one-third. You could
change this default with the script statement
IDE.SetRegion("Editor", 1, 1, 5000,5000);
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After executing this statement, the editors are in the upper left quarter of the
IDE desktop after tiling. Look atSTARTUP.SPP for oth~r examples.

SetWindowState method
Changes the style of the currently focused window.

Types expected

boo I SetWindowState(int desiredState)

desiredState The style to change the window to. One of the following values:
• SW_MINIMIZE
• SW_MAXIMIZE
• SW_RESTORE

Return value

TRUE if the state was successfully set, FALSE, otherwise

SimpleDialog method
Invokes a simple dialog containing a single text field, an OK button, and a
Cancel button.

Types expected

string SimpleOialog(string prompt, string initialValue Lint maxNumChars])

The caption of the dialog.
prompt
The value that initializes the edit field.
initial Value
maxNumChars The maximum number of characters allowed in the edit field.

Return value

The value in the edit field if the user clicks OK or presses Enter, or the empty
string (" ") if the user clicks Cancel.

SpeedMenu method
Activates the SpeedMenu for the current subsystem.

Types expected
Return value

void SpeedMenuO

None

StartWaitCursor method
Displays the Windows wait cursor (by default, the hourglass).
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Types expected
Return value

void StartyvaitCursorO

None

StatusBarDialog method
Displays a dialog on top of the status bar.

Types expected

string StatusBarDialog(string prompt, string initialValue [,int maxNumChars])

prompt
The caption of the dialog.
initial Value
The value that initializes the edit field.
maxNumChars The maximum number of characters allowed in the edit field.

Return value

The value in the edit field if the user clicks OK or presses Ente" or the empty
string (" ") if the user clicks Cancel.

StopBackgroundTask method
Terminates the background task of a compile, link, make or build when the
task is in asynchronous compile mode.

Types expected
Return value

void StopBackgroundTaskO

None

Tool method
Runs the specified tool specified using the specified command string.

Types expected

Return value

bool Tool([string toolName, string commandString])

tooIName

The name of the tool to be associated with the file to open.
Tools can be standalone programs (like GREP, Turbo
Debugger, or an alternate editor), or they can be translators
that are used for each file (or node) in a project. You can run
a DOS program with the Windows IDE transfer. If tooIName
is not provided, a default is used.

commandString

The name of the command to run.

TRUE if the tool successfully ran, FALSE, otherwise
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Description

If no parameters are specified, Tool displays a dialog box prompting the user
for a tool.

Undo method
Undoes the last edit operation.

Types expected
Return value
Description

void UndoO

None

Undo does the same thing as EditUndo. Undo is included for compliance with
Microsoft conventions.

ViewActivate method
Activates the IDE pane that is adjacent to th~ currently selected pane.

Types expected

bool ViewActivate(int direction)

direction

The direction of the. adjacent pane to activate, relative to the
current pane. The supported values are:
UP
DOWN
LEFT
RIGHT

Return value

TRUE if there was a valid current pane and the method was able to activate
an adjacen,t pane in the direction indicated by direction, FALSE, otherwise

ViewBreakpoint method
Opens the Breakpoints window.

Types expected
Return value
Description

boo I ViewBreakpointO

TRUE if breakpoints can be found, FALSE, otherwise

ViewBreakpoint corresponds to the View I Breakpoint command.

ViewCaliStack method
Opens the Call Stack window.
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Types expected
Return value
Description

bool ViewCallStackO

TRUE if the Call Stack window can be displayed, FALSE, otherwise

ViewCallStack corresponds to the View ICall Stack command.

ViewClasses method
Opens the Browsing Objects window, which displays all the classes in your
application.

. Types expected
Return value
Description

bool ViewClassesO

TRUE if the Browsing Objects window can be displayed, FALSE, otherwise

View Classes corresponds to the View IClasses command.

ViewClassExpert method
Displays the ClassExpert window, where you can add and manage classes in
an AppExpert application.

Types expected
Return value
Description

bool ViewClassExpertO

TRUE if the Class Expert can be run or FALSE if it cannot be run (for
example, because the current target was not generated with the AppExpert).

ViewClassEpxert does not work unless the current target is an AppExpert
target.
ViewClassEpxert corresponds to the View IClass Expert command.

ViewCpu method
Opens or selects the CPU window.

Types expected
Return value
Description

boo I ViewCpuO

TRUE if the CPU window can be displayed, FALSE, otherwise

ViewCpu corresponds to the View ICPU command.
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ViewGlobals method
Opens the Browsing Globals window, which lists every variable in the
program in the current Edit window or the first file in the current project.

Types expected

bool ViewGlobals(}

Return value

TRUE if the Browse Globals window can be displayed, FALSE, otherwise

Description

If the program has not been compiled, the IDE must first compile it before

invoking the Browser.

ViewGlobals corresponds to the View I Globals command.

ViewMessage method
Displays the specified page of the Message w,indow.

Types expected

bool ViewMessage([string tabName])

tabName

The name of the Message window page to select. If tabName is
not found, the currently selected tab remains unchanged.
tabNamecan be set to one of the following values:

• Buildtime
• Runtime
• Script
tabName can also be the name of a user-defined tab.

Return value

Description

TRUE if the Message window can be displayed or FALSE if it cannot. If
tabName is not found, the method returns FALSE even if the Message
window is successfully displayed.

ViewMessage corresponds to the View I Message command.

ViewProcess method
Opens the Process window.

Types expected
Return value
Description
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booI ViewProcess(}

TRUE if the Process window can be displayed, FALSE, otherwise

View Process corresponds to the View I Process command.
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ViewSlide method
Moves the border of the currently selected IDE pane the number of specified
characters in the specified direction.

Types expected

bool ViewSlide(int direction [, int amount])

direction

The direction in which to move the border of the currently
selected IDE pane. direction can be one of:

UP
DOWN
LEFT
RIGHT
amount

Return value

The number of characters to move the currently selected IDE
pane. The size of a character is determined by the number of
pixels high and wide a character is inthe font used by the pane.
If amount is not given, the border moves until the user presses
the Enter or Esc keys.

TRUE if there is a valid current IDE pane, and it was successfully moved,
FALSE, otherwise

ViewProject method
Displays the Project window for the currently open project.

Types expected
Return value
De$cription

bool ViewProjectO

TRUE if the Project window can be displayed, FALSE, otherwise
ViewProject corresponds to the View I Project command.

ViewWatch method
Displays the Watches window for the current program.

Types expected
Return value
Description

bool ViewWatchO

TRUE if the Watches window can be displayed, FALSE, otherwise
ViewWatch corresponds to the View I Watch command.
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WindowArrangelcons method
Rearranges any minimized window's icons on the desktop. The rearranged
icons are evenly spaced, beginning at the lower left corner of the desktop. .

Types expected
Return value

bool WindowArrangeleonsO

TRUE if there are icons to rearrange, FALSE, otherwise

DescriptionWindowArrange corresponds to the Window IArrange Icons command.

WindowCascade method
Stacks all open windows and overlaps them, making all windows the same
size and showing only part of each underlying window.

Types expected
Return value
Description

bool WindowCascadeO

TRUE if there are windows to cascade, FALSE, otherwise

WindowCascade corresponds to the Window ICascade command.

WindowCloseAl1 method
Closes all windows of the specified type.

Types expected

bool WindowCloseAII([string typeName])

typeName

The type of window to close. typeName can be one of the
following values:

• Browser
• Debugger
• Editor
If typeName is not specified, WindowCloseAll closes all open windows.

Return value
Description

TRUE if all windows successfully close, FALSE, otherwise

WindowCloseAll corresponds to the Window IClose All command.

WindowMinimizeAIi method
Minimizes all windows of the specified type.
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Types expected

boo I WindowMinimizeAII([string typeName])

typeName

The type of window to minimize. typeName can be one of the
following values:

• Browser
.. Debugger
• Editor
If typeName is not specified, WindowMinimizeAll minimizes all open window.

Types expected
Return value
Description

boo I WindowMinimizeAII([string typeName])

TRUE if all windows successfully minimize, FALSE, otherwise

WindowMinimizeAll corresponds to the Window IMinimize All command.

WindowRestoreAl1 method
Restores all minimized windows of the specified type.

Types expected

boo I WindowRestoreAII([string typeName])

typeName

The type of minimized window to restore. typeName can be one
of the following values:

• Browser
• Debugger
• Editor
If typeName is not specified, WindowRestoreAll restores all minimized
window.

Return value
Description

TRUE if all windows successfully restore or FALSE if at least one does not

WindowRestoreAll corresponds to the Window IRestore All command.

WindowTileHorizontal method
Stacks all open windows horizontally.

Types expected
Return value
Description

boo I WindowTileHorizontalO

TRUE if all windows successfully tile, FALSE, otherwise

WindowTileHorizontal corresponds to the Window ITile Horizontal
command.
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WindowTileVertical method
Stacks all open windows. vertically.

Types expected
Return value
Description

bool WindowTileVerticalO

TRUE if all windows successfully tile, FALSE, otherwise

Window Tile Vertical corresponds to the Window I Tile Vertical command.

YesNoDialog method
Displays a dialog box that prompts the user for a yes or no response.

Types expected

string YesNoDialog(string prompt, string default)

prompt
default

Return value

The prompt that displays inJhe dialog box
The button that is to be selected by default. Valid values are Yes
and No.

Yes or No

BuildComplete event
Raised at the end of a build.

Types expected

Return value

void BuildComplete(bool status, string inputPath, string outputPath)

status

Indicates if the build was successful. status is TRUE if
successful, FALSEif there were errors.

inputPath
outputPath

The source directory.
The directory where files created as a result of the build are
created.

None

BuildStarted event
Raised at the beginning.of a build.

Types expected
Return value
18-54

void BuildCompleteO

None
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DialogCreated event
Raised as new dialogs are presented to the user.

Types expected

void DialogCreated(string dialogName, int dialogHandle)

Return value

dialogName

The name of the dialog's caption.

dialogHandle

An environment-specific identifier used by the system when
referring to the dialog. For Microsoft Windows the
dialogHandle is the HWND of the dialog. This value is
supplied in case you need your script to interact directly with
the system.

None

Description

Use DialogCreated in conjunction with the KeyboardManager.SendKeys method
to simulate user entries to dialogs and drive the dialog.

DialogCreated is only raised if the property RaiseDialogCreatedEvent is set to
TRUE.

Exiting event
Raised as the IDE is closing. Default action is to do nothing.

Types expected
Return value

void ExitingO

N,one

HelpRequested event
Raised when one of the IDEApplication class Help methods is invoked:

Types expected

Return value

void HelpRequested(string fileName, int command, int data)

fileName

The name (with optional path) of the Windows Help file to
open.

Command

A constant representing a command passed to the Windows
Help engine. The command constants begin with HELP_ and are
defined in the C++ header file WINUSER.H. See the Windows
API Reference for details on these constants.

data

The data to display.

None
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.Description

HelpRequested is raised when one of the following IDEApplication class
methods are invoked:
•
•
•
•
•
•
•
•
•

EnterContextHelpMode
Help
HelpAbout
HelpContents
HelpKeyboard
HelpKeywordSearch
HelpOWLAPI
HelpUsingHelp
HelpWindowsAPI

HelpRequested passes the appropriate parameters to the Windows Help
engine. Default action is to do nothing.

Idle event
Raised when the number of seconds specified by IdleTimeout has elapsed
without a significant event occurring (like a user event). Default action is to
do nothing.

Types expected . void IdleO
Return value

None

KeyboardAssignmentsChanging event
Raised when the user exits the Options IEnvironment IEditor dialog after
having modified the keyboard file (.KBD) option.

Types expected

void KeyboardAssignmentsChanging(string newFileName)

newFileName

Return value

The name of the new keyboard (.KBD) file.

None

KeyboardAssignmentsChanged event
Raised after the keyboard file name (.KBD) is changed in the Options I
Environment IEditor dialog.
.

Types expected

void KeyboardAssignmentsChanged(string newFileName)

newFileName
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The name of the new keyboard (.KDB) file.

0 b j e c t S c rip tin 9 Pro 9 ram mer's G u ide

IDE A P PIi cat ion c I ass ,M a k e Com pie tee v e n t

Return value

None

MakeComplete event
Raised at the end of a make.

Types expected

Return value

void MakeComplete(bool status, string inputPath, string outputPath)

status

Indicates if the make was successful. status is TRUE if the make
was successful, FALSE if there were errors.

inputPath
outputPath

The source directory.
The directory where files created as a result of the make are
created.

None

MakeStarted event
Raised at the beginning of a make.

Types expected
Return value

void MakeCompleteO

None

ProjectClosed event
Raised when a project file has been successfully closed.

Types expected

void ProjectClosed(string projectFileName)

projectFileName

Return value
Description

The absolute name of the project file.

None
Since the IDE always has a project open (even if it is the default project:
BCWDEF.IDE), ProjectClosed will always precede the Project Opened that it
corresponds to.

ProjectOpenedevent
Raised when a project file has been successfully opened.

IDEApplication class
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Types expected

void ProjectOpened(string projectFileName)

projectFileName

Return value

The absolute name of the project file.

None

Second Elapsed event
Raised once every second. Default action is to do nothing.

Types expected
Return value

void SecondElapsedO

None

Started event
Raised after the IDE has been loaded and initialized and all startup scripts
have been processed.

Types expected

void Started(bool VeryFirstTime)

VeryFirstTime

Return value

Indicates whether this is the first time the IDE has been
loaded on a particular machine. Its value is determined by
the presence or absence of the default configuration file
(BCCONFIG.BCW). This file is created the first time you run
the IDE and should be present only if the IDE has been run
previously.

None

SubsytemActivated event
Raised when the active subsystem is changed (usually in response to the user
clicking on another window type).

Types expected

void SubsytemActivated(string system Name)

systemName

Return value

18-58

The name of the subsystem acquiring focus. Default action is
to do nothing.

None
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TransferOutputExists event
Raised when a transfer tool has created output that needs processing
(usually in a Make sequence). Default action is to do nothing.

Types expected

bool TransferOutputExists(TransferOutput butput)

output

Return value

The data that needs to be processed by the transfer tool.

FALSE if no error occurred, TRUE if there was an error parsing the data

supplied by output.

TranslateComplete event
Raised at the end of a translation.

Types expected

Return value

void TranslateComplete(bool status, string inputPath, string outputPath)

status

Indicates if the translation was successful. status is TRUE if the
translation was successful, FALSE if there were errors.

inputPath
outputPath

The source directory.
The directory where files created as a result of the translation
are created.

None
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Keyboard class
This class works with the KeyboardManager class to manage keyboards
assigned to various IDE components, such as the Editor and the Project
View.

Syntax

Keyboard([bool transparent])

transparent

Allows keystrokes with no assignment in this keyboard to be
passed to the next keyboard on the current keyboard stack.
This value defaults to FALSE if not supplied.

Properties '
int Assignments

Read-only

string DefaultAssignment

Read-write

Methods
void Assign(string KeySequence, string CommandName, int ImplicitAssignments)
void AssignTypeables(string CommandName)
void Copy(Keyboard SourceKeyboard)
int CountAssignments( string CommandName)
string GetCommand(string KeySequence )
string GetKeySequence(string Command Name Lint whichOne])
bool HasUniqueMapping(string KeySequence)

Key boa r del ass
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void Unassign(string KeySequence)

.Events
None

Keyboard ~Iass description
Keyboard objects administer key assignments and can be:
• Assigned to IDE components
• Pushed and popped from the keyboard manager's keyboard stack
• Queried on individual key assignments

KeyboardManager manipulates Keyboard objects.

Assignments property
Indicates the number of key assignments contained in this keyboard.

Access
Type expected

Read -only
int Assignments

DefaultAssignment property
Establishes the command to execute if no other commands are assigned to a
keystroke. It returns an empty string ("") if no assignment exists.

Access
Type expected

Read-write
string DefaultAssignment

Assign method
Assigns a script to.a keystroke.

19-2
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Types expected

void Assign (string KeySequence, string Command Name, int ImplicitAssignments)

KeySequence

A mnemonic key name made up of a key description,
such as <a>. Key descriptions can be augmented with
any (or all) of the following: Shift, etrl, Alt, and 'Keypad.

CommandName

The script to be executed when the key is pressed, for
exampl~, editor.MarkWord(TRUE)i

implicitAssignments One or more of the following values:
Value

Definition

ASSIGN_EXPLICIT (default)
ASSIGN~IMPLICIT_KEYP AD

No implicit assignments should be created.
When an assignment is made to a sequence that
has a numeric keypad (Keypad) equivalent, such as
Page Up, a second assignment is implicitly made for
the equivalent. Assignments are made to both the
shifted and non-shifted versions at the same time,
but only if the implicit assignment doesn't
overwrite an existing explicit assignment.
<a> == <A>
<Ctrl-k><Ctlr-b> == <Ctrl-k><b>

ASSIGN_IMPLICIT_SHIFT
ASSIGN_IMPLICIT_MODIFIER

Return value
Description

None
Keys that do not map to a single character have names associated with them.
Keys in this category are: Enter, Backspace, Tab, Home, End, Page Up, Page Down,
Left, Right, Up, Down, Insert, Delete, Escape, Space, Print Screen, Center, Pause, CapsLock,
Scroll Lock, and Number Lock.
Modifiers and names are separated by a hyphen (-). For example <Ctrl-Enter>
is valid.
Toassign the dash character in a key sequence, use the keyname <Minus>. Use
the keyname <Plus> for the + character.
The Assign method has no effect on the default keyboard, which is returned
from a call to KeyboardManager.GetKeyboard.

Example

II This example creates an explicit assignment to <Home>.
II It creates an implicit assignment to <Keypad-Home>.
Assign ("<Home>" "ToStart ()
I

-ASSIGN_IMPLICIT_KEYPAD)

i ",

i

II Explicit assignment to <Keypad-End>.
Assign( "<Keypad-End>" "ToEnd() i");
I

II Explicit assignment to <End>
Assign ("<End>" '~ToEnd(TRUE);" ASSIGN_IMPLICIT_KEYPAD);
I

I

II Implicit assignment to <Keypad-End> thwarted due to
II existence of explicit assignment to <Keypad-End>.

Keyboard class
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AssignTypeables method
Assigns a script to the predefined typeable characters.

Types expected

void AssignTypeables(string CommandName)

CommandName

Return value
Description

The command to assign and any parameters to the
command.

None
The AssignTypeables method has no effect on the default keyboard, which is
returned from a call to KeyboardManager.GetKeyboard.
Predefined typeable characters
@

#

')

$

+

%
1

1\

&

'*

2

3
Q

4

5

w

E

}
0

I
p

J

6

7

8

9

R

T

Y

U

w

e

r

t

0
y

P

q

\\

A

s

D

F

G

H

a

s

d

f

g

Z

X

C

V

z

x

c

v

[

K

L

h
B

j

N

M

b

n

ill

0

k

<

>

?

{

u

Other keys include: Enter, Delete and Backspace.

Copy method
Copies all assignments made from SourceKeyboard into this keyboard,
replacing any that already exist.

Types expected

void Copy(Keyboard SourceKeyboard)

Keyboard
SourceKeyboard

Return value
Description

19-4

The name of the keyboard to copy assignments into.
The name of the keyboard from which assignments are to
be copied.

None
The Copy method has no effect on the default keyboard, which is returned
from a call to KeyboardManager.GetKeyboard.
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CountAssignments method
Returns the number of key assignments tied to the specified command.

Types expected

int CountAssignments(string CommandName)

CommandName

Return value

The name of the command in which to count key
assignments.

None

GetCommand method
Returns the command assigned to the specified key code. GetCommand
returns the empty string ("") if no script has been assigned.

Types expected

string GetCommand (string KeySequence )

KeySequence

Return value

The name of the key sequence to check for an assigned
command.

None

GetKeySequence method
Returns the key sequence tied to the specified command.

Types expected

string GetKeySequence(string CommandName Lint whichOnej)

CommandName The name of the command to check for a key sequence.
whichOne

Returnvalue

Finds nth occurrence of that assignment. If less than 1 or
omitted, which One is assumed to be 1.

None

HasUniqueMapping method
Determines if a key:
• Has no mapping
• Maps directly to a command
• Is the non-terminating key of a multikey assignment

Key boa r d c I ass
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Types expected

bool HasUniqueMapping(string KeySequence)

Key Sequence

Return value

The name of the key sequence to check for mapping
assignments.

TRUE if a key either has no mapping or maps directly to a command. FALSE
if the key is a non-terminating key of a multikey assignment.
f

For example, WordS tar <Ctrl":K> would be FALSE since <Ctrl-K> signifies the
beginning of a multikey assignment, such as <Ctrl-K><Ctrl-B> or <CtrlK><Ctrl-K>.

Unassign method
Restores a key assignment.

Types expected

void Unassign(string KeySequence)

Key Sequence

Return value
Description

19-6

The name of the key sequence to restore.

None
The Unassign method has no effect on the default keyboard, which is
returned from a call to KeyboardManager.GetKeyboard.
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KeyboardManager class
This class works with the Keyboard class to manage keyboards assigned to
various IDE components, such as the Editor and the Project view.

Syntax

KeyBoardManagerO

Properties
bool AreKeysWaiting

Read-only

Record CurrentPlayback

Read-only

Record CurrentRecord

Read-write

int KeyboardFlags

Read-only

int KeysProcessed

Read-only

int LastKeyProcessed

Read-only

Record Recording

Read-only

string ScriptAbortKey

Read-write

Methods
string CodeToKey( int KeyCode )
void FlushO
Keyboard GetKeyboard( [string ComponentNamej )
int KeyToCode( string KeyName )
void PausePlaybackO

Key boa r d Man age rei ass
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int Playback( [Record RecordObject] )
Keyboard Pop( string ComponentName )
bool ProcessKeyboardAssignments( string fileName, bool unassign )
void ProcessPendingKeystrokesO
void. Push( Keyboard keyb0ard, string ComponentName, bool transparent)
int ReadChar( void)
void ResumePlaybackO
boo I ResumeRecord( Record RecordObject )
bool SendKeys(string keyStream)
bool StartRecord( Record RecordObject )
void StopRecord( )

Events
None

KeyboardManager class description
You access keyboard features through a keyboard manager, implemented by
the global KeyboardManager object. The keyboard manager manipulates
Keyboard objects (instantiations of the class Keyboard).

KeyboardManager manages individual component keyboards, such ~s that of
the Editor and the Project view. This implementation allows support of
BRIEF functionality through script simulation without predefined classes for
each of the individual IDE components. Each component has a define able
keyboard. The desktop has a keyboard assignment that acts as a global
assignment. If a key is not found in the local keyboard, the desktop keyboard
is searched. If the key assignment is not in the desktop's keyboard, the
default internal mapping is used.
The keyboard manager operates on the assumption of a set context. A
derived class is used in a call to SetContextO to specify the current object to be
used as a local scope. Since different macros may mean different things to
different components, this mechanism provides a simple, straightforward
approach to localizing functionality. For example, classes A and B both have
a member function called SearchO. If class A is the current context, class A's
SearchO member is called. The same goes with class B. If no context is set,
then a global SearchO function is accessed.
The IDE object contains a ReadOnly member that holds the value of the
KeyboardManager. New script instances may be created; however, they will
all reference the same internal data and changes to one will be reflected in all.

20-2

0 bj e c t S c rip tin 9 Pro 9 ram mer's G u ide

Key boa r d M an age rei as s, Are Key s W a i ti n 9 pro per t y

AreKeysWaiting property
TRUE if any keys are waiting to be processed, FALSE otherwise.

Access
Type expected

Read-only
bool AreKeysWaiting

CurrentPlayback property
Plays back the current keystroke assignment. CurrentPlayback is only valid
while the Playback method is active.

Access
Type expected

Read-only
Record CurrentPlayback

CurrentRecord property
Contains a reference to the Record object associated with this
KeyboardManager.

Access
Type expected

Read-write
Record CurrentRecord

KeyboardFlags property
Returns avalue whose bits indicate the state of Num Lock, Caps, Gtr/, Alt and so
on.

. Access
Type expected
Description

Read-only
int KeyboardFlags

The mask values returned are:
Ox03

Shift pressed

Ox04

Gtrl pressed

Ox08

Alt pressed

OxlO

Scroll Lock on

Key boa r d Man age rei ass
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Ox20

Num Lock on

Ox40

Caps Lock on

KeysProcessed property
The total number of keys processed by any keyboard since the IDE was
loaded.

Access
Type expected

Read-only
int KeysProcessed

LastKeyProcessed property
The keycode of the last key that was processed by any keyboard.

Access
Type expected

Read-only
int LastKeyProcessed

Recording property
TRUE if a keys are currently being recorded, FALSE otherwise.

Access
Type expected
Description
Note

Read-only
Record Recording

Only valid while in a StartRecord. Becomes invalid when StopRecord is called.
The return value matches Brief's inq_kbd_flagsO.

ScriptAbortKey property
Contains the key sequence of the key which, when pressed, causes the
currently running script to abort.

Access
Type expected
Description

20-4

Read-write
string ScriptAbortKey

The default value for ScriptAbortKey is <Escape>, except when Epsilon
emulation is enabled in which case the default is <Ctrl-G>.
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Key sequence
The key sequence is a mnemonic key name made up of a key description,
such as <a>. Key descriptions can be augmented with any (or all) of the
following: Shift, Gtrl Alt, and Keypad.
To assign the dash character in a key sequence, use the keyname <Minus>.
Use the keyname <Plus> for the + character.

Key mapping
Keys that do not map to a single character have names associated with them.
Keys in this category are: Enter, Backspace, Tab, Home, End, Page Up, Page Down,
Left, Right, Up, Down, Insert, Delete, Escape, Space, Print Screen, Genter, Pause, Gaps
Lock, Scroll Lock, and Num Lock.
o

Modifiers and names are separated by a dash ( - ). For example,
< Gtrl-Enter>

CodeToKey method
Accepts the integer key code representation.

Types expected

string CodeToKey(int KeyCode)

KeyCode

Return value

An integer representation of a keystroke.

The textual description of the key. It matches the Brief key naming
conventions for inq_assignment andassign_to_key.
.

Flush method
Removes all waiting keystrokes from the IDE message queue.

Types expected
Return value

void FlushO

None

GetKeyboard method'
This method finds the keyboard currently assigned to the IDE subsystem.

Key boa r d Man age r c I ass
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Types expected

Keyboard GetKeyboard ( [string ComponentName] )

ComponentName The name of the IDE subsystem. To return the internal
mapping, specify Default. Note that the default mapping
cannot be remapped. If ComponentName is· omitted, the
method gets the current keyboard. Valid subsystems are:
• Browser

• Editor

• ClassManager

• Message

• Default

• Project

• Desktop

Return value

The keyboard currently assigned to an IDE subsystem, or NULL if the
subsystem is invalid.

KeyToCode method
Converts the name of a key into its integer key code equivalent.

Types expected

int KeyToCode (string KeyName)

keyName

Return value
Description

The textual name of a key.

The integer keycode of the key.

Key To Code accepts single keystroke entries such as <F> and <Ctrl-B>, but not
multikey sequences such as Ctrl+K Ctrl+B.

PausePlayback method
Pauses the playback of a Record object.

Types expected
Return value
Description

void PausePlaybackO

None
For PausePlayback to work, the play back must have been initiated with the
Playback member. To resume playback, call ResumePlayback.

Playback method
Replays the series of keystrokes assigned to a Record object. If no Record
object is specified, the last recording is replayed.

20-6
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Types expected

int Playback ( [Record RecordObject) )

RecordObject

Return value

The name of the Record object from which keys are to be
replayed.

One of the following values:

o

No sequence to play back

1

Playback successful

-1

S~quence

-2

Error loading disk file (macros will handle this)

-3

Canceled by user with ScriptAbortKey

is paused or being remembered

Pop method
Restores the previously assigned keyboard mapping after a call to Push.

Types expected

Keyboard Pop(string ComponentName)

ComponentName

The name of the IDE subsystem whose keyboard you
want to restore. Valid IDE subsystem names are:
• Browser
• ClassManager

• Editor

• Default

• Project

• Message

• Desktop

Return value

The keyboard that was restored or NULL, which indicates that no additional
keyboard mappings were applied and the default keyboard desktop
mapping is active

ProcessKeyboardAssignments method
Converts a .KBD file into a .KBP file.

Types expected

Return value

booI ProcessKeyboardAssignments (string fileName, bool unassign)

fileName

The name of the .KBD formatted file. Includes the path to the
file.

unassign

Specifies if the file contents should be used to unassign keys
defined in the .KBD file. If TRUE, defined keys will be
unassigned. If FALSE, defined keys will be assigned.

TRUE if a .KBP file is loaded, FALSE otherwise.

Key boa r d Man age r c I ass

20-7

KeyboardManager class, ProcessPendingKeystrokes method

Description

ProcessKeyboardAssignments converts a .KBD file into a .KBP file, which is a
preprocessed version of the .KBD file. If the .KBP file exists and is newer than
the .KBD file, the .KBP file will be used without creating another .KBP file.

ProcessPendingKeystrokes method
Fine-tunes the behavior of SendKeys.

Types expected
Return value
Description

void ProcessPendingKeystrokesO

None
If one or more calls to SendKeys indicated that key processing was to be
delayed, these keystrokes are not processed until ProcessPendingKeystrokes is
called or until the script completes execution.

Push method
Pushes a keyboard on the keyboard stack, making the new keyboard
mapping current. A subsequent Pop operation restores the previously
assigned keyboard mapping.

Types expected

void Push ( Keyboard keyboard, string ComponentName, bool transparent)

keyboard

The name of the keybard to push onto the stack.

ComponentName

The name of the IDE subsystem whose keyboard is to be
pushed onto the stack. Valid IDE subsystem names are:

transparent

Return value

• Browser

• Editor

• ClassManager

• Message

• Default

• Project

• Desktop
Determines the run-time behavior of keystrokes not found
in the keyboard. If transparent is set, the next keyboard on
the stack is searched. Otherwise, the key is ignored.

None

ReadChar method
Reads the key that was pressed.

Types expected

20-8

int ReadChar( void)
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Return value

This method returns either -1 (no key is waiting) or the scan value for the key
that was pressed. The high-order byte is the scan code, and the low-order
byte is the AS~II value.

Description

ReadChar manages two queues, a local queue for Push and the queue for the
standard Windows messaging system. It first checks the local queue for any
waiting keys. If no keys are available in the local queue, it checks the
Windows me~sage queue.

ResumePlayback method
Resumes the playback of a Record object.

Types expected
Return value
Description

void ResumePlaybackO

None
For ResumePlayback to work, the playback must be initiated with the Playback
member after suspending the recording with a call to PausePlayback.

ResumeRecord method
Initiates record mode on a Record object.

Types expected

bool ResumeRecord ( Record RecordObject )

RecordObject

Return value
Description

The name of the Record object to continue recording.

TRUE if is able to resume recording, FALSE otherwise.

New keystrokes are appended to the end of the record buffer. The Recording
member is updated.

Send Keys method
Simulates the pressing of the keys indicated in the keyStream parameter.

Key boa r d Man age r c I ass
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Types expected

bool SendKeys(string keyStream[, boo I suppresslmmediateProcessing])

keystream

A series of key presses. The limit on the
number of characters in Windows 95 is 715.
There is no limit in Windows NT.

suppresslmmediateProcessing

The default behavior is to process the keys
immediately, before the next line of script is
processed. If you include this parameter and
set it to TRUE, SendKeys delays processing of
the keys until ProcessPendingKeystrokes is
called or until the script completes execution.

Return value. TRUE if keyStream has valid syntax and can be interpreted or FALSE if
keyStream could not be, turned into a series of key presses.
Description

SendKeys takes a key or series of keys as its parameter.
Simple displayable keys are just a string of characters that are the same as the
keycaps. For example, the following is valid:
SendKeys ("hello world");

There are two separate keyboard parsers: one for processing key
assignments and the other for processing SendKeys. These processors accept
different formats for the same keys. For example, <Alt-a> is the same as %a.
It is possible, though not probable, to accidentally send a key sequence to

another application besides Borland C++ with SendKeys. This can occur if
SendKeys is executed while BCW.EXE is not active. For.example, if SendKeys
is called by a timer event or while a user is in the process of task switching,
the key sequence could be sent to another application.

Alt, Sh ift and Ctrl keys
Keys that do not have simple displayable counterparts, like Alt+S, have a
special syntax.
The following table shows how to indicate Alt+keyname, Shift+keyname and
Gtrl+keyname:
~ey

Descripti.on

Example

Alt key modifier

Preface the key name with the percent
character (%).
Either preface the key name with the plus
character (+ ) or capitalize it.
Preface the key name with the carat
character (/\ ).

Alt+s is %s.

Shift key modifier
Gtrlkey modifier

Note
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Shift+s is either +s or S
Gtrl+s is /\s.

The SendKeys parameter is case-sensitive. /\s is Gtrl+S, but /\S is Gtrl+Shift+S.
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0/0, + and 1\ keys
To indicate the %, + and
below. To indicate:

A

key, precede the key name with a backslash (\) as

%, use +\ \ %
A,

use + \ \ A

+, use +\ \+

Non-displaying keys
To simulate non-displaying keys, use a key mnemonic and enclose it in
braces ({ }).
For example, to simulate the key sequence Alt+s 1 + 2 [Enter], use the following
syntax:
SendKeys ("%sl \ +2 {VK_RETURN} " ) i

Example

/ /Example

of SendKeys

x = new KeyboardManager()i
/* Sends Ctrl+S and processes it immediately
x. SendKeys (""S") i
/* Sends Ctrl+S and processes it immediately
z .SendKeys (""S" FALSE) i
I

/* Sends Ctrl+S and delays processing
x.SendKeys (" ... " TRUE) i
I

/* Processes the delayed keystrokes
x.ProcessPendingKeystrokes() i

Key mnemonics
VK_ADD

VK_F12

VK_NUMPAD2

'VK_BACK

VK_F13

VK_NUMPAD3

VK_CAPITAL

VK_F14

VK_NUMPAD4

VK_CANCEL

VK_F15

VK_NUMPAD5

VK_CLEAR

VK_F16

VK_NUMPAD6

VK_CONTROL

VK_F17.

VK_NUMPAD7

VK_DECIMAL

VK_F18

VK_NUMPAD8

VK_DELETE

VK_F19

VK_NUMPAD9

VK_DIVIDE

VK_F20

VK_PAUSE

VK_DOWN

VK_F21

VK_PRINT

VK_END

VK_F22

VK_PRIOR

VK_ESCAPE

VK_F23

VK_RBUTTON

Key boa r d Man age r c I ass
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VK_EXECUTE

VK_F24

VK_RETURN

VK_Fl

VK_HELP

VK_RIGHT

VK_F2

VK_HOME

VK_SCROLL

VK_F3

VK_INSERT

VK_SELECT

VK_F4

VK_LBUTTON

VK_SEPARATOR

VK_FS

VK_LEFT

VK_SHIFT

VK_F6

VK_MBUTTON

VK_SNAPSHOT

VK_F7

VK_MENU

VK_SPACE

VK_FS

VK_MULTIPL Y

VK_SUBTRACT

VK_F9

VK_NUMLOCK

VK_TAB

VK_FlO

VK_NUMPADO

VK_NEXT

VK_Fll

VK_NUMPADI

VK_UP

StartRecorci method
Begins storing keystroke sequences in a Record object. Updates the Recording
member.

Types expected

boo I StartRecord ( Record RecordObject )

RecordObject

Return value
Description

The name of the Record object in which keys are to be recorded.

TRUE if the key sequence is stored, FALSE otherwise.

StartRecord replaces .any key sequences already stored in the Record object.
You can record to only one Record object at a time. If you attempt a
StartRecord before calling a matching StopRecord for a previous riecording, the
StartRecord fails.

StopRecord method
Halts recording keystrokes previously started with StartRecord.

Types expected
Return value
Description
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void Stop Record ( )

None

StopRecord updates the CurrentRecord member and updates the Recording
member to FALSE.
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ListWindow class
The Lis tWin dow class implements and manages list windows.

Syntax

ListWindow(int Top; int Left, int Height, int Width, string Caption, bool MultipleSelect, bool Sorted,
string[] InitialValues)

Top, Left, Height, Width Initial coordinates of the list.
Caption
Text to be displayed in the list title.
MultipleSelect
Determines whether the list will support multiple
selections.

Sorted

Determines whether new additions to the list are put
in their sorted order.

InitialValues

An array of strings specifying the initial contents of
the list.

Properties
string Caption

Read-write

int Count

Read-only

int Currentlndex

Read-only

[]Data

Read-only

int Height

Read-write

boo I Hidden

Read-write

bool MultiSelect

Read-only

ListWindow class
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boo I Sorted

Read-only

int Width

Read-write

Methods
void Add(string newEl, int offset)
void ClearO
void CloseO
void ExecuteO
int FindString(string toFind)
string GetString(int offset)
void InsertO
boo I Remove(int offset)

Events
void AcceptO
void CancelO
void ClosedO
void DeleteO
bool KeyPressed(string keyName)
void LeftClick(int xPos, int yPos)
void MoveO
void RightClick(int xPos, int yPos)

ListWindow class description
ListWindow objects create a list window. A list window is a list view that
displays a list of selectable items. ListWindow objects control:

•
•
•
•
•

21-2

The size and position of the list
The contents of the list
The number of items in the list
Finding and getting strings in the list
Opening and closing the list
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Caption property
The title of the list· window.

Access

Read-write

Type expected

string Caption

Count property
The number of elements in the list.

Access
Type expected

Read-only
int Count

Currentlndex property
Contains the zero-based index of the currently highlighted list element, or -1
if nothing is selected.

Access
Type expected

Read-only
int CLirrentlndex

Data property
Contains an array of strings that represent the contents of the list.

Access
Type expected

Read-only
[]Data

Height property
Contains the height of the list window in pixels.

Access
Type expected

Read-write
int Height

Lis t Win dow c I ass
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Hidden property
Determines whether the list window can be removed from the display.

Access
Type expected
Description

Read-write
bool Hidden

Hidden only has meaning after the Execute method has been called and before

the list window is closed.

'

MultiSelect property
If TRUE,allows multiple selections from the list. If FALSE, only a single
selection can be made.

Access
Type expected

Read-only
booI MultiSelect

Sorted property
If TRUE, the elements in the list are sorted as new elements are added. If
FALSE, elements appear at the offset given in the call to the Add method.

Access
Type expected

Read-only
booI Sorted

Width property
Contains the width of the list window in pixels.

Access
Type expected

Read-write
int Width

Add method
Adds the string newEl to the list at the position designated by offset.
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Types expected

void Add(string newEl, int offset)

newEl
offset

Return value
Description

The string to add to the list.
The position to add the string to. offset is zero-based. offsetshould
not be higher than Count, or else the new element will not appear
in the list. offset is ignored if the list is sorted.

None

Add only has an effect after the ListWindow has been opened using the
Execute method.

Clear method
Removes all elements from the list.

Types expected . void ClearO
Return value

None

Close method
Removes the ListWindow from the screen.

.Types expected
Return value

void CloseO

None

Execute method
Creates and displays the ListWindow.

Types expected
Return value

void ExecuteO

None

FindString method
Finds the specified string.

Types expected

int FindString(string toFind)

stringToFind

The string to find.

Lis t Win dow c I ass
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Return value
Description

The. one-based offset of the string or zero if not found.

FindString only has an effect after the ListWindow has been opened using the
Execute method.

GetString method
Returns a string.

Types expected

string GetString(int offset)

offset

Return value

The location of the string to get.

The string at the specified offset or " " if the offset is illegal.

Insert method
Invoked when the user presses Insert. The default action is to do nothing.

Types expected

void InsertO

Return value

None

Remove method
__ Removes the element from the specified offset.

Types expected

bool Remove(int offset)

offset

Return value
Description

The position to remove the string from. offset is zero-based.

TRUE if the element was removed, FALSE otherwise.

Remove only has an effect after the ListWindow has been opened using the
Execute method.

Accept event
Raised when the user presses Enter or double-clicks on a list element. Default _
action is to close the list.

Types expected

21-6

void AcceptO
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Return value

None

Cancel event
Raised when the user presses Escape. Default action is to close the list.

Types expected

void CancelO

Return value

None

Closed event
Raised when the ListWindow is destroyed.

Types expected

void ClosedO

Return value

None

Delete event
Raised when the user presses Delete. Default action is to do nothing.

Types expected
Return value

void DeleteO

None

KeyPressed event
. Raised when the user presses a key other than Delete, Insert,· Accept, or Gancel.

Types expected

bool KeyPressed(string keyName)

keyName

Return value

Indicates a key in the standard key format «a>or <Gtrl-a».

TRUE indicates that the script has processed the key and that no further
processing is desired; FALSE indicates that normal processing should take
place.

LeftClick event
Raised when the user left-clicks the ListWindow.

ListWindow class
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Types expected

void LeftClick(int xPos, int yPos)

xPos
yPos

Return value

The x-position of the mouse at the time of the left-click.
The y-position of the mouse at the time of the left-dick.

None

Move event
. . Raised when the selection in the list is changed. Default action is to do
nothing.

Types expected
Return value

void MoveO

None

RightClickevent
Raised when the user right-clicks the ListWindow.

Types expected

void RightClick(int xPos, int yPos)

xPos
yPos

The x-position of the mouse at the time of the right-click.
The y-position of the mouse at the time of the right-click.

Return value· None

21-8
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PopupMenu class
The PopupMenu class manages pop-up menus. In the Borland C++ IDE, popup menus are known as SpeedMenus.

Syntax

PopupMenu(int Top, int Left, string [] InitialValues)

Top, Left

Initial coordinates of the pop-up menu.

InitialValues An array of strings specifying the initial contents of the pop-up
menu.

Properties
[] Data

Read -only

Methods
void Append(string newChoice)
int FindString(string toFind)
string GetString(int offset)
boo I Remove(int offset)
string TrackO

Events
None

PopupMenu class
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PopupMenu class description
PopupMenu objects create create a pop-up menu. A pop-up menu pops up,
and displays a list of menu choices. PopupMenu objects control:
•
•
•
•
•

The size and position of the pop-up menu
The contents of the pop-up menu
The number of itePls in the pop-up menu
Finding and getting strings in the pop-up menu
Opening and closing the pop-up menu

Data property
Contains an array of strings that specifies the choices that will be offered on
the pop-up menu.

Access
Type expected

Read-only

[] Data

Append method
Appends a new choice to the pop-up menu.

Types expected

void Append(string newChoice)

newChoice

Return value

The name of the new menu choice.

None

FindString method
Looks for the specified menu choice.

Types expected

int FindString(string toFind)

toFind

Return value

The name of the string to find.

The one-based offset of the string found or zero if not found.

GetString method
Returns a menu choice.

22-2
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Types expected

string GetString(int offset)

offset

Return value

The location of the string to get. offset is zero-based.

The string at the specified offset or "" if the offset is illegal.

Remove method
Removes the specified menu choice.

Types expected

bool Remove(int offset)

offset

Return value

The location of the menu choice to remove. offset is zero-based.

TRUE if the element is removed, FALSE, otherwise.

Track method
Displays the pop-up menu to the user and tracks responses.

Types expected
Return value

string TrackO

The string selected orthe empty string ("") if the user cancels the menu.

Pop u PMen u c I ass
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ProjectNode class
Manages the nodes of a project.

Syntax

ProjectNode(nodeName, EditView associatedView)

nodeName

A string indicating the full name of the node (as in
MyProg.exe). If no name is specified, ProjectNode uses the
top level IDE node.

associated View

associated View is optional. If given and if the specified
view is associated with a particular project node, the node
that represents the EditView is used and nodeName is
ignored. To associate an Edit View with a ProjectNode,
create the EditView. (To create an EditView, double-click
the node or press Enter in the Project window.)

Properties
[] Child Nodes

Read-only

string IncludePath

Read~only

string InputName

Read-only

boo I IsValid

Read-only

string LibraryPath

Read-only

string Name

Read-only

booI OutOfDate

Read-write

string OutputName

Read-only

Pro j ec t Nod eel ass
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string Source Path

Read-only

string Type

Read-only

Methods
bool Add(string nodeName [, string typel)
bool Build(bool suppressUI)
bool Make(bool suppressUI)
void MakePreviewO
bool Remove([string nodeName])
bool Translate(bool suppressUI)

Events
void Built(bool status)
void Made(bool status)
void Translated(bool status)

ProjectNode class description
Each node has its own ProjectNode class instance. ProjectNode class members:
•
•
•
•
•
•
•

Display child nodes
Indicate the node's source, input, output, and library source paths
Indicate if a specified node is valid
Indicate the type of node
Add nodes to and removes nodes from a project
Build or make a node
Translate a node

ChiidNodes property
Indicates all the child nodes of the current node.

Access

Read-only

Type expected

[] ChildNodes

Description

23-2

ChildNodes consists of an array of strings containing the InputNames of the
child nodes.
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IncludePath property
Indicates the path to use for include files for the currently loaded project.

Access
Type expected

Read-only
string IncludePath

InputName property
The node's relative path name of the input file including extension, as in
Myfile.cpp or SOURCE \ MYFILE.CPP.

Access
Type expected

Read-only
string InputName

IsValid property
Indicates whether a node is valid.
Note

Access
Type expected

A node becomes invalid if the project file it is associated with is closed or if
the node is deleted.
Read-only
boollsValid

LibraryPath property
Indicates the path to use for libraries for the currently loaded project.

Access
Type expected

Read-only
string LibraryPath

Name property
Indicates the node's relative path name with an extension, as in Myfile.cpp or
SOURCE \ MYFILE.CPP.
.

Access

Read-only

Pro j ec t Nod e c I ass
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Type expected

string Name

OutOfDate property
Can be checked, or set, to determine the date ofa node.

Access
Type expected
Description

Read-write
boo I OutOfDate

OutOfDate is used by the Make engine to determine if a node needs to be
rebuilt.

OutputName property
Indicates the relative path name of the output file including extension, as in
MYFILE.CPP or Source \ Myfile.cpp.

Access
Type expected
Description

Read -only
string OutputName

You can always generate the absolute file name by prepending the result of
IDEApplication.CurrentDirectory to InputName, as in:
absName

= IDE.CurrentDirectory

+

node.lnputName;

SourcePath property
Indicates the path where the source files for the currently loaded project
reside.

Access
Type expected

Read-only
string SourcePath

Type property
Indicates the type of node (.CPP, .H, SourcePool, .LIB, and so on).

Access
Type expected

23-4

Read-only
string Type
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Description

When the node is invalid, Type contains the empty string ("11).

Add method
Adds a node to this project node.

Types expected

boo I Add(string nodeName [, string type])

nodeName
type

Return value

The name of the node to add.
The type of the node, such as .CPP, .DEF or .~C. If type is
omitted, it is derived from the nodeName.

TRUE if the node is added, FALSE, otherwise

Build method
Causes the node to be built, made, or translated by the IDE's Make engine
according to the rules of the node.
.

Types expected

boo I Build(bool suppressUI)

suppressUI

Return value

If TRUE, the build status dialog will notbe displayed during
the build process.

TRUE if the node is built successfully, FALSE, otherwise.

Make method
Causes the node to be built, made, or translated by the IDE's Make engine
according to the rules of the node if the node's OutOfDate property is TRUE.

Types expected

bool Make(bool suppressUI)

suppressUI

Return value

If TRUE,the build status dialog will not be displayed during
the build process.

TRUE if the node is made successfully, FALSE, otherwise

MakePreview method
Provides information about what files will be processed if you Make or Build
this node.

Type,S expected

void MakePreviewO
Pro j e c t Nod e c I ass
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Return value
Description

None

MakePreview performs the same dependency checks as a make and generates
a report to the Message window listing the nodes that need to be rebuilt to
keep the project up to date.

Remove method
Removes the node from the project, if the name of the node is specified.

Types expected

bool Remove([string nodeName])

nodeNanie

Return value

The name of the node to remove from the project. If nodeName is
not specified, Remove removes this node from the project.

TRUE if the node is removed, FALSE, otherwise

Translate method
Causes the node to be built, made, or translated by the IDE's Make engine
according to the rules of the node.

Types expected

boo I Translate(bool suppressUI)

suppressUI

Return value

If TRUE, the build status dialog will not be displayed during
the build process.

TRUE if the node is translated successfully, FALSE, otherwise

Built event
Raised after a build has been performed on the node. The event's default
behavior is to do nothing.

Types expected

void Built(bool status)

status

Return value

23-6

Describes the result of the build. status is set to TRUE if the
build completed successfully or with warnings, and FALSE if
there were errors.

None
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Made event
Raised after a make has been performed on the node. The event's default '
behavior is to do nothing.

Types expected

void Made(bool status)

status

Return value

Describes the result of the build. status is set to TRUE if the
build completed successfully or with warnings, and FALSE if
there were errors.

None

Translated event
Raised after a translate has been performed on the node. The event's default
behavior is to do nothing.

Types expected

void Translated(bool status)

status

Return value
Description

Describes the result of the build. status is set to TRUE if the
build completed successfully or with warnings, and FALSE if
there were errors.

None
When the user performs a make or a build, the ProjectNode object receives a
Translated event before it receives the Built or Made event.

Pro j e c t Nod e c I ass
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Record class
Creates an empty Record object into which keystrokes are saved.

Syntax

Record([string RecordName])

RecordName The name of the Record object. If RecordName is not specified, a
default name is automatically assigned ("Recordl", "Record2",
and so on).

Properties
boo I IsPaused

Read-only

bool IsRecording

Read-only

int KeyCount

Read-only

string Name

Read-write

Methods
void Append( int KeyCode )
string GetCommand( int offset)
int GetKeyCode( int offset)
Reco.rd Next( void )

Events
None

R e cor del ass
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Record class description
Because Record objects can be built programatically (outside the context of
the keyboard manager), recordings can be saved to disk and restored, and
keyboard sequences can be simulate,!: through script.

KeyboardManager can also be used for key recording.
KeyboardManager.StartRecord and KeyboardManager.StopRecord members
populate a Record object with key sequences. An unlimited number of Record
objects can be named and iterated.

IsPaused property
TRUE when KeyboardManager.PauseRecording is called in order to allow users
to enter keystrokes that will not become part of the recording. FALSE

otherwise.

Access

Read-only

Type expected

bool IsPaused

IsRecording property
TRUE when the KeyboardManager begins storing keystrokes to the Record
object in response to a call to KeyboardManager.StartRecord. FALSE otherwise.

Access
Type expected

Read-only
bool IsRecording

KeyCount property
The number of keystrokes stored in this Record object.

Access

Read-only

Type expected

int KeyCount

Name property
The name of the Record object. This is a read-write property.

Type expected

24-2

string Name
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Append method
Appends akeycode to the record buffer.

Types expected

void Append(int KeyCode)

keyCode

Return value
Description

The keycode to append.

None

Append allows empty Record objects to be built prognlmatically or added to
through a script.

GetCommand method
Returns information describing a key stored in the Record object.

Types expected

string GetCommand(int offSet)

offSet

Return value

Description
Note

The offset to examine.

Because the meanings of the stored keystrokes can be altered by the
execution of the recording, the information returned is transitory. For
example, if the recording switches to another subsystem with a different key
map, the stored keystrokes would be different than expected. The return
values reflect the values as of the last run.

GetCommand is intended to be used after a Record object has been executed.
Keys are stored in the order which they are recorded. The first key in the
recording is at offset O.

GetKeyCode method
This method returns information describing a key stored in the Record object.
,Note

Types expected

Keys are stored in the order which they are recorded. The first key in the
recording is at offset O.
int GetKeyCode(int offset)

offSet

Return value

The offset to examine.

The keystroke of the key at the specified offset, or zero if the offset is illegal.

Re cor d c I ass
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Next method
As Record objects are created, they are automatically linked together. This
method provides a mechanism for iterating the recordings.

Types expected
Return value

24~4

Record Next(void)

The next Record object or NULL indicating the end of the list.
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ScriptEngine class
A ScriptEngine object is responsible for carrying out the action in script files.

Syntax

ScriptEngineO

Properties
boo I AppendToLog

Read-write

int DiagnosticMessageMask

Read-write

boo I DiagnosticMessages

Read-write

string Log FileName

Read-write

bool Logging

Read-write

string ScriptPath

Read-write

string StartupDirectory

Read-only

Methods
int Execute(string commandLine, bool temporary)
string Execute(string command Line, boo I temporary)
boo I IsAClass(string class Name)
boo I IsAFunction(string functionName)
boollsAMethod(string className, string methodName)
bool IsAProperty(string className, string propertyName)
bool IsLoaded(string scriptFileName)

S c rip tEn gin eel as s
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boo I Load(string scriptFileName)
[] Modules(bool libraryOnly)
boo I Reset(int resetWhat)
void SymbolLoad(string fileName, string symbols)
bool Unload(string scriptFileName)

Events
void Loaded(string scriptFileName)
void Unloaded(string scriptFileName)

ScriptEngine class description
A ScriptEngine object loads, unloads, executes, maintains modules and keeps
error information on scripts. A ScriptEngine object can be created in any
script; however, a system wide instance exists.
To create a local instance of a ScriptEngine object, use the following syntax:
declare ScriptEngine scriptEngine;

Once this statement is in your script file, you can use the ScriptEngine object
as in the following example:
Function ( )
(

scriptEngine.Load("ascript") ;

To reuse the system wide instance, include the following statement in your
script file:
import scriptEngine;
Note

Declaring the script engine locally provides slightly better performance than
importing it.

AppendToLog property
Determines whether the next message logged to the log file name should
replace an existing log file (if one exists) before performing the write.

Access
Type expected

25-2

Read-write
bool AppendToLog
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Description

AppendToLog is used when Logging is on. Once the write is completed,
AppendToLog is set to TRUE, causing subsequent messages to be appended to
the log.

DiagnosticMessageMask property
Controls which types of diagnostic messages to record.

Access
Type expected
Description

Read-write
int DiagnosticMessageMask

DiagnosticMessageMask can be any combination of:
•
•
•
•
•
•
•
•

OBJECT_DIAGNOSTICS
METHOD_DIAGNOSTICS
MEMBER_DIAGNOSTICS
ARGUMENT_DIAGNOSTICS
LANGUAGE_DIAGNOSTICS
MODULE_DIAGNOSTICS
FULL_DIAGNOSTICS
NO_DIAGNOSTICS

DiagnosticMessages property
Controls whether diagnostic messages should be recorded in the Message
window.

Access
Type expected

Read-write
bool DiagnosticMessages

LogFileName property
The name of the log file. Defaults to \SCRIPT.LOG.

Access
Type expected

Read-write
string Log FileName

Logging property
If TRUE, script messages will be stored in the log file.
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Access
Type expected

Read-write
bool Logging

ScriptPath property
Holds a string containing the names of the one or more directories to search
for script files. Each directory path is separated from the others by a
semicolon (;).

Access
Type expected

Read-write
string ScriptPath

StartupDirectory property
The name of the directory in which the file STARTUP.SPX was found during
initialization.

Access
Type expected

Read-only
string StartupDirectory

Execute method
Executes the specified command.

Types expected

int Execute(string commandLine, boo I temporary)
string Execute(string command Line, boo I temporary)

commandLine

The command to execute. commandLine must be a
valid cScript command.

temporary

If temporary is TRUE, the command is run within
a new context and must use import to access

global variables declared in another module. Any
global variables it creates will be used for the
purposes of the command and then discarded.
If temporary is FALSE (the default), the command

is executed with the scope of Immediate mode
and has automatic access toglobals from other
modules. In this case, any variables created by the
command continue to exist after the command
has run and can be accessed from Immediate
mode.
25-4
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Return value

The value appropriate to whatever commandLine evaluates to. If that value is
an object, it is converted to a string

IsAClass method
Determines if cScript has seen the class declaration for the specified class.

Types ~xpected

boollsAClass(string className)

className

Return value

The name of the class. IsAClass searches for declaration of this
class.

TRUE if instances of the class can be constructed, FALSE, otherwise

IsAFunction method
Determines if cScript has seen the function declaration for the specified
function.

Types expected

boollsAFunction(string function Name)

functionName

Return value

The name of the function. IsAClass searches for declaration
of this function.

TRUE if the function can be called, FALSE, otherwise

IsAMethod method
Determines if the specified class has as a method with the specified name.

Types expected

Return value

boollsAMethod(string className, string methodName)

className

The name of the class. IsAClass searches in this class for
the method specified in methodName.

methodName

The name of the method to search for.

TRUE if the method is a member of the class, FALSE, otherwise

IsAProperty method
Determines if the specified class has as aproperty with the specified name.
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Types expected

Return value

boollsAProperty(string className, string propertyName)

className

The name of the class. IsAClass searches in this class for the
property specified in propertyName.

propertyName

The name of the property to search for.

TRUE if the property is a member of the class, FALSE, otherwise

IsLoaded method
Determines whether the specified script file has been loaded, or if the file
(either the source or the binary) can be found in the ScriptPath.

Types expected

boollsLoaded(string scriptFileName)

scriptFileName

Return value

The naJ:ne of the script file to load.

TRUE if the file is loaded or can be loaded, FALSE, otherwise

Load method
Loads the specified scriptfile. If not already loaded, the file (either the source
or the binary) is searched for using the ScriptPath.

Types expected

bool Load(string scriptFileName)

scriptFileName

Return value
Description

The name of the script file to load.

TRUE if the script was located and loaded, FALSE if the script file was not
found
If the script file to be loaded has already been loaded into memory, Load

performs an in-place Reset. (The module's position in the module chain is not
affected, but all its variables are restored to their original state.) .
The on handlers are disconnected or reconnected. All variables local to the
module are released and reset. Any code at the module level scope is
executed again.

Modules method
Finds all the loaded modules.

25-6
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Types expected

[] Modules(bool MbduleName)
ModuleName

One of the following:
• SCRIPT_MODULES
For all modules
• LIBRARY_MODULES For only library modules

Return value

An array of strings containing the names of the loaded modules

Reset method
Resets the script session by discarding all modules that match the specified
value. If no value is supplied, the method does nothing.

Types expected

bool Reset(int resetWhat)

resetWhat

Return value

The module to reset. Can be either LIBRARY_MODULE or
SCRIPT_MODULE

TRUE if the session is reset, FALSE, otherwise

SymbolLoad method
Provides hints about where the definition of a given symbol might be. For
example:
SymbolLoad("ScriptFile", "Faa, Bar, jump")

Types expected

Return value
Description

void SymbolLoad(string fileName, string symbols)

fileName

A script file that should be loaded if the lookup for any of the
listed symbols fails.

symbols

A comma delimited string of the symbols which may be
resolved by loading fileName.

None
At run time when the Script Engine tries to find a class, function, method, or
global variable that it doesn't know about, it consults an internal table
constructed by calls to this method.

Unload method
Tries to unload the specified script file. Future references from other scripts
to variables, functions or classes defined in the unloaded script file are no
longer valid.
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Types expected

boo I Unload(string scriptFileName)

scriptFileName

Return value

The name of the script file to unload.

FALSE when the script file is not found to have been loaded, TRUE,
otherwise

Loaded event
Raised whenever a new script module is successfully loaded.

Types expected

void Loaded(string scriptFileName)

scriptFileName

Return value

The name of the script file that was loaded.

None

Unloaded event
Raised when when a module has been unloaded.

Types expected

void Unloaded(string scriptFileName)

scriptFileName

Return value

25-8

The name of the script file that was unloaded.

None
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SearchOptions class
The Search Options class members search for text and error locations in your
. script file.

Syntax

SearchOptionsO

Properties
bool CaseSensitive

Read-write .

boo I FromCursor

Read-write

boo I GoForward

Read-write

bool PromptOn Replace

Read-write

bool RegularExpression

Read-write

boo I ReplaceAIi

Read-write

string ReplaceText

Read-write

string SearchReplaceText

Read-write

string SearchText

Read-write

boo I Whole File

Read-write

bool Word Boundary

Read-write

Methods
void Copy(SearchOptions optionsToCopyFrom)

Sea r c hOp t ion sci ass

26-1

SearchOptions class, SearchOptions class description

Events
None

SearchOptions class description
SearchOptions class members search and replace occurrences of text strings.
SearchOptions class members allow:
•
•
•
•
•
•
•

Case sensitive searching
Searching from the current cursor position
Searching forward or backward in the file
Confirmation before text replacements
Use of regular expressions in the search
Replacement of all matching text
Searching and replacing in the same operation

CaseSensitive property
If TRUE, a case-sensitive search is performed.

Access
Type expected

Read-write
boo I CaseSensitive

FromCursor property
If TRUE, the search is made from the current cursor position.

Access
Type expected

Read-write
bool FromCursor

GoForward property
If TRUE, the search is "forward" towards the end of the file.

Access
Type expected

26-2

Read-write
boo I GoForward
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PromptOnReplace property
If TRUE, you are prompted (before a replacement is made) to confirm each
instance where the SearchReplaceText will be replaced by the ReplaceText.

Access
Type expected

Read-write
bool PromptOn Replace

RegularExpression property
If TRUE, regular expressions are used in matching the SearchText or
SearchReplaceText with the text to be searched.

Access
Type expected

Read-write
boo I RegularExpression

ReplaceAIi property
If TRUE, all text which matches the SearchReplaceText is replaced with the
ReplaceText without any prompting for confirmation.

Access
Type expected

Read-write
bool ReplaceAIi

ReplaceText property
Contains text which replaces instances of the SearchReplaceText string(s)
found in the text being searched.

Access
Type expected

Read-write
string ReplaceText

SearchReplaceText property
Contains the text to search for in a search and replace operation (not a searchonly operation).

Access

Read-write
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Type expected

string Search ReplaceText

SearchText property
Contains the text to search for in a search operation (not a search and replace
operation).

Access
Type expected

Read-write
string SearchText

WholeFile property
If TRUE, the whole file is searched for Search Text or SearchReplaceText,
regardless of the cursor position.

Access

Read-write

Type expected

bool Whole File

WordBoundary property
If TRUE, a match between SearchText or SearchReplaceText and the text being
searched only occurs if the characters in SearchText make up "an entire word
(that is, they are surrounded by whitespace) and are not embedded in a
larger word.

Access
Type expected

Read-write
bool Word Boundary

Copy method
Creates a copy of the current SearchOptions.

Types expected

void Copy(SearchOptions optionsToCopyFrom)

optionsToCopyFrom

Return value
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The options to copy.

StackFrame class
StackFrame class members display information aboutthe call stack.

Syntax

StackFrame(int howFarBack)

howFarBack The number of stack frames to go back through.
If howFarBack is 0, the stack frame for this call is retrieved.
If howFarBack is 1, the stack passed to this function's caller is
retrieved, and so on.

When howFarBack is less than the depth of the stack, the object is
not valid. '

Properties
int ArgActual

Read-only

int ArgPadding

Read-only

string Caller

Read-write

boo I IsValid

Read-only

Methods
StackElement GetParm(int parmNumber)
string InqType(int arg)
bool SetParm(int parmNumber, newValue)
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Events
None

StackFrame class description
StackFrame class members display information about the call stack, the
sequence of function calls that brought your script program to its current
state. It deciphers all active functions and their argument values and displays
them in a readable format.
The most recently called function displays at the top of the list, followed by
its caller and the previous caller to that. The list continues to the first function
in the calling sequence, which displays at the bottom of the list.

StackFrame class members:
• Return the number of arguments that were actually passed to a method.
• Indicate the number of objects cScript had to pad or truncate from the
original call stack.
• Indicate the name of the method owning the stack frame.
• Indicate if the stack frame is valid.
• Return the object at a specified stack frame offset.

ArgActual property
Indicates the number of objects on the cScript stack belonging to this call
frame.

Access
Type expected
Description

Read-only
int ArgActual

ArgActuaZ is the number of arguments that were actually passed to a method.
cScript either pads or truncates arguments as necessary, so it must keep track
of the number actually passed.
For example, if you have a call in your code to
MyMethod ("hi") ;

its declaration shows the following:
MyMethod(first, second, third, fourth) {
print first, second, third, fourth;
}

27-2
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If you were to insert x = new StackFrame (0) ; into the call to MyMethod, the
value of x.ArgActual would be 1 since only one argument is passed.

ArgPadding property
Indicates the number of objects cScript had to pad or truncate from the
original call stack to resolve any discrepancy between the number of
arguments in the declaration and the number of arguments in the call.

Access
Type expected

Read-only
int ArgPadding

Caller property
Indicates the name of the method owning the stack frame.

Access
Type expected
Description

Read-only
string Caller

Caller contains the empty string ("11) if the call is a top level one. When the
value is set, it is reflected in subsequent StackFrame calls until the current
stack frame is popped off, at which point the value of Caller is reset to its
original value.

IsValid property
FALSE if the object was constructed with an invalid stack frame depth or if
the stack frame has gone out of scope. It is TRUE otherwise.

Access

Read-only

Type expected· boollsValid

InqType method
Returns the type of argument.

Types expected

string InqType(int arg)

arg

The specified argument.
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Return value

A descriptor for the argument specified. If arg is greater than or equal to
ArgActual, "Out of range" is returned.

GetParm method
Returns the object at the specified stack frame offset.

Types expected

StackElement GetParm(int parmNumber)

parmNumber

Return value

The number of the parameter to return.

The object at the specified stack frame offset.

SetParm method
Sets the value of the object at the specified stack frame offset.

Types expected

Return value

boo I $etParm (int parmNumber, newValue)

parmNumber

The value of the object to change.

new Value

The object's new value.

TRUE when the value was successfully changed. FALSE if the StackFrame is
currently invalid or if parmNumber is not within the range of arguments

specified for the StackFrame.
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String class
The String object manipulates text.

Syntax

String(string theText)

theText

The text to declare as a text object.

Properties
int Character

Read-write

int Integer

Read-write

bool IsAlphaNumeric

Read-only

int Length

Read-only

string Text

Read-write

Methods
String CompressO
bool Contains(string charactersToLookFor, int mask)
int Index(string substrL int direction])
String LowerO
String SubString(int startPosL int length])
String Trim([bool from Left])
String UpperO
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Events
None

String class description
The String class manipulates text characters independently of each other. To
store and manipulate text characters as a group, delcare the text as a string
(note the lower case "s").
Class members can be used to:
• Get the first character of the text.
• Get the numeric equivalent of the beginning of the text. (Useful for
converting text to numeric values.)
• Test if the first character is alphanumeric.
• Return the length of the text.
• Return the text object as a string versus a String.
• Convert multiple whitespace characters to one whitespace character.
• Find any number of characters within the text.
• Return the offset of a particular character.
•. Lower case the text.
• Return a portion of the text as a String.
• Remove whitespace from either the right or left of the text.
• Upper case the text.

Character property
Indicates the integer value of character 0 of the string.

Access
Type expected
Description

Read-write
int Character

When the value of Character is set, it changes the whole string to the new
value.
For example, if you start with a string Str containing the text "Faa", the
value of Str. Text is "Faa" and the value of Str.Character is IF'. If you then set
the value of Str with Str. Character = X the value of Str.Text is now /IX" and
not "XOO".
I
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String class, Integer property

Integer property
Indicates the numerical equivalent of the character string that this object
represents, or zero if the string does not contain numerals.

Access

Read-write

Type expected

int Integer

IsAlphaNumeric property
TRUE if the text of the String is made up entirely of alphanumeric characters

(determined by checking the system's current locale). FALSE, otherwise.

Access
Type expected

Read-only
booI IsAlphaNumeric

Length property
Calculates length of the string (equivalent to strlen). Does not include the
NULL.

Access
Type expected

Read-only
int Length

Textproperty
The character string that this object represents.

Access
Type expected

Read-write
string Text

Compress method
Compresses a string.

Types expected
Return value

String CompressO

A new string consisting of String with whitespace removed.
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Contains method
Searches String for the specified characters.

Types expected

bool Contains(string charactersToLookFor, lint mask])

charactersToLookFor
mask

The characters to search for in String.
Any of the following constants:

Constant

Description

BACKWARD_RIP
INVERT_LEGAL_CHARS

Rip from left to right.
Interpret the string as the inverse of the
string you wish to use. In other words,
specify "t" to mean any ASCII value
between 1 and 255 except It' .
Append the characters
abcdefghijklmnopqrstuvwxyz to the string.
Append the characters
ABCDEFGHIJKLMNOPQRSTUVWXYZ to the string.
Append both uppercase and lowercase
alpha characters to the string.
Append the characters 1234567890 to the
string.
Append the characters' - = [ 1 ~ ;

INCLUDE_LOWERCASE_ALPHA_CHARS
INCLUDE_UPPERCASE_ALPHA..:.CHARS
INCLUDE_ALPHA_CHARS
INCLUDE_NUMERIC_CHARS
INCLUDE_SPECIAL_CHARS

f

./-!@#$%"&*()_+{} 1:"<
> ? to the string.

Return value

TRUE if the string contains one of the characters specified, FALSE, otherwise

Index method
Scans the string for an embedded occurrence of the specified substring.

Index does not accept regular expressions.

Types expected

int Index(string substr[, int direction])

substr
direction

The string to sea;rch for.
The direction to search in. One of:
- SEARCH_FORWARD (default)
-SEARCH_BACKWARD

Return value

28-4

0 if substr is not found or, if found, the one based offset + 1 of the substring

0 b j e c t S c rip tin 9 Pro g ram mer's G u ide

String class, Lower method

Lower method
Translates String to lowercase.

Types expected
Return value

String LowerO

A new string consisting of String in lowercase text.

SubString method
This method returns a new string consisting of the specified substring.

Types expected

String SubString(int startPos[, int length])

startPos
length

Return value

The starting point of the substring in the string.
The number of characters in the substring. Defaults to
MAX_EDITOR_LINE_LEN (1024). If length is not specified,
SubString continues to the end of the string.

A new string consisting of the specified substring.

Trim method
Trims whitespace from String.

Types expected

String Trim([bool from Left])

fromLeft

If TRUE, trims leading whitespace. If FALSE, trims trailing

whitespace.

Return value

A new string consisting of String without trailing or leading whitespaces
(depending on fromLeftselection).

Upper method
Translates String to uppercase.

Types expected
Return value

String UpperO

A new string consisting of String in upper case text.
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TimeStamp class
TimeStamp indicates the current time. It initializes to the system time at the
time of construction.

Syntax

TimeStampO

Properties
int Day

Read-write

int Hour

Read-write

int Hundredth

Read-write

int Millisecond

Read-write

int Minute

Read-write

int Month

Read-write

int Second

Read-write

int Year

Read-write

Methods
int Compare(TimeStamp tstamp)
string DayNameO
string MonthNameO
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TimeStamp class, Day property

Events
None

Day. property
Indicates the current day in the range of 0 (Sunday) to 6 (Saturday).

Access
Type expected

Read-write
int Day

Hour property
Indicates the current hour in the range of 0 (Midnight) to 23 (11:00 PM).

Access
Type expected

Read-write
int Hour

Hundredth property
Indicates the current hundredth of an hour in the range of 0 to 99.

Access
Type expected

Reag-write
int Hundredth

Millisecond property
Indicates the number of milliseconds after the current second in the range Qf

oto 999.
Access

Read-write

Type expected

int Millisecond

Minute property
Indicates the number of minutes after the current hour in the range of 0 to 59.

Access
29-2

Read-write
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Type expected

int Minute

Month property
Indicates the current month of the year in the range of 0 (January) to 11
(December).

Access
Type expected

Read-write
int Month

Second property
Indicates the number of seconds after the current minute in the range of 0 to
59.

Access
Type expected

Read-write
int Second

Year property
Indicates the current year.

Access
Type expected

Read-write
int Year

Compare method
Compares the time properties of the calling TimeStamp object with those of
the tstamp argument.

Types expected

int Compare(TimeStamp tstamp)

tstamp

Return value

The properties to compare TimeStamp to.

-1 if the calling TimeStamp is newer than tstamp, a if the calling TimeStamp is
the same age as tstamp, and 1 if the calling TimeStamp is older than tstamp.
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DayName method
Returns the name of the current day of the week.

Types expected
Return value

string DayNameO

Monday, Tuesday, and so on

MonthName method
Returns the name of the current month.

Types expected
Return value

29-4

string MonthNameO

January, February, and so on
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TransferOutput class
Internallycreated by the IDE after processing a transfer tool, TransferOutput
is passed to the IDE event TransferOutputExists.

Syntax

TransferOutputO

Properties
int Messageld

Read-only

string Provider

Read-only

Methods
string ReadLineO

Events
None

TransferOutput class description
An object of type TransferOutput is internally created by the IDE whenever a
transfer operation is performed.
When the IDE starts a transfer, it outputs a message to the Message window
saying "Transferring to ToolName ..."

T ran s fer 0 u t put c I ass
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When a transfer happens, the IDE captures all its output and stores it in an
internal buffer. The contents of this buffer may be accessed by using
TransferOutput.ReadLine. This method returns the next line of text until the
stream is exhausted, at which point it returns NULL.
The IDE contains built-in processing for tools it commonly transfers to.
These tools include TASM and'Grep. The script sample files FILTSTUB.SPP
and FILTERS.SPP show uses of this class in action.

Messageld property
The owning message stored to the message system.

Access

Read-only

Type expected

int Messageld

Description

MessageID is intended to be usedas the parentMessage parameter of
IDE.MessageCreate. The messages produced by the transfer can be grouped
with the transfer message rather than at the same level.

Provider property
Indicates the name of the tool that was spawned by the transfer; for example,
COMMAND;COM.

Access
Type expected

Read-only
string Provider

ReadLine method
Reads the next line of text that was produced by the transfer.

Types expected
Return value

string ReadLineO

The next line of text that was produced by the transfer. If the line is empty,
returns the empty string (U "). If there is no more input to r~ad, it returns
NULL.

Description

30-2

When a transfer happens, the IDE captures all its output and stores it in an
internal buffer. The contents of this buffer may be accessed by repeatedly
calling ReadLine, which returns the next line of text until the stream has been
exhausted, at which point it returns NULL.
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DLLs 4-10
do S-9
documentation
printing conventions 1-2
DoFileOpen 18-19
dot operator 6-12
Down 18-18
Drive 11-4.
drives, returning 11-4
dynamic-link libraries 4-10

E
edit boxes 18-32, 18-46, 18-47
edit buffers 11-2, 18-19
accessing lines 13-4,lS-3
changing contents 11-3,
11-5, 11-9, 11-10, 17-10
character positions lS-9
creating 11-S, 11-6, 11-7,
11-8, 17-6, 17-9
current position 10-3, 10-4,
10-5, 10-6, 13-3, 13-4, lS-6
destroying 11-6, 11-7
getting 11-4, 11-7, 11-8, lS-3,
17-4, 17-S, 17-7
1-4

naming 11-9
options 8-7, 12-2, 17-3, 17-4,
17-10
printing contents 11-8
referencing 11-3
saving 11-9
scrolling lS-7
selecting contents 17-9
selecting text 18-20, 18-21
undoing changes 17-S, 17-8
viewing contents lS-4,lS-S,
lS-7,IS-8
writing to 13-7, 18-21
zooming contents lS-4
Edit menu 18-20, 18-21, 18-22
edit rip 13-13
edit views 11-2
activating lS-3, lS-4, lS-6,
16-4,17-10 .
arranging 16-6, 17-4
creating 16-S, 17-7, 17-11
current position 10-3, 10-4,
10-S, 10-6
destroying lS-3, 16-S, 17-11
getting 11-6, 16-S, 17-7
getting next lS-S
moving through 11-7, 13-8,
13-9, 13-10, 13-11, lS-S, lS-8
moving to specific lines 13-6
repainting lS-7, lS-8, 16-4,
17-8
Edit windows 15-6, 17-2
See also edit views
activating 16-2, 16-3, 16-4
closing 16-4
getting current 16-3
moving through 16-3
naming 16-3
opening 18-44
EditBlock
Begin 10-S
Copy 10-S
Cut 10-S
Delete 10-6
End .10-6
EndingColumn 10-3
EndingRow 10-3
Extend 10-6
ExtendPageDown 10-6
ExtendPageUp 10-7
ExtendReal 10-7
ExtendRelative 10-7
Hide 10-3
Indent 10-8
IsValid 10-3
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LowerCase 10-8
overview 10-2
Print 10-8
Reset 10-8
Restore 10-9
Save 10-9
SaveToFile 10-9
Size 10-3
StartingColumn 10-4
StartingRow 10-4
Style 10-4
Text 10-S
ToggleCase 10-9
UpperCase 10-10
EditBuffer
ApplyStyle 11-6
AttemptToModifyReadOnlyBuffer 11-9
AttemptToWriteReadOnlyFile 11-9
Block 11-3
BlockCreate 11-6
CurrentDate 11-3
Describe 11-7
Destroy 11-7'
Directory 11-4
Drive 11-4
Extension 11-4
FileName 11-4
FullName 11-4
HasBeenModified 11-10
lnitialDate 11-S
IsModified 11-S
IsPrivate 11-S
IsReadOnly 11-S
IsValid 11-6
NextBuffer 11-7
NextView 11-7
overview 11-2
Position 11-6
,PositionCreate 11-8
Print 11-8
PriorBuffer 11-8
Rename 11-9
Save 11-9
TopView 11-6
EditBufferCreate 17-6
EditBufferList 18-19
EditCopy 18-20
EditCut 18-20
editing 13-13, lS-4, 16-3
EditMode 14-2
EditOptions 17-6
BackupPath 12-2
BlockIndent 12-2

BufferOptions 12-2
MirrorPath 12-3
OriginalPath 12-3
overview 12-2
SyntaxHighlightTypes 12-3
UseBRIEFCursorShapes 12-4
U seBRIEFRegularExpression
12-4
EditOptionsCreate 17-6
Editor 17-2, 17-3, 18-8
ApplyStyle 17-4
BufferCreated 17-9
BufferList 17-5
BufferOptionsCrea te 17-5
BufferRedo 17-5
BufferUndo 17-5
EditBufferCreate 17-6
EditOptionsCreate 17-6
EditStyleCreate 17-6
EditWindowCreate 17-7
FirstStyle 17-3
GetClipboard 17-7
GetClipboardToken 17-7
GetWindow 17-7
IsFileLoaded 17~7
MouseBlockCreated 17-9
MouseLeftDown 17-9
MouseLeftUp 17-9
MouseTipRequested 17-9
Options 17-3
OptionsChanged 17-10
OptionsChanging 17-10
overview 17-2
SearchOptions 17-4
StyleGetNext 17-8
TopBuffer 17-4
TopView 17-4
ViewActivated 17-10
ViewCreated 17-11
ViewDestroyed 17-11
ViewRedo 17-8
ViewUndo 17-8
editor 18-8
editor classes 17-2
buffer options 8-2
edit buffers 11-2
editing windows 15-2,16-2
overview 12-2, 13-2
settings 14-1
text blocks 10-2
Editor objects 17-2, 17-3, 17-4,
17-6, 17-8
Editor options
blocks 12-2
display 12-4

files 12-3
redefining 14-1, 14-2
EditPaste 18-21
EditPosition 15-5
Align 13-4
BackspaceDelete 13-5
Character 13-3
Column 13-3
Delete 13-6
DistanceToTab 13-6
GotoLine 13-6
InsertBlock 13-7
InsertCharacter 13-7
InsertFile 13-7
InsertScrap 13-7
InsertText 13-7
IsSpecialCharacter 13-3
IsWhiteSpace 13-3
IsWordCharacter 13-4
LastRow 13-4
Move 13-8
MoveBOL 13-8
MoveCursor 13-9
MoveEOF 13-9
MoveEOL 13-10
MoveReal 13-10
MoveRelative 13-11
overview 13-2
Read 13-11
Replace 13-11
ReplaceAgain 13-12
Restore 13-12
RipText 13-13
Row 13-4
Save 13-13
Search 13-14
SearchAgain 13-14
SearchOptions 13-4
Tab 13-15
EditRedo 18-21
EditSelectAll 18-21
EditStyle
EditMode 14-2
Identifier 14-2
Name 14-2
overview 14-1
EditStyleCreate 17-6
EditUndo 18-22
EditView
Attach 15'-6
Block 15-3
BookmarkGoto 15-6
BookmarkRecord 15-6
BottomRow 15-3
Buffer 15-3

Center 15-7
Identifier 15-3
IsValid 15-3
IsZoomed 15-4
LastEditColumn 15-4
LastEditRow· ·15-4
LeftColumn 15-4
MoveCursorToView 15-7
MoveViewToCursor 15-8
Next 15-5
overview 15-2
PageDown 15-8
PageUp 15-8
Paint 15-8
Position 15-5
Prior 15-5
RightColumn 15-5
Scroll 15-8
SetTopLeft 15-9
TopRow 15-5
Window 15-6
EditWindow
Activate 16-4
Close 16-4
Identifier 16-2
IsHidden 16-2
IsValid 16-3
Next 16-3
overview 16-2
Paint 16-4
Prior 16-3
Title 16-3
View 16-3
ViewActivate 16-4
ViewCreate 16-5
ViewDelete 16-5
ViewExists 16-5
ViewSlide 16-6
EditWindowCreate 17-7
else 5-12,6-6,7-2
End 10-6
end of lines 8-5
endif 7-2
EndingColumn 10-3
EndingRow 10-3
EndWaitCursor 18-22
EnterContextHelpMode 18-22
Environment options
saving 18-35
Environment Options dialog
box 18-34
equality 6-8
_error 4-10
error messages
displaying 18-32, 18-33
Index

1-5

errors 5-20
fixing 18-44
escape sequences 4-7
Evaluate 9-5
EvaluateWindow 9-5
event 4-10
events 4-18, 9-11, 9-12, 18-38
edit buffers 11-9, 11-10, 17-9,
17-10
edit views 17-10, 17-11
idle processing 18-9, 18-56,
18-58
list windows 21-p, 21-7, 21-8
nodes 23-6,23-7
example scripts 2-6
exclusive OR operator 6-2, 6-5
EXCLUS~VE_BLOCK 10-4
Execute 21-5,25-4
execu ting a script
statement 2-11
executing applications 18-13
executing scripts 18-41, 18-42,
20-4, 25-4, 25-7
Exit command 18-23
Exiting 18-55
exiting IDE 18-40, 18-55
ExpandWindow 18-23
expansion 7-1, 7-3
export 4-10, 5-10
exporting 5-10
expressions 5-20, 5-26, 6-1, 6-9,
6-17
evaluatiitg 6-13,9-5, 18-14
search 12-4,26-3
Extend 10-6
ExtendPageDown 10-6
ExtendPageUp 10-7
ExtendReal 10-7
ExtendRelative 10-7
Extension 11-4

F
Factory 4-10
FALSE 4-10
false 4-10
File menu 18-23, 18-24, 18-25,
18-26
file names 7-3, 11-4
getting extensions 11-4
returning 11-4
file open common dialog
boxes 18-23
FileClose 18-23
FileDialog 18-23
FileExit 18-23
1-6

FileN arne 11-4
FileNew 18-24
FileOpen 18-24
FilePrint 18-25
FilePrinterSetup 18-25
files 11-2
backing up 8-2
closing 18-23
opening 18-19, 18-23, 18-24
reading 13-7
saving 12-3, 18-26
writing to 10-9
FileSave 18-26
FileSaveAll 18-26
FileSaveAs 18-26
FileSend 18-27
FindExecutionPoint 9-5
finding text 12-4, 13-4, 13-14,
17-4,18-43,18-44,26-1
FindString 21-5, 22-2
FirstStyle 17-3
flow control statements 4-8 .
Flush 20-5
for 5-10
FormatString 4-9, 5-11
forward referencing 4-7
from 5-11
FromCursor··26-2
FULL_DIAGNOSTICS 25-3
FullN arne 11-4, 18-9
functions 5-1,5-20,25-5
exporting 4-10,5-10
importing 5-13
overriding 5-19

GotoLine 13-6

H
HasBeenModified 11-10
HasProcess 9. .3
HasUniqueN.{apping 19~5
Height 18-9, 21-3
He~p 18-29
Help About dialog box 18-30
Help contents screen 18-30
Help systems
activating 18-22, 18-29,
18-30, 18-31, 18-55
Help Topics dialog box 18-31
Help Topics Index page 18-31
HelpAbout 18-30
HelpContents 18-30
HelpKeyboard 18-30
HelpKeywordSearch 18-31
HelpOWLAPI 18-31
HelpRequested 18-55
HelpUsingHelp 18-31
HelpWindowsAPI 18-31
hexadecimal escape
sequences 4-7
Hidden 21-4
Hide 10-3
hiding windows 16-2, 21-4
hooks 4-18,4-19,4-20,4-21
horizontal scroll bars 8-3
HorizontalScrollBar 8-3
Hour 29-2
hourglass 18-22,18-46
Hundredth 29-2

G
garbage collection 5-8
GetClipboard 17-7
GetClipboardToken 17-7
GetCommand 19-5,24-3
GetKeyboard 20-5
GetKeyCode 24-3
GetKeySequence 19-5
GetParm 27-4
GetRegionBottom 18-27
GetRegionLeft 18-28
GetRegionRight 18-28
GetRegionTop 18-29
GetString 21-6, 22-2
getters 4-4,4-20,5-18,6-11
GetWindow 17":7
GetWindowState 18-29
global commands 2-3
global symbols 18-50
GoForward 26-2
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icons, arranging 18-52
IDE 18-7, 18-11, 18-32
. activating 18-8, 18-9, 18-10,
18-11, 18-12, 18-58
arranging windows 18-27,
18-28, 18-29, 18-45, 18-52,
18-53, 18-54
closing windows 18-13;
18-52
enabling help 18-22, 18-29,
18-30, 18-31, 18-55
exiting 18-40, 18-55
keyboard mapping 18-10,
18-30, 18-56
naming 18-8, 18-9, 18-11
opening windows 18-15,
18-48, 18-49, 18-50, 18-51

resizing windows 18-9,
18-12, 18-23, 18-52, 18-53
saving desktop 18-35
setting active
window 18-34, 18-46, 18-58
IDEApplication
AddToCredits 18-12
Application 18-7
BuildComplete 18-54
BuildStarted 18-54
Caption 18-8
CloseWindow 18-13
,CurrentDirectory 18-8
CurrentProjectNode 18-8
DebugAddBreakpoint 18-13
DebugAddWatch 18-13
DebugAnimate 18-13
DebugAttach 18-14
DebugBreakpointOptions 18-14
DebugEvaluate 18-14
Debuglnspect 18-15
DebuglnstructionStepInto 18-15
DebuglnstructionStepOver 18-15
DebugLoad 18-15
DebugPauseProcess 18-16
DebugResetThisProcess 18-16
Debv.gRun 18-16
DebugRunTo 18-16
DebugSourceAtExecutionPoint 18-17
DebugStatementStepInto 18-17
DehugStatementStepOver 18-18
DebugTerminateProcess 18-18
DefaultFilePath 18-8
DialogCreated 18..:55
DirectionDialog 18-18
DirectoryDialog 18-18
DisplayCredits 18-19
DoFileOpen 18-19
EditBufferList 18-19
EditCopy 18-20
EditCut 18-20
EditPaste 18-21
EditRedo 18-21
EditSelectAll 18-21
EditUndo 18-22
EndWaitCursor 18-22

EnterContextHelpMode
method 18-22
Exiting 18-55
ExpandWindow 18-23
FileClose 18-23
FileDialog 18-23
FileExit 18-23
FileNew 18-24
FileOpen 18-24
FilePrint 18-25
FilePrinterSetup 18-25
FileSave 18-26
FileSaveAll 18-26
FileSaveAs 18-26
FileSend 18-27
FullName 18-9
GetRegionBottom 18-27
GetRegionLeft 18-28
GetRegionRight 18-28
GetRegionTop 18-29
GetWindowState 18-29
Height 18-9
Help 18-29
HelpAbout 18-30
HelpContents 18-30
HelpKeyboard 18-30
HelpKeywordSearch 18-31
HelpOWLAPI 18-31
HelpRequested 18-55
HelpUsingHelp 18-31
HelpWindowsAPI 18-31
Idle 18-56
IdleTime 18-9
IdleTimeout 18-9
KeyboardAssignmentFile 18-10
KeyboardAssignmentsChanged 18-56
KeyboardAssignmentsChanging 18-56
KeyboardManager 18-10
KeyPressDialog 18-32
Left 18-10
ListDialog 18-32
LoadTime 18-9
MakeComplete 18-57
MakeStarted 18-57
Menu 18-32
Message 18-32
MessageCreate 18-33
ModuleName 18-10
Name 18-11
NextWindow 18-34
OptionsEnvironment 18-34
OptionsProject 18-34

OptionsSave 18-35
OptionsStyleSheets 18-35
OptionsTools 18-35
overview 18-6
Parent 18-11
ProjectAppExpert 18-35
ProjectBuildAll 18-36
ProjectClosed 18-57 .
ProjectCloseProject 18-36
ProjectCompile 18-36
ProjectGenerateMakefile 18-37
ProjectMakeAll 18-37
ProjectManagerInitialize 18-38
ProjectNewProject 18-38
ProjectNewTarget 18-38
ProjectOpened 18-57
ProjectOpenProject 18-40
Quit 18-40
RaiseDialogCreatedEvent 18-11
SaveMessages 18-40
ScriptCommands 18-41
ScriptCompileFile 18-41
ScriptModules 18-41
ScriptRun 18-42
ScriptRunFile 18-42
Sec;trchBrowseSymbol 18-42
SearchFind 18-43
SearchLocateSymbol 18-43
SearchNextMessage 18-43
SearchPreviousMessage 18-44
SearchReplace 18-44
SearchSearchAgain 18-44
SecondElapsed 18-58
SetRegion 18-45
SetWindowState 18-46
SimpleDialog 18-46
SpeedMenu 18-46
Started 18-58
StartWaitCursor 18-46
StatusBar 18-11
StatusBarDialog 18-47
StopBackgroundTask 18-47
SubsytemActivated 18-58
Tool 18-47
Top 18-11
TransferOutputExipts 18-59
TranslateComplete 18-59
Undo 18-48
U seCurrentWindowForSourceTracking 18-12
Version 18-12
Index

1-7

ViewActivate 18-48
ViewBreakpoint 18-48
ViewCallStack 18-48
ViewClasses 18-49
ViewClassExpert 18-49
ViewCpu 18-49
ViewGlobals 18-50
ViewMessage 18-50
ViewProcess 18-50
ViewProject 18-51
ViewSlide 18-51
ViewWatch 18-51
Visible 18-12
Width 18-12
WindowArrangeIcons 18-52
WindowCascade 18-52
WindowCloseAll 18-52
WindowMinimizeAll 18-52
WindowRestoreAll 18-53
WindowTileHorizontal 18-53
WindowTileVertical 18-54
YesNoDialog 18-54
Identifier 14-2, 15-3, 16-2
identifiers 4-5, 4-10, 5-1, 6-17,
7-2,7-4
Idle 18-56
idle processing 18-9, 18-56,
18-58
IdleTime 18-9
IdleTimeout 18-9
if 5-12,6-6
ifdef 7-2
ifndef 7-2
import 5-13
importing 5-13
include 7-3
include files 23-3
INCLUDE_ALPHA_CHARS 28-4
INCLUDE_LOWERCASE_ALPHA_CHARS 28-4
INCLUDE_NUMERIC_CHARS 28-4
INCLUDE_SPECIAL_CHARS 28-4
INCLUDE_UPPERCASE_ALPHA_CHARS 28-4
IncludePath ·23-3
inclusive OR operator 6-2, 6-5
increment operator 6-3, 6-13
Indent 10-8
indenting text 10-8, 12-2
Index 28-4
inequality 6-8
1-8

information messages 18-32,
18-33
inheritance 4-14
_init function 2-3
InitiruDate 11-5
initialized 4-9
initializing scripts 2-3
input operator 6-5
InputName 23-3
InqType 27-3
Insert 21-6
Insert mode 21-6
setting 8-3
InsertBlock 13-7
InsertCharacter 13-7
InsertFile 13-7
InsertMode 8-3
InsertScrap 13-7
InsertText 13-7
Inspect 9-5
inspecting 9-5
Inspector windows 9-5,18-15
instances 5-2,5-8,5-11
InstructionStepInto 9-6
InstructionStepOver 9-6
Integer 28-3
integrated debugger 9-1, 9-5
activating 9-4, 18-14
adding breakpoints 9-3, 9-4,
9-9, 18-l3, 18-14, 18-48
evaluating expressions 9-5,
18-14
events 9-11, 9-12
finding execution point 9-5
getting executables 18-15
inspecting code 9-5, 18-15
loading executables 9-7
pausing programs 9-7, 18-16
resetting 9-7
running programs 9-7,9-8,
9-11, 18-16
checking status 9-6
to specific addresses 9-8
setting watches 9-3, 9-4, 9-11,
18-13, 18-51
stepping and tracing 9-6, 9-8,
9-9, 18-15, 18-17, 18-18
single lines 9-6
terminating 9-9, 18-18
testing processes 9-3
viewing current state 9-10,
9-11, 18-48
viewing source code 18-17
invalid stack 27-3
INVALID_BLOCK 10-4
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INVERT_LEGAL_CHARS 28-4
IsAClass 25-5
IsAFunction 25-5
IsAlphaNumeric 28-3
IsAMethod 25-5
IsAProperty 25-5
IsFileLoaded 17-7
IsLoaded 25-6
IsModified 11-5
IsPaused 24-2
IsPrivate 11-5
IsReadOnly 11-5
IsRecording 24-2
IsRunnable 9-6
IsSpecialCharacter 13-3
IsValid
EditBlock 10-3
EditBuffer 11-6
EditView 15-3
EditWindow 16-3
ProjectNode 23-3
StackFrame 27-3
IsWhiteSpace. 13-3
IsWordCharacter 13-4
IsZoomed 15-4
iterate 5-15

J
justification 13-4

K
.KBD files 20-7
.KBP files 20-7
key codes 19-5,24-3
getting 20-5,20-6,20-8
Keyboard
Assign 19-2
Assignments 19-2
AssignTypeables 19-4
Copy 19-4
CountAssignments 19-5
DefaultAssignment 19-2
GetCommand 19-5
GetKeySequence 19-5
HasUniqueMapping 19-5
overview 19-2
Unassign 19-6
keyboard 19-2, 19-4, 19-5, 19-6,
20-5
keyboard mapping 18-10,18-30,
. 18-56, 19-5, 20-5, 20-7, 20-8 .
KeyboardAssignmentFile 18-10
KeyboardAssignmentsChanged 18-56

KeyboardAssignmentsChanging 18-56
KeyboardFlags 20-3
KeyboardManager 18-10
AreKeysWaiting 20-3
CodeToKey 20-5
CurrentPlayback 20-3
CurrentRecord 20-3
Flush 20-5
GetKeyboard 20-5
KeyboardFlags 20-3
KeysProcessed 20-4
KeyToCode 20-6
LastKeyProcessed 20-4
overview 20-2
PausePlayback 20-6
Playback 20-6
Pop 20-7
ProcessKeyboardAssignments 20-7
ProcessPendingKeystrokes 20-8
Push 20-8
ReadChar 20-8
Recording 20-4
ResumePlayback 20-9
ResumeRecord 20-9
ScriptAbortKey 20-4
SendKeys 20-9
StartRecord 20-12
Stop Record 20-12
KeyCount 24-2
KeyPressDialog 18-32
KeyPressed 21-7
keypresses 19-2,19-4,19-5,19-6,
20-3
playing back 20-3, 20-6, 20-9
processing 20-3,20-4,20-5,
20-8,20-9
recording 18-32,20-4,20-9,
20-12,24-2
predefined dialog 18-32
saving 24-2, 24-3
KeysProcessed 20-4
KeyToCode 20-6
keyword search lists 18-31
keywords 5-1

L
LANGUAGE_DIAGNOSTICS
25-3
LastEditColumn· 15-4
LastEditRow 15-4
LastKeyProcessed 20-4
LastRow 13-4

late-bound languages 4-1
leading whitespace
trimming 28-5
Left 18-10, 18-18
LeftClick 21-7
LeftColumn 15-4
LeftGutterWidth 8-3
Length 28-3
libraries 23-3
library 4-10
LIBRARY_MODULE 25-7
LibraryPath 23-3
line continuation character 7-6
LINE_BLOCK 10-4
list boxes 18-32
list window controls 21-3, 21-4
closing 21-5
closingv 21-7
events 21-6,21-7,21-8
ListDialog 18-32
lists 21-5,21-6
adding items 21-4
counting items 21-3
getting contents 21-3,21-5,
21-6
removing items 21-5, 21-6,
21-7
selecting items 21-4,21-8
sorting items 21-4
ListWindow
Accept 21-6
Add 21-4
Cancel 21-7
Caption 21-3
Clear 21-5
Close 21-5
Closed 21-7
Count 21-3
Currentlndex 21-3
Data 21-3
Delete 21-7
Execute 21-5
FindString 21-5
GetString 21-6
Height 21-3
Hidden 21-4
Insert 21-6
KeyPressed 21-7
LeftClick 21-7
Move 21-8
MultiSelect 21-4
overview 21-2
Remove 21-6
RightClick 21-8
Sorted 21-4

Width 21-4
Load 9-7, 25-6
load 4-9, 5-16
Loaded 25-8
loading a script 2-2
LoadTime 18-9
log files 25-2, 25-3
LogFileN arne 25-3
Logging 25-3
logical operators 6-2,6'-7
loops 5-3,5-6,5-9,5-10,5-12,
5-27
Lower 28-5
LowerCase 10-8
lowercase charact~rs 10-8, 10-9,
28-5
lvalues 6-17

M
macros 7-1,7-3,7-6
defining 7-1, 7-2, 7~3, 7':'4, 7-6
Made 23-7
main menu 18-32
main window 18-9
naming 18-8, 18-11
resizing 18-9, 18-12, 18-23
Make 23-5
MakeComplete 18-57
MakePreview 23-5
makes 18-37, 18-57, 18-59
MakeStarted 18-57
MAPI 18-27
Margin 8-4
margins 8-3,8-4
matching patterns 18-43, 18-44
mathematical expressions 6-3,
6-14
member selector operator 6-12
MEMBER_DIAGNOSTICS 25-3
members 4-14,5-23,6-12,25-5
getting 5-15
testing 6-12
memory
deallocating 5-8
Menu 18-32
menu items
adding 4-22
removing 4-24
menus 18-32, 18-46
adding commands 22-2
closing 22-3
.. displaying 22-3
getting commands 22-2
removing commands 22-3
Message 18-32
Index

1-9

message boxes 2-11, IS-IS,
lS-32, IS-54
Message window lS-33, lS-43,
lS-44, IS-50
saving messages lS-35,lS-40
MessageCreate lS-33
'
MessageId 30-2
messages 5-29, IS-50, 30-2
diagnostic 25-3
'
displaying lS-32, lS-33
getting lS-43, lS-44
saving lS-35, 25-2, 25-3
method 4-10
METHOD _DIAGNOSTICS 25-3
methods 5-2, 5-S, 5-1l, 5-1S,
25-5
Millisecond 29-2
minimizing windows IS-52,
IS-53
Minute 29-2
MirrorPath 12-3
modal dialog boxes lS-32
modifiable identifiers 6-17 ,
module 4-9,5-16
MODULE~DIAGNOSTICS 25-3
ModuleName lS-10
Modules 25-6
modules 5-16, 5-20, lS-10
closing 5-27,25-S
loading 5-20, 5-21, 25-6
renaming 5-16
Modules command 2-2
modulus 6-2,6-3,6-14
Month 29-3
MonthName 29-4
mouse events 17-9,21-7, 21-S
MouseBlockCreated 17-9
MouseLeftDown 17-9
MouseLeftUp 17-9
MouseTipRequested 17-9
Move 13-S, 21-S
MoveBOL 13-S
MoveCursor 13-9
MoveCursorToView 15-7
MoveEOF 13-9
MoveEOL 13-10
MoveReal 13-10
MoveRelative 13-11
MoveViewToCursor 15-S
moving through
windows lS-34, IS-5S
multidimensional arrays 6-9
multiplication 6-2,6-3,6-14
MultiSelect 21-4

1-10

N
Name 14-2, lS-11, 23-3, 24-2
naming lS-10
windows 16-3, lS-S, lS-11,
21-3 '
negation operator 6-7,6-13
nested classes 5-11
new 5-17
New command lS-24
new files lS-24,IS-3S
Next 15-5, 16-3, 24-4
NextBuffer 11-7
NextView 11-7
NextWindow lS-34
NO_DIAGNOSTICS 25-3
nodes
adding to projects 23-5, 23-6,
23-7
building lS-37
getting child 23-2
removing 23-6
selecting 'IS-S
setting paths 23-3,23-4
specifying 23-4
testing 23-3,23-4,23-5
NULL 4-10
number sign (#) 7-1
numeric characters
testing for 13-4
N umLock, testing 20-3

o
object 4-10
OBJECT_DIAGNOSTICS 25-3
objects 4-4, 5-17, 5-21, 5-22,6-10
allocating memory 5-S
finding members 5-15
ObjectScripting
debugging a script 2-5, 2-13
,,':' displaying output 2-11
example scripts 2-6
executing a script
statement 2-11
loading a script 2-2
referencing a script
function 2-4
running a script 2-1,2-13 (
script initialization 2-3
setting options 2-10
tutorial 3-1
unloading a script 2-15
writing a script 2-12
ObjectWindows Library lS-31
octal escape sequences 4-7
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of 5-1S
OLE automation 4-11
OLE index operator 6-9
OLE indexed properties 6-9
OLE2 registry 4-11
OleObject (cScript) 4-11
on 5-1S
onhandler 4-1S, 4-19, 4-20,4-21,
5-1S, 5-19,6-11
Open command lS-24
opening files lS-S, lS-19, lS-23,
lS-24, lS-40, IS-57
operators 6-1,6-12,6-17
arithmetic 6-2,6-3,6-14
assignment 6-2,6-4
binary 6-2
bitwise 6-2, ,6-5
comma expressions 6-6
conditional 6-2,6-6
enclosing expressions 6-9
logical 6-2, 6-7
object-oriented 6-10
precedence of 6-2
reference 6-7
relational 6-2,6-S
unary 6-13,6-14
Options 17-3
Options Save dialog box lS-35
Options I Environment I
Scripting command 2-10
OptionsChanged 17-10
OptionsChanging 17-10
OptionsEnvironment lS-34
OptionsProject IS-34
OptionsSave IS-35
OptionsStyleSheets lS-35
OptionsTools lS-35
OR operator 6-2, 6-5, 6-7
OriginalPath 12-3
OutOfDate 23-4
output IS-59,30-2
output operator 6-5
OutputN arne 23-4
overriding class members 5-23
overriding functions 5-1,9
Overwrite mode S-4
OverwriteBlocks S-4

p
,page layouts S-3, S-4
PageD own 15-S
PageUp 15-S
Paint 15-8, 16-4
panes 18-48, 18-51
parameters 7-6

passing by reference 4-8,6-7
passing by value 4-8
Parent 18-11
parsing strings 28-4, 28-5
parsing tokens 7-1,7-4
_pascal 4-10
pass 4-9,5-19
passing by reference 4-8,6-7
passing by value 4-8
Paste command 18-21
paths 18-8
pattern matching 18~43, 18-44
PausePlayback 20-6
PauseProgram 9-7
pcode 2-1
perjod operator 6-12
PersistentBlocks 8-5
PERSONAL.SPP 2-2
Playback 20-6
playing back keypresses 20-3,
20-6,20-9

Pop 20-7
pop-up menus
adding commands 22-2
closing 22-3
displaying 22-3
getting commands 22-2
removing commands 22-3
PopupMenu
Append 22-2
Data 22-2
FindString 22-2
GetString 22-2
overview 22-2
Remove 22-3
Track 22-3
Position 11-6, 15-5
PositionCreate 11-8
postdecrement operator 6-3,
6-13

postfix expressions 6-3, 6-13
postincrement operator 6-3,
6-13

pound sign (#) 7-1
precedence of operators 6-2
preprocessing directives 7-1,
7-2,7-3,7-4,7-5

preprocessor operator 6-17
PreserveLineEnds 8-5
Print 10-8, 11-8
print 4-9, 5-11, 5-20
Print command 18-25
Printer Setup command 18-25
Printer Setup dialog box 18-25
printers 18-25

printing 18-25
edit buffers 11-8
expressions 5-20
page layouts 8-3, 8-4
setting options 18-25
text 10-8
printing conventions
(documentation) 1-2
Prior 15-5, 16-3
PriorBuffer 11-8
private buffers 11-2, 11-5
Process window 9-11, 18-50
ProcessKeyboardAssignments
20-7

.

ProcessPendingKeystrokes 20-8
project files 18-38
closing 18-57
opening 18-8, 18-40, 18-57
saving 18-35
Project Manager 18-38
Project Options dialog
box 18-34
Project window 18-51
selecting nodes 18-8
ProjectAppExpert 18-35
ProjectBuildAll 18-36
ProjectClosed 18-57
ProjectCloseProject .18-36
ProjectCompile 18-36
ProjectGenerateMakefile 18-37
ProjectMakeAll 18-37
ProjectManagerInitialize 18-38
ProjectNewProject 18-38
ProjectNewTarget 18-38
ProjectN ode
Add 23-5
Build 23-5
Built 23-6
ChildNodes 23-2
IncludePath 23-3
InputName 23-3
IsValid 23-3
LibraryPath 23-3
Made 23-7
Make 23-5
MakePreview 23-5
Name 23-3
OutOfDate 23-4
OutputName 23-4
overview 23-2
Remove 23-6
Sour~ePath 23-4

Translate 23-6
Translated 23-7
Type 23-4

ProjectOpened 18-57
ProjectOpenProject 18-40
projects 7-1, 18-36, 18-38
adding nodes 23-5,23-6,23-7
building 18-36, 18-54
rebuilding 18-37
removing nodes 23-6
PromptOnReplace 26-3
. properties 4-20, 4-21, 6-11, 25-5
property 4-10
prototypes 4-7
Provider 30-2
punctuators 6-15,6-16
Push 20-8

Q
Quit 18-40
quitting IDE 18-40, 18-55
quotients 6-14

R
RaiseDialogCreatedEvent 18-11
raw data, storing 11-2
Read 13-11
ReadChar 20-8
ReadLine 30-2
Record
Append 24-3
GetCommand 24-3
GetKeyCode 24-3
IsPaused 24-2
IsRecording 24-2
KeyCount 24-2
Name 24-2
Next 24-4
overview 24-2
Recording 20-4
recording keypresses 20-4,
20-9,20-12,24-2

predefined dialog 18-32
records 20-3,24-2
Redo command 18-21
_refc 4-10
reference operator 6-5,6-7
references 5-28
edit buffers 11-3
referencing a script function 2-4
regions 18-28
RegularExpression 26-3
relational operators 6-2,6-8
reload 4-9,5-20
remainders 6-2, 6-3, 6-14
Remove 21-6, 22-3, 23-6
remove_view_menu_item 4-24
Index

1-11

removing menu items 4-24
Rename 11-9
Replace 13-11
Replace Text dialog box 18-44
ReplaceAgain 13-12
ReplaceText 26-3
replacing text 12-4, 13-11,
13-12, 18-44
.search options 26-3
reserved identifiers 4-10
reserved words 5-1
Reset 9-7, 10-8, 25-7
resizing windows 18-9,18-12,
18-23, 18-52, 18-53
Restore 10-9,13-12
ResumePlayback 20-9
ResumeRecord 20-9
return 5-20
Right 18-18
RightClick 21-8
RightColumn 15-5
RipText 13-13
rounding.6-14
Row 13-4
RTTI5-26
Run 9-7
run 4-9,5-21
Run command 2-1,2-11
Run File command 2-1,2-13
_runimmediate 4-10
running applications 18-13
running scripts 18-41, 18-42,
20-4,25-4,25-7
overview 2-1,2-13
run-time options 18-35
run-time type information 5-26
RunToAddress 9-8
RunToFileLine 9-8
rvalues 6-17

s
Save 10-9,11-9, 13-13
Save All command 18-26
Save As command 18-26
Save command 18-26
Save~essages 18-40
SaveToFile 10-9
saving
files 12-3, 18-26, 18-35
text blocks 10-9, 13-13
Script Breakpoint Tool 2-5,2-13,
2-14
Script Commands dialog
box 18-41
Script Debugger 5-3
1-12

Script Directory window 2-9
script files 25-4,25-6
closing 25-8
loading 5-16, 25-6, 25-7, 25-8
Script ~odules dialog
box 18-41
SCRIPT_~ODULE 25-7
ScriptAbortKey 20-4
ScriptCommands 18-41
ScriptCompileFile 18-41
ScriptEngine
AppendToLog 25-2
Diagnostic~essage-

~ask

25-3

Diagnostic~essages

25-3
Execute 25-4
IsAClass 25-5
IsAFunction 25-5
IsA~ethod 25-5
IsAProperty 25-5
IsLoaded 25-6
Load 25-6
Loaded 25-8
LogFileN arne 25-3
Logging 25-3
~odules 25-6
overview 25-2
Reset 25-7
ScriptPath· 25-4
StartupDirectory 25-4
SymbolLoad 25-7
Unload 25-7 .
Unloaded 25-8
Scripting Options dialog 2-2,
2-10
Script~odules 18-41
ScriptPath 25-4
ScriptRun 18-42
ScriptRunFile 18-42
scripts 2-14, 18-41, 19-4
debugging 2-5,2-13
displaying output 2-11
example 2-6
executing statements 2-11
finding 25-4,25-6
initializing 2-3
loading 2-2
referencing functions 2-4
running 2-1, 2-13, 18-41,
18-42,20-4,25-4,25-7
setting options 2-10
unloading 2-15
writing 2-12
Scroll 15-8
scroll bars 8-3, 8-7
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Scroll Lock, testing 20-3
Search 13-14
search lists 18-31
SearchAgain 13-14
SearchBrowseSymbol 18-42
searches 26-1, 26-4
case sensitivity 26-2
editor 13-4, 13-11, 13-12,
13-14,17-4, 18-43, 18-44
expressions in 12-4,26-3
implementing 26-2, 26-4
messages 18-43, 18-44
replacing text 26,:,,3
SearchFind 18-43
SearchLocateSymbol18-43
SearchNext~essage 18-43
SearchOptions 13-4, 17-4,26-1
CaseSensitive 26-2
FromCursor 26-2
, GoForward 26-2
overview 26-2
PromptOnReplace 26-3
RegularExpression 26-3
ReplaceText 26-3
SearchReplaceText 26-3
SearchText 26-4
WholeFile 26-4
WordBoundary 26-4
SearchPrevious~essage 18-44;
SearchReplace 18-44
SearchReplaceText 26-3
SearchSearchAgain 18-44
SearchText 26-4
Second 29-3
SecondElapsed 18-58
select 4-9, 5-21
Select All command 18-21
selecting text 10-3, 10-6, 10-7
.selection 5-22
selection objects 5-21, 5-22
SendKeys 20-9
separators 6-15,6-16
SetParm 27-4
SetRegion 18-45
setters 4-4, 4-21, 5-18, 6-11
setting properties 4-20, 4-21,
6-11
setting scripting options 2-10
SetTopLeft 15-9
SetWindowState 18-46
sHidden 16-2
Shift, testing 20-3
shift-left operator 6-2,6-5
shift-right operator 6-2, 6-5
SimpleDialog 18-46

Size 10-3
Sorted 21-4
sorting 21-4
SourcePath 23-4
Space key, testing for 13-3
sparse arrays 4-14
special characters
testing for 13-3
SpeedBar 4-22
Speed~enu 18-46
Speed~enus 4-22, 18-46
_stack 4-10
stack
invalid 27-3
ownership 27-3
padding 27-3
reading 27-2,27-3, 27-4
setting 27-4
StackFrame
ArgActual 27-2
ArgPadding 27-3
Caller 27-3
GetParm 27-4
InqType 27-3
IsValid 27-3
overview 27-2
SetParm 27-4
Started 18-58
StartingColumn 10-4
StartingRow 10-4
StartRecord 20-12
startup directories 25-4
STARTUP.SPP 2-2
StartupDirectory 25-4
StartWaitCursor 18-46
statements 4-7
StatementStepInto 9-8
StatementStepOver 9-9
status bars 18-11
getting text 18-11
setting text 18-11
StatusBar 18-11
StatusBarDialog 18-47
_stdcall 4-10
stepping 9-6,9-8,9-9, 18-15,
18-17, 18-18
single lines .9-6
StopBackgroundTask 18-47
StopRecord 20-12
storingraw data 11-2
String
Character 28-2
Compress 28-3
Contains 28-4
Index 28-4

Integer 28-3
IsAlphaNumeric 28-3
Length 28-3
Lower 28-5
overview 28-2
SubString 28-5
Text 28-3
Trim 28-5
Upper 28-5
strings 4-7,5-11, 18-32,28-5
assigning values 28-2,28-3
changing case 28-5
compressing 28-3,28-5
converting to numbers 28-3
searching 18-43, 18-44
size 28-3
testing 28-3, 28-4
Style 10-4
Style Sheets dialog box 18-35
StyleGetNext 17-8
subscript operator 6-9
SubString 28-5
substrings 28-4, 28-5
getting 18-43,18-44
Subsyte1;IlActivated 18-58
subtraction 6-2,6-3,6-14
super 5-23
SW_~AXIMIZE 18-46
SW_~INIMIZE 18-46
SW_RESTORE 18-46
switch 5-24
switch statements 5-3,5-4,5-7,
5-24
SymbolLoad 25-7
symbols 5-1,7-2
getting 18-42, 18-43, 18-50,
25-7
inspecting 18-15
syntax 4-5,4-7,5-18
Syntax Highlighting
options 8-5,8-6
SyntaxHighlight 8-5
SyntaxHighlightTypes 12-3
system 4-10

T
Tab 13-15
Tab key, testing for 13-3
tab stops 8-2, 8-6, 13-6, 13-15
TabRack 8-6
targets 18-37
creating 18-38
technical support 1-2
TerminateProgram 9-9
ternary operators 6-2,6-6

Text 10-5, 28-3
text blocks 8-5, 10-2
changing contents 13-13
converting case 10-8, 10-9,
10-10
copying 10-5
deleting 10-6
deselecting- 10-3
indenting 10-8, 12-2
printing 10-8
reading 8-5, 10-5, 13-11
replacing contents 13-11,
13-12, 18-44
restoring 10-9
saving 10-9, 13-13
selecting 10-3, 10-6, 10-7
size 10-3
styles 10-4, 10-8
writing 8-5, 13-7
text boxes 18-32, 18-46, 18-47
text buffers 30-2
text strings 28-5
assigning values 28-2,28-3
changing case 28-5
compressing 28-3, 28-5
converting to numbers 28-3
size 28-3
testing 28-3, 28-4
this pointer 5-25
tiling windows 18-45, 18-53,
18-54
time stamps 29-2,29-3
comparisons 29-3
edit buffers 11-3, 11-5
fractional values 29-2
timeout interval 18-9, 18-58
TimeStamp
Compare 29-3
Day 29-2
DayName 29-4
Hour 29-2
Hundredth 29-2
~illisecond 29-2
~inute 29-2
~onth 29~3
~onthName

29-4
Second 29-3
Year 29-3
Title 16-3
ToggleBreakpoint 9-9
ToggleCase 10-9
TokenFileName 8-6
tokens 7-1, 7-4
Tool 18-47
_tools 18-47, 18-59

Index

1-13

Tools dialog box 18-35
Top 18-11
TopBuffer 17-4
TopRow 15-5
TopView 11-6, 17-4
Track 22-3
trailing whitespace
trimming 28-5
transfer tools 30-2
TransferOutput
MessageId· 30-2
overview 30-1
Provider 30-2
ReadLine 30-2
TransferOutputExists 18-59
Translate 23-6
TranslateComplete 18-59
Translated 23-7
translations 18-59
Trim 28-5
TRUE 4-10
true 4-10
tutorial 3-1
Type 23-4
typeid 4-9, 5-26
types 4-4
typography 1-2

u
unary expressions 6-3
unary operators 6-13, 6-14
Unassign 19-6
unbounded arrays 4-14
undef 7-4
underscore, testing for 13-4
Undo 18-48
Undo command 18-22
undoing changes 17-5,17-8,
18-21, 18-22, 18-48
Unload 25:.7
unload 4-9, 5-27
Unloaded 25-8
unloading a script 2-15

1-14

Up 18-18
Upper 28-5
UpperCase 10-10
uppercase characters 10-9,
10-10,28-5

UseBRIEFCursorShapes 12-4
UseBRIEFRegularExpression 12-4
UseCurrentWindowForSourceTracking 18-12
UseTabCharacter 8-6

v
variables 5-10,5-13,5-26,6-7
declaring 5-7
referencing 5-28
Version 18-12
version numbers 18-12
vertical scroll bars 8-7
VerticalScrollBar 8-7
View 16-3
ViewActivate 16-4, 18-48
ViewActivated 17-10
ViewBreakpoint 9-9, 18-48
ViewCallStack 9-10, 18-48
ViewClasses 18-49
ViewClassExpert 18-49
ViewCpu 9-10, 18-49
ViewCpuFileLIne 9-10
ViewCreate 16-5
ViewCreated 17-11
ViewDelete 16-5
ViewDestroyed 17-11
ViewExists 16-5
ViewGlobals 18-50
ViewMessage 18-50
ViewProcess 9-11, 18-50
ViewProject 18-51
ViewRedo 17-8
ViewSlide 16-6, 18-51
ViewUndo 17-8
ViewWatch 9-11, 18-51
Visible 18-12
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w
wait cursors 18-22, 18-46
_warn 4-10
warnings 7-5,18-44
displaying 18-32, 18-33
Watches window 9-11,18-51
watching 9-3, 9-4, 9-11, 18-13,
18-51

while 5-27
whitespace
testing for 13-3
trimming 28-5
WholeFile 26-4
Width 18-12, 21-4
Window 15-6
window panes 18-48, 18-51
WindowArrangeIcons 18-52
WindowCascade 18-52
WindowCloseAll 18-52
WindowMinimizeAll 18-52
WindowRestoreAll 18-53
windows 16-4,18-52
activating 18-34, 18-58
arranging 18-27, 18-28,
18-29, 18-45, 18:-52, 18-53,
18-54
closing 18-13, 18-52
current state 18-29, 18-46
Windows messages 5-29
WindowTileHorizontal 18-53
WindowTileVertical 18-54
with 5-28
WordBoundary 26-4
writing a script 2-12

v
Year 29-3
YesNoDialog 18-54
yield 4-9,5-29
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